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• This manual explains the MotoSim EG-VRC.  Read this manual carefully and be sure to 
understand its contents before operation.

• General items related to safety are listed in the Chapter 1: Safety of Controller Instruc-
tions.  To ensure correct and safe operation, carefully read Controller Instructions before 
reading this manual.

• YASKAWA is not responsible for incidents arising from unauthorized modification of its 
products.  Unauthorized modification voids your product’s warranty.

• Software described in this manual is supplied against licensee only, with permission to use 
or copy under the conditions stated in the license.  No part of this manual may be copied 
or reproduced in any form without written consent of YASKAWA.

• Some drawings in this manual are shown with the protective covers or shields removed for 
clarity. Be sure all covers and shields are replaced before operating this product.

• The drawings and photos in this manual are representative examples and differences may 
exist between them and the delivered product.

• YASKAWA may modify this model without notice when necessary due to product improve-
ments, modifications, or changes in specifications. If such modification is made, the man-
ual number will also be revised.

• If your copy of the manual is damaged or lost, contact a YASKAWA representative to order 
a new copy. Be sure to tell the representative the manual number listed on the front cover.

DANGER

CAUTION

NOTICE
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Notes for Safe Operation
Before using this product, read this manual and all the other related documents carefully to 
ensure knowledge about the product and safety, including all the cautions. 
In this manual, the Notes for Safe Operation are classified as “DANGER”, “WARNING”, “CAU-
TION”,  or ”NOTICE”.

Even items described as “CAUTION” may result in a serious accident in some situations.  At 
any rate, be sure to follow these important items.

Indicates an imminently hazardous situation which, if not avoided, 
will result in death or serious injury.  Safety Signs identified by the 
signal word DANGER should be used sparingly and only for those 
situations presenting the most serious hazards.

Indicates a potentially hazardous situation which, if not avoided, will 
result in death or serious injury.  Hazards identified by the signal 
word WARNING present a lesser degree of risk of injury or death 
than those identified by the signal word DANGER.

Indicates a hazardous situation, which if not avoided, could result in 
minor or moderate injury.  It may also be used without the safety 
alert symbol as an alternative to “NOTICE”.

NOTICE is the preferred signal word to address practices not 
related to personal injury.  The safety alert symbol should not be 
used with this signal word.  As an alternative to “NOTICE”, the word 
“CAUTION” without the safety alert symbol may be used to indicate 
a message not related to personal injury.

To ensure safe and efficient operation at all times, be sure to follow all instructions, even if 
not designated as “DANGER”, “WARNING” and “CAUTION”.

DANGER

WARNING

CAUTION

NOTICE

NOTE
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Notation for Menus and Buttons
Descriptions of the programming pendant, buttons, and displays are shown as follows:

Description of the Operation Procedure
In the explanation of the operation procedure, the expression "Select • • • " means the follow-
ing operations:

• To move the cursor to the object item and left-click on it with the mouse.
• To pick out the object item by the tab key and press the Enter key.

(In case of selecting a menu, use arrow keys instead of the tab key to pick out the object 
item, then press the Enter key.)

Registered Trademark
In this manual, names of companies, corporations, or products are trademarks, registered 
trademarks, or bland names for each company or corporation.  The indications of (R) and TM 
are omitted.

Item Manual Designation

Menu The menus displayed on screen are denoted with { }.
ex. {TOOL}.

Button
The buttons, check boxes, radio buttons displayed on 
screen are denoted with [ ].
ex. [Close]; [Sync] check box; [Fast] radio button.
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1 Introduction

1.1 Overview of MotoSim EG-VRC

MotoSim EG-VRC is a software which has been developed as an offline teaching system for 
YASKAWA industrial robot MOTOMAN series.
MotoSim EG-VRC reduces teaching time requiring an actual robot, supports improvement of 
productivity and insures operator’s safety by enabling robot teaching on a personal computer.
MotoSim EG-VRC is an application software for MS-Windows having excellent operability and 
many advantages such as running multiple applications at once. 

1.1.1 Difference of the operation from 5.00

The appearance of MotoSim EG-VRC Ver5.00 differs greatly from Ver4.10 or before. 
Therefore, the difference in the operation method of a main screen is summarized so that the 
user before Ver4.10 could get used early. 

• Runs two or more MotoSim EG-VRC. However, the number of the cells which can be 
used by MotoSim EG-VRC is one. 

• " Docking Window "
• " Quick Access Toolbar "
• " Quick Access Toolbar "
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1.2 Notice and Restriction about MotoSim EG-VRC

1.2.1  Optional Functionof controller

Below is a list of the available optional functions on MotoSim EG-VRC.  For any other optional 
function not listed below, please consult with your Yaskawa representative.

*1 Standard function for FS100.
*2  Please refer to section "1.2.5 Restriction of Function of Controller" for Functional 

safety.

Please refer to section 
" 15.4  Standard function about YRC1000 "
" 15.5  Standard function about YRC1000micro "
" 15.6  Standard function about DX200 " 
" 15.7  Standard function about DX100 "

for the list of available standard function.

Function Name YRC1000 YRC1000
micro DX200 DX100 FS100 NX100

Relative Job      

TCP      

Macro Instruction      

I/F Panel      

External Reference Point      

Parallel Start Instruction      

Coordinated Instruction      

Extended Control Group  ―    

Station Angle Display      ―

Softlimits Customization  ―   ― ―

Tool No. Switching      

SI Unit Indication      ―

Display IO Name in Job     *1 ―

Variable Allocation      ―

Functional safety *2  *2 ― ― ―
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1.2.2 Using data saved from a real controller with
         MotoSim EG-VRC

To use the data saved from a real controller, depending on the environment, there are circum-
stance where the "CMOS.BIN' from the real controller can be used.
However, in some cases there may be problem cause by "CMOS.BIN" version incompatibility.  
In such cases, please use the individual data file save from the real controller for the jobs, 
condition files, parameters, etc. to reconstruct the system environment.

1.2.3 Using MotoSim EG-VRC data on a real controller 

Some data created with MotoSim EG-VRC can be use on the real controller, and some data 
cannot be use.

1.2.4 Function depending on the system version of control-
ler

Some functions of MotoSim EG-VRC can not use depending on the system version of control-
ler. Please refer to section " 15.8  List of Function depending on the system version of control-
ler ".

In regard to the FS100 controller, the "CMOS.BIN" file saved from a real controller can not 
be used with MotoSim EG-VRC to create the environment.

Usable data Job
Condition files
General data
All the name data

Unusable data Parameters
CIO Program

• The "CMOS.BIN" file cannot be saved from MotoSim EG-VRC.
Therefore, the "CMOS.BIN" cannot be used with a real controller.

• Option function selected by MotoSim EG-VRC can not be executed on the real robot.
• Parameter file or CIO program file of MotoSim EG-VRC can not be executed on the real 

robot. YASKAWA is not responsible for incidents arising from using these files.
• The format of the arc welding start condition file and arc welding end condition file 

(ARCSRT.CND, ARCEND.CND) has been changed in the YRC1000 system software 
YAS2.00-00. Therefore, if the version of the real controller is earlier than YAS2.00-00, 
the above files created with MotoSim EG-VRC2018 or later cannot be loaded. On the 
other hand, the above files created with the real controller before YAS2.00-00 can be 
loaded to MotoSim EG-VRC2018 or later.

NOTE

NOTE
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1.2.5 Restriction of Function of Controller

• MotoSim EG-VRC can not be connected to the real robot or pendant.
• MotoSim EG-VRC can not simulate the job in real time.
• MotoSim EG-VRC can not simulate CIO in real time.
• The function needed the special hardware (sensor, COMARC etc.) is disable.
• VPP is not supported the Enable Switch.
• MotoSim EG-VRC is supported the standard controller version only.
• The simulated coasting range is different from the real robot, when the emergency stop is 

done.
• Some INFORM connecting to the external device is not supported. ARCON/ARCOF 

SVSPOT SVSPOTMOV are supported.
• In regard to the NX100 controller, SVSPOT and SVSPOTMOV are not supported.
• Data transmission is not supported.
• Remote mode is not supported.
• Collision Detection is not supported.
• The standard CIO ladder is supported only. Modified CIO ladder is out of guaranteed 

operating range. So, lamps at the top of VPP (ex. servo lamp) may not work correctly, or 
IO Connect/IO Monitor/IO Event may not work correctly.

• Loading batch CMOS file "CMOSxx.HEX" saved from memory expanded system is sup-
ported only.

• Saving batch CMOS file "CMOSxx.HEX" and all CMOS area file "ALCMSxx.HEX" is not 
supported.

• In regard to the FS100 controller series, Loading/Saving/Verifying/Deleting the batch files 
and the all CMOS area file is not supported.
The appropriate files are "JOBxx.HEX", "CMOSxx.HEX", and "ALCMSxx.HEX".

• Ladder editor, PP application for arc welding, and MOTOPAL are not supported.
• MotoPlus function, MotomanSync function, and the applications used these functions are 

not supported.
• PP customize function is not supported.
• The simulation of spot gun change system is not supported.
• "PP display scroll function DX200 by touching operation" of DX200 controller is not avail-

able.
• Function of MotoSim EG-VRC for Function Safety is available only when the controller is 

YRC1000, YRC1000micro, DX200 and Function safety option is available. Simulation is 
possible only during jog operation in VPP or playback. It cannot be simulated with other 
functions like positional panels or OLP function.

• Function safety in which a simulation is possible on MotoSim EG-VRC is as follows.
Robot Range Limit
Axis Range Limit
Speed Limit
Tool Angle Monitor

Following function safety can not be simulated on MotoSim EG-VRC.
Axis Speed Monitor
Tool Change Monitor
Safety Signal

• When the edited files are loaded to YRC1000, YRC1000micro, DX200, it is necessary to 
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put in "SAFETY MODE", and to disable "SAVE DATA CRC CHECK FUNC.(FSU)". After 
loading, please make sure to enable "SAVE DATA CRC CHECK FUNC.(FSU)".
And, please make sure to check the settings on YRC1000, YRC1000micro, DX200.

1.2.6 Accuracy

• Positional Accuracy
When the job made in MotoSim EG-VRC is executed on the real robot, teaching points 
may be misaligned by the strain and placement error of work, and the deflection of robot. 
So, check the teaching points by NEXT/BACK, and modify them.

• Trajectory Accuracy
The simulated trajectory range is different from the real robot. When the job made in 
MotoSim EG-VRC is executed on the real robot, check the teaching points by NEXT/
BACK, and do test running. After sufficient operation check, execute playback.

• Cycle time Accuracy
The simulated cycle time is different from the real robot. If robot job contain the position 
level "PL=0" in move command, the resulting cycle time simulation may not provide suffi-
cient accuracy compared to the actual robot.

• Robot model Accuracy
Robot model is only external form, bolt hole and anchor bolt may be left out. Movable 
parts other than robot (ex. cable) can not be simulated.

1.2.7 Hardware Requirements

When simulate follow situation, PC with high-end CPU or graphic board may need.
• Multiple controllers are used. (4 or more)
• High-capacity CAD data is used.
• Collision check is used.
• Cable simulation is used.

1.2.8 Supported robot model

The robot models supported by MotoSim EG-VRC are those displayed on the virtual pendant 
for the controller version selected at the time of creation.  Please refer to section " 15.9  List of 
Manipulator Models and Offset Values Supported by MotoSim EG-VRC " for the list of avail-
able model. 
However, for similar robot model that only have differences in the details of their shape, it 
maybe possible to do simulation using the standard robot model (model ending with A0*).
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1.3 Environment Required for MotoSim EG-VRC

To run MotoSim EG-VRC, the following hardware and software are required:   

*1 Microsoft and Windows are registered trademarks of Microsoft Corporation in the U.S. 
and other countries.

*2 Intel Core is a trademark of Intel Corporation in the U.S. and/or other countries.
*3 NVIDIA is a trademark and/or a registered trademark of NVIDIA Corporation in the U.S. 

and/or other countries.
* This catalog may contain other proprietary names and copyright notices.
* TM and ? mark are not used in this catalog to indicate trademarks and registered trade-

marks.

1.3.1 3D Graphic Board Setting

3D graphics board may be disabled even on a computer with 3D graphics board installed. 
Unexpected error may occur when the 3d graphics board is disabled, so it is necessary to set 
to become 3D graphic board effective. The following is an example of setting when 3D graph-
ics board is NVIDIA.

OS

Microsoft Windows 10 (64bit)
<Tested version 2004>
<Windows 10 IoT and Windows 10 on ARM are not supported.>
Microsoft Windows 7 Service Pack1 (32bit / 64bit)
JAPANESE and ENGLISH Windows version are supported only. *1

CPU Intel Core i7 or higher multi-core processor. *2

Memory Capacity 4 GB or more

Free Hard Disk 
Space 500 GB or more

Monitor Supported by MS-Windows 
(256 colors or more)

Hardware Key Used under single user environment.
For details, refer to " 1.4  Hardware Key " in the following section.

GPU NVIDIA graphic card*3

Quadro series, etc.

MotoSim EG-VRC may not execute correctly, because of PC model, Graphic Board, other 
connected peripherals, and installed software, etc.

NOTE
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1. Right-click on the desktop to display the pop-up menu.

2. Select "NVIDIA Control Panel" from the menu above.
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3. Select "Manage 3D settings".

4. Select "High-performance NVIDIA processor" of the "Preferred graphics processor.
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5. Add MotoSimEG-VRC.exe when it isn't set at "Program Settings" tab.

• When setting of 3D graphics board is invalid, unexpected error may occur.
• Depending on the graphics board and OS version, the setting dialog may be different 

from the above. Please refer to the manual of 3D graphics board for details of setting.

 

NOTE

30/847



1.4  Hardware Key

HW0485348

1.4 Hardware Key

For proper operation, connect provided hardware lock key (USB type) to the personal
 computer before using this software.

Check and execute <Checking the computing environment> <Installing the driver> 
before connecting the key to USB port.

<Checking the computing environment>
Multi-connection of USB type key is not available for one USB port because of hardware 
structure.  Therefore, only one key can be connected to one USB port.  When installing multi-
ple offline software into one personal computer and multi-connectiong USB keys, use the per-
sonal computer which is provided same numbers of USB ports as the number of software to 
be installed.

<Installing the driver>  

Execute "\SentinelDriver\Sentinel System Driver Installer 7.6.0.exe" of installation DVD. Refer 
to "\SentinelDriver\Manual\Sentinel System Driver ReadMe.pdf" for the details of
installation.

Refer to " 15.9  List of Manipulator Models and Offset Values Supported by MotoSim EG-VRC 
" for other countermeasures concerning hardware key.

Please install the driver after detaching the all sentinel hardware key from the personal
computer.

• Be sure to install the driver.
• When installing the driver, be sure to login in administrator mode in order to add files to 

system folder and input information in registry.
• If a key is connected to personal computer before installing the driver,the message con-

cerning the driver is displayed. In this case, and detach the key from personal computer 
and then install the driver.
If a key is connected to personal computer before installing the driver under Windows 95/
98/NT4.0/2000/XP environment, Windows wizard ([Add New Hardware] Wizard)
starts up. In this case, push [cancel], and detach the key from personal computer and 
then install the driver.

• When installing the driver under Windows NT4.0, 2000 environment, please install the 
driver located in the folder "\SentinelDriver\SSD5411\SSD5411-32bit.EXE" of installa-
tion DVD.
For the driver installation procedure, please consult the installation manuarl "\Sentinel-
Driver\SSD5411\Manual\us\Readme.pdf".

NOTE

NOTE
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1.5 Installing MotoSim EG-VRC

1. It is strongly recommended that you exit all applications before running the setup pro-
gram.. 

2. Insert the installation DVD into the DVD drive.
3. If want to install the 32-bit version, run the "\setup_32bit\setup.exe". If want to install 

the 64-bit version, run the "\setup_64bit\setup.exe". When the User Account Control 
dialog is displayed, click [Yes].  [MotoSim EG-VRC InstallShield Wizard] will be dis-
played.

4. Follow the on-screen instructions. 

Be sure to login in administrator mode when installing the MotoSim EG-VRC in Windows 
7/10, or else the system related DLL files in Windows might not be updated.

If the following message appears during the installation, press [Yes] to continue installa-
tion.
This message is displayed when the installation of redistribution package of Visual C ++ 
2012 has been executed but installation is required.
If this message is displayed, run manually \setup_32bit\ISSetupPrerequisites\ 
{BF2F04CD-3D1F-444e-8960-D08EBD285C3F}\vcredist_x86.exe
after installing MotoSim EG-VRC, and install or repair the redistribution package of Visual 
C ++ 2012.

If the following message appears during the installation of the 64-bit version, press [Yes] to 
continue installation.
If this message is displayed, run manually \setup_64bit\ISSetupPrerequisites\{3A3AF437-
A9CD-472f-9BC9-8EEDD7505A02}\vcredist_x64.exe
after installing MotoSim EG-VRC, and install or repair the redistribution package of Visual 
C ++ 2012.

NOTE

NOTE
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5. When the setup is completed, MotoSim EG-VRC is registered under the 
{MotoSim EG-VRC} folder that appears by clicking the [Start] button in the task bar and 
selecting {Program} and then {Motoman}. 

6. Connect the hardware key to the printer port or USB port.  
For details, refer to " 1.4  Hardware Key " in this chapter.
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1.6 Definition of Terms 

Cell (*.vcl)

A file in which MotoSim EG-VRC simulation environmental data 
are recorded.
Folder information to store the operation contents, model file 
information such as robots, workpieces or tools, data of opera-
tional environment layout, etc. is recorded.

Model file (*.mdl) A file in which geometric data of robots, workpieces or tools are 
recorded.

Parent model

Each model requires a coordinate that refers to something in the 
layout.  Model to which the coordinate of a model refers to is 
called "parent model".
The most basic reference model in the MotoSim EG-VRC is 
"world".  Normally, world becomes parent for workpiece models 
or robot models.
However, since tool models or positioners move along with exter-
nal axis or robot axes, they refer to different parent models than  
fixed model. Since tool models must move with the robot, the 
robot model flange is normally set as the parent model of the tool 
model.
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1.7 Folder Configuration 

The above diagram is based on the assumption that the cell "TEST" is the file in which the 
simulation environmental data is stored, and that there is one controller named "NX100" with 2 
robots defined under the folders “RB1” and “RB2”.
The model files other than the robot model files are stored in the folder "TEST\MODELS".

 

 

 

 

 

  

MotoSimEG-VRC 

CELLS 

TEST 

MODELS 

RB1 

TEST.VCL 

Simulation environment used for the cell 
“TEST” is constructed in this directory. 

Stores model files of floor, tool, 
workpiece, etc. 

Stores the robot data: robot 
model files, etc. 

Cell file 

DX100 

Stores the controller related 
data files. 

RB2 

Stores the robot data: robot 
model files, etc. 

STORAGE CARD 

Stores the controller files 
accessible by the VPP 
SAVE/LOAD function. 

¥ 
Users 

MOTOMAN 

Public 

Documents 

EXAMPLE Stores sample cell files 

TEMPLATE 

CELLS 

Stores template cell files created by the 
template function of MotoSim EG-VRC. 

Program Files 

MOTOMAN 

MotoSimEG-VRC 

CONTROLLER 

Stores the VRC (Virtual Robot Controller) 
application files and default data of each 
controller. 

DEVICE 

Stores the files about devices. 

DOC 

Stores the help files. 

MODELS 

Stores standard models such as controller, 
tools, welder, etc. 

ROBOTS 
Stores files related to robot models by 
controller type. 

Files required to run MotoSimEG-VRC such as 
executable, initialization files, etc. 

3DPDF 

Stores template PDF files for 3DPDF 
output function. 

ModelLibrary Stores sample cell files 
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2 MotoSim EG-VRC Quick Tour

This chapter describes the basic operation of MotoSim EG-VRC by giving practical examples 
to first time users of this system. 
Read this chapter thoroughly in order to quickly take advantage of the excellent operability 
and various functions of MotoSim EG-VRC.

2.1 Overview

This chapter describes the procedures from cell construction to job creation.  An arc welding 
application is used as an example to illustrate the creation of workpieces for fillet-welding and 
a welding torch for tool, and then to teach a welding path.  
The following sections aim to create a robot, a workpiece and a stand like the ones prepared 
in "Arc_samp_NX" sample cell shown in the figure below.
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2.2 Cell Construction

1. Click on [START] in the task bar menu, then click {PROGRAM} - {Motoman} - {Moto-
Sim EG-VRC} - {MotoSim EG-VRC} to run MotoSim EG-VRC. 

2. When the main window appears, Click the MotoSim EG-VRC button (  ), and 
select the [New] - [New] menu. 

3. When the New Cel dialog box appears, enter any cell name: a folder where cells, 
parameter data, model data, job data, etc. are stored can also be set.  (The new folder 
name is the same as the cell name.)  In this example, the "TestCell" cell is created in 
the "CELLS" folder in the "Cells" folder.  
Enter "CelTest" in the File name edit box and click the [OK] button.  

 

Select here 
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4. The new cell with only a floor model appears.
Register a controller in the cell by selecting the [Controller] tab, in the [Setup] group, 
click the [New] button.  

5. The “Create Controller with” will display.
Select “No CMOS.BIN file” and press the [OK] button.

6. Select the controller system version, then press the [OK] button.

7. Controller Initialization.
The virtual controller will boot with the selected sytem version.  This may take a few 
moments.  Once the boot up is completed, the virtual pendant will display in mainte-
nance mode along with the “Controller Maintenance Mode Instructions” guide.  
When adding a controller with “No CMOS.BIN”, the controller needs to be initialized.  
Follow the steps displayed by the intstruction guide dialog to initialize the controller.  
When asked for the “Control Group”, select the robot “HP6-A0*” for the R1 group 
(press the spacebar to display the list of available robots.) 
When all the initialization steps are completed, press the [Complet] button of the 
instruction guide dialog to reboot the controller in normal operation mode.

 

 

Select here 
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8. Once the virtual controller has rebooted, the virtual programming pendant will display 
in normal mode. 
In the “Robot Settings” dialog that will also appear, enter a name for the robot (for this 
example, the default name “NX100-RB1” is used.)  Select the model file corresponding 
to the robot type (for the HP6-A0* select the “HP6-a00.mdl” file).
Press the [OK] button.

 

9. When the controller registration has been completed normally, the robot model 
appears in the cell screen as shown in the figure below. 
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However, as shown in the following figure, the robot may be displayed as if it is sank in 
the floor.  This is because the offset value of the robot operational origin and the floor 
center coordinate has been set to 0 (initial value).  In this case, correct the robot posi-
tion by following steps 10 and 11. 

10. On the [Home] tab, in the [Model] group, click the [CadTree] button, display the Cad 
Tree selection box.
Select “NX100-RB1” and click on [Pos] button. 
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11. In the Position dialog box below, the robot model can be moved to any arbitrary place. 
In the case of NX100-RB1, the height from the floor to the robot operational origin is 
450 mm, enter "450" for "Z" and click the [OK] button.  

The height from the floor to the robot operational origin (here the height is 450 mm) can be 
obtained by measuring the distance between the floor and the robot bottom by clicking the  
on the [Home] tab, in the [Mesurement] group, click the [Distance] button.  Refer to " 5.1  
MotoSim EG-VRC Display " for the details of measuring tools, and " 15.9  List of Manipula-
tor Models and Offset Values Supported by MotoSim EG-VRC " for each robot offset val-
ues.

When initialized the robot controller, MotoSim EG-VRC set the absolute data auto-
matically. So absolute setting is not needed in MotoSim EG-VRC. 
Refer to " 7.1.4  Initializing the Controller (FS100) " for details.

NOTE

 

Distance between the 
robot frame and the floor. 

NOTE
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2.3 Creation of Models

This section explains how to create workpiece models and tool models using the CAD func-
tions.

2.3.1 Creating a Workpiece and a Workpiece Stand

Follow the flowchart below to create a workpiece and its stand.
  

 

 

Create workpiece stand model
file in Cad Tree. 

 

 

 

 

 

Start

Add BOX model in file data 
editing dialog box.

Set model size and position
in BOX Edit dialog box.

Create workpiece model file  
in Cad Tree.

Add parts in the file data 
editing dialog box.

Set sizes and positions of 
parts in BOX Edit dialog box.

End
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1. The dimensions of the workpiece model and workpiece stand model are shown in the 
following figure:  

2. On the [Home] tab, in the [Model] group, click the [CadTree] button, the [CadTree] dia-
log appears.

3. When the Cad Tree appears, select "world" from the model tree; select {New Model} in 
the right-click menu, or click the [Add] button.   

To create a new model in the model selection screen, verify that the cursor is pointed to 
"world" so that it will be the parent model.

25

30

200

200

500

400

600

600

Units: mm

Workpiece Stand Model

Workpiece Model

Click the [Add] button 

NOTE
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4. Enter "STAND" (a word for “stand” in Japanese) in the Add Model Dialog box and click 
the [OK] button.  

A confirmation dialog box appears, to create the new model: click on [OK].  

5. The "STAND" model appears in the Cad Tree: point the cursor to "STAND" and double-
click it.  

6. The model editing dialog box appears: select “BOX” from the "Add Parts" combo box, 
and click [Add].  

The “STAND” model is 
added here. 

 

The “STAND” model is 

added here. 
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7. The BOX Edit dialog box appears: input the dimensions of the workpiece stand.  

Select 400 for width, 600 for depth and 400 for height by using the spin button  at 
the side of the edit box or by entering the values directly.  The incremental values of 
the spin box can be changed from 0.1 to 100 in the incremental value list box.  Select 
desired colors, and check if the stand is displayed properly.  
When satisfied, click the [OK] button to return to the file data editing box.  Click the 
[Close] button in the file data editing dialog box to complete the creation of workpiece 
stand model.

8. The workpiece stand model is located at the center of the floor under the current condi-
tions: therefore, click the [Pos] button in the Cad Tree to display the position dialog box, 
and input 800 for X, 0 for Y and 200 for Z to modify the model location.  

When a part is added with the [Add] button, the parts editing dialog box appears automati-
cally.  However, to reedit a part that has already been added, use the [Edit] button to dis-
play the part editing dialog box after selecting the subject part name.

NOTE
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9. To create a workpiece, set "STAND" as the parent model by pointing the cursor to 
"STAND" in the Cad Tree.  Create a new model named "WORK" as shown in the fig-
ures below.  

10. Display the BOX Edit dialog box by selecting "BOX" from the "Add Parts" combo box in 
the model editing dialog box, then click [Add].  

11. Set the workpiece size and position as shown in the table below in the BOX Edit dialog 
box: this model will be the bottom part of the fillet-welding workpiece.  

Width (W) 200 Depth (D) 500 Height (H) 30

X (mm) 0 Y (mm) 0 Z (mm) 0

Rx (degree) 0 Ry (degree) 0 Rz (degree) 0
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12. The model is currently displayed in the center of STAND model: to modify its position, 
first close the BOX Edit dialog box by clicking [OK] and the file data editing dialog box 
by clicking [Close]; after closing those dialog boxes, click the [Pos] button in Cad Tree 
to display the Position dialog box, and enter 0 for X, 0 for Y, and 215 for Z to display 
WORK model on top of STAND model.  

13. Create the upper part of the workpiece: the upper workpiece is composed of a second 
BOX part.  Double-click "WORK" in Cad Tree to call up the file data editing dialog box, 
and add another BOX model (note that this operation should not be done by clicking 
the [Add] button in the Cad Tree).

14. Set the workpiece size and position as shown in the table below in the BOX Edit dialog 
box.  

Width (W) 25 Depth (D) 500 Height (H) 200

X (mm) 0 Y (mm) 0 Z (mm) 115

Rx (degree) 0 Ry (degree) 0 Rz (degree) 0

Place the “WORK” 
model on top of the 
“STAND” model 
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15. Check if the workpiece model has been created according to the dimensions specified 
in the step 1.  
If the model has different dimensions or to change the color of the model, proceed to 
the step 16 and 17 to make modifications.

16. Display the BOX Edit dialog box by pointing the cursor to BOX model to be edited 
among the models added to the Cad Tree, then double-click it.

17. Reedit the workpiece size, etc. in the BOX Edit dialog box.  To modify the color of the 
model, click on the [Color...] button.
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2.3.2 Editing Tool Data

This section explains on how to edit the tool data.  The tool to be created is a torch for arc-
welding.  The tool dimensions are: 0 mm for X, 0 mm for Y, and 395 mm for Z.  

1. On the Virtual Programming Pendant, select from the main menu {ROBOT} - {TOOL}. 

 

2. The TOOL settings appear.  Move the cursor with the arrow keys to the Z field.  Press 
the [Spacebar] to select the Z field for edition and enter the value “395”.  Press [Enter] 
to register the entered value.   Repeat the same procedure for the Ry field and enter a 
value of -35.  (In this example, the tool end curves by “Ry = -35” relative to the flange 
axis.  

49/847



2.3  Creation of Models

HW0485348

2.3.3 Adding a Tool Model

There are two ways to add a tool model:
(1) Create a tool model with the CAD function of MotoSim EG-VRC.
(2) Read a tool model in the HSF format (*.hsf). 

First, method (1) is used to explain the creation of a tool model with the MotoSim EG-VRC 
CAD function. 

In method (2), an HSF format model is used; this is explained in " Reading the HSF Format 
Model " later on. 

 Creating and Adding a Tool Model with the CAD Function

Follow the flowchart below to create a tool model.  

Part A

Part C

Part B

Part D

Start

Create a tool model file in
Cad Tree.

Add parts in the file data 
editing dialog box.

Set parts size and layout in
BOX Edit dialog box.

Click on [Close] button in 
the file data editing dialog 
box after verification.

End
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1. Display the Cad Tree to create a new model names "TOOL".  In this case, point the 
cursor to "NX100-RB1_flange" and create a new model so that the parent model of the 
tool model is the flange of the robot.  
 

If the parent model is not set correctly, change the parent model by selecting 
{Model Attribute} - {Set Parent } as shown in the following figure.

 

Select the 
NX100-RB1_flange 
model and click [Add] 

 

Select the parent  
model in this  
dialog box. 
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2. The dimensions of the tool model are shown in the following figure: 

3. Double-click "TOOL" in the Cad Tree to display the file data editing dialog box, and add 
parts in the file data editing dialog box.  
The tool model is composed of two BOX models and two CYLINDER models.  Assume 
these four parts as parts A, B, C and D, respectively: edit parts A and B in the BOX edit 
dialog box and parts C and D in the CYLINDER Edit dialog box.  
The following tables show the size and layout of each parts A, B, C and D. 

• Part A (BOX) 

• Part B (BOX) 

Width (W) 70 Depth (D) 70 Height (H) 80

X (mm) 0 Y (mm) 0 Z (mm) 40

Rx (degree) 0 Ry (degree) 0 Rz (degree) 0

Width (W) 150 Depth (D) 70 Height (H) 20

X (mm) 40 Y (mm) 0 Z (mm) 90

Rx (degree) 0 Ry (degree) 0 Rz (degree) 0

150 70 
70 

80 

20 

170

145

35˚
30

X Y

ZZ

X

Y
Units: mm
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• Part C (CYLINDER) 

• Part D (CYLINDER) 

4. When the parts are all added, check the tool model on the screen, then click on the 
[Close] button to exit the file data editing dialog box.

5. Verify that the size and layout of the tool model, STAND model and WORK model are 
properly set, and click the [Close] button in the Cad Tree to complete creation of the 
models.

Lower Dia. 30 Height (mm) 170 Division 16 Upper Dia. 30

X (mm) 80 Y (mm) 0 Z (mm) 100

Rx (degree) 0 Ry (degree) 0 Rz (degree) 0

Lower Dia. 30 Height (mm) 145 Division 16 Upper Dia. 30

X (mm) 80 Y (mm) 0 Z (mm) 270

Rx (degree) 0 Ry (degree) -35 Rz (degree) 0
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 Reading the HSF Format Model
This section describes how to add a tool model which is provided as an HSF format (*.hsf).
If the tool model has been already added in the previous section " Creating and Adding a Tool 
Model with the CAD Function ", select "TOOL" from the Cad Tree and select "Hide" to hide it.  

1. Select "NX100-RB1_tcp" in Cad Tree and click [Add] to display the Add Model Dialog 
dialog box, then enter "TOOL2" in the Name edit box.  
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2. Click the [...] button of the file name and select "Torch.hsf" file in the folder "Mod-
els\Torch"; click the [OK] button.  

The HSF model files can be added by drag and drop from the Explorer.  (Refer to" 11.11  
Reading a Model " for details.)  In this case, answer "Yes" when prompt "Select the parent 
model? and then select "NX100-RB1_tcp" as the parent.

 

Select the file type 

Select the “Torch” folder 

Select the “Torch.hsf” file 

NOTE
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2.4 Setting of Target Points (AXIS6 Model)

This section explains on how to add an AXIS6 model before starting to teach.  This procedure 
is not necessarily required, however, it makes future teaching easier.

AXIS6 is a model composed of only X, Y and Z-axis frames.  Set AXIS6 as target points for 
the following two steps which will be teach later.

• Step 3: welding start position
• Step 4: welding end position

1. On the [Home] tab, in the [Teaching] group, click the [OLP] button to display OLP dia-
log box as shown below.  Select the [Teacher] radio button in the “Operation Obj” sec-
tion, check the [OLP Pick] check box.  

 

Select “Teacher” 

Check the “Pick 
Enable” box 
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2. Set the Teacher to the welding start position of Step 3: click the welding start position 
with [Enable] checked.  

3. Set the Teacher to optimum angle for the tool welding position: in the following exam-
ple, welding is performed at an angle of 45° to the welding position.  Press the [Display 
Position] button from the OLP panel and set Rx, Ry and Rz as shown below.  

4. Double-click the "WORK" model in the Cad Tree and add AXIS6 in the file editing dia-
log box.  

5. Click on [Add] and verify that the number “1” has been added to the Index list box.  
Then, check the [Pose] check box in the Teacher group and click the [Goto] button.  
With this operation, the teacher frame color in the cell window changes, which means 
that AXIS6 has been set to the teacher coordinate and orientation and now overlaps it. 

Rx (degree) 180 Ry (degree) 45 Rz (degree) 0

          

 Click here.
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6. Set AXIS6 to the welding end point by performing steps 1 and 2 again, however, since 
the welding end point is to be set this time, be sure to click the part shown below in the 
OLP function.  (Since the teacher angle has already been modified in the 3rd step, the 
angle modification is not necessary here.)  

7. Add frame number 2 by clicking the [Insert] button in Frame Edit dialog box for AXIS6 
which has been previously set; verify that the [Pose] check box is checked and click on 
[Goto].

8. When AXIS6 is set, click on [OK] to complete the setting.

           

Click here.

 

58/847



2.5  Teaching

HW0485348

2.5 Teaching

Follow the flowchart below to create an actual job for arc-welding.
 
 

 

 

Select a job. 

 

 

 

 

 

Start

Step1: Set in the standby 
            position.

Step2: Determine the welding 
            approach posture.

Step 3: Move to welding start 
            position.

Step 4: Determine welding 
             end position.

Verify each step.

End

 
Step 5: Move to the position
            where the robot does 
            not interfere with 
            workpiece.

 
Step 6: Return to the standby
             position.
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2.5.1 Creating a New Job

Create a new job before teaching: 
1. On the virtual pendant main menu, select {JOB} - {CREATE NEW JOB}

2. With the cursor in the “JOB NAME” field, press the [Spacebar] to select the “JOB 
NAME” field and display the alphanumeric input window.  Enter a name for the job.  
For this example, enter "GUIDE" in the “Result” field and then press [ENTER].  To enter 
a name for the job, the keyboard is also available. For details, please refer to the sec-
tion " 5.2.6  Input with keyboard ".

3. Click the [EXECUTE] button or press [ENTER], to create the new job.
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2.5.2 Teaching the Standby Position

1. Press the [SERVO ON] button.  Once the servo power is activated, move the robot to 
its standby position by using the Virtual Pendant axis keys.  

To display or hide the pendant keypad, press the [/] key or click on the  icon.
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2. In the input line, select the motion type using the [MOTION TYPE] key of the pendant 
keypad.  
For this example, select joint motion (MOVJ)

 
3. Set the motion speed:

• Press [Select] to the focus in the input line.
• Move the cursor to the speed value with the cursor key.
• Select the speed value by using the [SHIFT] and the up and down arrow of the cur-

sor key.
For this example, set the motion:

• Type: Joint Motion (MOVJ)
• Speed: 100%

4. Press [Enter] to register the motion instruction to the robot current position. 

2.5.3 Determining the Welding Approach Posture

Use the virtual pendant to posture the robot so that it can perform welding.
Press [Enter] to register this step (Step 2). 
 

62/847



2.5  Teaching

HW0485348

2.5.4 Teaching the Welding Start Position

1. On the [Home] tab, in the [Teaching] group, click the [OLP] button to display the OLP 
dialog box.

2. Select the [OLP Pick] check box and [Vertex] check box in the “Pick type” section, and 
click an arbitrary point; the TCP moves to overlap the vertex near the clicked point.  
To make the most of the AXIS6 which has been set to the welding start point in the pre-
vious section, the OLP settings should be made as follows: 

• OLP Active:         Checked
• Move Mode:         Position, Orientation
• Pick Mode:           Vertex
• Pick Object:          Frames
• Operation Object: Robot Name (NX100-RB1)
• 

3. Click on AXIS6 displayed on the screen with the mouse as shown in the figure below: 
the tool angle is adjusted to the angle of the AXIS6.  
If the tool collides with the workpiece due to an improper tool angle, avoid the collision 
by manually repositioning the robot with the programming pendant dialog box.

4. With the virtual pendant, set the motion:
• Type: Joint Motion (MOVJ)
• Speed: 25%

5. Press [Enter]  to register this step (Step 3).

 

Click around here.
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2.5.5 Teaching the Welding End Position

1. Enable the OLP function and click on AXIS6 which has been set to the welding end 
point to move the tool to the welding end point.

2. With the virtual pendant, set the motion:
• Type: Linear Motion (MOVL)
• Speed: 558 cm/min

3. Press [Enter] to register this step (Step 4).

           
 Click around here.
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2.5.6 Teaching the Torch Retraction

1. Use the virtual pendant axis keys to move the robot away from the weld.

2. Set the motion:
• Type: Joint Motion (MOVJ)
• Speed: 50%

3. Press [Enter]  to register this step (Step 5).
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2.5.7 Returning to the Standby Position

1. On the virtual pendant, move the cursor in the job to the first step.  
Press and hold the [FWD] key on the virtual pendant keypad to move the robot to this 
position.
(Use the [FAST] and [SLOW] keys to adjust the speed for manual operation.)
When the robot reaches the position for step 1, the robot will stop and the job cursor 
will stop blinking. 

2. Set the motion:
• Type: Joint Motion (MOVJ)
• Speed: 100%

3. Move the job cursor back to Step 5 (before the END command).

4. Press [Enter]  to register this step (Step 6).
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2.5.8 Verifying Each Step

On the virtual pendant, move the cursor in the job to the first step.  
Press and hold the [FWD] key on the virtual pendant keypad to move the robot to this position.
When the robot reaches the position, the robot will stop and the job cursor will stop blinking.  
Release the [FWD] key, then press it again to move to the next step of the job.  Repeat until 
the end of the job is reached.

2.5.9 Editing a JOB

A JOB can be edited with the following procedure.

 Modifying Steps Position
1) Move the cursor to the step to be modify.
2) Move the robot to the desired position using the virtual pendant or MotoSim EG-

VRC functions (OLP, Position panel...)
3) Press the [MODIFY] key of the pendant keypad and the [ENTER] key. 

 Adding Steps
1) Move the cursor to the step preceding the insertion point.
2) Move the robot to the desired position using the virtual pendant or MotoSim EG-

VRC functions (OLP, Position panel...)
3) Set the motion type and motion speed.
4) Press the [ADD] key of the pendant keypad and then the [ENTER] key

 Deleting Steps or Instructions
1) Move the cursor to the instruction to delete.
2) If the instruction is a motion instruction (step), move the robot to the step position 

by pressing and holding the [FWD] key until the robot stops moving and the cur-
sor stops blinking.

3) Press the [DELETE] key of the pendant keypad and then the [ENTER] key.
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2.6 Playback

1. On the virtual pendant, move the job cursor to the top of the job.
2. In MotoSim EG-VRC, click the job execution button [Start]  to perform playback and 

check the movement.

3. When the playback is completed, the play time can be displayed by clicking [Trace] to 
show the Trace Manager dialog.

• To modify the job after playback the virtual pendant next to be change back to teach 
mode by pressing the [TEACH] button.

• During the execution of job, please do not sleep or hibernate the PC.
The display of cell window may not recover.

NOTE
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3 Offline Teaching Procedure

This chapter describes the procedure for offline teaching and examination of robot application 
with MotoSim EG-VRC, and other related software.

3.1 Operation Flow

The following flowchart shows the general flow of the offline teaching using MotoSim EG.  

Solid lines indicate operation by MotoSim EG-VRC and dotted lines indicate operations by 
other software.

Construct MotoSim EG-VRC operational envi-
ronment (cell) on the computer.

Register created controller and layout the robots 
in the cell. 

Create models to represent the workpiece, tool, 
etc. using MotoSim EG-VRC.  Set target points 
to simplify teaching.

Layout the model on the cell.

Perform teaching and playback by using Moto-
Sim EG-VRC to examine the motion.

From the virtual pendant menu, select {FD/CF} - 
{SAVE} ans save the job and data.

Correct the layout error between MotoSim EG-
VRC and the actual manipulator.

Send/receive job and data to the actual control-
ler using CompactFlash or transmission soft-
ware.

Reduce the error between MotoSim EG-VRC 
data and actual robot using calibration software, 
and verify and correct the motion. 

Work cell construction 

Start 

Registration of controller and  
arrangement of robots  

Creation of work model and  
teaching target points 

Model arrangement 

Teaching of robot motion 

Review of robot motion, time and 
interference 

Correction 
(work calibration) 

JOB data transfer to the 
actual controller 

Verification/correction of the motion  
using the actual robot. 

End 

Saving of jobs, parameters and  
tool data. 
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4 Creating and Editing a Cell

This chapter explains on how to create and edit a cell.  Before starting to program robot 
motion with MotoSim EG-VRC, first create a cell and then register the controllers with the type 
and number of the robots to be used. 
For controller and robot registration, refer to " 7.1  Adding a New Controller ".

4.1 Creating a New Cell

Procedure

1. Click the MotoSim EG-VRC button (  ), and select the [New] - [New] menu. 
2. Enter a file name in the File name edit box, and click on [Open] to create a basic cell.  

4.1.1 Template Function

If the template cells are registered, the new cell is created from the template, so creation time 
is shortened. And the template cells can be renamed and deleted.

 Registration of Template
The cell are currently open is registered as the template. When many cells with same robot 
configuration are created, creating the cell can be easily through the use of the template.

Procedure
1. Open the cell to register as template.

2. Click the MotoSim EG-VRC button (  ), and select the [New] - [Template] menu. 

 

Enter a file name here.

70/847



4.1  Creating a New Cell

HW0485348

3. Select the [Template] radio button, and click the [Add] button.

4. Set the name of template, and click the [OK] button.

5. The registered template is displayed in the template list.
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 Rename the Template
The registered template is renamed.

Procedure

1. Click the MotoSim EG-VRC button (  ), and select the [New] - [Template] menu.
2. Select the name of template to rename in the template list.

3. Select the [Template] radio button, and click the [Rename] button.
4. Set the new name of template, and click the [OK] button.
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5. The renamed template is displayed in the template list.

 Delete the template
The registered template is deleted.

Procedure

1. Click the MotoSim EG-VRC button (  ), and select the [New] - [Template] menu.
2. Select the name of template to delete in the template list.

3. Select the [Template] radio button, and click the [Delete] button.
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4. A confirmation dialog box is displayed. Click the [OK] button.

5. The deleted template disappears in the template list.

 Create the new cell from the template
The new cell is created from the registered template.

Procedure

1. Click the MotoSim EG-VRC button (  ), and select the [New] - [Template] menu.
2. Select the name of template to delete in the template list.
3. Select the [Create cell from template] radio button, and set the name of new cell.
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4. Click the [Create cell] button.

5. The new cell is created. If the [Open the created cell] is checked, the new cell is 
opened.
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4.2 Opening a Cell

Procedure

1. Click the MotoSim EG-VRC button (  ), and select the [Open] - [Open] menu.

When the sample cell is opened, click the MotoSim EG-VRC button (  ), and select 
the [Open] - [Open Sample Cell] menu.

2. Select a cell file, and click on [Open]: the cell appears.  

When opening a cell with LINE data (wire frame), it is recommended to use LINE data in 
the HMF format: opening a cell with LINE data in other format may take some time. 
If the LINE data is in the format other than HMF, convert the LINE data with “MDL2HMF.EXE” 
(located in a folder where MotoSim EG has been installed).

NOTE
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4.3 Storing a Cell

A cell file can be stored either under it current name “Save” or under a new name “Save As”.

4.3.1 Save

To store a file under its current name, click the MotoSim EG-VRC button (  ), and select 
the [Save] menu.
If the cell file was loaded from an older MotoSim EG-VRC version, the following message will 
display to confirm if the cell should be saved in the cell original format or in the MotoSim EG-
VRC current version.

Click [Yes] to save the file in MotoSim EG-VRC current version.  Click [No] to save the file in 
its original version.  Click [Cancel] to abort saving the cell file.

Newer cell files containing HSF files may not display properly on older MotoSim EG-VRC 
versions.  If a cell file need to be used with an older MotoSim EG-VRC version, it is recom-
mended to save it in the corresponding version with the "Save As" dialog box.

NOTE
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4.3.2 Save As

To store a file under a new name, click the MotoSim EG-VRC button (  ), and select the 
[Save As] menu. Then store the file with the desired cell name.  By changing the "Save as 
type" selection, the cell file may also be saved in a previous MotoSim EG-VRC format.

4.3.3 Save For SharePoint

Conversion operations are required when saving cells containing YRC1000, YRC1000micro 
controllers to SharePoint Server. To convert to a format that can be saved to SharePoint 
Server, click [MotoSimEG - VRC Button] and select [Save For SharePoint].

4.4 Exiting a Cell and MotoSim EG-VRC

To exit MotoSim EG-VRC, click the MotoSim EG-VRC button (  ), and select the [Exit] 
menu.
They can also be terminated by clicking  button in the control menu box on each window.
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5 Displays

MotoSim EG-VRC has various displays.  The main MotoSim EG-VRC display shows the cell 
layout and the robot motion in a 3D environment.  Also, for every VRC controller in the cell 
there is a Virtual Pendant that allows to operate the VRC controller in the same manner than 
the real controller.

5.1 MotoSim EG-VRC Display

For improvement of operability, the basic operations of MotoSim EG-VRC are common with 
those of other Windows applications. 
The following figure shows the MotoSim EG-VRC main window.

The appearance of MotoSim EG-VRC Ver5.00 differs greatly from Ver4.10 or 
before. For more detail, please refer to the " 1.1.1  Difference of the operation from 
5.00 " section.

NOTE

 

 

 

 

Docking Window Cell window 

Quick Access Toolbar 
Title bar 

MotoSim EG-VRC button 

Tab 

Group 

 R
ibbon 
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5.1.1 Ribbon

The ribbon is a command bar that organizes the features of an application into a series of tabs 
at the top of the main window. The ribbon replaces the traditional menu bar and toolbars.

 MotoSim EG-VRC button

Creates a new cell.
For details, refer to section " 4.1  Creating a New Cell " .

Create the new cell form the template.
For details, refer to section ." 4.1.1  Template Function "

Reads an existing cell.
For details, refer to section " 4.2  Opening a Cell ".

Reads an existing sample cell.
For details, refer to section " 4.2  Opening a Cell ".
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 Home

Saves the edited cell information of a cell file. 
For details, refer to section " 4.3.1  Save ".

Save the active cell file with a new name.
For details, refer to section " 4.3.2  Save As ".

Convert the cell folder to a format that can be saved to Share-
Point Server and overwrite it.
For details, refer to section " 4.3.3  Save For SharePoint ".

The help of MotoSim EG-VRC is displayed. 

The help of a MotoSim EG-VRC CAM function is displayed. 

Displays the Option dialog box.
For details, refer to section " 12  Configuration Settings ".

To close the active cell. 
For details, refer to section " 4.4  Exiting a Cell and MotoSim 
EG-VRC ".

Edit

Undoes the last operation.
Click the down arrows beside the icon to display the last 9 opera-
tions.  Selecting an operation from the list will undo this operation 
and all the operations performed after.

Redoes the last undone operation.
Click the down arrows beside the icon to display the last 9 undone 
operations.  Selecting an operation from the list will redo this opera-
tion and all the undone operations performed before.

Open the cell folder.

• Undo and Redo function supports the robot position change, model edition, Cad Tree 
operations and camera viewpoint operations.  Any operation generated by the virtual 
pendant or the playback of a JOB is not supported by the Undo and Redo function.

• Undo and Redo function may generate temporary files (mseg????.tmp) located in the 
Temp folder under the MotoSimEG installation folder.  Deleting these files while MotoSi-
mEG-VRC is running may prevent undoing some operations.  Normal termination of the 
MotoSimEG-VRC application will automatically remove all temporary files in this folder.

NOTE
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Teaching

Displays the Position Panel.
Position Panel displays the robot position, pulse data, etc.  
For details, refer to section " 8.1  Position Panel ".

Displays OLP dialog box and enables OLP function.  Moves the end of the 
robot tool or a model to a target point with one-click operation.
For details, refer to section " 8.10  Teaching ".

Displays the Job Browser.
For details, refer to section " 8.16  Job Browser ".

For detail on the CAM function please refer to CAM help (click  and 
select [CAM Help] menu).

View

Displays the View Manager panel, which offers a wider selection of 
standard view and allows to save and load up to 10 user defined 
views.
For details, refer to section " 6.1.2  Preset Viewpoint Operation ".

Displays all the models in the cell to fit in the view.

Change the viewpoint to display the default isometric view.

Changes the viewpoint to display the default top view.

Change the viewpoint to display the default side view.

Changes the viewpoint to display the default front view.

• This function is available MotoSim EG-VRC ver4.00 or later.
• To use this function (CadPack option), the MotoSim EG-VRC-

CadPack is required. (The MotoSim EG-VRC-CadPack is sep-
arate product from MotoSim EG-VRC.)

• For Laser-welding use and Laser-cutting use, the additional 
options sold separately are needed.

NOTE
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Model

Selects a model: click any point of the desired model for selection.

Displays the model “Cad Tree” (tree structure organization of the models), 
indicating  models display status and relationship.  Can be used to add and 
edit models.
For details, refer to section " 11.1.1  Outline of the Cad Tree ".

Displays the model library dialog.
For details, refer to section " 8.17  Model Library ".

Pick

The Pick Mode sets conditions determining the selected point in the clicked 
area.
For details, refer to section " Pick Mode Setting ".

Pick object set filters on the type of objects that can be selected by the mouse 
pick.
For details, refer to section " Pick Object Setting ".

Screen

Toggles display of the AXIS6 in frame indicators in the view.
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Displays cross-section X/Y/Z.
For details, refer to section " 6.7  Cutting Planes ".

Creates a memo (text).
For details, refer to section " 6.6  Memo ".

Creates a dimension line. 
For details, refer to section " 6.10  Measure Line ".

Draws a free-form line/circle/rectangle or adds a note (text).
For details, refer to section " 6.5  Markup ".

The display mode can be change.
For details, refer to section " 6.11  Changing the Rendering Mode ".

Changes the frame line to display the width.
For details, refer to section " 6.12.1  Changing Frame Width ".

Displays the Light Manager panel, which allows to add or remove 
lights, and to modify each light's properties.
For details, refer to section " 6.2  Light Manager Operation ".

Shadows can be displayed for the models on the screen.
For details, refer to section " 6.3  Displaying Shadows ".

Displays the axis triad.
For details, refer to the section " 12.1.3  Display ".

Changes the perspective.
For details, refer to the section " 12.1.3  Display ".

Mesurement

Measures the distance between two clicked points.
For details, refer to section " 6.8  Measure Distance ".
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Measures the angle between three clicked points.
For details, refer to section " 6.9  Measure Angle ".

Tools

Copy the static image of the cell window.
For details, refer to section " 6.12.2  Copying the Image ".

Drawing performance is measured. 

External software is executed. 
For details, refer to section " 8.15  Running an External Software 
".

Settings

The re-drawing interval at the playback is set every second (s).
For details, refer to section " 7.5.4  Refresh Interval ".

Sets the language.
For details, refer to section " 12.4  Language and Unit Settings ".

Operation Handle For details, refer to section " 8.10.2  Operation Handle ".

Display/Hide the operation handle.

When operate the Operation handle, the selected robot only 
moves.

When operate the Operation handle, the selected robot and 
another robot move to keep their TCP the same relative position.

Select the coordinate of the Operation handle.
The following coordinates are available.

Display the control group of the current job.

Display/Hide the tool names at the tip of tool (TCP).
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 Controller

Display/Hide the guide line.

Setup

Create a new controller and define a system in MotoSim EG-VRC.
For details, refer to section " 7.1  Adding a New Controller ".

A controller already define in a MotoSimEG-VRC cell can be copied over to 
another cell.
For details, refer to section " 7.2  Copying a Controller ".

To delete the controller and its associated robots from a cell.
For details, refer to section " 7.3  Deleting a Controller ".

Boot

Reboot the controller to update parameter changes.
For details, refer to section " 7.5.3  Reboot Controller ".

The controller is rebooted in the maintenance mode.
For details, refer to section " 7.10  VRC Maintenance Mode ".

VPP

Displays the Virtual Pendant.
Virtual Pendant can be operated same as Teaching Pendant of each control-
ler.
When click the button with pressing [Ctrl] key, the [Virtual Pendant] is dis-
played at upper left of MotoSim EG-VRC dialog.
For details, refer to section " 5.2  Virtual Pendant ".

Open the Storage Card folder
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Displays all Virtual Pendants. 
When click the button with pressing [Ctrl] key, all [Virtual Pendant] are dis-
played at upper left of MotoSim EG-VRC dialog.

Hides all Virtual Pendants.

Job

Displays the Simple Pendant dialog.
For details, refer to the section " 8.18  Simple PP ".

Displays the JobPad dialog.
For details, refer to the section " 8.19  JobPad ".

File Settings

Modify the tool data file.
For details, refer to section " 7.5.1  Tool Editor ".

Modify the user frame data.
For details, refer to section " 7.5.2  User Frame ".

Modify robot callbration data file.
For details, refer to section " 7.6.3  Robot Calibration Setting ".

Set the welding machine for spot welding.
For details, refer to section " 13.8.3  Setting of welding machine 
".

Display/delete the cube interference area.
For details, refer to section " 7.5.6  Cube Interference Area ".
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Display and modify the safety function. And switch the input sig-
nal of safety logic circuit.
For function safety's details, refer to " 7.10  VRC Maintenance 
Mode " and " 7.11  Displaying model / Editing Data of Safety 
Function ".
For safety logic circuit details, refer to " 7.13  Safety Logic Circuit 
Setting Support Function "..

Set the welding machine for arc welding.
For details, refer to section " 13.20  Setting of arc welding simu-
lation ".

Robot

Set the robot model.
For details, refer to section " 7.6.1  Robot Property ".

Draw TCP Reach View.
For details, refer to section " 7.6.2  Reach View ".

External Device

Creates a new external device.
For details, refer to section " 7.7  Peripheral Equipment ".

Set the soft limit.
For details, refer to section " 7.7.4  Modifying the Soft Limit of 
a Device ".

Displays the Job Panel.
For details, refer to section " 7.7.6  Programming a Device ".

Edit conveyor specification.
For details, refer to section " Conveyor Setting ".

Set the conveyor condition file.
For details, refer to section " 7.7.9  Conveyor Synchroniza-
tion ".

Display conveyor operation panel.
For details, refer to section " 7.7.8  Conveyor Operation 
Panel ".
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 Simulation

Playback

Moves the cursor in the job to the first step on the virtual pendant, and 
sets the robot position to the position of starting the job.

Executes the job currently selected of all the controllers in the cell.  
Use the virtual pendant to change the selected job.

Interrupts the job under execution.

Enables a job to skip backward step by step.

Enables a job to skip forward step by step.

Display the Stage master.
For details, refer to section " 8.7  Stage Master ".

To playback without considering the lag of servo.

Display the Cycle time.
For details, refer to section " 7.8  Cycle Time ".

This function can not use depending on the system ver-
sion of controller. Please refer to section " 15.8  List of 
Function depending on the system version of controller ".

NOTE

During the execution of job, please do not sleep or hiber-
nate the PC.
The display of cell window may not recover..

NOTE
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Monitor

Display the Variable Monitor.
For details, refer to section " 8.5  Variable Monitor ".

Displays a window which enables monitoring of the [Virtual I/O] signals.
The I/O signals are link to the job I/O instructions execution.
For details, refer to section " 8.2  I/O Monitor ".

Display the Speed Graph.
For details, refer to section " 8.14  Speed Graph Function ".

Display the Pulse Record.
For details, refer to section " 8.9  Pulse Recorder ".

Display the Lap Time Panel.
For details, refer to section " 8.6  Lap Time Panel ".

Display the Trace Manager.
For details, refer to section " 7.9  Trace ".

Display the Working Trace Manager.
For details, refer to section " 7.12  Working Trace ".

Collision

Display the Collision Detection.
For details, refer to section " 8.11  Collision Detection ".
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I/O Settings

Display the I/O Events.
For details, refer to section " 8.3  I/O Events ".

Display the I/O commection.
For details, refer to section " 8.4  I/O connection ".

Model Simulation

Display the Model Script Editor.
For details, refer to section " 11.12  Model Script ".

Settings

Display the Sensing Option Setting.
For details, refer to section " 8.12  Sensing Option Setting ".

Display the Paint Panel.
For details, refer to section " 8.13  Spray Model for Paint ".

OutPut

Outputs the 3DPDF file.
For details, refer to the section " 13.16  3DPDF Output Function ".

Outputs the AVI file.
For details, refer to the section " 13.17  AVI Output Function ".
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 Tool

Cable Simulation

Outputs the 3DPDF file.
For details, refer to the section " 8.21  Cable Simulation ".

Outputs the AVI file.
For details, refer to the section " 8.21.3  Cable Setting ".

Teaching Assistance

Displays the Layout Robot dialog.
For details, refer to section " 8.20  Layout Robot Function ".

Displays the Path Planning dialog.
For details, refer to section " 8.22  Path Planning ".

Retrofit

Displays the Safety fence interference setting dialog.
For details, refer to section " 13.22.2  Setting of Safety Fence Model 
and Collision Check ".

Displays the Job conversion and Analyze dialog.
For details, refer to section " 13.22.3  Job Conversion and Analysis 
".

Displays the Trajectory difference report dialog.
For details, refer to section " 13.22.4  Trajectory Difference Report ".

Estimate

Displays the Motor Load Estimate.
For details, refer to section " 13.23  Motor Load Estimate ".

Displays the Life Estimate.
For details, refer to section " 13.24  Life Estimate ".
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 About Saving Display Positions in Dialogs
From MotoSimEG-VRC 2019SP1, several dialogs called from the ribbon menu have their dis-
play position saved. The following table shows the supported dialogs.
These dialogs are displayed in the upper left or center of the screen by pressing the Ctrl key 
with selecting the ribbon menu.

Tab name Group name Button name
Home Teaching CAM Function

View View Manager
Screen Light Manager
Tools Execute Soft
Settings Heart Beat
Operation Handle Grid Settings

Controller Setup New
Job Visual Path Edit - Settings
File Settings Tool Data

User Frame
Robot Calibration
Functon Safety - Safety Function File
Function Safety - Tool Interference Model
Function Safety - Robot Approximation 
Model
Welding Condition
Arc Welding Condition

Robot Model Setting
TCP Reach

External Device New - Conveyor
New - Gantry
New - Press
Soft Limit
Conveyor Settings
Conveyor Condition File
Conveyor Operation Panel
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5.1.2 Mouse Operation Switching Bar

 Viewpoint Operation Switching Bar
Click the button, the icon is surrounded with yellow frame and viewpoint operation by right but-
ton is changed.
To show the viewpoint operation switching bar, refer to the section " 12.6  Mouse Customiza-
tion ".

Simulation Playback Stage Master
Monitor Trace

Working Trace
I/OSettings I/O Event Manager

I/O Connection Manager
Model Simulation Model Script Manager
Settings Sensing Setting

Paint Setting
Output 3DPDF - Output Settings

AVI - Output Settings
Debug Job Stack
Cable Simulation Setting

Tool Teaching Assistance Layout Robot
Path Planning

Retrofit Safety fence setting
Job conversion and analysis
Difference report

Estimate Motor Load Estimate
Life Estimate

Online Function Connect File Manager

Zoom in and out the image by dragging the mouse upward (to zoom 
in) or downward (to zoom out) over the screen; rotate the image cen-
tering on the Z-axis of "world" coordinates by dragging the mouse 
from side to side.

Drag the mouse over the desired range to be enlarged.

For vertical rotation, drag the mouse up and down; for horizontal rota-
tion, drag the mouse from side to side.

Drag the mouse from side to side and up and down to synchronize the 
viewpoint with the mouse motion. 

Zoom in and out the image by dragging the mouse upward (to zoom 
in) or downward (to zoom out) over the screen; rotate the image hori-
zontally by dragging the mouse from side to side.
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Zoom in and out the image by dragging the mouse upward (to zoom 
in) or downward (to zoom out) over the screen.

Click any desirable point so that the image is displayed with the 
clicked point located in the center of the screen.
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5.2 Virtual Pendant

When a Virtual Robot Controller (VRC) is registered in a cell, the associated Virtual Pendant is 
displayed.  The Virtual Pendant can be use to operate the VRC controller is the same manner 
as with the programming pendant of each controller.  The Virtual Pendant is composed of two 
separed windows: the pendant screen and the prendant keypad.  The display of the pendant 
keypad can be toggled from the pendant screen by pressing the [/] key or by clicking on the 

 icon.

When the mouse right button is clicked on the pendant keypad, "Fit" menu is displayed. When 
"Fit" menu is clicked, the pendant keypad moves to the center of the bottom of the pendant 
screen window.

When the   icon is clicked with the [Ctrl] key of the keyboard, the pendant keypad moves 
similarly.

• For operation on the Virtual Pendant, please refer to each controller “Operator Manual”.
• When two keys are to be pressed simultaneously, the keys are shown with a “+” sign 

between them, such as [SHIFT]+[COORD].  Press and hold the first key and then press 
the 2nd key.

• Multiple axis keys cannot be used simultaneously.
• When resizing the pendant screen, if necessary, the display font size can be adjusted by 

selecting {DISPLAY SETUP} - {CHANGE FONT} from the Virtual Pendant main menu.

NOTE
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5.2.1 YRC1000, YRC1000micro Virtual Pendant

  

 

Pendant 
Screen 

Pendant 
Keypad 
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 Virtual Pendant Button

Button Keyboard 
Equivalent Description

Insert

TEACH Mode
The axis operation and edition from the programming 
pendant are enabled.

Home

PLAY Mode
The playback of taught job is enabled.

Delete

Starts the manipulator motion in play-
back operation.
The lamp on this button is lit during the playback 
operation.
The lamp turns OFF when the playback operation is 
stopped by alarm occurrence, HOLD signal, or mode 
change.

End

Holds the manipulator motion.
When lamp is turned OFF, the manipulator stays 
stopped until a START command is input.
The start and axis operations are disabled while the 
lamp is lit.

Page Down

Turns ON the servo power.
Press this button to enable the servo power to be 
turned ON.
The SERVO ON lamp is lit while the servo power is 
ON.

Turns OFF the servo power.
When the servo power is turned OFF, the SERVO ON 
LED on the programing pendant will extinguish.
An emergency stop message is displayed on the 
screen.

Activates the job synchronization mode.
When the SYNC button is blue, the robot position is 
instantly change to match the selected step of the dis-
played job.

Open the Storage Card folder
When this button is clicked, the storage card folder of 
this controller is opened.
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/

Displays the Virtual Pendant keypad
When the button is down, the Virtual Pendant keypad 
is displayed.

When resizing the pendant screen to a smaller size, the displayed text maybe shorten to 
fit in the smaller size buttons. 

NOTE
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 Virtual Pendant Keypad

Keypad key Keyboard 
Equivalent Description

[SELECT]

Space

Works as described below.  
• Selects a menu item in the main menu area and the menu area. 
• Makes the selected item ready to be set in the general-purpose 

display area. 
• Shows two or more messages in the human interface display 

area.

[Cursor Key]

↑
←→
↓

Moves the Cursor in the direction of the arrow.  
• The size of the Cursor and the range/place where the cursor 

can move vary depending on the window.  
• In the JOB CONTENT window, if the UP cursor is pressed when 

the cursor is on the first line, the cursor moves to the last line of 
the job.  Conversely, if the cursor is on the last line of the job 
and the DOWN cursor is pressed, the cursor will jump to the first 
line of the job.  

[SHIFT] + [↑] (UP) 
Scrolls the screen upward. 
[SHIFT] + [↓] (DOWN) 
Scrolls the screen downward. 
[SHIFT] + [→] (RIGHT) 
Scrolls the screen to the right. 
[SHIFT] + [←] (LEFT) 
Scrolls the screen to the left.   

[MAIN MENU]

F1

Displays the main menu.  
• When the main menu is shown, press this key to hide the main 

menu.  

[MAIN MENU] + UP 
Increases the brightness of the screen. 
[MAIN MENU] + DOWN 
Decreases the brightness of the screen. 

[SIMPLE MENU]

F2

Displays the simple menu.  
• When the simple menu is shown, press this key to hide the sim-

ple menu. 

[SHIFT] + [SIMPLE MENU] 
Registers the layout displayed in the general-purpose area to the user 
defined menu.

Press [SIMPLE MENU] for three seconds to display the pop-up menu 
window.

[↑] UP

[→]
RIGHT

[←]
LEFT

[↓] DOWN
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Keypad key Keyboard 
Equivalent Description

[SERVO ON 
READY]

Page 
Down

Enables the servo power supply to be turned ON.  
• IIf the servo power supply is shut OFF by the emergency stop or 

overrun signal, press this key to enable the servo power supply 
to be turned ON. 

• When this key is pressed, 
1. in the play mode, the servo power supply turns ON if the 

safeguarding is securely closed; 
2. in the teach mode, the “SERVO ON” LED blinks, and the servo 

power supply turns ON with the Enable Switch turned ON; 
3. while the servo power is ON, the “SERVO ON”  LED lights up.

[CANCEL]

Esc

Cancels the current status.  
• Hides the sub menu in the main menu area and the menu area. 
• Cancels the current input data or input status in the general-pur-

pose display area. 
• Cancels the list of messages in the human interface display 

area. 
• Cancels the current error. 
 
[SHIFT] + [CANCEL] 
When the job content is shown and the undo function is enabled, the 
assist menu is shown. 

[MULTI]

F5

Works for the multi mode.  
• If this button is pressed when the multi mode is ON, the active 

window switches. 

[SHIFT] + [MULTI] 
Switches between the multi-window display and the single-window 
display when the multi mode is ON.

[COORD]

K

Select the operation coordinate system when the manipulator is 
operated manually.  
• The coordinate system can be selected from the six coordinate 

systems, i.e., joint, Cartesian, cylindrical, tool, user, and teach-
ing line. 
Each time this key is pressed, the coordinate system is 
switched in the following order: JOINT ? CAR/CYL ? TOOL ? 
USER ? TEACHING LINE (only for arc welding purpose) 

• The selected coordinate system is shown in the status display 
area. 

[SHIFT] + [COORD]
The number of the coordinate system can be changed when the “TOOL” 
or “USER” coordinate system is selected. 
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[DIRECT OPEN]

L

Displays the content related to the current line.  

• When the job content is displayed, move the cursor to an 
instruction and press this key to show its related content. 
Example: 

        For a CALL instruction, the content of the called 
        job is shown. 
        For a work instruction, the content of the current 
        condition file is shown. 
        For an input/output instruction, the input/output 
        status is shown. 
• The lamp on this button lights up while the direct open is ON. 

While the lamp lights up, press this button to return to the previ-
ous window.

[PAGE]

F4

Displays the next page.
• The page can be switched only when the lamp on this button 

lights up.

[SHIFT] + [PAGE] 
Switches to the previous page. 

[AREA]

TAB

Moves the cursor in the display in the following order: Menu Area ? 
General-Purpose Display Area ? Human Interface Display Area ? 
Main Menu Area.  If no item is displayed, the cursor does not move. 

[SHIFT] + [AREA] 
Switches the language when the bilingual function is valid.  (Bilingual 
function is optional.) 
[AREA] + DOWN 
Moves the cursor from the general-purpose display area to the operation 
button when the operation button is displayed. 
[AREA] + UP 
Moves the cursor to the general-purpose display area when the cursor is 
on the operation button. 

[SHIFT]

Shift

Changes the functions of other keys by pressing together.
Can be used with [SIMPLE MENU], [PAGE], [DIRECT OPEN], [MULTI], 
[COORD], [AREA], [MOTION TYPE], the cursor, [Numeric Key], 
[ROBOT], [EX. AXIS], or [AUX] to access alternate functions. 
Refer to the description of each key for the alternate functions with 
[SHIFT]. 

[INTERLOCK]

Ctrl

Changes the functions of other keys by pressing together.  
Can be used with [TEST START], [FWD], [Numeric Key] (Numeric key 
customize function), [ROBOT], or [AUX]. 
Refer to the description of each key for the alternate functions with 
[INTERLOCK].

[INFORM LIST]

O

Displays the list of instructions available for editing the job.   

Keypad key Keyboard 
Equivalent Description
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[ROBOT]

I

Switches the robot axis to be operated. 
• Press this key to enable the robot axis operation.
• [ROBOT] is enabled for the system with one YRC1000, 

YRC1000micro and multiple manipulators or the system with 
one or more external axes. 

[SHIFT] + [ROBOT] 
The robot axis to be operated is switched to a robot axis which is not 
registered in the currently selected job.
[INTERLOCK] + [ROBOT]
Switches the application when multiple applications are set to one robot.

[EX.AXIS]

F11

Switches the external axis to be operated.  
• Press this key to enable the external axis (base axis or station 

axis) operation.
• [EX.AXIS] is enabled for the system with one or more external 

axes. 

[SHIFT] + [EX. AXIS]
The external axis to be operated is switched to an external axis which is 
not registered in the currently selected job.

[MOTION TYPE]

F7

Selects the interpolation type for playback operation. 
• The selected interpolation type is shown in the input buffer line 

in the display. 
• Each time this key is pressed, the interpolation type changes in 

the following order: 
MOVJ  MOVL  MOVC  MOVS 

[SHIFT] + [MOTION TYPE]
The interpolation mode changes in the following order:
STANDARD ? EXTERNAL REFERENCE POINT* ? CONVEYOR* 
In each interpolation mode, by pressing only [MOTION TYPE], the 
usable interpolation method is switched as in the above STANDARD 
mode. 
*: These modes are options. 

[AUX]
Calls a function.

[INTERLOCK] + [AUX]
Shows the confirmation dialog for enabling/disabling the touch panel. 
[SHIFT] + [AUX]
When the job content is shown the welding line control list function is 
called.  (Only for the arc welding application)

Keypad key Keyboard 
Equivalent Description
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[TEST START]

N

Press [TEST START] and [INTERLOCK] simultaneously to move the 
manipulator through the taught steps in a continuous motion for 
checking the path. 
• The manipulator moves in the currently selected operation 

cycle: AUTO, 1 CYCLE, or STEP. 
• The manipulator moves at the taught speed. If the taught speed 

exceeds the maximum teaching speed, the operation proceeds 
at the maximum teaching speed. 

[INTERLOCK] + [TEST START]
The manipulator moves through the taught steps in a continuous motion. 
Operation immediately stops when this key is released during the 
continuous motion. 

[FWD]

F12

Moves the manipulator through the taught steps only while this key 
is pressed.
• Only the move instruction is executed. 
• The manipulator moves at the selected manual speed. 

Before operating the manipulator, make sure that the selected 
manual speed is set as intended. 

[INTERLOCK] + [FWD]
All instructions including the move instruction are executed. 
[REFP] + [FWD] 
The manipulator moves to the reference point indicated by the line with 
the cursor.  

[BWD]

M

Moves the manipulator through the taught steps in the reverse 
direction only while this key is pressed.
• Only the move instruction is executed. 
• The manipulator moves at the selected manual speed. 

Before operating the manipulator, make sure that the selected 
manual speed is set as intended.

[DELETE]

F9

Deletes the registered instruction.  
• Deletion completes when [ENTER] is pressed while the lamp on 

this key lights up. 

[INSERT]

F8

Inserts a new instruction.  
• Insertion completes when [ENTER] is pressed while the lamp on 

this key lights up.

[MODIFY]

F6

Modifies the taught position data or instruction.  
• Modification completes when [ENTER] is pressed while the 

lamp on this key lights up.

Keypad key Keyboard 
Equivalent Description
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[ENTER]

Enter

Completes the execution of each process for registration and 
edition of instructions, data, current position of the manipulator, 
etc.  
• When [ENTER] is pressed, the instruction or data shown in the 

input buffer line moves to the cursor position to complete a reg-
istration, insertion, modification, etc.

MANUAL SPEED 

D

C

Sets the speed for manual operation.  This speed is also valid for 
operations with [FWD] and [BWD].   
• There are four speed levels (slow, medium, fast, and inching).  

The speed changes as described below.  The selected speed is 
displayed on the status area.

Each time [FAST] is pressed, manual speed changes in the following 
order: 
INCH SLOW  MED  FST. 
Each time [SLOW] is pressed, manual speed changes in the following 
order: 
FST  MED  SLOW  INCH

[HIGH SPEED]

E

Makes the manipulator move at high speed while this key and one 
of the axis keys are pressed simultaneously during manual 
operation.  No need to change the setting of speed.
• The speed for [HIGH SPEED] is specified in advance. 

Axis Key
Q W   R T
A S   F G
Z X   V B

Y U   H J

Moves specified axes on manipulator.  
• The manipulator operates only while the key is pressed. 
• By pressing two or more keys simultaneously, multiple axes can 

be operated at the same time. 
• The manipulator operates in the selected coordinate system at 

the selected manual speed. 
Before operating the axis, make sure that the selected coordi-
nate system and the manual speed are set as intended. 

• A user-selected external axis can be allocated to [E-], [E+], [8-], 
or [8+].  For details, refer to chapter 6.9  “Jog Key Allocation” .

Numeric Key

0-9
-
.

Enters the number or symbol on the key when the prompt “>” 
appears on the input line.  
• “.” is the decimal point.  “-” is a minus sign or hyphen. 
• [Numeric Keys] are also used as function keys. 

Refer to the explanation of each function for details.

USAGE

F10

A dedicated key to be used according to the application. Cannot be 
used with MotoSim EG-VRC.

Keypad key Keyboard 
Equivalent Description
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 Keyboard Layout
The Virtual Pendant keypad key all have a corresponding key on the computer keyboard.  
When the Virtual Pendant Screen has the input focus, the those keyboard key can be pressed 
instead of clicking the keys on the pendant keypad.

ESC   F1 F2 F3 F4 F5 F6 F7 F8 F9 F10 F11 F12           

CANCEL   MAIN 
MENU 

SIMPLE 
MENU  PAGE MULTI MODIFY MOTION 

TYPE INSERT DELETE ＡＰＰＬＩＣ
ＡＴＩＯＮ EX.AXIS FWD           

                                      

` 1 2 3 4 5 6 7 8 9 0 - = Backspace   Insert Home Page 
Up 

 1 2 3 4 5 6 7 8 9 0 -  Backspace   Teach Play  

TAB Q W E R T Y U I O P [ ] ¥   Delete End Page 
Down 

AREA X- 
S- 

X+ 
S+ 

HIGH 
SPEED 

X- 
R- 

X+ 
R+ E- E+ ROBOT INFORM 

LIST AUX      Start Hold Servo On 
Ready 

CapsLock A S D F G H J K L ; ‘ Enter         

 Y- 
L- 

Y+ 
L+ FAST Y- 

B- 
Y+ 
B+ 8- 8+ COORD DIRECT 

OPEN   ENTER         

Shift Z X C V B N M , . / Shift     ↑   

SHIFT Z- 
U- 

Z+ 
U+ SLOW Z- 

T- 
Z+ 
T+ 

TEST 
START BWD  . Keypad 

Display SHIFT     ↑   

Ctrl Win Alt Space Alt  Ctrl   ← ↓ → 

INTERLOCK   SELECT   INTERLOCK   ← ↓ → 
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5.2.2 DX200 Virtual Pendant

 Virtual Pendant Button
The pendant buttons are the same as those for YRC1000, YRC1000micro virtual pendant.
For details, please refer to the " Virtual Pendant Button " of the " 5.2.1  YRC1000, 
YRC1000micro Virtual Pendant " section.

 

Pendant 
Screen 

Pendant 
Keypad 
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 Virtual Pendant Keypad

Keypad key Keyboard 
Equivalent Description

[SELECT]
Space

Works as described below.  
• Selects menu items in the main menu area and the pull-down 

menu area.  
• Makes the selected item ready to be set in the general-purpose 

display area.  
• Displays multiple messages in the message area.  

Cursor ↑
←→
↓

Moves the Cursor in the direction of the arrow.  
• The size of the Cursor and the range/place where the Cursor 

can move will vary depending on the window.  
• If the UP Cursor button is pressed when the Cursor is on the 

first line, the Cursor will move to the last line of the job.  Con-
versely, if the Cursor is on the last line of the job and the DOWN 
Cursor button is pressed, the Cursor will jump to the first line of 
the job.  

SHIFT key + UP 
Scrolls the screen upward.  

SHIFT key + DOWN 
Scrolls the screen downward.  

SHIFT key  + RIGHT 
Scrolls the screen to the right.  

SHIFT key + LEFT 
Scrolls the screen to the left.  

[MAIN MENU]

F1

Displays the main menu.  
If this button is pressed while the main menu is displayed, the main menu 
disappears.  

MAIN MENU key  + UP 
Increases the brightness of the screen.  

MAIN MENU key   + DOWN 
Decreases the brightness of the screen.  

[SIMPLE MENU]

F2

Displays the simple menu.  
If this button is pressed while the simple menu is displayed, the simple 
menu disappears.  

SELECT

SHIFT

SHIFT

SHIFT

SHIFT

MAIN
MENU

MAIN
MENU

MAIN
MENU

ENTRY

SIMPLE
MENU
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Keypad key Keyboard 
Equivalent Description

[SERVO ON 
READY]

Page 
Down

Enables the servo power supply to be turned ON.  
Press this button to enable the servo power supply to be turned ON if the 
servo power supply is shut OFF by the emergency stop or overrun 
signal.  
When this button is pressed:  
• In the play mode, the servo power supply is turned ON if the 

safeguarding is securely closed.  
• In the teach mode, the SERVO ON lamp flashes and the servo 

power supply is turned ON when the Enable switch is ON.  
• The SERVO ON lamp is lit while the servo power is ON.  

[ASSIST]

F3

Displays the menu to assist the operation for the currently 
displayed window.  

Pressing this button with SHIFT key  or INTERLOCK key  
displays the help guidance for the operation.  

• SHIFT key + ASSIST key  

The function list of key combinations with SHIFT key  
appears.  

• INTERLOCK key  + ASSIST key 

The function list of key combinations with INTERLOCK key  
appears.  

[CANCEL]

Esc

Cancels the current status.  
• Deletes the sub menu in the main menu area and the pull-down 

menu area.  
• Cancels the input data or the input status in the general-purpose 

display area.  
• Cancels the multiple views in the message area.  
• Cancels the occurred error.  

[MULTI]

F5

Works for the multi mode.  
If this button is pressed when the multi mode is ON, the active window 
switches.  

SHIFT key  + MULTI Key  
Switches between the multi-window display and the single-window 
display when the multi mode is ON.  

SERVO
ON

READY

ASSIST
!?

SHIFT
INTER
LOCK

SHIFT ASSIST
!?

SHIFT

INTER
LOCK ASSIST

!?

INTER
LOCK

CANCEL

MULTI
LAYOUT

SHIFT
MULTI

LAYOUT
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[COORD]

K

Select the operation coordinate system when the manipulator is 
operated manually.  
• Five coordinate systems (joint, cartesian, cylindrical, tool and 

user) can be used.  Each time this key is pressed, the coordi-
nate system is switched in the following order: "JOINT""WLD/
CYL""TOOL""USER" 

• The selected coordinate system is displayed on the status dis-
play area.  

SHIFT key + COORD Key 
The coordinate number can be changed when the "TOOL" or "USER" 
coordinate system is selected.  

[DIRECT OPEN]

L

Displays the content related to the current line.  

• To display the content of a CALL job or condition file, move the 

Cursor to the next line and press DIRECT OPEN key .  The 
file will be displayed for the selected line.  Display content will 
vary depending on the type of instruction used in the job.  

Example: 
For a CALL instruction, the content of the called job will be displayed.  
For a work instruction, the content of the condition file will be displayed.  
For Input/output instructions, the input/output condition will be displayed.  
• The lamp on this button is lit while the direct open is ON.  Press 

this button while the lamp is lit to return to the previous window.  

[PAGE]

F4

Displays the next page.
The page can be switched only when the lamp on this button is lit.  

SHIFT key  + PAGE key  
Switches to the previous page.  

[AREA]

TAB

Moves the Cursor in the following order : “Menu Area”“General-
Purpose Display Area”“Message Area”“Main Menu Area”.  If no 
item is displayed, the Cursor does not move.  

SHIFT key + AREA key  
The language can be switched when the bilingual function is valid.  
(Bilingual function is optional.)  

AREA key  + DOWN 
Moves the Cursor  from the general-purpose display area to the 
operation button when the operation button is displayed.  

AREA key   + UP 
Moves the Cursor to the general-purpose display area when the Cursor 
is on the operation button.  

[SHIFT]

Shift

Changes the functions of other keys by pressing this key together.  

Can be used with ASSIST key , COORD key , AREA key , 
[MOTION TYPE], [ROBOT], [EX. AXIS], Cursor key or Numeric key to 
access alternate functions.  
Refer to the description of each key for the alternate SHIFt functions.  

Keypad key Keyboard 
Equivalent Description

TOOL SEL
COORD

SHIFT
TOOL SEL
COORD

DIRECT
OPEN

DIRECT
OPEN

GO BACK
PAGE

SHIFT
GO BACK
PAGE

AREA

SHIFT AREA

AREA

AREA

SHIFT

ASSIST
!?

TOOL SEL
COORD AREA
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[INTERLOCK]

Ctrl

Changes the functions of other keys by pressing together.  

Can be used with ASSIST key , MULTI key , [TEST START], 
[FWD], or Numeric key (Numeric key customize function), [ROBOT].  
Refer to the description of each key for the alternate NTERLOCK 
functions.  

[INFORM LIST]

O

Displays instruction lists of commands available for job editing.  

[ROBOT]

I

Enables the robot axis operation.  

[ROBOT] is active for the system where multiple manipulators are 
controlled by one DX200 or the system with external axes.  

SHIFT key + [ROBOT] 
The robot under axis operation can be switched to a robot axis which is 
not registered to the currently selected job.

INTERLOCK key  + [ROBOT]
Switchs the application when several applications are set to a robot.

[EX.AXIS]

F11

Enables the external axis (base axis or station axis) operation.  

[EX.AXIS] is active for the system with external axes.  

SHIFTkey + [EX. AXIS]
The external axis under axis operation can be switched to an external 
axis which is not registered to the currently selected job.

[MOTION TYPE]

F7

Selects the interpolation type for playback operation.  
The selected interpolation type is shown in the status display area on the 
screen.  

• Each time this key is pressed, the interpolation type changes in 
the following order: 
"MOVJ"" MOVL""MOVC"

SHIFT key  + [MOTION TYPE]
The interpolation mode changes in the following order:
"STANDARD"" EXTERNAL REFERENCE POINT"*" CONVEYOR"* 

Interpolation type can be changed in any mode.  

*: These modes are purchased options.  

Keypad key Keyboard 
Equivalent Description

INTER
LOCK

ASSIST
!?

MULTI
LAYOUT

INFORM
LIST

ROBOT SHIFT

INTER
LOCK

EX.AXIS
SHIFT

MOTION
TYPE

SHIFT
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[TEST START]

N

Moves the manipulator through taught steps in a continuous 

motion when [TEST START] and INTERLOCK key  are 
simultaneously pressed.  
The manipulator can be moved to check the path of taught steps.  
Operation stops immediately when this key is released.  
• The manipulator operates according to the currently selected 

operation cycle: "AUTO", "1CYCLE" or "STEP". 
• The manipulator operates at the taught speed.   However, if the 

taught speed exceeds the maximum teaching speed, the opera-
tion proceeds at the maximum teaching speed.  

[FWD]

F12

Moves the manipulator through the taught steps while this key is 
pressed.  
• Only move instructions are executed (one instruction at a time, 

no welding instructions).  

INTERLOCK key  + [FWD]
All instructions are executed.  
[0] + [FWD]  
Moves to the reference point of the cursor line.  
The manipulator operates at the selected manual speed.  Make sure that 
the selected manual speed is the desired one before starting operation.  

[BWD]

M

Moves the manipulator through the taught steps in the reverse 
direction while this key is pressed.  
• Only move instructions are executed (no weld commands).  
The manipulator operates at the selected manual speed.  Make sure that 
the selected manual speed is the desired one before starting operation.  

[DELETE]

F9

Deletes the registered instruction.  
• Deletion completes when [ENTER] is pressed while this key 

lamp is lit.  

[INSERT]

F8

Inserts a new instruction.  
• Insertion completes when [ENTER] is pressed while this key 

lamp is lit.  

[MODIFY]

F6

Modifies the taught position data or instruction.  
• Modification completes when [ENTER] is pressed while this key 

lamp is lit.  

[ENTER]

Enter

Registers instructions, data, current position of the manipulator, 
etc. 
• When [ENTER] is pressed, the instruction or data displayed in 

the input buffer line moves to the Cursor position to complete a 
registration, insertion, or modification.  

Keypad key Keyboard 
Equivalent Description

TEST
START

INTER
LOCK

FWD INTER
LOCK

BWD

DELETE

INSERT

MODIFY

ENTER
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MANUAL SPEED 
keys

D

C

Sets the speed for manual operation.  This speed is also valid for 
operations with [FWD] and [BWD].  
• There are four speed levels (slow, medium, fast, and inching).  

The speed changes as described below.  The selected speed is 
displayed on the status area.  

Each time [FAST] is pressed, manual speed changes in the following 
order: 
"INCH"" SLOW""MED""FST".  
Each time [SLOW] is pressed, manual speed changes in the following 
order: 
"FST""MED""SLOW""INCH"

[HIGH SPEED]

E

Makes the manipulator move at high speed while this button and 
one of the axis keys are pressed simultaneously during manual 
operation.  No need to change the setting of speed.  
• The speed for [HIGH SPEED] is specified in advance.  

Axis Key
Q W   R T
A S   F G
Z X   V B

Y U   H J

Moves specified axes on manipulator.  
• The manipulator axes only move while the key is pressed.  
• Multiple axes can be operated simultaneously by pressing two 

or more keys at the same time.  

The manipulator operates in the selected coordinate system at the 
selected manual speed.  Make sure that the selected coordinate system 
and the manual speed are the desired ones before starting the axis 
operation. 

It is possible to allocate any external axes to [E-] + [E+], [8-] + [8+] keys 
to operate them.   
 

Numeric Key

0-9
-
.

Enters the number or symbol when the ">" prompt appears on the 
input line.  
• “.” is the decimal point.  “-” is a minus sign or hyphen. 
The Numeric keys are also used as function keys.   Refer to the 
explanation of each function for details.  

USAGE

F10

A dedicated key to be used according to the application. Cannot be 
used with MotoSim EG-VRC.

Keypad key Keyboard 
Equivalent Description

MANUAL SPEED

FAST

SLOW

FAST
MANUAL SPEED

X+
R+

Y+
B+

Z+
T+

X-
R-

Y-
B-

Z -
T -

8+8-

X+
S+

Y+
L+

Z+
U+

X-
S-

Y-
L -

Z-
U-

E+E-

TOOL OF
0

1
TOOL ON
2

TOOL ON
JOB

3

SMOV
4 5 6

SYNCRO
SINGLE

7 8 9

TOOL OF
JOB
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 Keyboard Layout
The Virtual Pendant keypad key all have a corresponding key on the computer keyboard.  
When the Virtual Pendant Screen has the input focus, the those keyboard key can be pressed 
instead of clicking the keys on the pendant keypad.

ESC   F1 F2 F3 F4 F5 F6 F7 F8 F9 F10 F11 F12           

CANCEL   MAIN 
MENU 

SIMPLE 
MENU ASSIST PAGE MULTI MODIFY MOTION 

TYPE INSERT DELETE ＡＰＰＬＩＣ
ＡＴＩＯＮ EX.AXIS FWD           

                                      

` 1 2 3 4 5 6 7 8 9 0 - = Backspace   Insert Home Page 
Up 

 1 2 3 4 5 6 7 8 9 0 -  Backspace   Teach Play  

TAB Q W E R T Y U I O P [ ] ¥   Delete End Page 
Down 

AREA X- 
S- 

X+ 
S+ 

HIGH 
SPEED 

X- 
R- 

X+ 
R+ E- E+ ROBOT INFORM 

LIST AUX      Start Hold Servo On 
Ready 

CapsLock A S D F G H J K L ; ‘ Enter         

 Y- 
L- 

Y+ 
L+ FAST Y- 

B- 
Y+ 
B+ 8- 8+ COORD DIRECT 

OPEN   ENTER         

Shift Z X C V B N M , . / Shift     ↑   

SHIFT Z- 
U- 

Z+ 
U+ SLOW Z- 

T- 
Z+ 
T+ 

TEST 
START BWD  . Keypad 

Display SHIFT     ↑   

Ctrl Win Alt Space Alt  Ctrl   ← ↓ → 

INTERLOCK   SELECT   INTERLOCK   ← ↓ → 
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5.2.3 DX100 Virtual Pendant

 Virtual Pendant Button
The pendant buttons are the same as those for YRC1000, YRC1000micro virtual pendant.
For details, please refer to the " Virtual Pendant Button " of the " 5.2.1  YRC1000, 
YRC1000micro Virtual Pendant " section.

 

Pendant 
Screen 

Pendant 
Keypad 
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 Virtual Pendant Keypad

Keypad key Keyboard 
Equivalent Description

[SELECT]
Space

Works as described below.
• Selects menu items in the main menu area and the pull-down 

menu area.
• Makes the selected item ready to be set in the general-purpose 

display area.
• Displays multiple messages in the message area. 

Cursor ↑
←→
↓

Moves the cursor in the direction of the arrow.
• The size of the cursor and the range/place where the cursor can 

move will vary depending on the window.
• If the UP cursor button is pressed when the cursor is on the first 

line, the cursor will move to the last line of the job.  Conversely, 
if the cursor is on the last line of the job and the DOWN cursor 
button is pressed, the cursor will jump to the first line of the job.  

[SHIFT] + UP
Scrolls the screen upward.
[SHIFT] + DOWN
Scrolls the screen downward.
[SHIFT] + RIGHT
Scrolls the screen to the right.
[SHIFT] + LEFT
Scrolls the screen to the left.  

[MAIN MENU]

F1

Displays the main menu.
If this button is pressed while the main menu is displayed, the 
main menu disappears.

[MAIN MENU] + UP
Increases the brightness of the screen.
[MAIN MENU] + DOWN
Decreases the brightness of the screen.  

[SIMPLE MENU]
F2

Displays the simple menu.
If this button is pressed while the simple menu is displayed, the 
simple menu disappears. 

[SERVO ON 
READY]

Page 
Down

Enables the servo power supply to be turned 
ON.
Press this button to enable the servo power supply to be turned 
ON if the servo power supply is shut OFF by the emergency stop 
or overrun signal.  When this button is pressed:
• In the play mode, the servo power supply is turned ON if the 

safeguarding is securely closed.
• In the teach mode, the SERVO ON lamp flashes and the servo 

power supply is turned ON when the Enable switch is ON.
• The SERVO ON lamp is lit while the servo power is ON. 
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[ASSIST]

F3

Displays the menu to assist the operation for 
the currently displayed window.
Pressing this button with [SHIFT] or [INTERLOCK] displays the 
help guidance for the operation. 
• [SHIFT] + [ASSIST]

The function list of key combinations with [SHIFT] appears.  
• [INTERLOCK] + [ASSIST]

 The function list of key combinations with [INTERLOCK] 
appears.

[CANCEL]

Esc

Cancels the current status.
• Deletes the sub menu in the main menu area and the pull-down 

menu area.
• Cancels the input data or the input status in the general-purpose 

display area.
• Cancels the multiple views in the message area.
• Cancels the occurred error.  

[MULTI]

F5

Works for the multi mode.
If this button is pressed when the multi mode is ON, the active 
window switches.

[SHIFT] + [MULTI]
Switches between the multi-window display and the single-win-
dow display when the multi mode is ON.

[COORD]

K

Select the operation coordinate system when the 
manipulator is operated manually.
• Five coordinate systems (joint, cartesian, cylindrical, tool and 

user) can be used.  Each time this key is pressed, the coordi-
nate system is switched in the following order:
 "JOINT"→"WLD/CYL"→"TOOL"→"USER"

• The selected coordinate system is displayed on the status dis-
play area.

[SHIFT] + [COORD]
The coordinate number can be changed when the "TOOL" or 
"USER" coordinate system is selected. 

Keypad key Keyboard 
Equivalent Description
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[DIRECT OPEN]

L

Displays the content related to the current line.
• To display the content of a CALL job or condition file, move the 

cursor to the next line and press [DIRECT OPEN].  The file will 
be displayed for the selected line.  Display content will vary 
depending on the type of instruction used in the job.

Example:
For a CALL instruction, the content of the called job will be dis-
played.
For a work instruction, the content of the condition file will be dis-
played.
For Input/output instructions, the input/output condition will be 
displayed.
• The lamp on this button is lit while the direct open is ON.  Press 

this button while the lamp is lit to return to the previous window.  

[PAGE]

F4

Displays the next page.
The page can be switched only when the lamp on this button is lit. 
 [SHIFT] + [PAGE]
Switches to the previous page. 

[AREA]

TAB

Moves the cursor in the following order : "Menu 
Area"→"General-Purpose Display Area"→"Message 
Area"→"Main Menu Area".  If no item is displayed, 
the cursor does not move.

[SHIFT] + [AREA] 
The language can be switched when the bilingual function is 
valid.  (Bilingual function is optional.)
[AREA] + DOWN
Moves the cursor from the general-purpose display area to the 
operation button when the operation button is displayed. 
[AREA] + UP
Moves the cursor to the general-purpose display area when the 
cursor is on the operation button. 

[SHIFT]

Shift

Changes the functions of other keys by pressing 
together.
Can be used with [MAIN MENU], [ASSIST], [COORD], [AREA], 
[MOTION TYPE], cursor key or Numeric key to access alternate 
functions.  Refer to the description of each key for the alternate 
[SHIFT] functions. 

[INTERLOCK]

Ctrl

Changes the functions of other keys by pressing 
together.
Can be used with [ASSIST], [MULTI], [TEST START], [FWD], or 
Numeric key (Numeric key customize function).
Refer to the description of each key for the alternate [INTER-
LOCK] functions.

[INFORM LIST]
O

Displays instruction lists of commands available for 
job editing.

Keypad key Keyboard 
Equivalent Description
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[ROBOT]

I

Enables the robot axis operation.

[ROBOT] is active for the system where multiple manipulators are 
controlled by one DX100 or the system with external axes.

[EX.AXIS]

F11

Enables the external axis (base axis or station axis) 
operation.

[EX.AXIS] is active for the system with external axes.

[MOTION TYPE]

F7

Selects the interpolation type for playback opera-
tion.
The selected interpolation type is shown in the status display area 
on the screen.

• Each time this key is pressed, the interpolation type changes in 
the following order:
"MOVJ"" MOVL""MOVC""MOVS"

[SHIFT] + [MOTION TYPE]
The interpolation mode changes in the following order:
"STANDARD"" EXTERNAL REFERENCE POINT"*" CON-
VEYOR"* 

Interpolation type can be changed in any mode.

*: These modes are purchased options.

[TEST START]

N

Moves the manipulator through taught steps in a 
continuous motion when [TEST START] and [INTER-
LOCK] are simultaneously pressed.
The manipulator can be moved to check the path of taught steps.  
Operation stops immediately when this key is released.
• The manipulator operates according to the currently selected 

operation cycle: "AUTO," "1CYCLE," or "STEP."
• The manipulator operates at the taught speed.   However, if the 

taught speed exceeds the maximum teaching speed, the opera-
tion proceeds at the maximum teaching speed.

[FWD]

F12

Moves the manipulator through the taught steps 
while this key is pressed.
• Only move instructions are executed (one instruction at a time, 

no welding instructions).  

[INTERLOCK] + [FWD]
All instructions are executed.  
[REFP] + [FWD]  
Moves to the reference point of the cursor line.  
The manipulator operates at the selected manual speed.  Make 
sure that the selected manual speed is the desired one before 
starting operation.  

Keypad key Keyboard 
Equivalent Description
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[BWD]

M

Moves the manipulator through the taught steps in 
the reverse direction while this key is pressed.
• Only move instructions are executed (no weld commands).  
The manipulator operates at the selected manual speed.  Make 
sure that the selected manual speed is the desired one before 
starting operation. 

[DELETE]

F9

Deletes the registered instruction.
• Deletion completes when [ENTER] is pressed while this key 

lamp is lit.

[INSERT]

F8

Inserts a new instruction. 
• Insertion completes when [ENTER] is pressed while this key 

lamp is lit.

[MODIFY]

F6

Modifies the taught position data or instruction.
• Modification completes when [ENTER] is pressed while this key 

lamp is lit.

[ENTER]

Enter

Registers instructions, data, current position of the 
manipulator, etc.
• When [ENTER] is pressed, the instruction or data displayed in 

the input buffer line moves to the cursor position to complete a 
registration, insertion, or modification.

MANUAL SPEED 
keys

D

C

Sets the speed for manual operation.  This speed is 
also valid for operations with [FWD] and [BWD].
• There are four speed levels (slow, medium, fast, and inching).  

The speed changes as described below.  The selected speed is 
displayed on the status area.

Each time [FAST] is pressed, manual speed changes in the fol-
lowing order:
"INCH"" SLOW""MED""FST"
Each time [SLOW] is pressed, manual speed changes in the fol-
lowing order: 
"FST"" MED""SLOW""INCH"

[HIGH SPEED]
E

Makes the manipulator move at high speed while 
this button and one of the axis keys are pressed 
simultaneously during manual operation.  No need to 
change the setting of speed. 
• The speed for [HIGH SPEED] is specified in advance.

Keypad key Keyboard 
Equivalent Description

120/847



  

HW0485348

 Keyboard Layout
The Virtual Pendant keypad key all have a corresponding key on the computer keyboard.  
When the Virtual Pendant Screen has the input focus, the those keyboard key can be pressed 
instead of clicking the keys on the pendant keypad.

Axis Key Q W   R T
A S   F G
Z X   V B

Y U   H J

Moves specified axes on manipulator.
• The manipulator axes only move while the key is pressed.
• Multiple axes can be operated simultaneously by pressing two 

or more keys at the same time.

The manipulator operates in the selected coordinate system at 
the selected manual speed.  Make sure that the selected coordi-
nate system and the manual speed are the desired ones before 
starting the axis operation.

Numeric Key

0-9
-
.

Enters the number or symbol when the ">" prompt 
appears on the input line.
• "." is the decimal point.  "-" is a minus sign or hyphen. The 

Numeric keys are also used as function keys.   Refer to the 
explanation of each function for details. 

USAGE

F10

A dedicated key to be used according to the applica-
tion. Cannot be used with MotoSim EG-VRC.

Keypad key Keyboard 
Equivalent Description

  

ESC   F1 F2 F3 F4 F5 F6 F7 F8 F9 F10 F11 F12           

CANCEL   MAIN 
MENU 

SIMPLE 
MENU ASSIST PAGE MULTI MODIFY MOTION 

TYPE INSERT DELETE ＡＰＰＬＩＣ
ＡＴＩＯＮ EX.AXIS FWD           

                                      

` 1 2 3 4 5 6 7 8 9 0 - = Backspace   Insert Home Page 
Up 

 1 2 3 4 5 6 7 8 9 0 -  Backspace   Teach Play  

TAB Q W E R T Y U I O P [ ] ¥   Delete End Page 
Down 

AREA X- 
S- 

X+ 
S+ 

HIGH 
SPEED 

X- 
R- 

X+ 
R+ E- E+ ROBOT INFORM 

LIST AUX      Start Hold Servo On 
Ready 

CapsLock A S D F G H J K L ; ‘ Enter         

 Y- 
L- 

Y+ 
L+ FAST Y- 

B- 
Y+ 
B+ 8- 8+ COORD DIRECT 

OPEN   ENTER         

Shift Z X C V B N M , . / Shift     ↑   

SHIFT Z- 
U- 

Z+ 
U+ SLOW Z- 

T- 
Z+ 
T+ 

TEST 
START BWD  . Keypad 

Display SHIFT     ↑   

Ctrl Win Alt Space Alt  Ctrl   ← ↓ → 

INTERLOCK   SELECT   INTERLOCK   ← ↓ → 
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5.2.4 FS100 Virtual Pendant

 Virtual Pendant Button
The pendant buttons are the same as those for YRC1000, YRC1000micro virtual pendant.
For details, please refer to the " Virtual Pendant Button " of the " 5.2.1  YRC1000, 
YRC1000micro Virtual Pendant " section.

 

Pendant 
Screen 

Pendant 
Keypad 
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 Virtual Pendant Keypad

Keypad key Keyboard 
Equivalent Description

[SELECT]
Space

Works as described below.  
• Selects menu items in the main menu area and the pull-down 

menu area.  
• Makes the selected item ready to be set in the general-purpose 

display area.  
• Displays multiple messages in the message area.  

Cursor ↑
←→
↓

Moves the Cursor in the direction of the arrow.  
• The size of the Cursor and the range/place where the Cursor 

can move will vary depending on the window.  
• If the UP Cursor button is pressed when the Cursor is on the 

first line, the Cursor will move to the last line of the job.  Con-
versely, if the Cursor is on the last line of the job and the DOWN 
Cursor button is pressed, the Cursor will jump to the first line of 
the job.  

SHIFT key + UP 
Scrolls the screen upward.  

SHIFT key + DOWN 
Scrolls the screen downward.  

SHIFT key  + RIGHT 
Scrolls the screen to the right.  

SHIFT key + LEFT 
Scrolls the screen to the left.  

[MAIN MENU]

F1

Displays the main menu.  
If this button is pressed while the main menu is displayed, the main menu 
disappears.  

MAIN MENU key  + UP 
Increases the brightness of the screen.  

MAIN MENU key   + DOWN 
Decreases the brightness of the screen.  

[SIMPLE MENU]

F2

Displays the simple menu.  
If this button is pressed while the simple menu is displayed, the simple 
menu disappears.  

[SERVO ON 
READY]

Page 
Down

Enables the servo power supply to be turned ON.  
Press this button to enable the servo power supply to be turned ON if the 
servo power supply is shut OFF by the emergency stop or overrun 
signal.  
When this button is pressed:  
• In the play mode, the servo power supply is turned ON if the 

safeguarding is securely closed.  
• In the teach mode, the SERVO ON lamp flashes and the servo 

power supply is turned ON when the Enable switch is ON.  
• The SERVO ON lamp is lit while the servo power is ON.  

SELECT

SHIFT

SHIFT

SHIFT

SHIFT

MAIN
MENU

MAIN
MENU

MAIN
MENU

ENTRY

SIMPLE
MENU

SERVO
ON

READY
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[ASSIST]

F3

Displays the menu to assist the operation for the currently 
displayed window.  

Pressing this button with SHIFT key  or INTERLOCK key  
displays the help guidance for the operation.  

• SHIFT key + ASSIST key  

The function list of key combinations with SHIFT key  
appears.  

• INTERLOCK key  + ASSIST key 

The function list of key combinations with INTERLOCK key  
appears.  

[CANCEL]

Esc

Cancels the current status.  
• Deletes the sub menu in the main menu area and the pull-down 

menu area.  
• Cancels the input data or the input status in the general-purpose 

display area.  
• Cancels the multiple views in the message area.  
• Cancels the occurred error.  

[MULTI]

F5

Works for the multi mode.  
If this button is pressed when the multi mode is ON, the active window 
switches.  

SHIFT key  + MULTI Key  
Switches between the multi-window display and the single-window 
display when the multi mode is ON.  

[COORD]

K

Select the operation coordinate system when the manipulator is 
operated manually.  
• Five coordinate systems (joint, cartesian, cylindrical, tool and 

user) can be used.  Each time this key is pressed, the coordi-
nate system is switched in the following order: "JOINT""WLD/
CYL""TOOL""USER" 

• The selected coordinate system is displayed on the status dis-
play area.  

SHIFT key + COORD Key 
The coordinate number can be changed when the "TOOL" or "USER" 
coordinate system is selected.  

Keypad key Keyboard 
Equivalent Description

ASSIST
!?

SHIFT
INTER
LOCK

SHIFT ASSIST
!?

SHIFT

INTER
LOCK ASSIST

!?

INTER
LOCK

CANCEL

MULTI
LAYOUT

SHIFT
MULTI

LAYOUT

TOOL SEL
COORD

SHIFT
TOOL SEL
COORD
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[DIRECT OPEN]

L

Displays the content related to the current line.  

• To display the content of a CALL job or condition file, move the 

Cursor to the next line and press DIRECT OPEN key .  The 
file will be displayed for the selected line.  Display content will 
vary depending on the type of instruction used in the job.  

Example: 
For a CALL instruction, the content of the called job will be displayed.  
For a work instruction, the content of the condition file will be displayed.  
For Input/output instructions, the input/output condition will be displayed.  
• The lamp on this button is lit while the direct open is ON.  Press 

this button while the lamp is lit to return to the previous window.  

[PAGE]

F4

Displays the next page.
The page can be switched only when the lamp on this button is lit.  

SHIFT key  + PAGE key  
Switches to the previous page.  

[AREA]

TAB

Moves the Cursor in the following order : “Menu Area”“General-
Purpose Display Area”“Message Area”“Main Menu Area”.  If no 
item is displayed, the Cursor does not move.  

SHIFT key + AREA key  
The language can be switched when the bilingual function is valid.  
(Bilingual function is optional.)  

AREA key  + DOWN 
Moves the Cursor  from the general-purpose display area to the 
operation button when the operation button is displayed.  

AREA key   + UP 
Moves the Cursor to the general-purpose display area when the Cursor 
is on the operation button.  

[SHIFT]

Shift

Changes the functions of other keys by pressing this key together.  

Can be used with ASSIST key , COORD key , AREA key , 
[MOTION TYPE], [ROBOT], [EX. AXIS], Cursor key or Numeric key to 
access alternate functions.  
Refer to the description of each key for the alternate SHIFt functions.  

[INTERLOCK]

Ctrl

Changes the functions of other keys by pressing together.  

Can be used with ASSIST key , MULTI key , [TEST START], 
[FWD], or Numeric key (Numeric key customize function), [ROBOT].  
Refer to the description of each key for the alternate NTERLOCK 
functions.  

[INFORM LIST]

O

Displays instruction lists of commands available for job editing.  

Keypad key Keyboard 
Equivalent Description

DIRECT
OPEN

DIRECT
OPEN

GO BACK
PAGE

SHIFT
GO BACK
PAGE

AREA

SHIFT AREA

AREA

AREA

SHIFT

ASSIST
!?

TOOL SEL
COORD AREA

INTER
LOCK

ASSIST
!?

MULTI
LAYOUT

INFORM
LIST
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[ROBOT]

I

Enables the robot axis operation.  

[ROBOT] is active for the system where multiple manipulators are 
controlled by one FS100 or the system with external axes.  

SHIFT key + [ROBOT] 
The robot under axis operation can be switched to a robot axis which is 
not registered to the currently selected job.

INTERLOCK key  + [ROBOT]
Switchs the application when several applications are set to a robot.

[EX.AXIS]

F11

Enables the external axis (base axis or station axis) operation.  

[EX.AXIS] is active for the system with external axes.  

SHIFTkey + [EX. AXIS]
The external axis under axis operation can be switched to an external 
axis which is not registered to the currently selected job.

[MOTION TYPE]

F7

Selects the interpolation type for playback operation.  
The selected interpolation type is shown in the status display area on the 
screen.  

• Each time this key is pressed, the interpolation type changes in 
the following order: 
"MOVJ"" MOVL""MOVC"

SHIFT key  + [MOTION TYPE]
The interpolation mode changes in the following order:
"STANDARD"" EXTERNAL REFERENCE POINT"*" CONVEYOR"* 

Interpolation type can be changed in any mode.  

*: These modes are purchased options.  

[TEST START]

N

Moves the manipulator through taught steps in a continuous 

motion when [TEST START] and INTERLOCK key  are 
simultaneously pressed.  
The manipulator can be moved to check the path of taught steps.  
Operation stops immediately when this key is released.  
• The manipulator operates according to the currently selected 

operation cycle: "AUTO", "1CYCLE" or "STEP". 
• The manipulator operates at the taught speed.   However, if the 

taught speed exceeds the maximum teaching speed, the opera-
tion proceeds at the maximum teaching speed.  

Keypad key Keyboard 
Equivalent Description

ROBOT SHIFT

INTER
LOCK

EX.AXIS
SHIFT

MOTION
TYPE

SHIFT

TEST
START

INTER
LOCK
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[FWD]

F12

Moves the manipulator through the taught steps while this key is 
pressed.  
• Only move instructions are executed (one instruction at a time, 

no welding instructions).  

INTERLOCK key  + [FWD]
All instructions are executed.  
[0] + [FWD]  
Moves to the reference point of the cursor line.  
The manipulator operates at the selected manual speed.  Make sure that 
the selected manual speed is the desired one before starting operation.  

[BWD]

M

Moves the manipulator through the taught steps in the reverse 
direction while this key is pressed.  
• Only move instructions are executed (no weld commands).  
The manipulator operates at the selected manual speed.  Make sure that 
the selected manual speed is the desired one before starting operation.  

[DELETE]

F9

Deletes the registered instruction.  
• Deletion completes when [ENTER] is pressed while this key 

lamp is lit.  

[INSERT]

F8

Inserts a new instruction.  
• Insertion completes when [ENTER] is pressed while this key 

lamp is lit.  

[MODIFY]

F6

Modifies the taught position data or instruction.  
• Modification completes when [ENTER] is pressed while this key 

lamp is lit.  

[ENTER]

Enter

Registers instructions, data, current position of the manipulator, 
etc. 
• When [ENTER] is pressed, the instruction or data displayed in 

the input buffer line moves to the Cursor position to complete a 
registration, insertion, or modification.  

MANUAL SPEED 
keys

D

C

Sets the speed for manual operation.  This speed is also valid for 
operations with [FWD] and [BWD].  
• There are four speed levels (slow, medium, fast, and inching).  

The speed changes as described below.  The selected speed is 
displayed on the status area.  

Each time [FAST] is pressed, manual speed changes in the following 
order: 
"INCH"" SLOW""MED""FST".  
Each time [SLOW] is pressed, manual speed changes in the following 
order: 
"FST""MED""SLOW""INCH"

Keypad key Keyboard 
Equivalent Description

FWD INTER
LOCK

BWD

DELETE

INSERT

MODIFY

ENTER

MANUAL SPEED

FAST

SLOW
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[HIGH SPEED]

E

Makes the manipulator move at high speed while this button and 
one of the axis keys are pressed simultaneously during manual 
operation.  No need to change the setting of speed.  
• The speed for [HIGH SPEED] is specified in advance.  

Axis Key
Q W   R T
A S   F G
Z X   V B

Y U   H J

Moves specified axes on manipulator.  
• The manipulator axes only move while the key is pressed.  
• Multiple axes can be operated simultaneously by pressing two 

or more keys at the same time.  

The manipulator operates in the selected coordinate system at the 
selected manual speed.  Make sure that the selected coordinate system 
and the manual speed are the desired ones before starting the axis 
operation. 

It is possible to allocate any external axes to [E-] + [E+], [8-] + [8+] keys 
to operate them.   
 

Numeric Key

0-9
-
.

Enters the number or symbol when the ">" prompt appears on the 
input line.  
• “.” is the decimal point.  “-” is a minus sign or hyphen. 
The Numeric keys are also used as function keys.   Refer to the 
explanation of each function for details.  

USAGE

F10

A dedicated key to be used according to the application. Cannot be 
used with MotoSim EG-VRC.

Keypad key Keyboard 
Equivalent Description

FAST
MANUAL SPEED

X+
R+

Y+
B+

Z+
T+

X-
R-

Y-
B-

Z -
T -

8+8-

X+
S+

Y+
L+

Z+
U+

X-
S-

Y-
L -

Z-
U-

E+E-

TOOL OF
0

1
TOOL ON
2

TOOL ON
JOB

3

SMOV
4 5 6

SYNCRO
SINGLE

7 8 9

TOOL OF
JOB
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 Keyboard Layout
The Virtual Pendant keypad key all have a corresponding key on the computer keyboard.  
When the Virtual Pendant Screen has the input focus, the those keyboard key can be pressed 
instead of clicking the keys on the pendant keypad.

ESC   F1 F2 F3 F4 F5 F6 F7 F8 F9 F10 F11 F12           

CANCEL   MAIN 
MENU 

SIMPLE 
MENU ASSIST PAGE MULTI MODIFY MOTION 

TYPE INSERT DELETE ＡＰＰＬＩＣ
ＡＴＩＯＮ EX.AXIS FWD           

                                      

` 1 2 3 4 5 6 7 8 9 0 - = Backspace   Insert Home Page 
Up 

 1 2 3 4 5 6 7 8 9 0 -  Backspace   Teach Play  

TAB Q W E R T Y U I O P [ ] ¥   Delete End Page 
Down 

AREA X- 
S- 

X+ 
S+ 

HIGH 
SPEED 

X- 
R- 

X+ 
R+ E- E+ ROBOT INFORM 

LIST AUX      Start Hold Servo On 
Ready 

CapsLock A S D F G H J K L ; ‘ Enter         

 Y- 
L- 

Y+ 
L+ FAST Y- 

B- 
Y+ 
B+ 8- 8+ COORD DIRECT 

OPEN   ENTER         

Shift Z X C V B N M , . / Shift     ↑   

SHIFT Z- 
U- 

Z+ 
U+ SLOW Z- 

T- 
Z+ 
T+ 

TEST 
START BWD  . Keypad 

Display SHIFT     ↑   

Ctrl Win Alt Space Alt  Ctrl   ← ↓ → 

INTERLOCK   SELECT   INTERLOCK   ← ↓ → 
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5.2.5 NX100 Virtual Pendant

 Virtual Pendant Button
The pendant buttons are the same as those for YRC1000, YRC1000micro virtual pendant.
For details, please refer to the " Virtual Pendant Button " of the " 5.2.1  YRC1000, 
YRC1000micro Virtual Pendant " section.

 

Pendant 
Screen 

Pendant 
Keypad 
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 Virtual Pendant Keypad

Keypad key Keyboard 
Equivalent Description

Cursor ↑
← →
↓

Moves the cursor in the direction of the arrow.
The size of the cursor and the range/place where the cursor can 
move will vary depending on the window.
If the UP cursor button is pressed when the cursor is on the first 
line, the cursor will move to the last line of the job.  Conversely, if 
the cursor is on the last line of the job and the DOWN cursor but-
ton is pressed, the cursor will jump to the first line of the job.

• [SHIFT] + UP
Goes back to the previous page.

• [SHIFT] + DOWN
Goes to the next page.

• [SHIFT] + RIGHT
Scrolls the instruction area of the job content or play back dis-
play to the right.

• [SHIFT] + LEFT
Scrolls the instruction area of the job content or playback dis-
play to the left.

[SELECT]

Space

Selects menu items such as main menu, pull-down 
menu, etc.

[MAIN MENU]

F1

Displays the main menu.
If this button is pressed while the main menu is displayed, the 
main menu disappears.

[SHIFT] + [MAIN MENU]
While a window opens, the window is switched in the following 
order:
Window → Sub-menu → Main menu

[SERVO ON 
READY]

Page 
Down

Enables the servo power supply to be turned 
ON.
Press this button to enable the servo power supply to be turned 
ON if the servo power supply is shut OFF by the emergency stop 
or overrun signal.
When this button is pressed:
• In the play mode, the servo power supply is turned ON if the 

safeguarding is securely closed.
• In the teach mode, the SERVO ON lamp flashes and the servo 

power supply is turned ON when the Enable switch is ON.
• The SERVO ON lamp is lit while the servo power is ON.
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[AREA]

TAB

Moves the cursor between “Menu Area” and "Gen-
eral Purpose Display Area."
When [SHIFT] is pressed simultaneously:

• [SHIFT] + [AREA]
The language can be switched when the bilingual function is 
valid.  (Bilingual function is optional.)

• DOWN cursor button + [AREA]
Moves the cursor to the operation button on the screen if dis-
played.

• UP cursor button + [AREA]
Moves the cursor to the general-purpose display area when the 
cursor is on the operation button.

[PAGE]

F4

Displays the next page.

[SHIFT] + [PAGE]
The previous page is displayed.

The page can be changed when  appears in the status area 
on the screen.

[DIRECT OPEN]

L

Displays the content related to the current line.

To display the content of a CALL job or condition file, move the 
cursor to the next line and press [DIRECT OPEN].  The file will be 
displayed for the selected line.  Display content will vary depend-
ing on the type of instruction used in the job.

Example:
For a CALL instruction, the content of the called job will be dis-
played.
For a work instruction, the content of the condition file will be dis-
played.
For Input/output instructions, the input/output condition will be 
displayed.

[COORD]

K

Select the operation coordinate system when the 
manipulator is operated manually.
Five coordinate systems (joint, cartesian, cylindrical, tool and 
user) can be used.  Each time this key is pressed, the coordinate 
system is switched in the following order: "JOINT""WLD/
CYL""TOOL""USER"
The selected coordinate system is displayed on the status display 
area.

[SHIFT] + [COORD]
The coordinate number can be changed when the "TOOL" or 
"USER" coordinate system is selected.

Keypad key Keyboard 
Equivalent Description
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MANUAL SPEED 
keys

D

C

Sets the speed for manual operation.
This speed is also valid for operations with [FWD] and [BWD].
There are four speed levels (slow, medium, fast, and inching).
Each time [FAST] is pressed, manual speed changes in the fol-
lowing order: "INCH"" SLOW""MED""FST"
Each time [SLOW] is pressed, manual speed changes in the fol-
lowing order: "FST"" MED""SLOW""INCH"
The selected speed is displayed on the status area.

[HIGH SPEED]
E

Changes the speed of axis operation when the axis 
button is pressed. 
The speed of the manipulator will change to high regardless of 
the programmed speed while this key is pressed.
The speed for [HIGH SPEED] is specified in advance.

[MOTION TYPE]

F7

Selects the interpolation type for playback opera-
tion.
The selected interpolation type is shown in the status display area 
on the screen.

Each time this key is pressed, the interpolation type changes in 
the following order:
"MOVJ"" MOVL""MOVC""MOVS"

[SHIFT] + [MOTION TYPE]
The interpolation mode changes in the following order:
"STANDARD"" EXTERNAL REFERENCE POINT"*" CON-
VEYOR"* 

Interpolation type can be changed in any mode.

*: These modes are purchased options.

[ROBOT]

I

Enables the robot axis operation.

[ROBOT] is active for the system where multiple manipulators are 
controlled by one NX100 or the system with external axes.

[EX.AXIS]

F11

Enables the external axis (base axis or station axis) 
operation.

[EX.AXIS] is active for the system with external axes.

Axis Key
Q W   R T
A S   F G
Z X   V B

Moves specified axes on manipulator.
The manipulator axes only move while the key is held down.
Multiple axes can be operated simultaneously by pressing two or 
more keys at the same time.

The manipulator operates in the selected coordinate system at 
the selected manual speed.  Make sure that the selected coordi-
nate system and the manual speed are the desired ones before 
starting the axis operation.

Keypad key Keyboard 
Equivalent Description

133/847



  

HW0485348

[TEST START]

N

Moves the manipulator through taught steps in a 
continuous motion when [TEST START] and [INTER-
LOCK] are simultaneously pressed.
The manipulator can be moved to check the path of taught steps.
The manipulator operates according to the currently selected 
operation cycle: "AUTO," "1CYCLE," or "STEP."
The manipulator operates at the taught speed.  However, if the 
taught speed exceeds the maximum teaching speed, the opera-
tion proceeds at the maximum teaching speed.
Operation stops immediately when this key is released.

[FWD]

F12

Moves the manipulator through the taught steps 
while this key is pressed.
Only move instructions are executed (one instruction at a time, no 
welding instructions).

[INTERLOCK] + [FWD]
All instructions except move instructions are executed.

[SHIFT] + [FWD]
Move instructions are executed in succession.

As for the operation of pressing [REFP]  simultaneously, refer to 
the “NX100 Operator Manual”.  
The manipulator operates at the selected manual speed.  Make 
sure that the selected manual speed is the desired one before 
starting operation.

[BWD]

M

Moves the manipulator through the taught steps in 
the reverse direction while this key is pressed.
Only move instructions are executed (no weld commands).

[INFORM LIST]

O

Displays instruction lists of commands available for 
job editing.

[CANCEL]

Esc

Cancels data input and resets errors.

[DELETE]

F9

Deletes registered instructions and data.
Deletion completes when [ENTER] is pressed while this key lamp 
is lit.

Keypad key Keyboard 
Equivalent Description
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[INSERT]

F8

Inserts new instructions or data.
Insertion completes when [ENTER] is pressed while this key lamp 
is lit.

[MODIFY]

F6

Modifies taught position data, instructions, and data.
Modification completes when [ENTER] is pressed while this key 
lamp is lit.

[ENTER]

Enter

Registers instructions, data, current position of the 
manipulator, etc.
When [ENTER]  is pressed, the instruction or data displayed in 
the input buffer line moves to the cursor position to complete a 
registration, insertion, or modification.

[SHIFT]

Shift

Changes the functions of other keys by pressing 
together.
Can be used with [MAIN MENU], [COORD], [MOTION TYPE], 

cursor key, Numeric key, page key  to access alternate func-
tions.
Refer to the description of each key for the alternate [SHIFT] 
functions.

[INTERLOCK]

Ctrl

Changes the functions of other keys by pressing 
together.
Can be used with [TEST START], [FWD], Numeric key (Numeric 
key customize function).
Refer to the description of each key for the alternate [INTER-
LOCK] functions.

Numeric Key
0-9

-
.

Enters the number or symbol when the ">" prompt 
appears on the input line.
“.” is the decimal point. “-” is a minus sign or hyphen.
The Numeric keys are also used as function keys.  Refer to the 
explanation of each function for details.

[BACK SPACE]
Back 
space

Deletes the last character while typing charac-
ters.

[Multi]

F5

Displays multiple windows.
This function is for future use. (Cannot be used with the 
NX100 of the current version.)

[SHORTCUT]

F2

Displays the shortcut selection dialog box.
This function is for future use. (Cannot be used with the 
NX100 of the current version.)

Keypad key Keyboard 
Equivalent Description
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 Keyboard Layout
The Virtual Pendant keypad key all have a corresponding key on the computer keyboard.  
When the Virtual Pendant Screen has the input focus, the those keyboard key can be pressed 
instead of clicking the keys on the pendant keypad.

5.2.6 Input with keyboard

In MotoSim EG-VRC, To enter the string, the keyboard is also available.

[ASSIST]

F3

Displays the menu to assist the operation for 
the currently displayed window.
This function is for future use. (Cannot be used with the 
NX100 of the current version.)

USAGE

F10

A dedicated key to be used according to the 
application. Cannot be used with MotoSim EG-
VRC.

Keypad key Keyboard 
Equivalent Description

  

ESC   F1 F2 F3 F4 F5 F6 F7 F8 F9 F10 F11 F12           

CANCEL   MAIN 
MENU 

SHORT 
CUT ASSIST PAGE MULTI MODIFY MOTION 

TYPE INSERT DELETE USAGE EX.AXIS FWD           

                                      

` 1 2 3 4 5 6 7 8 9 0 - = Backspace   Insert Home Page 
Up 

 1 2 3 4 5 6 7 8 9 0 -  Backspace   Teach Play  

TAB Q W E R T Y U I O P [ ] ¥   Delete End Page 
Down 

AREA X- 
S- 

X+ 
S+ 

HIGH 
SPEED 

X- 
R- 

X+ 
R+   ROBOT INFORM 

LIST       Start Hold Servo On 
Ready 

CapsLock A S D F G H J K L ; ‘ Enter         

 Y- 
L- 

Y+ 
L+ FAST Y- 

B- 
Y+ 
B+   COORD DIRECT 

OPEN   ENTER         

Shift Z X C V B N M , . / Shift     ↑   

SHIFT Z- 
U- 

Z+ 
U+ SLOW Z- 

T- 
Z+ 
T+ 

TEST 
START BWD  . Keypad 

Display SHIFT     ↑   

Ctrl Win Alt Space Alt  Ctrl   ← ↓ → 

INTERLOCK   SELECT   INTERLOCK   ← ↓ → 
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Procedure
1. Click the [KB] button in the software keypad.

2. Enter the string, and click the [OK] button, the inputted string is fixed and the previous 
screen appears. Press the [Cancel button, the inputted string is canceled and the pre-
vious screen appears.

  Input the job name or folder name
If the gray-out characters as bellow are inputted, the characters are deleted from the inputted 

• The inputted string is not checked. Please make sure not to use the character which can 
not be inputted by the software keyboard.

• The other operation can not used on the input mode. When use the other operation, 
Press the [OK] button or the [Cancel] button to close the input window.

NOTE
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string, when the inputted string is fixed (when the previous screen appears)

 Input the label name
If the gray-out characters as bellow are inputted, the characters are deleted from the inputted 
string, when the inputted string is fixed (when the previous screen appears).
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6 Display Operation

The display tool functions help to achieve better visualization enabling text input on the cell 
window, sectional display of models, display mode change, etc.  

6.1 Viewpoint Operation Tools
MotoSim EG-VRC can control the display with the viewpoint operation tool as follows:

6.1.1 Viewpoint Operation with the Mouse

Each viewpoint operation mode is assigned to the button of the mouse.
Drag with the mouse to the up to down or side to side, a viewpoint will change by the view-
point operation mode currently assigned to the button.

The assignment of the viewpoint operation mode is as follows.

Viewpoint Operation Mode Mouse Operation Viewpoint Movement

Parallel Press-and-hold the scroll 
wheel and drag

Drag the mouse from side to side 
and up and down to synchronize 
the viewpoint with the mouse 
motion.

Rotate Press-and-hold the scroll 
wheel and the right button, 
and drag

For vertical rotation, drag the 
mouse up and down; for horizontal 
rotation, drag the mouse from side 
to side.

Zoom Rotate the scroll wheel Zoom in and out the image by 
dragging the mouse upward (to 
zoom in) or downward (to zoom 
out) over the screen.

Zoom And Rotate Press-and-hold the right 
button and drag

Zoom in and out the image by 
dragging the mouse upward (to 
zoom in) or downward (to zoom 
out) over the screen; rotate the 
image centering on the Z-axis of 
"world" coordinates by dragging 
the mouse from side to side.

Change the viewpoint Press the scroll wheel Click any desirable point so that 
the image is displayed with the 
clicked point located in the center 
of the screen.

Free Zoom Press [CTRL] key + Press-
and-hold the right button 
and drag

Drag the mouse over the desired 
range to be enlarged.
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 Right Mouse Button Operation
A pop-up menu for viewpoint operation appears by clicking the right mouse button on the cell 
window.

6.1.2 Preset Viewpoint Operation 

The camera viewpoint can also be changed to a preset viewpoint.

The most communly used viewpoint are available by clicking on the [Home] tab, in the [View] 

group .
For detail on the preset viewpoint choices please refer to section " 5.1.1  Ribbon ". 

Further preset viewpoint choices are available with the View Manager.

 Viewpoint Operation with the View Manager
The View Manager panel allows to quickly change the view point of the scene by selecting 
one of the standard views or user views.  And, +90 degree or -90 degree rotation from the cur-
rent viewpoint can be executed.
The View Manager panel can be displayed by clicking the [Home] tab, in the [View] group, the 
[View Manager] button.
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View Manager

Item Description

[Standard View] buttons Changes the viewpoint to display associated the standard view.

+90 deg. or -90 deg. rota-
tion button

Rotates the viewpoint + 90 degree or -90 degree from the current 
viewpoint.

[Fit view to extends] button Displays all the models in the cell to fit in the view.

[User View] listbox
Double clicking one of the views will display the associated user 
defined view.Clicking the selected view name will enable the edition 
mode to allow renaming the selected view.

[Load] button Changes the viewpoint displayed on the screen to the user view 
selected in the "User View" listbox.

[Save] button Saves the current viewpoint displayed on the screen to the user view 
selected in the "User View" listbox.

[Close] button Closes the View Manager panel.

 

Standard View 
buttons 

Enables/disables the 
zoom to extents function 
when a standard view 
button is pressed 

User Views 
listbox 

+90 deg. or -90 
deg. rotation 
button 
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 Using Shortcuts
Each view has an associated shortcut key that can be used to recall one of the defined views 
when the input focus is on either the cell display or on the View Manager panel.  Pressing one 
of the numeric keys (1... 9, 0) will load the corresponding user view; the "0" key is used for the 
10th user view.  The first letter of the standard view name is used (.e.i. "T" for the Top view, "F" 
for the Front view...), the letters are indicated on the buttons of the View Manager panel.  The 
keys "I", "O", "J" and "K" are used for the four isometric views.

 Smooth Transition
The viewpoint can be changed with or without smooth transition function by setting the display 
as follows:

Smooth transition ON (smooth transition checked in the menu):
• The viewpoint changes as the image continuously moves.

• For the duration setting, click the MotoSim EG-VRC button (  ), and select the 
[Options] menu.

Smooth transition OFF (smooth transition unchecked in the menu):
• The viewpoint changes instantaneously.

User views definitions are only saved to the file when the cell is saved.NOTE
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6.2 Light Manager Operation

The Light Manager panel allows to add or remove lights and to modify the settings or each 
light.  In addition to the default light, up to 4 additional lights can be added.
On the [Home] tab, in the [Screen] group, click the [Light Manager] button, the [Light Manager] 
dialog appears.

Light Manager

Intensity Adjusts the intensity of the lights.
Sliding the control toward the left will reduce the general lighting of the 
scene.  
Sliding the control toward the right will increase it.
(The standard intensity is 100)
All the lights are affected by this control.

Light No. Selects a light for operations.
The properties of the currently selected light are displayed in the Light 
Property section.

 

Pressing the [Shift] key 
enables or disables the 
Pick Light Position with 
Mouse function. 

Selects the light to be 
modified. 

Set the properties of the 
selected light.  Note that only 
the color can be changed for 
the “Default” light. 

Light intensity adjustment. 
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Add Adds a new light.
To complete the operation, click on the main view to position the light.  
A light object will be displayed to indicate the location of the light.  Up 
to 4 lights can be added.  For more details please refer to the " Adding 
and Modifying Lights " and " Light Sources " sections.

Remove Deletes the currently selected light.
Note that the "Default" light cannot be deleted.

Pick Light Position with 
Mouse

When checked, clicking on the main view will move the position of the 
light to the clicked position.  (When unchecked, clicking the main view 
doesn't change the light position and allows view point change opera-
tion.)
Pressing the [Shift] key toggles the Pick Light Position with Mouse 
check mark.

Light Property [On / Off]
  [Off] : The selected light is turned off.  But, the light is not erased, the 
           settings remains valid.
  [On] : The selected light is turned on.
[Type]
  Distant Light  : Light rays are all parallel (coming from an infinite dis
                        tance)
  Local Light    : Omni directional rays coming from the light source 
                        point (light marker). 
  Spot Light     : Cone shaped directional rays coming from the light   
                        source point (light marker).
  For more detail, please refer to the " Light Sources " section.
[Color]
  The color of the light is displayed in the rectangle.
[Change]
  Displays the Color Dialog to change the color of the light.

OK Closes the Light Manager panel.The lights information will be save to 
the cell file when the cell is saved.
The light markers in the main view will disappear when Light Manager 
is closed.  To display the light markers again, reopen the Light Man-
ager panel.

Cancel Cancels the light setting modifications and closes the Light Manager 
panel. 
The light markers in the main view will be deleted.

• To preserve the light settings for next time the cell is opened, the cell needs to be saved 
after the light settings are changed.

• When exporting files (i.e. html format), changing the light settings don't affect the result-
ing exported file.

Light Manager

NOTE
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 Adding and Modifying Lights
Operation Procedure
1. Press the [Add] button.  The properties of the newly added light will display in the Light 

Property section. (At this stage, the light source still isn't created.)

2. Click on the main view to position the light.  The light will be created and a light marker will 
be displayed to indicate the location of the light.
The light location and type can be confirmed by looking at the light marker in the main 
view.

  

 

Light Marker 
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The lighting of the cell will change to reflect the new light influence.
As long as the [Pick Light Position with Mouse] is checked, clicking on the main view will move the 
light to the clicked position.  Other items can be changed in the Light Property section.
Note that a maximum of 4 lights can be added to the cell.

3. To modify existing light, first select the "Light No." and then change the settings in the 
"Light Property" section.

4. Press [OK] or [Cancel] to close the Light Manager panel.
When the Light Manager is closed the light markers in the main view will disappear.  To 
display the light markers again, reopen the Light Manager panel.

 Deleting Lights
Select the light number.  Press the [Remove] button to remove the light.
Note that the "Default" light cannot be deleted. 

To preserve the light settings for next time the cell is opened, the cell needs to be saved 
after the light settings are changed.

  

NOTE
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 Light Sources
Default
Directional light constantly attached to the viewpoint.  The initial light color is white.

 

 

 

 

Result after changing the
light color 

The FLOOR model is not affected
by light change and will always
display the same way. 
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The light reflection and intensity of the whole scene can be modified by adjusting the "Inten-
sity" value.

Distant Light

Light is emitted from a infinite distance so that all 
the rays are parallel.Light type for general use.
The light direction is from the clicked position 
toward the viewpoint center.

Intensity:       100     75      50 

     

 

 
 

 

Distant Light Marker 
(Located at the clicked position) 
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Local Light

Spot Light

Light is emitted in all direction from the light position.
Useful for generating light from a given point.

Light is emitted in a specific direction forming a cone from the light position in 
a cone shape. Useful to illuminate a specific face of a part.
The light direction is from the clicked position toward the viewpoint center.  
For proper illumination of a model or a face, it may be necessary to relocate 
the viewpoint center on the intended target before setting the light position.
Viewpoint center can be moved with click on the mouse wheel.

 

Local Light Marker 
(Located at the clicked position) 

 

 
Spot Light Marker 
(Located at the clicked position) 
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6.3 Displaying Shadows

Shadows can be displayed for the models on the screen.
Since the shadows are not easily visible when the floor is displayed, use the shadow with the 
opacity of floor image decreased (approx. to 0.5 or less), or hide the floor image. 
For the detailed setting of shadow, refer to " 12.1.4  Shadow ".

6.4 Pick Settings

The Pick settings influence the selection of objects when picking object in the cell view with 
the mouse.

 Pick Mode Setting
The Pick Mode sets conditions determining the selected point in the clicked area.

Procedure
On the [Home] tab, in the [Pick] group, click the [Pick Mode] button, and select one of the fol-
lowing items.   

• Free: Selects the point of the model corresponding to the clicked position.

• Vertex: Selects the model vertex nearest to the clicked position.

• Center: Selects the face or edge center nearest to the clicked position.  Note that 
in order to select the center of the cylindrical model, select the model using 
[Vertex] instead of [Center].

• Edge Selects the edge point nearest to the clicked position.
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 Pick Object Setting
Pick object set filters on the type of objects that can be selected by the mouse pick. 

Procedure
On the [Home] tab, in the [Pick] group, click the [Selectable Object] button, and select one of 
the following items.   

 Pick method and screen display
When the mouse pointer is over the cell view, press down the left mouse button.  The model 
considered for selection will display in yellow with a red dot to indicate the specific point loca-
tion.  The display will update to represent change of selection as the mouse pointer is moved 
over different models.  The actual selection is made only when the mouse button is released.

That these settings are also linked to the same settings available in the OLP dialog.

• Models: Solid models.

• Frames: Model frame or AXIS6 models. (Note: The model frame needs to be visible 
to be selected.)

• Lines &  
lnters:

Lines such as LINE part, WORK line and wireframe model, and intersec-
tion lines generated by the intersection of parts or models.  
(Note the intersection lines are displayed during the pick operation when 
the left mouse button is pressed down.  In cells with many detailed models, 
the intersection generation may slow down the pick function response.  In 
such case, you may uncheck this item to improve performance.) 

• Points: Points such as TRACE points.

• Floor: FLOOR parts. (Note: FLOOR parts tend to interfere selection depending 
on the viewpoint, therefore their selection is managed independently from 
other models.)

That these settings are also linked to the same settings available in the OLP dialog.

NOTE

NOTE
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Picked point 
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6.5 Markup

Graphic forms (such as circles, rectangles) and text can be temporarily drawn on the cell win-
dow.

6.5.1 Freehand

This section explains on how to draw a free-form line.  

Procedure

1. Set the viewpoint of the window.  (This step must be done first since the line will be 
deleted when the viewpoint is changed.)

2. On the [Home] tab, in the [Screen] group, click the [Make-up] button, and  select [Free 
Hand].

Position the mouse pointer at a desired point, and drag the mouse freely so that the 
mouse pointer on screen draws a line with the mouse movement. 

Click the MotoSim EG-VRC button (  ), and select the [Options] menu to set the 

The line drawn on the cell is deleted by changing the viewpoint of the window.NOTE
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color and thickness of the line.  Refer to " 12.2  Markup Settings " for details.   

6.5.2 Circle

This section explains on how to draw a circle.  

Procedure

1. Set the viewpoint of the window.  (This step must be done first since the circle will be 
deleted when the viewpoint is changed.)

2. On the [Home] tab, in the [Screen] group, click the [Make-up] button, and  select [Cir-
cle].

Position the mouse pointer at a desired point, and drag the mouse: a circle is drawn 
centering around the point where the mouse started dragging. 

Click the MotoSim EG-VRC button (  ), and select the [Options] menu to set the 
color and line thickness of the circle.  Refer to " 12.2  Markup Settings " for details.   

The circle drawn on the cell is deleted by changing the viewpoint of the window.NOTE
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6.5.3 Rectangle

This section explains on how to draw a rectangle.  

Procedure

1. Set the viewpoint of the window.  (This step must be done first since the rectangle will 
be deleted when the viewpoint is changed.)

2. On the [Home] tab, in the [Screen] group, click the [Make-up] button, and  select [Rect-
angle].

Position the mouse pointer at a desired point, and drag the mouse: a rectangle is 
drawn from the point where the mouse started dragging. 

Click the MotoSim EG-VRC button (  ), and select the [Options] menu to set the 
color and line thickness of the rectangle.  Refer to " 12.2  Markup Settings " for details.   

The rectangle drawn on the cell is deleted by changing the viewpoint of the window.NOTE
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6.5.4 Notes

This section explains on how to add a note.  

 Adding a Note

Procedure

1. Set the viewpoint of the window.  (This step must be done first since the note will be 
deleted when the viewpoint is changed.)

2. On the [Home] tab, in the [Screen] group, click the [Make-up] button, and  select 
[Notes].

Click any point on the window where to add notes; a "Note" indication appears at the 
clicked point.  Right-click the “Note” to open a pop-up menu, and select {Edit} to enter 
texts.   

3. Click on [OK] after entering the texts.  

The note added on the cell is deleted by changing the viewpoint of the window.NOTE
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Click the MotoSim EG-VRC button (  ), and select the [Options] menu to set the 
font and color of the text.  Refer to " 12.2  Markup Settings " for details.  

 Deleting a Note
Select the note to be deleted, and right-click it.  Select {Delete} from the pop-up menu to 
delete the text.

 Relocating a Note
Drag a note to a different location with on the [Home] tab, in the [Screen] group, click the 
[Make-up] button, and  selected [Notes].
Note that the arrow remains at the same point.

• The note added on the cell is deleted by changing the viewpoint of the window.
• When adding two-byte characters, use a font that properly displays two-byte characters.

NOTE
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6.6 Memo

This section explains on how to create a memo (text).  

 Creating a Memo

Procedure

1. On the [Home] tab, in the [Screen] group, click the [Memo] button.

Click the desired model and drag the mouse to the desired memo location; a "Memo" 
indication with an arrowed line appears at the position where the mouse button is 
released after dragging.    

2. Right-click “Memo” to open a pop-up menu, and select {Edit} to enter texts.   

3. Enter texts, and click on [OK].  
Click the MotoSim EG-VRC button (  ), and select the [Options] menu to set the 

Non-displayed model or the point where there is no model cannot be selected as a subject 
for the memo indication whereas any point of the model displayed on the window can be 
selected for the memo indication.

Memo

NOTE
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font and color of the texts.  Refer to " 12.2  Markup Settings " for details.  

 Deleting a Memo
Select a memo to be deleted, and right-click it.  Select {Delete} from the pop-up menu to 
delete the memo with the arrowed line.

 Relocating a Memo
Drag a note to a different location with on the [Home] tab, in the [Screen] group, click the 
[Make-up] button, and  selected [Memo].
Note that the arrow remains at the same point.

When adding two-byte characters, use a font that properly displays two-byte characters.NOTE
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6.7 Cutting Planes

This section explains on how to display cross sections that are perpendicular to the X-, Y-, Z-
axes directions in the cell window.  
When the cell is saved with the cutting plane displayed, the next time the cell starts up, it starts 
up in cutting plane displayed state.

6.7.1 X-Cutting Planes

With this command, the X-cutting plane (a cutting plane which is perpendicular to the X-axis 
direction in the window) can be displayed as shown in the following figure:

 Displaying the X-Cutting Plane
When the X-cutting plane is not displayed.On the [Home] tab, in the [Screen] group, click the 
[Cutting Plane] button, and  select [X]  

When do not use or set up the recommended graphic board, MotoSim EG-VRC may not 
execute correctly.

NOTE

 

 

Shifted in parallel in the X-axis 
direction.

Rotated centering on the Z-axis

Rotated centering on the Y-axis

�

�

�
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 Deleting the X-Cutting Plane
When the X-cutting plane is displayed.On the [Home] tab, in the [Screen] group, click the [Cut-
ting Plane] button, and  select [X]  

 Changing Display of the X-Cutting Plane
Drag the tools  to on the figure above to rotate the X-cutting plane centering on the Y- or 
Z-axis, or shift it in a direction parallel to the X-axis.  

6.7.2 Y-Cutting Planes

With this command, the Y-cutting plane (a cutting plane which is perpendicular to the Y-axis 
direction in the window) can be displayed as shown in the following figure:

 Shift the X-cutting planes in a direction parallel to the X-axis.

 Rotate the X-cutting planes centering on the Y-axis.

 Rotate the X-cutting planes centering on the Z-axis.

 

 Shifted in parallel in the Y-axis 
direction.

Rotated centering on the Z-axis

Rotated centering on the X-axis

�

�

�
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 Displaying the Y-Cutting Plane
When the Y-cutting plane is not displayed.On the [Home] tab, in the [Screen] group, click the 
[Cutting Plane] button, and  select [Y]  

 Deleting the Y-Cutting Plane
When the Y-cutting plane is displayed.On the [Home] tab, in the [Screen] group, click the [Cut-
ting Plane] button, and  select [Y]  

 Changing Display of the Y-Cutting Plane
Drag the tools  to  on the figure above to rotate the Y-cutting plane centering on the X- or 
Z-axis, or shift it in a direction parallel to the Y-axis.  

6.7.3 Z-Cutting Planes

With this command, the Y-cutting plane (a cutting plane which is perpendicular to the Z-axis 
direction in the window) can be displayed as shown in the following figure:

 Shift the Y-cutting plane in a direction parallel to the Y-axis.

 Rotate the Y-cutting plane centering on the X-axis.

 Rotate the Y-cutting plane centering on the Z-axis.

Shifted in parallel in the Z-axis 
direction.
Rotated centering on the Y-axis

Rotated centering on the X-axis

�

�

�
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 Displaying the Z-Cutting Plane
When the Z-cutting plane is not displayed.On the [Home] tab, in the [Screen] group, click the 
[Cutting Plane] button, and  select [Z]  

 Deleting the Z-Cutting Plane
When the Z-cutting plane is displayed.On the [Home] tab, in the [Screen] group, click the [Cut-
ting Plane] button, and  select [Z]  

 Changing the Z-Cutting Plane
Drag the tools  to  on the figure above to rotate the Z-cutting plane centering on the X- or 
Y-axis, or shift it in a direction parallel to the Z-axis.  

 Shift the Z-cutting plane in a direction parallel to the Z-axis.

 Rotate the Z-cutting plane centering on the X-axis.

 Rotate the Z-cutting plane centering on the Y-axis.
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6.7.4 Pick Object

When [Select Object] is enabled, you can pick cutting plane during OLP operation.

However, depending on the size of cell, this operation takes time. So when [Select Object] is 
enabled, following message box is displayed.
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6.8 Measure Distance

Click 2 points to measure the distance between them.  

Procedure
1. On the [Home] tab, in the [Mesurement] group, click the [Distance] button.

Measure Distance dialog

Copy Copies the measurement result to the clipboard.

Close Closes the Measure Distance dialog.

 

Coordinate of the 1st point 

Coordinate of the 2nd point 

Difference between 
the 2 points  
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2. Click with the mouse any 2 points on models. (Blue dots on the clicked positions and a 
blue line joining the points will appear.)  The Measure Distance dialog will display with the 
measurement results.

When clicking in an area the selected point depends on the current "Pick Mode" and "Pick 
Object" settings.  Please refer to " 6.4  Pick Settings " for details.

NOTE
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6.9 Measure Angle

Click 3 points to measure the angle between them.  

Procedure
1. On the [Home] tab, in the [Mesurement] group, click the [Angle] button.

Measure Distance dialog

Copy Copies the measurement result to the clipboard.

Close Closes the Measure Angle dialog.

 

Coordinates of the 3 points 

Angle between the 2 lines 
linking the 3 points  
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2. Click with the mouse any 3 points on models. (Blue dots on the clicked positions and blue 
lines joining the points will appear.)  The Measure Angle dialog will display with the mea-
surement results.

When clicking in an area the selected point depends on the current "Pick Mode" and "Pick 
Object" settings.  Please refer to " 6.4  Pick Settings " for details.

NOTE

 

This angle. 
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6.10 Measure Line

With this command, a dimension line can be created as shown in the figure below.  

 Creating a Dimension Line

Procedure

1. On the [Home] tab, in the [Mesurement] group, click the [Measure Line] button.

2. Click a model and drag; a dimension line with two-headed arrow appears where the 
mouse is dragged across, displaying the dimension between the both ends.  

 Deleting a Dimension Line
Select a dimension to be deleted, and right-click it.  Select {Delete} from the pop-up menu to 
delete the dimension with the dimension line.

 Relocating a Dimension Line
Drag a note to a different location with on the [Home] tab, in the [Mesurement] group, click the 
[Measure Line] button.
Note that the arrow remains at the same point.

• Non-displayed model or the point where there is no model cannot be selected as a sub-
ject for the dimension line indication whereas any point of the model displayed on the 
window can be selected for the dimension indication.

• When clicking in an area the selected point depends on the current "Pick Mode" and 
"Pick Object" settings.  Please refer to " 6.4  Pick Settings " for details.

NOTE
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6.11 Changing the Rendering Mode

On the [Home] tab, in the [Screen] group, click the [Rendering Mode] button, the display mode 
can be change..  

Flat Shading
The image displayed in flat shaded rendering mode:  

Gourand Shading
The image displayed in Gourand shaded rendering mode:  

Wire Frame
The image displayed in wire frame:  

• The cell is displayed in "GourandShading" mode when it is opened.
• For edition, select desired mode from "FlatShading", "GourandShading", or "Wireframe".

SUPPLE
-MENT
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6.12 Other Display Operations

6.12.1 Changing Frame Width

Modify the frame line width for better visualization on the display. 
Refer to " 12.1.5  Frame & AXIS6 " to set the frame length.

Procedure
On the [Home] tab, in the [Screen] group, click the [Line Size] button,and select the frame 
width from {Small}, {Medium}, or {Large}.

6.12.2 Copying the Image

Copy the static image of the cell window: the copied data can be used in other application 
software by pasting it.

Procedure
Display the cell to be copied.  On the [Home] tab, in the [Tools] group, click the [Copy] button, 
or hold down the Ctrl key and press the C key.
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6.12.3 Dividing a Cell Window

A cell window can be divided up to four views by dragging a separator of the vertical or hori-
zontal scroll bar in the cell window.  This function provides users with different viewpoint 
angles, enabling teaching or playback operations viewed from several directions.
However, depend on PC spec and size of the cell, simulatiton with four windows might not be 
able.

6.12.4 Printing the Image

MotoSim EG-VRC does not have any printing function.  
On the [Home] tab, in the [Tools] group, click the [Copy] button, or hard-copy the screen (Alt + 
Print Screen), and paste it to another application.

         

Drag here.
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7 Controller and Robot Settings

MotoSim EG-VRC allows many robot and controller operations, such as adding, deleting, etc. 
This chapter describes operation related to setting controllers and robots

7.1 Adding a New Controller

A single controller may have one or more control group representing robot, base station or 
external stations. Then, there are 2 ways to create the environment. One is to recreate the 
system configuration in the MotoSim EG-VRC with the "CMOS.BIN" file saved from a real 
controller. The "CMOS.BIN" file contains all the information defining a controller and its robots. 
The other is to create the "CMOS.BIN" file in the MotoSim EG-VRC.

On the [Controller] tab, in the [Setup] group, click the [New] button, the new controller can be 
created.

There are 2 ways to proceed depending on the presence or absence of the "CMOS.BIN" file.
• If there is not the "CMOS.BIN" file (the "CMOS.BIN" file is created in the MotoSim EG-

VRC), proceed to section " 7.1.1  Create a New VRC Controller (no file) ".
• If there is the "CMOS.BIN" file (the "CMOS.BIN" file is taken from a real controller), pro-

ceed to section " 7.1.2  Create VRC Controller (using CMOS.BIN file or ALL.PRM file) ".

Note that a controller that has already been created by MotoSim EG-VRC cell can be simply 
copied into the cell.  To do so, please refer to section " 7.2  Copying a Controller ".

In regard to the FS100 controller, the "CMOS.BIN" file saved from a real controller can not 
be used with MotoSim EG-VRC to create the environment.

NOTE
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7.1.1 Create a New VRC Controller (no file)

Create a new controller and define a system in MotoSim EG-VRC.

Procedure
1. On the [Controller] tab, in the [Setup] group, click the [New] button.  To display the 

“Create Controller” dialog. Select “New VRC Controller (no file)” and press the [OK] 
button. 

2. The "New Controller" dialog box appears.  Select the controller type and then the sys-
tem version from the list below.  If desired you may change the default name for the 
controller.  Click the "OK" button.

• When ECD80D-A00 (NX100) is registered, select the following controller certainly. That 
robot model is only used with the following controller system version.

[Controller Type] NX100
[System Version] NS 4.69-A5

• The expanded memory option is not supported for the FS100 controller.

 

Check the Expanded Memory check 
box, construct the controller with the 
expanded memory.  
Uncheck this check box, construct the 
controller with the standard memory. 

NOTE
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3. New controller dialog for the selected controller version is displayed.
When executes standard setting, set the "Language", "Control Group" and "Applica-
tion" and press the [Standard Setting Execute] button. Proceed the step 5 next.When 
executes setup on maintenance mode of controller, press the [Maintenance Mode Exe-
cute] button. Proceed the step 4 next.

4. The controller will launch with the selected system version and display the Virtual Pen-
dant in maintenance mode.  (This may take a few moments.)  At the same time, the 
“Controller Maintenance Mode”  Instruction Guide will appear.
Since there is no CMOS.BIN file, it is necessary to initialize the controller with the Vir-
tual Pendant in order to define the system (language, robot, application...).  
To do so:

• Initialize the controller
• Once the controller initialization is completed, click on the “Finish” button of the 

Instruction Guide to reboot.
For details how to proceed to set initialize the controller, follow the procedure described 
in the “Instruction Guide” or refer to the " 7.1.3  Initializing the Controller (YRC1000, 
YRC1000micro, DX200, DX100, NX100) " sections that follow later in this chapter.

5. The Virtual Pendant will close and reboot in normal mode.  (This may take a few 
moments.)  The “Robot Setting” dialog will display.  A default robot name and model file 
should be pre-entered.  If required, enter a name for the robot and select a robot model 

• When the controller is "FS100", "Application" of Standard Setting cannot be set.
• When the controller system version is "NS4.69-A5", Standard Setting is not supported.NOTE
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file corresponding to the robot type.  (In the example below, the robot model is 
“VA01400-A00” the corresponding model is “VA01400-A00.mdl”.)  Robot models are 
found in the “Robot” folder under MotoSimEG-VRC install folder.  Click the [OK] button.  

6. The robot will display with the selected model file.

7.1.2 Create VRC Controller (using CMOS.BIN file or 
ALL.PRM file)

Reproduce an existing system composition in MotoSim EG-VRC using the "CMOS.BIN" file or 
"ALL.PRM" file saved from a real system.

When initialized the robot controller, MotoSim EG-VRC set the absolute data auto-
matically. So absolute setting is not needed in MotoSim EG-VRC. 
Refer to " 7.1.4  Initializing the Controller (FS100) " for details.

• In regard to the FS100 controller, the "CMOS.BIN" file saved from a real controller can 
not be used with MotoSim EG-VRC to create the environment.

• In regard to the NX100 controller, the "ALL.PRM" file saved from a real controller cannot 
be used with MotoSim EG-VRC to create the environment.

NOTE

NOTE
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Procedure
1. On the [Controller] tab, in the [Setup] group, click the [New] button.  To display the 

“Create Controller” dialog. Select “VRC Controller (using file)” and press the [OK] but-
ton. 

2. The “Open” dialog box appears.  Select the CMOS.BIN file  or “ALL.PRM” file to be 
used to create the controller, and click [Open].

3. The "New Controller" dialog box appears. If desired you may change the default name 
for the controller. Select the system version from the list below that corresponds to the 
version of "CMOS.BIN" or "ALL.PRM" selected in step 2. If you do not want to initialize 
the CIO while "CMOS.BIN" is selected, uncheck "Initialize CIO". When the kind of con-
troller corresponding to "CMOS.BIN" or "ALL.PRM" cannot be detected automatically, 
the controller type can be selected. Please select the controller type.
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4. The Virtual Pendant will close and reboot in normal mode.  (This may take a few 
moments.)  The “Robot Setting” dialog will display.  A default robot name and model file 
should be pre-entered.  If required, enter a name for the robot and select a robot model 
file corresponding to the robot type.  (In the example below, the robot model is 
“VA01400-A00” the corresponding model is “VA01400-A00.mdl”.)  Robot models are 
found in the “Robot” folder under MotoSimEG-VRC install folder.  Click the [OK] button.  

When ECD80D-A00 (NX100) is registered, select the following controller certainly. 
That robot model is only used with the following controller system version.

[Controller Type] NX100
[System Version] NS 4.69-A5

   
ALL.PRM is selected   CMOS.BIN is selected 

NOTE
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5. The robot will display with the selected model file.
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7.1.3 Initializing the Controller (YRC1000, YRC1000micro, 
DX200, DX100, NX100)

Using the virtual pendant in maintenance mode, the system of controller (language, robot, 
application…) can be set.

Procedure
1. Select {SYSTEM} - {INITIALIZE} from the main menu.

  

2. In the “LANGUAGE” screen, select a language for LANGUAGE1 and LANGUAGE2.  

A series of configuration screen will display to configure the controller.  Press 
[ENTER] to go to the next screen.  Press the [Esc] key on the keyboard or [CAN-
CEL] on the pendant keypad to go back to the previous screen. 

To change a field, move the cursor over that field with the arrow keys and then 
select it by pressing the [Space] key on the keyboard or by clicking the [Select] 
button on the pendant keypad.  Depending on the field, either select a value from 
the list of choices; or enter the required value and press [ENTER]  to register the 
value.

The Virtual Pendant interface can change between the set languages by pressing 
the [SHIFT] key on the keyboard and clicking the [AREA] key on the pendant key-
pad.  

NOTE

NOTE

NOTE
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3. In the “CONTROL GROUP” screen, define the control groups by selecting the manipu-
lator connecter to the each group.  “R” groups are for robot, “B” groups are for robot 
base station and “S” groups are for external axis devices.  When the selection is com-
plet, press [ENTER] to go to the next screen.

4. The “CONNECT” screen doesn’t need any change.  Press [ENTER] to go to the next 
screen.

• The robot models supported by MotoSim EG-VRC are those displayed on the virtual 
pendant for the controller version selected at the time of creation.  Please refer to section 
" 15.9  List of Manipulator Models and Offset Values Supported by MotoSim EG-VRC " 
for the list of available model. However, for similar robot model that only have differences 
in the details of their shape, it maybe possible to do simulation using the standard robot 
model (model ending with A0*).

• When ECD80D-A00 (NX100) is registered, select the following controller certainly. That 
robot model is only used with the following controller system version.

[Controller Type] NX100
[System Version] NS 4.69-A5

NOTE
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5. In the “APPLICATION” screen, select the application that correspond best to what the 
robot will be doing.

6. The “OPTION BOARD” screen doesn’t need any change.  Press [ENTER] to go to the 
next screen.

7. The “I/O MODULE” screen is only for confirmation and I/O modules selection cannot 
be changed at this step.  Press [ENTER] twice to go to the next screen.  To add I/O 
modules please refer to section " 13.3  Collision Detection Setting ".
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8. The “CMOS MEMORY” screen cannot be modified.  Press [ENTER] to go to the next 
screen.

9. The “DATE/TIME SET” screen cannot be modified.  Press [ENTER] to go to the next 
screen.

10. A confirmation dialog box will appear, select [YES] to start initializing the CMOS data. 
Then, the message "Initializing system data. Don't turn the power off." is displayed at 
the bottom of the virtual pendant. Don't operate anything while that message is dis-
played. If the initialization is finished, the message is changed to "Maintenance Mode".
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7.1.4 Initializing the Controller (FS100)

Using the virtual pendant in maintenance mode, the system of controller (language, robot, 
application…) can be set.

Procedure

1. Select {SYSTEM} - {INITIALIZE} from the main menu.

2. In the "LANGUAGE" screen, select a language for LANGUAGE1 and LANGUAGE2. 
When the selection is completed, press [ENTER] to go to the next screen.

A series of configuration screen will display to configure the controller.  Press 
[ENTER] to go to the next screen.  Press the [Esc] key on the keyboard or [CAN-
CEL] on the pendant keypad to go back to the previous screen. 

To change a field, move the cursor over that field with the arrow keys and then 
select it by pressing the [Space] key on the keyboard or by clicking the [Select] 
button on the pendant keypad.  Depending on the field, either select a value from 
the list of choices; or enter the required value and press [ENTER]  to register the 
value.

The Virtual Pendant interface can change between the set languages by pressing 
the [SHIFT] key on the keyboard and clicking the [AREA] key on the pendant key-
pad.  

NOTE

NOTE

NOTE
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3. In the "CONTROL GROUP" screen, define the control groups by selecting the manipu-
lator connecter to the each group. "R" groups are for robot, "B" groups are for robot 
base station and "S" groups are for external axis devices. When the selection is com-
pleted, press [ENTER] to go to the next screen.

4. The "CONNECT" screen doesn't need any change. Press [ENTER] to go to the next 
screen.

5. The "IO MODULE" screen doesn't need any change. Press [ENTER] to go to the next 
screen.

The robot models supported by MotoSim EG-VRC are those displayed on the virtual pen-
dant for the controller version selected at the time of creation.  Please refer to section " 
15.9  List of Manipulator Models and Offset Values Supported by MotoSim EG-VRC " for 
the list of available model. However, for similar robot model that only have differences in 
the details of their shape, it maybe possible to do simulation using the standard robot 
model (model ending with A0*).

NOTE
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6. The "SENSOR FUNCTION ALLOCATION" screen doesn't need any change. Press 
[ENTER] to go to the next screen.

7. The "EXTERNAL IO ALLOCATION(INPUT)" screen doesn't need any change. Press 
[ENTER] to go to the next screen.

8. The "EXTERNAL IO ALLOCATION(OUTPUT)" screen doesn't need any change. 
Press [ENTER] to go to the next screen.

9. The "CMOS MEMORY" screen doesn't need any change. Press [ENTER] to go to the 
next screen.
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10. The "DATE/TIME SET" screen doesn't need any change. Press [ENTER] to go to the 
next screen.

11. A confirmation dialog box will appear, select [YES] to start initializing the CMOS data. 
Then, the message "Initializing system data. Don't turn the power off." is displayed at 
the bottom of the virtual pendant. Don't operate anything while that message is dis-
played. If the initialization is finished, the message is changed to "Maintenance Mode"

7.1.5 Defining the Robot Home Position

When initialized the robot controller, MotoSim EG-VRC set the absolute data automatically. So 
absolute setting is not needed in MotoSim EG-VRC. (This setting should be needed in real 
robot.)
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7.2 Copying a Controller

A controller already define in a MotoSimEG-VRC cell can be copied.

Procedure
1. On the [Controller] tab, in the [Setup] group, click the [Copy] button.

2. The “Open” dialog box appears.  Select the VRC.BIN file located in the controller folder 
(folder bearing the name of the controller) of a MotoSimEG-VRC cell, and click [Open].

3. The “Add Controller” dialog box appears.  Enter a name for the controller.  The “File 
Name” field already contains the path to the VRC.BIN selected in step 2 above.  Click 
[OK].  The controller and robot files will be copied over to the current cell folder and the 
controller will boot in normal mode.  This may take a few moments.
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4. When the controller has completed its boot up, the “Robot Setting” dialog will display.  
Default robot name and model file should be pre-entered.  If required, they may be 
modified.  Click the [OK] button.  

5. The robot will display with the selected model file.

If you copy the controller from within the same cell, the tool model is also copied.NOTE
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7.3 Deleting a Controller

To delete the controller and its associated robots from a cell, follow the procedure below. 

Procedure
1. On the [Controller] tab, in the [Setup] group, click the [Delete] button.

2. The “Select Controller/Robot” dialog box appears.  Select the controller to be deleted, 
then click on [OK].

  

3. The confirmation message below will appear.  Select [Yes] to remove the controller 
from the cell.

The controller is removed from the cell but its corresponding folder and files are 
not deleted from the cell folder.
A delete controller may be added later on by using the “Copy Controller...” menu.  
(For details refer to section " 7.2  Copying a Controller ") 

NOTE
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7.4 Select Controller

A cell always have an active controller .  
Simply click on the down arrow to display the list of controllers  and select the desired control-
ler. (See figure below)
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7.5 Controller Setting

7.5.1 Tool Editor

The Tool Editor is used to select the active tool and to modify the tool data.
On the [Controller] tab, in the [File Settings] group, click the [Tool Data] button, the [Tool Edi-
tor] dialog appear.

Select the tool number, and then, if required, modify the tool data by using the spin button  
at the side of each edit box or entering a value directly.  The tool data can also be changed by 
checking the [Pick Enable] check box and clicking in the cell window.

• In a cell with multiple controllers, it is necessary to select the controller to edit with the 

ribbon   before opening the Tool Editor dialog box.
• In order to change the Tool No., the controller must be set to operate with multiple tools.  

Use the following parameter to activate the multiple tool function on the controller:
YRC1000, YRC1000micro, DX200, DX100, FS100
             S2C431:  Tool number change (0: Single tool, 1: Multiple tool)
NX100  S2C333:  Tool number change (0: Single tool, 1: Multiple tool)

For more detail please refer to the "Tool Coordinates" section of the controller "Opera-
tor's Manual".

• To change the tool selection and tool data using the virtual pendant, please refer to the 
"Tool Coordinates" section of the controller "Operator's Manual".

NOTE

 

 

Robot name 

Incremental value of the  

Tool Number 

Selected controller 
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 Setting the Tool Load Information
Tool Editor dialog box extends to show the tool load information as follows when [Exp. >>] but-
ton is selected.

Tool Editor Dialog Box

Item Description

[OK] button Closes the dialog box after modifying the tool data.

[Cancel] button Closes the dialog box without modifying the data to the new values.

[Apply] button Modifies the tool data; does not close the dialog box.

[Pick Enable]
     check box

Enables mouse picking operation to move the tool center point to the 
clicked position.
When clicking in an area the selected point depends on the current 
"Pick Mode" and "Pick Object" settings. Please refer to " 6.4  Pick Set-
tings " for details.
Pressing the [Shift] key enables or disables the [Active] checkbox.

[Exp >>] button Displays tool load information, enabling data setting.
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7.5.2 User Frame

The Set User Frame dialog box is used define user coordinate system or delete existing ones.
On the [Controller] tab, in the [File Settings] group, click the [User Frame] button, the [Set User 
Frame] dialog appear.

• In a cell with multiple controllers, it is necessary to select the controller to edit with the 

ribbon  before opening the Set User Frame dialog box.
• To change the user coordinate selection and the coordinate system definition using the 

virtual pendant, please refer to the "User Coordinates" section of the controller "Opera-
tor's Manual".

• Master tool user coordinate can be edited the values only. New master tool user coordi-
nate can not be created in this dialog. When select the existing master tool user coordi-
nate, robot name is gray out.

• The user coordinate made by this function is for only simulator. Use the user coordinate 
made by virtual pendant for real robot.

• The error 3140 occurs when loading to controller for user coordinate format change on 
DX200.  In this case, delete the below two lines in the "uframe.cnd" file, and load to the 
controller.

        ///BASICFRM
        ///BASEP

NOTE

 
 

 

User Frame Number 

Selected Controller 

Incremental value of the  

Robot Name 

Coordinate system of 
the parent 
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Procedure
1. Select the user frame number to be edited with the top left combobox.
2. If the selected UF#2 doesn't already exist, press to the [Add] button.
3. Check the [Pick Enable] or [Pick 3 points] check box, and then left-click with the mouse 

on the cell window to move the user frame.
• [Pick Enable]

Check the [Pick Enable] checkbox, and then left-click with the mouse on the cell 
window to move the user frame to the clicked position.

• [Pick 3 points]
Check the [Pick 3 points] checkbox, and then left-click with the mouse on the cell 
window to move the user frame to the clicked position. Next, left-click with the 
mouse on the cell window to define the X-axis direction. Finally, left-click with the 
mouse on the cell window to define the XY-plane. Then the user frame is shown.

4. If necessary, set the axis values to move the user frame.
5. Press [OK] to save the user frame settings.

Set User Frame Dialog Box

Item Description

Parent frame 
display box

Displayed only with a controller after YRC1000, YRC1000micro.
The user coordinate system is made on the basis of the coordinate
system of the parent.
The selectable coordinate system is only [BASE coordinate system]
and [USER coordinate system].
The parent-child relation of the USER coordinate system is limited by
two levels.

[Add] button Create a coordinate system for the selected user frame number.

[Delete] button Delete the coordinate system of the selected user frame number.

[Pick Enable]
     check box

Enables mouse picking operation to move the user frame.
When clicking in an area the selected point depends on the current 
"Pick Mode" and "Pick Object" settings. Please refer to " 6.4  Pick Set-
tings " for details.
Pressing the [Shift] key disables, enables, and 3 point the [Active] 
checkbox.

[Pick 3 Points]
check box

Enables 3 points picking operation to move the user frame.
When clicking in an area the selected point depends on the current 
"Pick Mode" and "Pick Object" settings. Please refer to " 6.4  Pick Set-
tings " for details. Pressing the [Shift] key disables, [Pick Enable] 
checkbox, enables and [Pick 3 points] checkbox.

[OK] button Closes the dialog box after confirming the overwrite of user frame.

[Cancel] button Closes the dialog box without modifying the data to the new values.
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7.5.3 Reboot Controller

Some operation perform in the Virtual Pendant such as parameter changes may require to 
reboot the controller in order for the change to be affective.  
On the [Controller] tab, in the [Boot] group, click the [Reboot] button,The controller can be 
rebooted.

7.5.4 Refresh Interval

The re-drawing interval at the playback is set every second (s).
During playback, the drawing time interval can be set in the “Refresh Interval” dialog box.
On the [Home] tab, in the [Settings] group, click the [Heart Beat] button,the [Refresh Interval] 
dialog appears.
The VRC sends position data to MotoSimEG-VRC for every segment (usually between 10 and 
20 milliseconds).  For animation purpose, the screen doesn’t need to be refreshed so quickly.  
The refresh interval can be adjusted to optimize the playback visualization according to a spe-
cific computer capability. 

 Setting of high-speed playback function
When [More >>] button is pushed, the high-speed playback set up information is displayed. 
The playback can be done at high speed by setting the high-speed playback function.

• The high-speed playback function is a function sped up by omitting the segment data.
The effect might not become visible according to a set value at drawing intervals and 
computers that use it.

• Please do not use this function when you want to check the movement of every one seg-
ment on the pulse record.

NOTE
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 Setting of real time playback function
When [More>>] button is pushed, the real time playback set up information is 
displayed.

Refresh Interval Setting Dialog Box

Item Description

[Enable Fast Playback] 
check box

The high-speed playback function is made effective.
When you press OK with the checked, the following message box will 
be displayed.

[Subject Pass]

The section where the high-speed playback function is made effective 
is set.
  All                  : The function is made effective in all sections.
  Welding Pass : The function is made effective while welding
                          (ARCON-ARCOF section).

[Speed] The degree at the speed of the high-speed playback function is set by 
five stages.
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The playback can be done at real time by setting the real time playback function.

7.5.5 Servo Emulation

To playback without considering the lag of servo, On the [Simulation] tab, in the [Playback] 
group, click the [Servo Emulation] button.

• This function is to simulate the segment processing of controllers in real time.
Usually, there is a difference in the actual time it takes to play back simulation by PC per-
formance.
When real time playback enabled, playback is performed so as to coincide with the real 
time.

• When used with a heavy load function (e.g. interference checking or trace display), seg-
ment processing can not run in real time, and playback might be interrupted. In that 
case, disable the high-load function, or increase the setting of tolerance.

• Real time playback function and high-speed playback function can not be used at the 
same time.

Refresh Interval Setting Dialog Box

Item Description

Enable Realtime play-
back

The real time playback function is made effective.

Tolerance
Sets the maximum allowable error between the actual time and play-
back time during playback. If the playback is delayed more than the set 
value, playback will be interrupted.

NOTE
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7.5.6 Cube Interference Area

Interference area can be define on the controller to determine if a robot is in a given cube or 
prevent the robot  to enter the defined area. 

 Displaying the Cube Interference Area
On the [Controller] tab, in the [File Settings] group, click the [Cube Interference Area] button 
and select [Draw Cube Area Model] , the defined interference cubes display.  

 Deleting the Cube Interference Area
On the [Controller] tab, in the [File Settings] group, click the [Cube Interference Area] button 
and select [Delete Cube Area Model] , the defined interference cubes display.
This will only delete the models, the cube area definition in the controller will not be affected.

 Setting the Cube Interference Area
The cube interference areas can be defined by using the Virtual Pendant.  Please refer to the 
“INSTRUCTIONS”  of the controller for the procedure.

If the cube areas are already displayed and the cube definitions are changed, the cube 
model in MotoSimEG-VRC will not automatically be updated.
After modifying the cubes with the Virtual Pendant, the {Cube Area Update & Display} 
menu need to be selected in order to update the MotoSimEG-VRC display. 

        

NOTE
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7.6 Robot Settings

7.6.1 Robot Property

The “Robot Property” diaog can be used to change the robots name and their model files.  On 
the [Controller] tab, in the [Robot] group, click the [Model Setting] button, the [Robot Settings] 
dialog appears.

Procedure
1. Select a robot from the robot list.  Its name and model file will display in the corre-

sponding field in the section below the robot list.
2. Edit the robot name or select a new model file.
3. If multiple changes are required, repeat the above steps.  As new selections are made 

the data in the robot list will be updated.
4. When all the changes have been entered, press the “OK” button to apply those 

changes and close the “Robot Settings” dialog.  Or, press “Cancel” to discard the 
changes. 
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7.6.2 Reach View

The motion range of the robot P-point (wrist rotation center) can be displayed in 2D or 3D.
To create or delete Reach View models, 
On the [Controller] tab, in the [Robot] group, click the [TCP Reach] button, the [Reach Area] 
dialog appears. 

Reach Area Dialog Box

Item Description

“Mode” section

Selects P-point or tool end as a base point of range motion.

“Disp” section

Specifies display style for range of motion.  (For some robot models, 
3D display is not available.)

• [2D] radio button: displays range of motion in 2D style.
• [3D] radio button: displays range of motion in 3D style.

“Level” section Selects display level (rough/standard/fine) of range of motion.

[Color] button Displays Color dialog box to specify colors.

[Delete] button Deletes the previously created Reach View models.

[Create] button Creates a Reach View model of the specified style representing the 
range of motion of the cell active robot.

[Close] button Closes Reach Area dialog box.

When [Tool] is selected, the motion range model is cre-
ated at P-point. And displayed at a position shifted by the 
tool position at the time of creation.

NOTE

Motion Range can be displayed in both 2D and 3D style 
simultaneously:  Select 2D and press the [Create] but-
ton; then select 3D, change color (optional) and press 
[Create] again.

NOTE
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7.6.3 Robot Calibration Setting

The robot calibration data define the relative position between robots and stations of a same 
controller.  This information is necessary to use the “Coordination Motion” function of the con-
troller.  In order for MotoSimEG-VRC to properly display the coordinated motion between 
robots/stations, the controller calibration data and robot/station model layout must correspond 
to each other.  

To adjust the controller calibration and robot/station model layout to correspond to each other, 
display the “Coordinated Motion Calibration” dialog by selecting: on the [Controller] tab, in the 
[File Setting] group, click the [Robot Calibration] button.

“Coordinated Motion Calibration” Dialog Box

Item Description

Layout robot models to 
match calibration data

Adjusts the relative position between the robot/station models to 
match the calibration data of the controller. 

Set calibration data base 
on robot model layout

Sets the calibration data of the controller based on the relative posi-
tion between the robot/station models in the MotoSimEG-VRC lay-
out.

[Close] button Closes the “Coordinated Motion Calibration” dialog box.

The “Calibration” menu item is only available for controller with the “Coordinated 
Motion” option activated.  In order to activate this function,please refer to the steps to 
set {OPTION FUNCTION} for each controller in the section " 13.5  Dual-Arm robot Setting 
". 

The calibration data must be define in the controller 
before using this function.

NOTE

NOTE
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7.7 Peripheral Equipment

Peripheral Equipment or Device are considered as a RCS controllers.  Their name appears in 
the Controller lists with the other controllers.  They can be programmed to move in the same 
manner as a robot controller by creating jobs and then playing them back.   
Three types of device are available: conveyor, press and gantry.

7.7.1 Adding a Conveyor

 Adding a Conveyor
Conveyors are device that can be setup with 1 to 3 linear axis (X, Y, Z).
To add a conveyor to the cell. On the [Controller] tab, in the [External Device] group, click the 
[New] button, and select [Conveyor] the [Conveyor Installation] dialog appears.

Up to 6 conveyors can be added to a cell.  The conveyor is registered as a controller with 
the name displayed in the "Name" edit box of the Conveyor Install dialog box.  This name 
is determine by the selection of the conveyor number and cannot be changed.

Conveyor Installation dialog box

Item Description

"No" section Specifies the conveyor number.

"Joint Num" section Specifies the number of axis by selecting one of the radio buttons.  

NOTE

 
The conveyor name is automatically completed 
when the conveyor No. is selected. 
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 Conveyor Setting
Specify the dimensions, speed, and operating range of the conveyor to be registered in the 
Edit Conveyor Information dialog box.
This dialog is automatically displayed when a new conveyor is installed.  It can also be dis-
played afterward to modify the conveyer settings by selecting:
On the [Controller] tab, in the [External Device] group, click the [Conveyor Setting] button.  

[OK] button
Adds the conveyor to the cell and then displays the “Conveyor Setting” 
dialog box.
Refer to " 7.7.1  Adding a Conveyor " for details.

Conveyor Setting dialog box

Item Description

"No" section Specifies the conveyor number to set the condition.

Conveyor Installation dialog box

Item Description
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"Model info" section

Specifies the dimensions of the conveyor to be registered.  

"Motion info" section

Specifies the dimensions of the conveyor to be registered.  

[make model] check box Creates a default conveyor model. 

• When the default conveyor model is modified, clear the [make model] check box unless  
the default conveyor model is to be used.  If the [make model] check box is not cleared, 
the modification for the model becomes invalid, and the model is restored to the default 
model.

Conveyor Setting dialog box

Item Description

"L(mm)" edit box Entire length of the conveyor.

"D(mm)" edit box Width of the conveyor.

"H(mm)" edit box Thickness of the conveyor. (Distance from 
the floor to the conveyor top.)

"Org(mm)" edit box Limit switch position for the conveyor home 
position. (Distance from the conveyor end.)

"Speed(mm/s)" 
 edit box Operation speed of the conveyor.

"Start(mm)" 
 edit box

Start position of the conveyor operation. 
(Specify the distance from the home position
 of the conveyor.)

"End(mm)" 
 edit box

End position of the conveyor operation. 
(Specify the distance from the home position
 of the conveyor.)

NOTE
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7.7.2 Adding a Press

Presses are device that have 3 linear axis (X, Y, Z).  By default, only the Z-axis is enabled to 
move because the X and Y axes motion have been restrained by soft limits.  To change the 
soft limit restriction please refer to the " 7.7.4  Modifying the Soft Limit of a Device " section.

To add a press to the cell. On the [Controller] tab, in the [External Device] group, click the 
[New] button, and select [Press] .

Procedure
1. On the [Controller] tab, in the [External Device] group, click the [New] button, and 

select [Press]  the [Press] dialog appears.
Select if the default press model is to be used or not by checking or unchecking the 
[Make Model] check box.  (The [Make Model] check box is selected by default.)
Press the [OK] button.

2. Enter the name of the press in the “Device Install” dialog, as shown in the figure below.
Press the [OK] button.

3. The press is added to the cell and a model is automatically generated if the [Make 
Model] option was checked in the “Press” dialog.
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7.7.3 Adding a Gantry

A gantry device is composed of a “robot” model (RB1) with three linear axes (X, Y, Z) for the 
base and a “station” model (ST1) with three external rotation axes for the head (Rx, Ry, Rz).  
The control point (TCP) is thoroughly determined by the three rectangular linear axes, and is 
independent of the external axes.

To add a gantry to the cell. On the [Controller] tab, in the [External Device] group, click the 
[New] button, and select [Gantry] .

Procedure
1. On the [Controller] tab, in the [External Device] group, click the [New] button, and 

select [Gantry]  the [Gantry] dialog appears.
Select the check box to specify if the following items in “Gantry” dialog box are 
required.
[Series List] check box: Configuration of external rotation axis.
                                      (Checked: serial configuration; cleared: parallel configuration.)
[Make Model] check box: Creation of a model.  (Check the box if model creation is
                                         desired.)
Note that both check boxes are selected by default. 
Press the [OK] button.
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2. Enter the name of the gantry in the “Device Install” dialog, as shown in the figure below.
Press the [OK] button.

3. The gantry is added to the cell and a model is automatically generated if the [Make 
Model] option was checked in the “Gantry” dialog. 

7.7.4 Modifying the Soft Limit of a Device

The motion range of device can be modified with the “Soft Limit Setting” dialog.

Procedure
1. On the [Controller] tab, in the [External Device] group, click the [Soft Limit] button, the 

[Soft Limit Setting] dialog appears. 

2. Select the device to be edited from the “Name” combobox.
Note that when a gantry device is selected, the dialog expand to also display settings 
for the Rx, Ry, Rz axes.   
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3. Modify the values as required and press the [Apply] button to make the modification.
4. Press “Close” to close the dialog.
5. For the modification to take affect, close the cell file and then open it again.  

7.7.5 Moving a Device

Devices can be moved by using the Position Panel.  
On the [Home] tab, in the [Teaching] group, click the [Position Panel] button, the [Position 
Panel] dialog appears.

Unlike other robots, they can only be moved using the “Pulse” or “Joint” frame coordinate sys-
tem.  Using the “Joint” frame is the equivalent of a rectangular coordinate system (coordinate 
X, Y, Z in millimeters).  

Gantry also have a station (external axes) mounted at the end of the robot TCP (X, Y, Z axes) 
that allows Rx, Ry and Rz rotations.  To move this axis, change the selection in the robot com-

To enable the modifications, reload the cell.NOTE
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bobox to the robot name ending by “-ST1”.

For further detail on the Position Panel operation, please refer to section " 8.1  Position Panel 
" .

7.7.6 Programming a Device

Devices can be programmed to move in the same manner as a robot controller by creating 
jobs and then playing them back. 
The Job panel is used to display the job and allow teaching.  On the [Controller] tab, in the 
[External Device] group, click the [Job Panel] button, the [Job Panel] dialog appears.

If the cell contains multiple devices and the "Multiple Controller Dialog" mode is enable, a 
separate Job panel can be displayed for each device in the cell.  Select the device to be 
displayed in the controller combobox of the toolbar before displaying the Job panel.

 

Select the [Enter] button 
processing mode. 

Adds, modifies or deletes 
instructions. 

Adds multiple lines of 
instructions at a time by 
entering coordinate 
values. 

- Updates the job if it has been edited with other software. 
- Moves the cursor to the step of the current robot position. 

Job display box 

Selected job 

Synchronizes the robot 
position with the current 
position in the display box. 

Displays the “Select Job” 
dialog 

NOTE
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Job Panel

Item Description

Job selection 
combobox

Select the current job from the dropdown list or click on the [...] button 
to its right to display the “Select Job” dialog. (Refer to the " Select Job " 
section for details.

Job display box

The device moves to the step selected in the job display panel if the 
[Sync] step synchronization check box is selected.
JOB Edit dialog box for job editing appears by double-clicking the 
selected line.  

JOB Edit Dialog Box:
Modify the instruction in the edit box.  Select either the [Add Line] or 
[Replace Line] button. 

[Enter] button Executes the command selected among [Del], [Add], [Mod] radio but-
tons.

[MOVE...] button

Displays the Interpolation dialog box.
Specify motion type, speed and position level for the playback opera-
tion, and click [OK].  

[Close] button Closes the Job Panel

To enable the modification of the motion type and speed 
when a teaching position is modified, select the [Allow 
Modif.] check box.

NOTE
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 Select Job
The Select Job dialog box (see the figure below) allows to select, copy, delete the jobs.  It can 
also import jobs registered in other cells. 

Selecting a Job
Select a job from the job list, then click on [OK]. 

Creating a Job
Type the name of the new job in the “Selected Job” field.  The job name may not 
exceed 8 characters and cannot contain any spaces.

Importing a Job
Procedure

1) Click on [Import].
2) Select a job, and click [Open].
3) Click [OK] to import the job.

 

List of the jobs in the controller folder. 

Displays the content 
of the selected job. 

Selected controller 

Selected job 

Controller folder 
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Copying a Job
Procedure

1) Select a job to be copied, and click on [Copy...]: the Job Copy dialog box as 
shown below appears.  

2) Enter a job name in the Destination of Copy edit box, and click on [Copy>>].
3) The job to be copied is displayed on the right; check the item, then click on [OK] 

to copy the job.

Deleting a Job
Select a job to be deleted from the job list in the Select dialog box, then click on [Delete].

 Input of Coordinates (AxisInput)
Press [AxisInput] in the Job Panel to display Axis Data Input dialog box shown below, and cre-
ate a list by entering coordinate values (either pulse or rectangle).  Instructions are added to 
the job for each point of the list.

213/847



7.7  Peripheral Equipment

HW0485348

Axis Data Input Dialog Box

Item Description

[Pulse] radio button Coordinate values are entered in pulse value.

[Rectangle] radio button Coordinate values are entered in rectangle value.

[CSV File Load] button Loads the coordinate values from a CSV file, and inserts the coordi-
nate values right after the selected line in the list.

[Line Insert] button Inserts the coordinate entered in the Axis Input dialog box right after 
the selected line in the list.

[Line Edit] button Edits the selected line in the Axis Input dialog box.

[Line Delete] button Deletes the selected line from the list.  (Multiple selection is 
allowed.)

[OK] button Closes the Axis Data Input dialog box; the list is added as instruc-
tions.

[Cancel] button Closes the Axis Data Input dialog box without modifying the job.
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Procedure
1. Select either the [Pulse] or [Rectangle] radio button in Axis Data Input dialog box. 
2. Edit coordinate values with [Line Insert], [Line Edit], or [Line Delete], and create a list.  

If a CSV file already exists, load coordinate values by selecting [CSV File Load].
3. When the list is completed, press [OK] to add the created list as instructions after the 

selected line in the job.  

Axis Input Dialog Box

Item Description

Pulse/Rectangle

[OK] button Applies the modification, and closes the Axis Input dialog box.

[Cancel] button Closes the Axis Input dialog box without executing the modification.

The motion type and speed of MOVE instructions which have been added with the input of 
coordinates are the set values specified in Interpolation dialog box displayed by clicking 
[MOVE...] in the Job Panel.

Coordinate

Radio Button selected in 
the Axis Data Input Dialog Box

Pulse Rectangle

S/X S-axis X-axis

L/Y L-axis Y-axis

U/Z U-axis Z-axis

R/Rx R-axis Rx-axis

B/Ry B-axis Ry-axis

T/RZ T-axis Rz-axis

NOTE
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7.7.7 Other Operations with devices

 Deleting a Device
Device and their model can be deleted by using the same procedure as other controllers. 
On the [Controller] tab, in the [Setup] group, click the [Delete] button, the [Select Controller/
Robot] dialog appears..

 I/O Signals for Devices
Devices also have I/O signals that can be use to interact with other controllers in the cell.  
They can be used in a similar way than those of a VRC controller.

Device I/O Monitor 
The I/O Monitor for device is displayed in the same way as other controller but the displayed 
dialog is different.
On the [Simulation] tab, in the [Monitor] group, click the [I/O Monitor] button, the [I/O Monitor] 
dialog appears 

I/O Monitor can display signals change from an instruction and also give signals to the robot 
by selecting an IN signal before or during playback.  
The I/O data specified in I/O Monitor can be saved as well.

If the cell contains multiple device and the "Multiple Controller Dialog" mode is enable, a 
separate I/O Monitor can be displayed for each device in the cell.  Select the device to be 
displayed in the controller combobox of the toolbar before displaying the I/O Monitor.

NOTE
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I/O Monitor Dialog Box

Item Description

[Group No] Specifies the I/O group number to display.

[Set all IN-Signal] check box Turns ON all the IN signals of all registered robots.  Uncheck 
the box to turn OFF all the IN signals.

[Set all OT-Signal] check box Turns ON all the OUT signals of all registered robots.  Uncheck 
the box to turn OFF all the OUT signals.

[Clear I/O] button Clears all the signals of the selected robot.

[Close] button Closes I/O Monitor dialog box.

217/847



7.7  Peripheral Equipment

HW0485348

7.7.8 Conveyor Operation Panel

This panel is used to operate the conveyor with 1 axis.
To operate the conveyor with multi-axis, refer to section " 7.7.5  Moving a Device ".

Conveyor Operation Panel

Item Description

Position To set the conveyer position for teaching the robot, input the 

number or set the number by the  button.

Conveyor Power On When this is turned off during playback, the review on stopping 
the conveyor is enabled.

Robot Moving with Conveyor If this is turned on, the selected robot moves with conveyor on 
operating the conveyor.
When [Robot Moving with Conveyor] is used, set the conveyor 
synchronization of the selected robot in advance.

 

Setting the conveyor 

The position of conveyor in [Position] is 
reflected LS offset value of the each robot. 
When the other robot is selected, the position of 
conveyor in [Position] is changed, without the 
displayed conveyor is not operating.

NOTE
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7.7.9 Conveyor Synchronization

This panel is used to set the synchronization condition between the robot and the conveyor.
If the conveyor synchronization option is available, this panel is displayed automatically when 
the conveyor is added. Refer to section " 13.7  Registering the Equipment Model " about con-
veyor synchronization option.
To change the synchronization condition of registered conveyor. On the [Controller] tab, in the 
[External Device] group, click the [Conveyor Condition File] button, the [Conveyor Synchroni-
zation] dialog appears.

Conveyor Synchronization Setting

Item Description

Robot The list of the controller which can use the conveyor synchro-
nized function is displayed. Select the controller by the list.

Conveyor No Select the conveyor synchronized with the controller selected by 
[Robot].

Conveyor Info The name and speed of the conveyor selected by [Conveyor 
No] is displayed.
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Condition [Condition File No]          : Select the conveyor condition file of 
the selected conveyor and controller. 
the file is registered by the virtual 
pendant.

[Tracking]                        : Specify whether to carry out the syn-
chronization with the robot-axis or the 
base-axis.

[Base Axis]                      : When the [Base Axis] is selected by 
[Tracking], the selected axis is dis 
played.

[Direction Rev]                : When the [Base Axis] is selected by 
[Tracking], the item is displayed. 
When the conveyor traveling direc-
tion is opposite of the forward direc-
tion of base axis, this item is "ON".

[Average Time (msec)]   : The averaged travel time of conveyor 
is displayed.

[User Frame No]             : The user frame number of the con-
veyor direction is displayed. The user 
frame number corresponding to the 
conveyor number is selected auto-
matically.

[LS offset (mm)]               : Set the distance of the conveyor origin 
position. When this item is set to 
1000mm, the conveyor origin position 
of the selected robot is located 
1000mm before the origin position on 
the display.

Conveyor Synchronization Setting

Item Description
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7.8 Cycle Time

On the [Controller] tab, in the [Playback] group, click the [Cycle time] button.
The latest cycle time of playback is displayed on the following display.

This function can not use depending on the system version of controller. Please refer to 
section " 15.8  List of Function depending on the system version of controller ".

NOTE

 

Displays the maximum of playback 

Copys the displayed data to the clipboard 

221/847



7.9  Trace

HW0485348

7.9 Trace

Trace is a function to display update points of the robot position when the robot playback is 
performed. Larger dots in the traces mean the separation of the command data (step end). 
Traces can be set with the "Trace Manager" dialog box. On the [Simulation] tab, in the [Moni-
tor] group, click the [Trace] button.

7.9.1 Trace Manager

Multiple traces can be set.
When a controller is registered to the cell a trace is automatically added for Tool Center Point 
(TCP) of each robot. 

This function can not use depending on the system version of controller. Please refer to 
section " 15.8  List of Function depending on the system version of controller ".

“Trace Manager” Dialog Box

Item Description

Trace list

Displays the information of the defined traces.
Trace Model: Name of the trace model (used in the CadTree)
Enable: Enable/Disable the trace generation during playback.
Length: Approximate travel distance of the traced point during 

playback.
Time: Playback Time
Keep TraceLine: In the case of Disable, the trace lines is deleted 

automatically before the playback is started.
The “Trace Property”  of a trace can be displayed by double-clicling on 
a trace from the list.

[Edit] button Edits a trace with the “Trace Property” dialog.
For details refer to section " 7.9.2  Trace Properties ".

NOTE
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7.9.2 Trace Properties

The “Trace Property” dialog box is displayed by pressing the [Edit] or [Add] button of the 
“Trace Manager” dialog box.
It allows to set the trace properties such as the color, number of points, traced model, etc.

 

“Trace Property” Dialog Box

[Add] button Defines a new trace with the “Trace Property” dialog.
For details refer to section " 7.9.2  Trace Properties ".

[Delete] button Deletes the trace definition currently selected in the trace list.

[Clipboard] button
Opens the “Trace Copy” dialogs with the data of the trace currently 
selected in the list.
For details refer to section " 7.9.3  Trace Copy ". 

[Clear Model] button
Deletes all the trace models.
Note that before playback, all the previously generated trace models 
are automatically deleted.

[Clear TraceLine] 
button

Delete all the trace lines.

[Save TraceLine] 
button

Save the trace lines as the model file.

[Close] button Closes the “Trace Manager” dialog box.

Item Description

[Enable] Indicates that the trace will be generated during playback when 
checked.

“Trace Manager” Dialog Box

Item Description

The trace is not saved on the cell. When it needs that the 
trace is saved, the trace is saved by [Save TraceLine], 
and save the cell.

NOTE
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[Robot] Selects the robot associated with the trace.
A trace point is generated everytime the robot position is updated 
during playback.  
This field cannot be modified when editing an existing trace.

[Model] Displays the name of the model that will be traced.  
The default model is the robot TCP.  
To change model, press the [...] button beside the “Model” field to dis-
play the “Select Model” dialog box.  Select a model and press [OK].

[Parent] Displays the name of the model that is used as the parent of the trace 
and as a coordinated system for the trace point.  
The default model is the “world” model.  
To change model, press the [...] button beside the “Parent” field to dis-
play the “Select Model” dialog box.  Select a model and press [OK].

[Keep TraceLine] When this item is checked, the trace lines before playback is not 
deleted and the playback is started.

[Max Points] Defines the maximum number of data points that are generates in the 
trace model.  The value may be increase up to 20 000 points.  When 
the maximum value is reached, the oldest points are erased as new 
points are generates.

[Color] Displays the color of the trace model.  
To change the color, press the [...] button beside the “Color” field to 
display the “Color” dialog box.  Select a color and press [OK].

[Line Type] Selects the line type: dotted, normal, thick.

[OK] button If in [Add] mode: adds a new trace definition. 
If in [Edit] mode: updates the selected trace definition.
Closes the “Trace Property” dialog box.

[Cancel] button Closes the “Trace Property” dialog box.

Item Description

224/847



7.9  Trace

HW0485348

7.9.3 Trace Copy

The “Trace Copy” dialog box is displayed by pressing the [Clipboard] button of the “Trace 
Manager” dialog box.
It allows to copy the last playback data points of the selected trace to the clipboard or a text 
file.
The displayed trace data are "Controller Name", "Robot Name", "Model Traced", "Trace 
Model", and "Reference". Then, the values of position and speed at each trace points are dis-
played.

“Trace Copy” Dialog Box

Item Description

[File] button Saves the displayed trace information to a text file.

[Clipboard] button Copies the displayed trace information to the clipboard.

[Close] button Closes the “Trace Copy” dialog box.
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7.10 VRC Maintenance Mode

The VRC controller can be started up in maintenance mode to perform various maintenance 
task such as initializing data, setting, etc.  When there are no opened cell, the “VRC Mainte-
nance Mode” dialog can be displayed by selecting from MotoSim EG-VRC : on the [Controller] 
tab, in the [Boot] group, click the [Maintenance Mode] button. 

VRC Maintenance Mode

VRC.BINPath Select the VRC.BIN file to be maintenance by pressing the [...] button.

Start Start up the controller (VRC.BIN) and displays the Virtual Pendant in
maintenance mode.

End Closes the Virtual Pendant and shuts down the controller. 

Some operations in the Virtual Pendant may take a few moments.  Do not press the “End” 
button until the Virtual Pendant has completed its current operation.
Closing the “Virtual Pendant” in the middle of an operation may cause the lost of VRC.BIN 
data.

NOTE
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7.11 Displaying model / Editing Data of Safety Function

Display the model from Safety Function File. And the file can be edited.
Following function is available in MotoSim EG-VRC.

• Display the robot range limit data
• Edit the safety function data
• Display the tool interference model
• Display the robot approximate model

7.11.1 Displaying Robot Range Limit

Display the model from the Robot Range Limit.
On the [Controller] tab, in the [File Settings] group, click the [Safety Function] button, and 

• This function is available only when the controller is YRC1000/YRC1000micro/DX200 
and the parameter of safety function is available.
Simulation is possible only during jog operation in VPP or playback. It cannot be simu-
lated with other functions like positional panels or OLP function.

• Function safety in which a simulation is possible on MotoSim EG-VRC is as follows.
Robot Range Limit
Axis Range Limit
Speed Limit
Tool Angle Monitor

  Following function safety can not be simulated on MotoSim EG-VRC.
Axis Speed Monitor
Tool Change Monitor
Safety Signal

• YASKAWA does not warrant the result of this function. It should be used only as a guide. 
Because it is affected by load condition of real robot, lubricated condition of grease, and 
temperature. Whether or not an alarm occurs may be different from the actual robot.

• This function simulates when the job is executed. Therefore, the coasting in the interrup-
tion (ex. the emergency stop) is not included.

• When the edited files are loaded to YRC1000/YRC1000micro/DX200, it is necessary to 
put in "SAFETY MODE", and to disable "SAVE DATA CRC CHECK FUNC.(FSU)". After 
loading, please make sure to enable "SAVE DATA CRC CHECK FUNC.(FSU)".
And, please make sure to check the settings on DX200.

NOTE
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select [Safety Function File]. And. choose the [Robot Range Limit]tab.

       

Parameter 
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[Robot Range Limit]

Item Description

File No. Select the file number. When selecting the file number, the parame-
ter is displayed.
[Add Model]

The model of selected file number is displayed. Click the vertex list 
when the model is displayed, teacher model is moved to that posi-
tion.

[Delete Model]
The model of selected file number is cleared.

Parameter For those details or Editing them, please refer to "DX200 OPTIONS 
INSTRUCTIONS FOR FUNCTIONAL SAFETY BOARD OPERA-
TION".

Range Combination Range combination dialog appears, and combine the ranges.

Model Settings Set the contents of Inside model or Outside/Plane model.
[Color]

Displays the Color Dialog to change the color of model.
[Opacity]

Specifies the opacity of model. The value can be set between 1.00 
and 0.00, which corresponds respectively to fully opaque and 
completely transparent.

[Add All Model]
The models of all file number are displayed.

[Delete All Model]
The models of all file number are cleared.

Safety fence Utility Displays a support dialog for creating a safety fence.
This function cannot be used in the following cases.
･When the controller is other than DX200, YRC1000
･ When the "Monitor Target" selected other than "Inside"
･ For 7-axis robot
･ When the model is MHC0130-J0*
･ When the multiple tool numbers are used.

Delete Safety fence Delete the safety fence model created on the safety fence utility dia-
log.

Close Close the dialog.
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 Area Combination
Creates a new area by combining two already-specified areas.
Click the [Area Combination] button, the [Range Combination] dialog is displayed.
For details, please refer to "DX200 OPTIONS INSTRUCTIONS FOR FUNCTIONAL SAFETY 
BOARD OPERATION".

When combination is finished, the following dialog is displayed. Click the [OK] button, a new 
area is written to output file. Click the [Cancel] button, a new area is not written.

 

When the "Monitor Target" is selected "Plane", the boundary surface of the safe/non-safe 
area is displayed. This boundary surface is displayed as a plate model with a limited area 
on drawing, but it actually extends infinitely.

[Range Combination]

Item Description

Input File1 Select the input file1.

Logic Select "AND" or "OR".

Input File2 Select the input file2.

Output File Select the output file.

Combine Execute Combination.

Close Close the dialog.

SUPPLE
-MENT

230/847



7.11  Displaying model / Editing Data of Safety Function

HW0485348

When overwriting is finished, the following dialog is displayed. Click the [OK] button, a new 
area model is displayed. Click the [Cancel] button, a new area model is not displayed.

 Safety fence Utility
It is a function to support creation of robot range limit based on the trajectory of the job.
By creating a safety fence model which covers the trajectory of the job, the robot range limit is 
determined.

This function cannot be used in the following cases.
• When the controller is other than DX200, YRC1000.
• When the "Monitor Target" selected other than "Inside".
• For 7-axis robot.
• When the model is MHC0130-J0*.
• When using tool interference setting, create a tool interference model.
• When the model has linear axis.
• It is not supported the tool number switching function.
• YASKAWA does not warrant the result of safety fence utility function. It should 

be used only as a guide. Because it is affected by load condition of real robot, 
lubricated condition of grease, and temperature. Whether or not an alarm 
occurs may be different from the actual robot.

• Please make sure to check the settings on real controller when setting is 
applied to the real controller.

• When the multiple tool numbers are used.

NOTE
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Safety fence design utility

Item Description

Job list The job containing the control group selected in "Group" on the 
robot range limit tab is displayed in the list.

Sampling Interval Sets the interval to analyze the trajectory of the job.
The shorter the interval, the longer it will take to create a safety 
fence model.

Safety fence margin Sets the margin of the fence which covers the robot trajectory.

Color Sets the color of the safety fence model to be created.

Create safety fence Jobs selected in the job list are executed sequentially, and a fence 
which covers all the trajectories is created.
When creating a safety fence model, a safety fence margin is 
added.
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7.11.2 Editing the Safety Function Data

Edit the safety function file. Following files are available. To edit the files, it is necessary to put 
them into the robot folder. On the [Controller] tab, in the [File Settings] group, click the [Safety 
Function] button, and select [Safety Function File] the [Safety Function File Settings] dialog 
appears.

• Robot Range Limit
• Axis Range Limit
• Axis Speed Monitor
• Speed Limit
• Tool Angle Monitor
• Tool Change Monitor

Output file by safety 
area

The robot range limit is saved as a file in the setting contents of the 
safety fence displayed. When set, the safety fence model is dis-
played in yellow.

Close Closes the dialog.

If you have not set the tool interference settings, you will see the error "Model can not be 
created". This error is displayed when a tool interference model cannot be created. If the 
tool interference setting is set, the error is eliminated. Even if the tool interference setting is 
not set, if there is no problem in parts other than the tool, a safety fence area and an oper-
ation area are created.

Safety fence design utility

Item Description

    

Set 

NOTE
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 Robot Range Limit Data
Edit the Robot Range Limit Data. Choose the {Robot Range Limit} tab. For details, please 
refer to " 7.11.1  Displaying Robot Range Limit ".

 Axis Range Limit Data
Edit the Axis Range Limit Data. Choose the {Axis Range Limit} tab.

[Axis Range Limit]

Item Description

File No. Select the file number. When selecting the file number, the parame-
ter is displayed.

Parameter For those details or Editing them, please refer to "DX200 OPTIONS 
INSTRUCTIONS FOR FUNCTIONAL SAFETY BOARD OPERA-
TION".

Close Close the dialog.

Parameter 
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 Axis Speed Monitor Data
Edit the Axis Speed Monitor Data. Choose the {Axis Speed Monitor} tab.

[Axis Speed Monitor]

Item Description

File No. Select the file number. When selecting the file number, the parame-
ter is displayed.

Parameter For those details or Editing them, please refer to "DX200 OPTIONS 
INSTRUCTIONS FOR FUNCTIONAL SAFETY BOARD OPERA-
TION".

Close Close the dialog.

Parameter 
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 Speed Limit Data
Edit the Speed Limit Data. Choose the {Speed Limit} tab.

[Speed Limit]

Item Description

File No. Select the file number. When selecting the file number, the parame-
ter is displayed.
Select the Speed Limit in Teach Mode, the setting of it is available.

Parameter For those details or Editing them, please refer to "DX200 OPTIONS 
INSTRUCTIONS FOR FUNCTIONAL SAFETY BOARD OPERA-
TION".

Close Close the dialog.

Parameter 
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 Tool Angle Monitor Data
Edit the Tool Angle Monitor Data. Choose the {Tool Angle Monitor} tab.

[Tool Angle Monitor]

Item Description

File No. Select the file number. When selecting the file number, the parame-
ter is displayed.

Parameter For those details or Editing them, please refer to "DX200 OPTIONS 
INSTRUCTIONS FOR FUNCTIONAL SAFETY BOARD OPERA-
TION".

Close Close the dialog.

Parameter 
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 Tool Change Monitor Data
Edit the Tool Change Monitor Data. Choose the {Tool Change Monitor} tab.

[Tool Change Monitor]

Item Description

File No. Select the file number. When selecting the file number, the parame-
ter is displayed.

Parameter For those details or Editing them, please refer to "DX200 OPTIONS 
INSTRUCTIONS FOR FUNCTIONAL SAFETY BOARD OPERA-
TION".

Close Close the dialog.

Parameter 
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7.11.3 Displaying the Tool Interference Model

Display the tool interference model from the Tool Interference Data.
On the [Controller] tab, in the [File Settings] group, click the [Safety Function] button, and 
select [Tool Interference Model]  the [Tool Interference] dialog appears.

Item Description

File No. Select the file number. When selecting the file number, the parame-
ter is displayed.
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7.11.4 Displaying the Robot Approximate Model

Display the robot approximate model from robot parameter. 
On the [Controller] tab, in the [File Settings] group, click the [Safety Function] button, and 
select [Robot Approximate Model]  the [Robot Approximate] dialog appears.

Data No. Select the data number. 
[Points]

Specify the X, Y, and Z of two points.
[Radius]

Specify the radius of sphere and cylinder.
For those details or Editing them, please refer to "DX200 
OPTIONS INSTRUCTIONS FOR FUNCTIONAL SAFETY BOARD 
OPERATION".

Model Settings Display/Clear the tool interference model.
[Color]

Displays the Color Dialog to change the color of model.
[Opacity]

Specifies the opacity of model. The value can be set between 1.00 
and 0.00, which corresponds respectively to fully opaque and 
completely transparent.

[Add Model]
The model of the file number is displayed.

[Delete Model]
The model of the file number is cleared.

Close Close the dialog.

Item Description
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[Robot Approximate Model]

Item Description

Show Model Display the approximate model.
[Color]

Displays the Color Dialog to change the color of model.
[Opacity]

Specifies the opacity of model. The value can be set between 1.00 
and 0.00, which corresponds respectively to fully opaque and 
completely transparent.

Delete Model Clear the approximate model.

Close Close the dialog.

 

 

 
 

Selected controller 

Value of   

Robot Name 

When the parameter does not have approximate 
model, the model is not displayed.

NOTE
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7.12 Working Trace

 When the lines where drawing starting and where drawing end are inserted a job, the contin-
uous cylinder, line and seat is drawn on the TCP position of the robot at the time of a play-
back.

 
Working trace can be set with the "Working Trace Manager" dialog box. On the [Simulation] 
tab, in the [Monitor] group, click the [Working Trace] button.

 
To draw the working trace, it is necessary to execute the following two procedure.
1. Adds/Edits the setting of working trace
2. Inserts the lines where drawing starting and where drawing ending to the job

For details about above step1, refer to the section " 7.12.1  Working Trace Manager " and " 
7.12.2  Working Trace Property ". For details about above step2, refer to the section " 7.12.3  
Specify the Start Point and End Point ".
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7.12.1 Working Trace Manager

Multiple working traces can be set.
When a controller is registered to the cell a trace is automatically added for Tool Center Point 
(TCP) of each robot. The [Enable] setting is set to "Disable".

• This function can use virtual robot controller only.
• The working trace is not saved on the cell. When it needs that the working trace is saved, 

the working trace is saved by [Save WorkingTrace], and save the cell.
• When working trace has many points, the playback may become slowly.
• When the 3DPDF file is output, that working trace is that when playback is finished. Work-

ing trace is not moved on the animation of 3DPDF.
• When the type of working trace is "Line" and the 3DPDF file is output, the width of the line 

is not reflected. When the tick line is needed on 3DPDF file, the type is needed to set 
"Cylinder" or "Sheet".

• Drawing start and end by the ARCON/ARCOF instruction can be used only the following 
system version of controller.

• YRC1000: Since YAS1.01-00
• DX200: Since DN1.61-00
• DX100: DS3.93-00
• NX100: NS4.75-00

• NS4.69-A5 Controller is not supported.

Working Trace Manager

Working Trace list Displays the information of the defined traces.
    Display: Show/Hide the working trace
    Enable: Enable/Disable the working trace generation during 
                 playback
    Working Trace Name: Name of the working trace model
    Length: Approximate travel distance of the working trace
    Time: Time during working trace generation
The "Working Trace Property" of a trace can be displayed by dou-
ble-clicking on a working trace from the list.

[Edit] button Edits a trace with the "Working Trace Property" dialog.
For details refer to section " 7.12.2  Working Trace Property ".

NOTE
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7.12.2 Working Trace Property

The "Working Trace Property" dialog box is displayed by pressing the [Edit] or [Add] button of 
the "Working Trace Manager" dialog box.
It allows to set the trace properties such as the color, type, opacity, diameter, traced model, 
etc.

[Add] button Defines a new working trace with the "Working Trace Property" dia-
log.
For details refer to section " 7.12.2  Working Trace Property ".

[Delete] button Deletes the working trace definition currently selected in the working 
trace list.

[Clear WorkingTrace] 
button

Deletes all working traces.

[Save WorkingTrace] 
button

Save the working trace as a model file.

[Close] button Closes the "Working Trace Manager" dialog box.

The working trace is deleted automatically when the following operation is done.
• Start playback
• Click the [Reset] button
• Close the cell
• Click the [Clear WorkingTrace] button
• Add/Edit/Delete the setting of working trace

Working Trace Manager

The working trace is not saved on the cell. When it 
needs that the working trace is saved, the working 
trace is saved by [Save WorkingTrace], and save the 
cell. 

NOTE

NOTE
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Working Trace Property

[Enable] Indicates that the working trace will be generated during playback 
when checked.

[Name] Input the name of working trace. (Up to 8 one-byte characters) 
When adding the working manager, WT[serial number] is set auto-
matically.

[Robot] Selects the robot associated with the working trace.

[Parent] Displays the name of the model that is used as the parent of the 
working trace and as a coordinated system for the working trace.
The default model is the "world" model.
To change model, press the [...] button beside the "Parent" field to 
display the "Select Object" dialog box. Select a model and press 
[OK].

[Color] Displays the color of the working trace model.
To change the color, press the [...] button beside the "Color" field to 
display the "Color" dialog box. Select a color and press [OK].

[Opacity] Specifies the opacity of model. The value can be set between 1.00 
and 0.00, which corresponds respectively to fully opaque and com-
pletely transparent.

[Type] Specifies the type of working trace. (Cylinder, Line or Sheet).

[Diameter] Specifies the diameter of working trace.
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[Display Accuracy] Specifies the minimum distance to add the point to working trace.

[Step] Specifies the increment value of the spin control.

[Instruction of working] Sets whether to display the work trace when executing a work 
instruction such as ARCON.

[Start] Selecta the target instruction among the work instructions. Select-
able instructions are as follows.
    ARCON
    DOUT
    HAND
    SPYON
    TOOLON

[ALL] Regardless of condition number, all are displayed.

[other] Set the condition number to display the work trace.
(e.g.) ASF# 1
          OT# 3

[Width Direction] Specifies the direction of TCP as the width direction of sheet.
 
  (e.g. Width Direction is set to "X")

Working Trace Property

When display accuracy becomes smaller, the working 
trace becomes finer. When display accuracy becomes 
larger, the working trace becomes rougher.

NOTE

 

 

Sheet Width 

Working Trace (Sheet) 

X-axis of TCP 

This item is available only when type is "Sheet".NOTE
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[Draw back plane] If this is disable, the back plane of sheet is not drawn.

[Offset] Specifies the offset values of working trace point. These values are 
the value of the tool coordinates.

Working Trace Property

This item is available only when type is "Sheet".NOTE

247/847



7.12  Working Trace

HW0485348

7.12.3 Specify the Start Point and End Point

Inserts the lines where drawing starting and where drawing ending to the job.

To insert the lines, there are two methods as follows.
• ARCON/ARCOF instruction

When ARCON and ARCOF instructions are inserted in the job, working trace is created 
between ARCON and ARCOF.

Examples are given below.
Working trace is created between ARCON and ARCOF. Working trace property of R1 of 
this controller is reflected.

When the job is for multiple robots, working traces of all robots are created between 
ARCON and ARCOF.

When the job has many ARCON/ARCOF pairs as follows, working traces of each pair are 

 

Start 

End 
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created between ARCON and ARCOF.

• Comment instruction
When the following two comment instructions are inserted in the job, working trace is cre-
ated during two comment instructions.

'DRW?[Name]=ON?(Where drawing starts)
'DRW?[Name]=OFF (Where drawing ends)

Examples are given below.
Working trace is created during two comment instructions. Working trace property of 
"WT2" is reflected.

When the job has many comments pairs as follows, working traces of each pair are cre-

Drawing start and end by the ARCON/ARCOF instruction can be used only the following 
system version of controller.

• YRC1000: YAS1.01-00
• DX200: Since DN1.61-00
• DX100: DS3.93-00
• NX100: NS4.75-00

NOTE

 

Start 

End 
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ated between comments.

NS4.69-A5 Controller is not supported.NOTE
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7.13 Safety Logic Circuit Setting Support Function

Edit safety logic circuit files and simulate logic circuits. By switching the input signal, it is pos-
sible to check whether the designed logic circuit operates as intended.

 RESTRICTION
• The safety logic signal of this function is applied and affected only on the safety logic cir-

cuit screen. Signal information cannot be linked with other VRC functions.
• Signal information can be switched only for some input signals. 
• This function is used when the controller is YRC100. When the controller is DX200 or 

YRC1000micro, you can only edit the safety logic circuit file.
• The signal names which circuit information can be checked in MotoSim EG-VRC 

YRC1000 controller are as follows :

• The signal names which signal information can be checked in MotoSim EG-VRC 
YRC1000 controller are as follows :

Input Signals

PPESP PBESP EXESP PPDSW SAFF

ONEN
(only ONEN1)

GSIN GSOUT FSBIN FSBOUT

FS-OUT MS-OUT PLAY TEACH REMOTE

HOLD SPIN SFRON SVON SVONRDY0

RBSY RBSM RBSX SFBIN SFBOUT 

PROFISafe R S-EXDSW S-EXESP S-FST

S-SAFF S-ONEN
(only S-ONEN1)

S-SVON_EN S-GSEDM S-XEDM

CSCFG01 CSCFG02 CSCFG03 CSCFG04 SICFGTRG

Output Signals

GSOUT FSBOUT MS-OUT RBSX SFBOUT

SVOFF CAT0 SVOFF CAT1 R S-EXDSW S-EXESP

S-FST S-SAFF S-ONEN
(only S-ONEN1)

S-SVON_EN SICFGTRG

Input Signals

PPESP PBESP EXESP PPDSW SAFF

ONEN GSIN GSOUT FSBIN FSBOUT

FS-OUT  MS-OUT PLAY TEACH REMOTE
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• The signal names which input signal information can be switched in MotoSim EG-VRC 
YRC1000 controller are as follows :

7.13.1 Editing the Safety Logic Circuit Data

Edit and check safety logic circuit files on Virtual Programming Pendant. 
Select and display from the main menu {Safety Func.}-{Safety Logic Circuit}.
The signal information for each signal is calculated by the logic circuit. 
Please refer to "INSTRUCTIONS for each controller" for how to edit the safety logic circuit file.

HOLD SPIN SFRON SVON SVONRDY0

RBSY RBSM RBSX SFBIN SFBOUT

PROFISafe R S-EXDSW S-EXESP S-FST

S-SAFF S-ONEN S-SVON_EN S-GSEDM S-XEDM

Output Signals

GSOUT FSBOUT MS-OUT RBSX SFBOUT

SVOFF CAT0 SVOFF CAT1 R S-EXDSW S-EXESP

S-FST  S-SAFF S-ONEN S-SVON_EN

Input Signals

PPESP PBESP EXESP PPDSW SAFF

ONEN GSIN FSBIN FS-OUT PLAY

TEACH REMOTE HOLD SPIN SFRON

SVON SVONRDY0 RBSY RBSM SFBIN

PROFISafe

Input Signals
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7.13.2 Changing the Input Signal

By switching the input signal, it is possible to check whether the designed logic circuit oper-
ates as intended.
On the [Controller] tab, in the [File Settings] group, click the [Safety Function] button, and 
select [Safety Logic Circuit], then the [Safety Logic Function] dialog is displayed.
The circuit information written in safety logic circuit file and the signal information are dis-
played for each controller. When you click the area of signal information, ON/OFF switched for 
some signals. At this time, the virtual pendant display also changes, and you can check 
whether the designed logic circuit operates as intended.

[Safety Logic Circuit:Controller Name]

Item Description

User/System You can select User mode or System mode.

Leftmost column Same number with safety logic circuit on virtual programming pen-
dant.

INPUT1
Same with INPUT1 on virtual programming pendant. When signal 
information can be acquired, ON or OFF is displayed in the right 
adjacent column.

INPUT2
Same with INPUT2 on virtual programming pendant. When signal 
information can be acquired, ON or OFF is displayed in the right 
adjacent column.

• Signal information is not updated in real time. If the virtual programming pendant display 
differs from the [Safety Logic Circuit] display, update the user or system.

• "" on the virtual pendant shows the result based on the logic calculation such as 
"NOT", so it may be reversed with ON / OFF of [Safety logic circuit].

• When the input signal SVONRDY0 is set, that is, when SVONRDY0 is ON at [Safety 
Logic Circuit], the virtual pendant displays it "". (When the bit is OFF, it is "● ")

NOTE
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8 Tool Functions

MotoSim EG-VRC has tools to operate and teach a robot, including functions to display the 
current position and pulses of the robot; it also has functions that simplifies teaching opera-
tions such as OLP (on-screen teaching function to teach target point) and interference check 
function.
This chapter explains each function and its application.

8.1 Position Panel

The Position panel displays position data of a robot, and enables robot operation by entering 
numerical values in pulses or coordinate units.
On the [Home] tab, in the [Teachingl] group, click the [Position Panel] button, the [Position 
Panel] dialog appears.

.

If the cell contains multiple controllers and the "Multiple Controller Dialog" mode is enable, 
a separate Position panel can be displayed for each robot in the cell.  Select the robot to 
be displayed in the robot combobox of the toolbar before displaying the Position panel.

NOTE
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Position Data Panel

Item Description

[Frame] combobox
The coordinate system reference frame can be selected with the 
"Frame" combobox.  The choice of frame available in the list may 
change depending on the robot configuration.  

[Fix TCP] checkbox
When checked, the [Fix TCP] function is enabled.  The robot TCP 
position remains fixed relative to another model in the cell.  Refer to 
section " 8.1.2  Fix TCP " for details.

[Set Fix TCP...] button Displays the "Select Model" dialog to change the model reference 
used by the Fix TCP function.

[Configuration] button
Displays the robot "Configuration" dialog to select a different robot 
configuration to reach the current position.  (Refer to section " 8.1.3  
Robot Position Configuration " for details)

[Move Slave] checkbox

When checked, the [Move Slave] function is enabled.  When a robot 
or station is moved, other slave robots from the same controller are 
moved with it so that their TCP maintain the same relative position to 
the moved robot or station. 
By default all robots are set as slave.  The individually setting of each 
robot can be changed by pressing the [...] button to display the “Set 
Slave Robot” dialog.
Note that when the function is enable, if one of the robot cannot reach 
the proper position, all the robots are prevented from moving.

 

 
Controller Name  

Selected Robot  

Values units  

Coordinate system 
reference frame  

Specify each axes 
value  

Set the step value 
for the spin buttons  

Change the value 
with these buttons  

Sets the selected robot 
to all 0 pulse and return 
to the home position.
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Keyboard entry
The value of an axis can be entered directly with the numeric keys.  Select the desired axis 
edit box, enter the new value, and then press the [Enter] key to update the robot position or 
the [Tab] key to move to the next axis.

 Pulse
Displays the pulse values of the S, L, U, R, B, T axis of the robot.

 Joint
Displays the angular values of the S, L, U, R, B, T axis in angular units (degrees or radians).

 Robot
Displays the position (X, Y, Z, Rx, Ry, Rz) of the robot current Tool frame (TCP) relative to the 
Robot frame.

[Home Position] button

Sets the selected robot to all 0 pulse and return to the home position.

The Fix TCP section is not available when the Frame is set to "Work Angle". 

Position Data Panel

Item Description

• When "Fix TCP" is enabled, the robot does not return 
to 0 pulse even if this button is pressed.

•  Even if the "Move Slave" is enabled, only the 
selected robot returns to 0 pulse.

NOTE

NOTE
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 Base
Displays the position (X, Y, Z, Rx, Ry, Rz) of the robot current Tool frame (TCP) relative to the 
Base frame.  If the robot doesn't have any base axis, the Base frame and Robot frame over-
laps each other.

 Tool
This frame is useful to move the robot in the Tool coordinate system (X, Y, Z, Rx, Ry, Rz) but 
the displayed values are always "0" even though the robot moves since the reference system 
and the Tool coordinate frame are the same. 

 User
Displays the position (X, Y, Z, Rx, Ry, Rz) of the robot current Tool frame (TCP) relative to the 
selected user frame.  When selected, a 2nd combobox will appear next to the "Frame" combo-
box to allow the selection of the user frame number.  Only the defined user frame will appear 
in the list.  At least one user frame need to be define in order to select the User Frame refer-
ence system. 
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 Work
Displays the position (X, Y, Z, W, T, C) of the robot current Tool frame (TCP) relative to the set 
Work frame.  When this coordinate system is selected, the "Set Frame..." button and the 
"Reverse Work Side" checkbox will appear under the axis values.

The Work frame is defined by three components: the frame position (or origin), the travel 
direction, and the work surface.  The normal of the work surface is set as the Z-axis (red 
arrow) and the tool travel direction is set as the X-axis (blue arrow). The Y-axis (green arrow) 
will be set perpendicular to the other two axes.  

The Work angle (W) is defined by the angle between the tool and the work surface in the YZ 
plane.  Changing the value of "W" will rotate the tool around the Work frame X-axis.  The "W" 
angle is define between -90.0 and 90.0 degrees.  The Reverse Work Side checkbox indicates 
if the Work Angle is on the same side then the Y-axis (unchecked) or on the opposite side 
(checked).  If a work angle is moved over the 90.0 degree limit, the work angle side will 
change and the work angle will be set back within its allowable limit.

  

Work Frame 
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The Travel angle (T), also called the Push/Pull angle, is defined as the angle between the 
torch and the YZ plane.  When set to 0 degree, the tool is in perpendicular to the travel direc-
tion.  If "T" is positive, the tool is pushing; and if it is negative, the tool is pulling.  The "C" angle 
is the rotation angle around the Tool Z axis.
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8.1.1 Work Frame Setting

The Work frame can be set manually or automatically.  Press the "Set Frame..." button to dis-
play the Work Frame Set dialog and set your preferences.

Set Work Frame

Item Description

"Auto Search" section Determine which components of the Work frame are to be auto-
matically updated as the robot moves.  Settings during teaching 
[Teach] and during playback [Play] are independently set.

[Screen Pick Active] check box Enables the mouse picking operation.Pressing the [Shift] key 
enables or disables the "Screen Pick Active" mode.

[Close] button Closes the dialog box.

[More] or [Less] button Displays or hides the pick mode setting section.

"Set Value For:" section Determine which values of the Work Frame will be changed 
when the screen is clicked.

"Use Face:" section Determines which information for a click surface is used to set 
the Travel Direction or the Work Surface.

[Normal] radio button:
The normal of the face is used.

[Edge] radio button:
The edge direction closes to the picked point is used.  
Note if both the X-axis and the Z-axis are checked, the Z-
axis is set in the Edge direction.

[Point] radio button:
The direction defined by the Work frame origin and the 
picked face point is used.

The [Reverse Direction] checkbox can be used to select the 
opposite direction.
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Auto Search
MotoSimEG can automatically set the Work frame by searching from the work surface.  The 
tool Z-axis positive direction is searched to find the first intersecting face.  The found face 
intersection point and normal can be used to calculate the frame position and Z-axis.  The 
travel direction (or Work frame X-axis) can automatically be determined by using the robot 
previous position and new position.

Each component of the Work frame can be set to automatically updated as the robot moves or 
not.  The settings are independently set for "Teach" and "Play" mode.  By default the "Auto 
Search" is active (checked) for all the components except for the "Travel Direction" in "Teach" 
which tends make jogging operation of the robot difficult because the Work frame changes 
after each position change.

Manually setting the Work Frame
The Work frame components can be set manually by clicking on the screen.  To control the 
pick result, press the "More" button to display the Pick Setting section of the dialog.  Select the 
value to be set and click on the screen to change those values to those of the clicked geome-
try.

Note that the "Auto Search" - "Teach" check boxes and the "Pick" - "Set Value for" check 
boxes are exclusive of one another.  By default, only the "Travel Direction" is checked to be 
manually set by using the face point information ("Use Face: point").  Therefore, clicking on 
the screen will cause travel direction (X-axis) to turn in the work surface plane to point toward 
the clicked point.

"Pick Object" section Sets the type of objects that can be selected when clicking on 
the screen.  Please refer to " 6.4  Pick Settings ".

"Pick Mode" section Sets conditions determining the selected point in the clicked 
area.  Please refer to " 6.4  Pick Settings ".

• The Work surface search and calculation can become fairly intensive in cells with large 
models made of thousand of faces and will slow down the playback animation.  For 
such cases, it may necessary to turn off (uncheck) the Work Surface auto search and 
manually set the Z-direction. 

• When the tool is close to an edge formed by multiple faces, the face with the normal 
pointing upward will be selected over the other ones. 

• If no surface can be found, the position is set as the tool position and the previously 
found normal (Z-axis) is reused.

Set Work Frame

Item Description

NOTE
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8.1.2 Fix TCP

The Fix TCP function allows fixing (or attaching) the robot TCP position relative to another 
model in the cell.  If the robot base or the attached model is moved, the robot changes posi-
tion so that it TCP remains in the same position relative to the specified model.

The Fix TCP function is enabled by the robot Position panel.  Check the "Fix TCP" check box 
to enable the function.  The default model to which the TCP is attached is the world.  To 
change the model, press the "Set Fix TCP..." button to display the "Select Model" dialog.  

This function is useful to determine the layout of a cell.  For example the robot TCP can be 
attached to a work piece.  As the robot base or work piece are moved around during the lay-
out procedure, the robot automatically adjust itself to keep its TCP in the same position on the 
work piece.  It then becomes obvious if the work piece become out of reach, because robot 
will no longer maintain its position on the work piece.

• The function is automatically disabled if the Position panel is closed or if a job is played 
back.

• The Fix TCP section is not available when the Frame is set to "Work Angle".
• The Fix TCP section is not available when move the robot external axis.

 

NOTE
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8.1.3 Robot Position Configuration

The robot position "Configuration" dialog displays a list of different ways the robot can reach 
its current position.  To display the "Configuration" dialog, select {Tool} - {Teaching} - {Robot 
Configuration} or from the robot "Position" panel click the "Configuration" button.

A robot can often reach the same position in different ways.  The robot resulting pulse position 
will be different but the tool will be at same position (XYZ position).  The robot configuration is 
used to differentiate between those possibilities.

The configuration is define by six parameters:

Configuration Dialog Box

Item Description

Configuration List Displays the list of all available robot configurations in which the 
robot can reach the current position. Changing the selected configu-
ration will move the robot into the specified configuration. The aster-
isk next to the index number indicates the initial configuration of the 
robot.

[OK] button Closes the Configuration dialog and changes the robot configuration 
to the select one.

[Cancel] button Closes the Configuration dialog and returns the robot to its initial 
configuration.

FRONT or REAR Specifies if the B-axis rotation center is in the FRONT or the 
REAR of the S-axis rotation center.

UP or DOWN Specifies if the elbow of the robot (angle between the lower 
and upper arm) is UP or DOWN.
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Example:

FLIP or NO FLIP YRC1000, YRC1000micro, DX200, DX100, FS100
            : B-axis position

Specifies if the angle of the B-axis is to be positive or 
negative.

FLIP: B-axis angle is greater or equal to 0°
NO FLIP: B-axis angle is small than 0°

NX100 : R-axis position
Specifies if the R axis is FLIP or NOFLIP.  FLIP posi-
tion indicates an angle from -90° to 90°, 270° to 360°, 
or -360° to -270°. 

S<180 or S>=180 Specifies if the S-axis absolute angle is smaller then 180° 
(within one turn) or greater (over one turn).

R<180 or R>=180 Specifies if the R-axis absolute angle is smaller then 180° 
(within one turn range) or greater (over one turn range).

T<180 or T>=180 Specifies if the S-axis absolute angle is smaller then 180° 
(within one turn range) or greater (over one turn range).

FRONT,UP,FLIP,S<180,R<180,T<180 REAR,DOWN,FLIP,S<180,R<180,T>=180
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8.2 I/O Monitor

The I/O Monitor allows the simulation of input and output signals. It displays the current I/O 
states of the controller. The users can change input signals before or during playback of the 
job. Output signals can be changed by the execution of I/O instructions during job playback or 
by the virtual pendant.
On the [Simulation] tab, in the [Monitor] group, click the [I/O Monitor] button, and select [I/O 
Monitor(IN)] button, input signal monitor appears, and click the [I/O Monitor]  button, and 
select [I/O Monitor(OUT)] button, output signal monitor appears.
The [Operation Panel] button is valid only for MOTOFEEDER cells. For details, refer to sec-
tion " 13.13  Setting of Paint workpiece supplying system "MOTOFEEDER"(NX100) ".  

8.2.1 Simple Mode

In the simple mode, you can monitor the I/O status of each group in units of 10.

 
 

     
(External Input)          (External Output） 

When the user double-clicks the relay number, it switches to 
the display in the detail mode corresponding to that number. 

As with the virtual pendant, the I / O status of 
each bit is displayed in order from the 8th bit. 

265/847



8.2  I/O Monitor

HW0485348

Relay number search Enter a 5 digit number and display the page containing the corre-
sponding I / O number.
If you enter a number less than 5 digits, the following message will 
be displayed.

Also, if you enter a value out of range, the following message will be 
displayed. 
(example : #25128, #80080)

Next page button Increase I/O group number by 10.

Previous page button Decrease I/O group number by 10.

(IN)
Set All-In button

Set the I/O general input area to the forced ON state.
(General input area : IN#0001?)

(OUT)
Set All-Out button

Set the I/O output area to the forced ON state.

Detail mode button Display the first group number of simple mode in detail mode.
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8.2.2 Detail Mode

In the detail mode, you can check the I/O ON / OFF status in bit units of individual groups.

Relay number search Enter a 5 digit number and display the page containing the corre-
sponding I / O number.
If you enter a number less than 5 digits, the following message will 
be displayed.

Also, if you enter a value out of range, the following message will be 
displayed. 
(example : #25128, #80080)

Next page button Move to the next group number.

Previous page button Move to the previous group number.

 

 

     

(External input)       (External output) 

External input can be switched 
ON / OFF by left mouse click. 

If external input / external output 
name is set with virtual pendant, it is 
displayed in this column. 
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(IN)
Set All-In button

Set the I/O general input area to the forced ON state.
 (General input area : IN#0001-)

(OUT)
Set All-Out button

Set the I/O output area to the forced ON state.

Simple mode button The display returns to the simple mode display including the group 
number displayed at that time.

IN The ON / OFF status from external input number from #20010 to the 
upper limit value for each controller is displayed.
Users can also switch the ON / OFF state with the left click of the 
mouse.?
  ● (Green) : ON
  ● (Black) : OFF

OUT The ON / OFF status from external output number from #30010 to 
the upper limit value for each controller is displayed.
However, users cannot switch ON / OFF state.
  ● (Green) : ON
  ● (Black) : OFF
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8.2.3 Inputs and Outputs

 YRC1000, YRC1000micro, DX200, DX100, NX100
YRC1000

Classification of I/O signals

Logic Name Classification Description Range

0xxxx General Input Reference with input instruction of 
the job.

00010 - 05127
(4096 signals)

1xxxx General Output Reference with input instruction of 
the job.

10010 - 15127
(4096 signals)

2xxxx External Input Signal No. corresponding to the 
input terminal.

20010 - 25127
(4096 signals)

3xxxx External Output Signal No. corresponding to the 
output terminal.

30010 -35127
(4096 signals)

4xxxx Specific Input Signal to change the operating 
condition of the robot.

40010 - 42567
(2048 signals)

5xxxx Specific Output Signal notifying the operating con-
dition of the robot.

50010 - 55127
(4096 signals)

6xxxx Interface Panel 
Input

Signal notifying the operating con-
dition of the interface panel.

60010 - 60647
(512 signals)

7xxxx Auxiliary Relay Auxiliary relay in the concurrent I/O 70010 - 79997
(7992 signals)

80xxx
    -
85xxx

Control Status Monitoring of the hardware signal 
status of the robot control section.

80010 - 85127
(4096 signals)

87xxx Pseudo Input Pseudo input relay reading from 
the system parameter.

87010 - 87207
(160 signals)

27xxx
    -
29xxx

Network Input Input signal from thenetwork 
device.

27010 - 29567
(2048 signals)

37xxx
    -
39xxx

Network Output Output signal to the network 
device.

37010 - 39567
(2048 signals)

Mxxxx Register 1 word data (16 bits)
General Register

M000 - M559
Analog output register

M560 - M599
Analog input register

M600 - M639
System Register

M650 - M999

M00 - M999
(1000 signals)
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YRC1000micro

Classification of I/O signals

Logic Name Classification Description Range

0xxxx General Input Reference with input instruction of 
the job.

00010 - 05127
(4096 signals)

1xxxx General Output Reference with input instruction of 
the job.

10010 - 15127
(4096 signals)

2xxxx External Input Signal No. corresponding to the 
input terminal.

20010 - 21287
(1024 signals)

3xxxx External Output Signal No. corresponding to the 
output terminal.

30010 -31287
(1024 signals)

4xxxx Specific Input Signal to change the operating 
condition of the robot.

40010 - 42567
(2048 signals)

5xxxx Specific Output Signal notifying the operating con-
dition of the robot.

50010 - 55127
(4096 signals)

6xxxx Interface Panel 
Input

Signal notifying the operating con-
dition of the interface panel.

60010 - 60647
(512 signals)

7xxxx Auxiliary Relay Auxiliary relay in the concurrent I/O 70010 - 79997
(7992 signals)

80xxx
    -
85xxx

Control Status Monitoring of the hardware signal 
status of the robot control section.

80010 - 85127
(4096 signals)

87xxx Pseudo Input Pseudo input relay reading from 
the system parameter.

87010 - 87207
(160 signals)

27xxx
    -
29xxx

Network Input Input signal from thenetwork 
device.

27010 - 29567
(2048 signals)

37xxx
    -
39xxx

Network Output Output signal to the network 
device.

37010 - 39567
(2048 signals)

Mxxxx Register 1 word data (16 bits)
General Register

M000 - M559
Analog output register

M560 - M599
Analog input register

M600 - M639
System Register

M650 - M999

M00 - M999
(1000 signals)
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DX200

Classification of I/O signals

Logic Name Classification Description Range

0xxxx General Input Reference with input instruction of 
the job.

00010 - 05127
(4096 signals)

1xxxx General Output Reference with input instruction of 
the job.

10010 - 15127
(4096 signals)

2xxxx External Input Signal No. corresponding to the 
input terminal.

20010 - 25127
(4096 signals)

3xxxx External Output Signal No. corresponding to the 
output terminal.

30010 -35127
(4096 signals)

4xxxx Specific Input Signal to change the operating 
condition of the robot.

40010 - 41607
(1280 signals)

5xxxx Specific Output Signal notifying the operating con-
dition of the robot.

50010 - 53007
(2400 signals)

6xxxx Interface Panel 
Input

Signal notifying the operating con-
dition of the interface panel.

60010 - 60647
(512 signals)

7xxxx Auxiliary Relay Auxiliary relay in the concurrent I/O 70010 - 79997
(7992 signals)

80xxxx Control Status Monitoring of the hardware signal 
status of the robot control section.

80010 - 80647
(512 signals)

82xxxx Pseudo Input Pseudo input relay reading from 
the system parameter.

82010 - 82207
(160 signals)

27xxxx Network Input Input signal from thenetwork 
device.

27010 - 29567
(2048 signals)

37xxxx Network Output Output signal to the network 
device.

37010 - 39567
(2048 signals)

Mxxxx Register 1 word data (16 bits)
General Register

M000 - M559
Analog output register

M560 - M599
Analog input register

M600 - M639
System Register

M650 - M999

M00 - M999
(1000 signals)
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DX100

Classification of I/O signals

Logic Name Classification Description Range

0xxxx General Input Reference with input instruction of 
the job.

00010 - 02567
(2048 signals)

1xxxx General Output Reference with input instruction of 
the job.

10010 - 12567
(2048 signals)

2xxxx External Input Signal No. corresponding to the 
input terminal.

20010 - 22567
(2048 signals)

3xxxx External Output Signal No. corresponding to the 
output terminal.

30010 -32567
(2048 signals)

4xxxx Specific Input Signal to change the operating 
condition of the robot.

40010 - 41607
(1280 signals)

5xxxx Specific Output Signal notifying the operating con-
dition of the robot.

50010 - 52007
(1600 signals)

6xxxx Interface Panel 
Input

Signal notifying the operating con-
dition of the interface panel.

60010 - 60647
(512 signals)

7xxxx Auxiliary Relay Auxiliary relay in the concurrent I/O 70010 - 79997
(7992 signals)

80xxxx Control Status Monitoring of the hardware signal 
status of the robot control section.

80010 - 80647
(512 signals)

82xxxx Pseudo Input Pseudo input relay reading from 
the system parameter.

82010 - 82207
(160 signals)

25xxxx Network Input Input signal from thenetwork 
device.

25010 - 27567
(2048 signals)

35xxxx Network Output Output signal to the network 
device.

35010 - 37567
(2048 signals)

Mxxxx Register 1 word data (16 bits)
General Register

M000 - M559
Analog output register

M560 - M599
Analog input register

M600 - M639
System Register

M650 - M999

M00 - M999
(1000 signals)
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FS100

Classification of I/O signals

Logic Name Classification Description Range

0xxxx General Input Reference with input instruction of 
the job.

00010 - 01287
(1024 signals)

1xxxx General Output Reference with input instruction of 
the job.

10010 - 11287
(1024 signals)

2xxxx External Input Signal No. corresponding to the 
input terminal.

20010 - 21287
(1024 signals)

3xxxx External Output Signal No. corresponding to the 
output terminal.

30010 -31287
(1024 signals)

4xxxx Specific Input Signal to change the operating 
condition of the robot.

40010 - 41607
(1280 signals)

5xxxx Specific Output Signal notifying the operating con-
dition of the robot.

50010 - 52007
(1600 signals)

6xxxx Interface Panel 
Input

Signal notifying the operating con-
dition of the interface panel.

60010 - 60647
(512 signals)

7xxxx Auxiliary Relay Auxiliary relay in the concurrent I/O 70010 - 79997
(7992 signals)

80xxxx Control Status Monitoring of the hardware signal 
status of the robot control section.

80010 - 80647
(512 signals)

82xxxx Pseudo Input Pseudo input relay reading from 
the system parameter.

82010 - 82207
(160 signals)

25xxxx Network Input Input signal from thenetwork 
device.

25010 - 26287
(1024 signals)

35xxxx Network Output Output signal to the network 
device.

35010 - 36287
(1024 signals)

Mxxxx Register 1 word data (16 bits)
General Register

M000 - M559
Analog output register

M560 - M599
Analog input register

M600 - M639
System Register

M650 - M999

M00 - M999
(1000 signals)
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NX100

Classification of I/O signals

An External Input signal (#20010 - #25127(YRC1000, DX200), #22567(DX100), 
#21287(YRC1000micro, FS100, NX100)) or External Output signal (#30010 - 
#35127(YRC1000, DX200), #32567(DX100), #31287(YRC1000micro, FS100, NX100)) can 
be operated in the I/O monitor dialog..

The dedicated I/O assignment depends on the controller selected application, the first 16 I/O 
points are normally configured has dedicated I/O. The remaining I/O points are assigned to 
the General I/O.

Logic Name Classification Description Range

0xxxx General Input Reference with input instruction of 
the job.

00010 - 01287
(1024 signals)

1xxxx General Output Reference with input instruction of 
the job.

10010 - 11287
(1024 signals)

2xxxx External Input Signal No. corresponding to the 
input terminal.

20010 - 21287
(1024 signals)

3xxxx External Output Signal No. corresponding to the 
output terminal.

30010 -31287
(1024 signals)

4xxxx Specific Input Signal to change the operating 
condition of the robot.

40010 - 40807
(640 signals)

5xxxx Specific Output Signal notifying the operating con-
dition of the robot.

50010 - 51007
(800 signals)

6xxxx Interface Panel 
Input

Signal notifying the operating con-
dition of the interface panel.

60010 - 60647
(512 signals)

7xxxx Auxiliary Relay Auxiliary relay in the concurrent I/O 70010 - 79997
(79921 signals)

80xxxx Control Status Monitoring of the hardware signal 
status of the robot control section.

80010 - 80647
(512 signals)

82xxxx Pseudo Input Pseudo input relay reading from 
the system parameter.

82010 - 82127
(96 signals)

22xxxx Network Input Input signal from thenetwork 
device.

22010 - 23287
(1024 signals)

32xxxx Network Output Output signal to the network 
device.

32010 - 33287
(1024 signals)

Mxxxx Register 1 word data (16 bits) M00 - M499
(500 signals)
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Input Output

20010 - 20017: Dedicated Input
20020 - 20027: Dedicated Input

30010 - 30017: Dedicated Output
30020 - 30027: Dedicated Output

20030 - 20037 : General I/O (IN#001-008)
20040 - 20047 : General I/O (IN#009-016)
20050 - 20057 : General I/O (IN#017-024)
        :
        :
        :

30030 - 30037 : General I/O (OUT#001-008)
30040 - 30047 : General I/O (OUT#009-016)
30050 - 30057 : General I/O (OUT#017-024)
        :
        :
        :
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8.3  I/O Events

An I/O Event allows to monitor a specific I/O state during playback.  When the I/O state 
changes to a set condition, it triggers an event, which executes a model script. 
 For example, in a handling application, if the output #1 is used to open and close the gripper,  
an event can be linked to this I/O signal in MotoSim EG-VRC to execute a model script to 
change the gripper appearance to an open or close state.
On the [Simulator] tab, in the [I/O Setting] group, click the [I/O Events Maneger] button, the [I/
O Events] dialog appears.

8.3.1 I/O Event Manager
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I/O Events Dialog Box

Item Description

I/O Event list

List of all the I/O Events registered in the cell.
• Controller: Name of the controller.

The checkbox on the left of the controller name, 
indicates if the I/O Event is enables or not.  The 
enable state can be changed by clicking on the 
checkbox.

• I/O Signal: Displays the I/O number or I/O name of the I/O 
signal being monitors.  
Displayed information is changed by checking or 
unchecking the “Display I/O Signal Name” 
checkbox.

• Condition: The event will execute when the I/O signal 
changes to this condition (ON or OFF).

• Event: Description of the event that will be executed 
when the I/O signal changes to the set condition.

Double-clicking on an I/O Events will display its I/O Event Property 
dialog for edition.  

[Display I/O Signal Name] 
checkbox

When checked the I/O Signal column in the list displays the I/O 
name instead of the I/O number.

[Add] button Displays the “I/O Event Property” dialog to create a new I/O event. 

[Edit] button Displays the “I/O Event Property” dialog of the currently selected 
I/O Event for edition.

[Delete] button Deletes the currently selected I/O Event.

[Enable All] button Enables all of the I/O Events

[Disable All]button Disables all of the I/O events.

[Script Editor]button Displays the “Model Script Editor” dialog to add or edit the model 
scripts.  (For details, refer to " 11.12  Model Script ")

[Close]button Closes the I/O Events dialog.
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 Adding the comment for each external I/O points
The comment for each external I/O points can be added in the VRCNXMAIN.INI file under the 
[IO_ALLOC] section.

The information is entered in the following format:
    LG<External I/O No.>=Comment
For example:
File:VRCNXMAIN.INI
        [IO_ALLOC]
        LG20030=IN0001
        LG20031=IN0002
        LG20032=IN0003
                :
                :
                :

8.3.2 I/O Event Property

The “I/O Event Property” dialog box is displayed by pressing the [Edit] or [Add] button of the 
“I/O Events” dialog box.
It allows setting the I/O Event properties such as the I/O signal, condition and event.

“I/O Event Property” Dialog Box

Item Description

[Enable] Indicates that the I/O Event will be monitored during playback when 
checked.

[Controller] Selects the controller associated with the I/O Event.
This field cannot be modified when editing an existing I/O Event.
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[I/O Signal] Selects the controller I/O signal that will be monitored during playback.
The combobox list contains both the I/O number and I/O name, but 
only one of the information will display in the box.
Displayed information is changed by checking or unchecking the “Dis-
play I/O Name” checkbox.

The combobox list only contains the I/O signals available on the 
selected controller.  Changing controller selection changes the list 
content. 

[Condition] Selects if the event will execute when the I/O signal changes to the 
ON or OFF condition.

[Event] Enter or select the script name to be executed when the I/O signal 
changes to the set condition.

[OK] button If in [Add] mode: adds a new I/O Event definition. 
If in [Edit] mode: updates the selected I/O Event definition.
Closes the “I/O Event Property” dialog box.

[Cancel] button Closes the “I/O Event Property” dialog box.

The I/O names displayed for the I/O signals correspond to those defined in the 
VRCNXMAIN.INI file (For detail, refer to section " Adding the comment for each external I/
O points ")

Item Description

NOTE
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8.4 I/O connection

The I/O connect allows to exchange I/O signals between robot controllers.
It is possible to interlock the motion of robot to set this function.
On the [Simulator] tab, in the [I/O Setting] group, click the [I/O Connection Maneger] button, 
the [I/O Connections] dialog appears.

8.4.1 Management of I/O connection

I/O Connection

Item Description

Controller
The robot controller can be selected.
When selected the "ALL Controller", all setting can be displayed in 
current cell.

 

 

Select a controller. 

I/O connection list. 
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I/O connection list

List of all the I/O connections registered in the cell.
• Controller: Name of the controller.

The checkbox on the left of the controller name, 
indicates if the I/O Event is enables or not.  
The enable state can be changed by clicking on 
the checkbox.

• I/O Name: Displays the I/O number or I/O name of the I/O 
signal being input. 
Displayed information is changed by checking or 
unchecking the “Display I/O Signal Name” 
checkbox.

• Connection: The value of connection will be output to I/O 
name signal.  

Double-clicking on an I/O Connections will display its I/O Connec-
tion Property dialog for edition.

[Display I/O Signal Name] 
checkbox

When checked the I/O Name column in the list displays the I/O 
name instead of the I/O number.

[Add] button Displays the I/O Connection Setting dialog to create a new I/O 
Connection. 

[Edit] button Displays the I/O Connection Setting dialog of the currently selected 
I/O Connection for edition.

[Delete] button Deletes the currently selected I/O Connection.

[Enable All] button Enables all of the I/O Connection.

[Disable All]button Disables all of the I/O Connection.

[Close]button Closes the I/O Connection dialog.

The I/O names displayed for the I/O signals correspond to those defined in the 
VRCNXMAIN.INI file (For detail, refer to section " Adding the comment for each external I/
O points ")

I/O Connection

Item Description

NOTE
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8.4.2 I/O Connection setting

The I/O Connect setting dialog box is displayed by pressing the [Edit] or [Add] button of the 
I/O Connection dialog box. It allows setting the I/O Connection properties such as the I/O 
Name and connection.

I/O Connection setting

Controller The robot controller can be selected to edit the I/O connection.

Input

Select the controller I/O name that will be connected.
Displayed information is changed by checking or un-checking the 
[Display I/O Name check] box.
The combo-box list only contains the I/O Names available on the 
selected controller.  Changing controller selection changes the list 
content.

Delay Timer The time can be set to delay to substitute connection for input. 
(Unit of time is second)

[Display I/O Signal Name] 
checkbox

When checked the I/O Name column in the list displays the I/O 
name instead of the I/O number

Connection

Displayed contents of connection by selecting the Input.
• [Oper.]: “+”,”*”, “ “  can be selected.
• [ (! ]: “!”, “(“, “!(“, “(!“, “ “ can be selected.
• [Controller]: The robot controller can be selected that will 

have the   output signals.
• [I/O Signal]: Displayed I/O signals as output by un-checking 

the [Display I/O Signal Name] checkbox.
• [I/O Name]: Displayed I/O names as output.
• [ ) ]: “)“, “ “ can be selected. Should be set to be equal 

to the number of pre brackets.

[OK] button
If in [Add] mode: adds a new I/O Connection definition. 
If in [Edit] mode : updates the selected I/O Connection definition. 
Closes the I/O Connection Property dialog.

 

 

Displayed contents of connection. 
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Procedure
1. When pushed [Add] button, displays the I/O Connection Setting dialog to create a new 

I/O Connection. When pushed [Edit] button , Displays the I/O Connection Setting dia-
log of the currently selected I/O Connection for edition.

2.  After setting each items, and pushed [OK] button, connection will be updated.
Below is example setting, the [OUT001] of [NX100-2] will be set to the [IN001] of 
[NX100-1] after 1.0 second.

 PLC setting
The PLC device can be used to set the complicated connection
“X“, “Y“, “M“ means,

- “X“ : Input signal 
- “Y“ : Output signal
- “M“ : Internal register

The maximum number of each signal is 128.

[Cancel] button Closes the I/O Connection Property dialog.

Logical expression

+ Mean OR (∪ ).

* Mean AND (∩ ).

! Mean NOT. This will be used to set "make-before-break con-
tact".

(  ) Mean bracket.

I/O Connection setting

 

 

 

(1) Select controller 

example：NX100 

(2) Input signal 

example：IN0001 

(3) Connection expression 

example：Controller：NX100-2 

I/O Name：OUT0001 

(4)Delay timer(second) 

example：1.00 
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Below is example diagram to set,

1. Set to substitute OUT001 of NX100 for X001 of PLC device.

Also, “OUT0002”, “OUT0005” and “OUT0006”set to substitute “X0002”, “X0003” and 
“X0004” of PLC device.

①

NX100 NX100-2

OUT0001

OUT0006

OUT0002

OUT0005

IN0001

PLC

X0001

X0004

X0002

X0003

Y0001

X0001

X0002

X0003 X0004

M0001

M0001

Y0001

②

③

④
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2. Set to substitute the internal register [PLCX:0001+PLC:X0002] for [PLC:M0001].

3. Set to substitute the internal register [(PLC:X0003*PLC:X0004) + PLC:M0001] for 
PLC:Y0001.
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4. Finally, set to substitute PLC:Y001 for NX100-2:IN001.

The setting of example diagram is finished,
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8.5 Variable Monitor

Displaying and editing the robots are enabled by setting the Variable Monitor.
On the [Simulator] tab, in the [Monitor] group, click the [Variable Monitor] button, the [Variable 
Monitor] dialog appears.

Variable Monitor

Item Description

[Add(A)] button

Displays the Variable Property dialog box to set the variables to be 
displayed and edited.
When setting a position variable (such as P, BP, EX variables), be 
sure to specify the frame (coordinate) in the FRAME combo box.

Setting of FRAME:
Variable P:   When "USER" has been selected, set the user
                     coordinate number in the [UF#] box.
Variable BP: Enabled only when "PULSE" or "BASE" is 
                     selected.
Variable EX: Enabled only when "PULSE" is selected.
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8.6 Lap Time Panel

The Lap Time Panel dialog box shows playback time of a specified section or the number of 
stroke per minute (spm).
On the [Simulator] tab, in the [Monitor] group, click the [Lap Time Panel] button, the [Lap Time 
Panel] dialog appears.

Procedure
1. Enter the following comment at the point where the lap time count is to be started.

(Note that the comment has to be entered before the start point as shown in the figure 
below at "(a)".)
        'RPT:LAP=START

[Mod(M)] button

Displays the Variable Property dialog box to modify the variables.
If "PULSE" is selected in the FRAME combo box when a position 
variable
(such as P, BP, EX variables) is selected in the Name combo box,
no selection can be made in the .TYPE. section.

[Del(D)] button Deletes the selected variables.

[Clear(L)] button Deletes all the variables displayed in the Variable Monitor window.

[Close(C)] button Closes the Variable Monitor window.

This function can not be used with high-speed playback function. Refer to section " 7.5.4  
Refresh Interval " about high-speed playback function.

Variable Monitor

Item Description

NOTE
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2. Enter the following comment at the point where the lap time count is to be stopped. 
(Note that the comment has to be entered after the end point as shown in the figure 
below at "(b)".)
        'RPT:LAP=STOP

3. On the [Simulator] tab, in the [Monitor] group, click the [Lap Time Panel] button, the 
[Lap Time Panel] dialog appears.

4. Play back the job.

5. After the playback, the Lap Time Panel dialog box shows the playback time between 
two points specified in step 1 and 2 above, or the number of stroke per minute (spm) of 
the currently selected controller.
To display the lap time of each controllers, change the robot selection in the controller 
list.

6. Press   to reset the value to zero in the Lap Time Panel dialog box.

Controllers can not be selected during the playback.

 

(a) Comment to start the 
Lap Time count. 

(b) Comment to stop the 
Lap Time count. 

 

Playback time of specified  
interval, 

OR 
The number of stroke per  
minute (spm.) 

Controller 
li

NOTE
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8.7 Stage Master

The Stage Master dialog allows selecting which controller will be affected by the  playback 
start command. 
On the [Simulator] tab, in the [Playback] group, click the [Stage Master] button, the [Stage 
Master] dialog appears.
In the Stage Master dialog, put a check mark next to the controller that will be affected by the 
playback start command then press [OK] to close the dialog.
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8.8 Step Interval Time Panel

When playback with the Step Interval Time dialog box, the tact time of every step are shown. 
When a cursor moves to an indicated list after playback completion, a robot moves to the 
teaching point.
To display the Step Interval Time dialog box, on the [Simulation] tab, in the [Monitor] group, 
click the [Step Interval Time Panel] button.

Step Internal Time Dialog Box

Item Description

[Copy]button

Stores the content of the list on the clipboard.
Selects whether to paste data into the text document or Excel 
spread sheet in COPY Option dialog box.

 
 

 

Playback Time Playback Time（Total） 

JobName Step Number Move Time Move Time（Total） 
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8.9 Pulse Recorder

When playback is performed with [Pulse Recorder] dialog box displayed on the screen, the 
pulse position of the specified robot or the model information are displayed in the dialog box at 
every screen refresh. When it needs that the model information are displayed, Check the 
[Output Model Script].
When moving the cursor in the displayed list of data, if the selected data line contains pulse 
information, the robots are moved to the specified pulse positions. If the selected data line 
contains model information, the model script is executed.

On the [Simulator] tab, in the [Monitor] group, click the [Pulse Recorder] button, the [Pulse 
Recorder] dialog appears. 

Pulse Recorder Dialog Box

Item Description

Moves the cursor to the first data line and executes it.

Move the cursor to the previous data line and executes the line.

Continuously executes the data line in the pulse record from the 
cursor current position to the end of the list or until stopped.

Stops the continuous execution of the data lines started by press-
ing the  button.

Moves the cursor to the next data line and executes the line.
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Moves the cursor to the last data line and executes it.

Output Model Script Model information is displayed in the list of pulse record.

Update VRC
When the pulse record is played, the robot position is set to the 
controller. If this item is "OFF", the playback gets faster because 
the robot position is not reflected.

[Copy] button Copies all the data lines to the clipboard. 

[Delete] button Deletes the data line where the cursor is located.

[Reset] button Deletes the all the data lines. 

[Load] button Retrieves the previously saved data lines from a text file (.txt). 

[Save]button Stores all the data lines in a text file (.txt).

[Close]button Closes the Pulse Recorder.

• Buttons in the Pulse Recorder dialog box can only be used after a job has been played 
back.

• When the pulse record is played, the robot position is updated at refresh intervals. Refer 
to section " 7.5.4  Refresh Interval "" for refresh interval.

Pulse Recorder Dialog Box

Item Description

NOTE
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8.10 Teaching

8.10.1 OLP

OLP is a teaching tool that simplifies the robot teaching by moving the robot to an target posi-
tion. 
On the [Home] tab, in the [Teaching group, click the [OLP] button, the [OLP] dialog appears.
For the details on how to use OLP, refer to " 13.1  Teaching Using OLP Function ".

                                                      

 

Name of the 
operation object Use the [Shift] key 

to toggle the “Pick 
Enable” checkbox 
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OLP dialog box

Item Description

[OLP Pick] check box
To be selected whenever OLP is used.
The check box is automatically cleared when another function is 
selected to operate the robot.

“Move Mode” section

Determines the method to move to the target point.
[Position] check box:

The Operation Object is moved to the position (XYZ) of the target 
point. 

[Orientation] check box:
The Operation Object is turned to match the orientation (Rx, Ry, 
Rz) of the target point frame.

[Z-Axis] check box:
The Operation Object is turned so that its Z-axis matches the Z-
axis of the target point frame.

[Use Face] section:
This setting is enable with  [Orientation] or [Z-Axis] mode.  It can 
be use to change the direction of the Z-Axis when selecting a 
face.
[Normal] radio button:

The Z-axis is in the same direction as the face normal. 
[Reverse] radio button:

The Z-axis is in the opposite direction of the face normal.

“Tool Child to Model 
Move” section

Sets the movement method when moving the target 
point.

[Center of a circle] check box:
Move the robot's TCP toward the center of the circle obtained by 
picking three points.

[Two Points] check box:
Moves the robot's TCP so that the selected first point matches the 
second point.

[Two Faces] check box:
Move the robot's TCP so that the selected first face matches the 
second face.

If only the orientation is to be changed without 
changing the position, uncheck the [Position] 
checkbox before clicking any point.

NOTE

• Only the robot can be selected as the operation target.
• The model that can be picked at the first point by [Two 

Point] or [Two Faces] is only the model registered 
under the flange of the selected robot in [Operation 
Object].

• When the item of [Tool Child to Model Move] is 
enabled, [Move to External Ref. Point] is disabled.

NOTE
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“Pick Mode” section

Sets conditions determining the selected point in the clicked area. 
[Free] check box:

Point of the model at the clicked position. 
[Vertex] check box:

Nearest vertex from the clicked position.
[Center] check box:

Center of the nearest face or edge from the clicked position. 
[Edge] check box:

Nearest edge point from the clicked position.

“Pick Object” section

Sets the type of the object to be selected when clicking on the cell 
view.  (Multiple items can be selected) 

[Model] check box:
Solid models. 

[Frame] check box:
Model frame or AXIS6 models. 

[Lines & Inters] check box:
Lines such as LINE part, WORK line and wireframe model, and 
intersection lines generated by the intersection of parts or models. 

[Point] check box:
Points such as TRACE points. 

[Floor] check box:
FLOOR parts.

OLP dialog box

Item Description
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“Operation Obj” section

Selects an object to be moved to the target point.
[Robot TCP] radio button:

-Sets the robot TCP as the object to move.To select the robot, 
please refer to section " 7.3  Deleting a Controller ".
[Move Slave] checkbox:

- When checked, the [Move Slave] function is enabled.  When a 
robot or station is moved, other slave robots from the same con-
troller are moved with it so that their TCP maintain the same rel-
ative position to the moved robot or station. 
By default all robots are set as slave.  The individually setting of 
each robot can be changed by pressing the [...] button to display 
the “Set Slave Robot” dialog.

[Teacher] radio button:
-Sets the “Teacher” coordinate axis as the object to move.

[Model] radio button:
-Sets the selected model as the object to move.
Model can be selected with  or {Screen} - {Model} - {Select-
Model} or the [CADTree].

[XYZ] button:
-Displays the position data panel as shown below to manually 
modify the position or orientation of the operation object.  

        Position dialog                              Teacher dialog

OLP dialog box

Item Description

Refer to the dialog title bar to confirm the operation 
object name.

NOTE
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 OLP Function Pick Method and Display
When the mouse pointer is over the cell view, press down the left mouse button.  The model 
considered for selection will display in yellow with a red dot to indicate the specific point loca-
tion.  In the case of a solid model, the border (edges) of the pick face will be highlighted in 
green.  The display will update to represent change of selection as the mouse pointer is 
moved over different models.  The actual selection is made only when the mouse button is 
released.

The pick point display will change depending on the selected move mode.

“Move to External Ref. 
Point” section

TUse to move the part held by the robot to a specific point (External 
Reference Point).

[Active] check box:
- When check the robot will move the point clicked on the model it 
is holding to the defined external reference. 

[Select Reference] button:
Displays the Select Model dialog to select a model (frame) as the 
external reference point. 

"Synchronous Move of 
Base Axis" section

Use to move the base axis (servotrack) at the same time as the robot 
when moving to a target point.

[Active] check box:
- When check the base axis will move according the set method to 
enable the robot to reach the target point.

[Method...] button
-Specifies the method to move the base axis. 

Position Displays a point.

OLP dialog box

Item Description

 

   

Pick Point 
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 Selecting [Position] in the "Move Mode" section: (Other items set at 
default)

The robot moves so that the robot TCP overlaps with any clicked point.
Note that this motion does not involve any change in the wrist posture.

  

Orientation Displays a frame (Z-axis is in red).

Z-axis Display an arrow (Z-Axis).
 

 

               

Click 
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 Selecting [Position] and [Orientation] in the "Move Mode" section: 
(Other items set at default)

The robot moves changing its wrist's posture so that the frame of the robot TCP overlaps the 
frame of the clicked point.  

 Selecting "Move to External Reference Point"
Click a point on a model carried by the robot and the robot will move to bring that point to the 
reference point.  (The reference point needs to have been set before this operation can be 
used.)   

                

Click 

               
Click 

Reference Model 
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 Selecting [CurModel] in the "Operation Object" section
Click a point and the currently selected model will be move to the click location.  The name of 
the current model is displayed in the OLP dialog title bar.

8.10.2 Operation Handle

The operation handle is to perform robot jog operation or model allocating by intuitive opera-
tion.
Drag the operation handle on the cell screen, the position of the robot is changed. So, 
unskilled engineers can perform robot operation easily.
And, drag the operation handle of the model, model allocating can be performed easily.

 Grid Settings
Sets the distance or angle of grid. This grid setting is available by following functions.

• Each Axis Operation
• TCP Handle
• Model Handle

For more details on the OLP operation, please refer to section " 13.1  Teaching Using 
OLP Function ".

               

Click 

Current Model 

NOTE
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On the [Home] tab, in the [Operation Handle] group, click the [Grid Settings] button. Grid Set-
ting dialog box is displayed.

 Display Settings
Display/Hide the additional information of operation handle.

 Handle Display
On the [Home] tab, in the [Operation Handle] group, click the [Handle Display] button, the 
operation handle bar is displayed on the upper center of the view.

Tool Name Display Display/Hide the tool names at the tip of tool (TCP).

Guide Display Display/Hide the guide line. For details, please refer to the 
"Guide Line" section of "TCP Handle".

When enabled, each axis can be operated. When drag the robot 
model, that axis can be operated.

       

 

       

Sets the travel distance. This setting 
is available by following functions. 
･Each Axis Operation 
･TCP Handle (axis, face) 
･Model Handle (axis, face) 

Sets the rotation angle. This setting is 
available by following functions. 
 ･Axis Operation 
･TCP Handle (rotation) 
 ･Model Handle (rotation) 
･Elbow Handle 
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  Each Axis Operation
When drag the robot model, each robot axis is rotated. And, station and base axis can be 
operated. The base axis moves to the movable direction.
The distance while dragging, that is set by grid setting. For details, refer to the "Grid Setting".

Procedure

1. Click the icon  .
2. Move the mouse cursor to the robot model.
3. When a mouse cursor comes to the robot model, robot model is highlighted.

When enabled, TCP handle (axis) is displayed. 

 When enabled, TCP handle (face) is displayed. 

When enabled, TCP handle (rotation) is displayed. 

When enabled, OLP drag function is enabled.
When drag to the model, the TCP of the robot is moved to the 
position of mouse cursor. 

When enabled, model handle (axis) is displayed. 

When enabled, model handle (face) is displayed. 

When enabled, model handle (rotation) is displayed.

• A yellow frame is shown to an icon of the function performed.
• When the TCP handle is displayed in the cell with a double arm robot included in a cur-

rent controller, the elbow angle handle to operate an elbow corner is displayed.

SUPPLE
-MENT

 

Drag 
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4. Drag the highlighted robot model. During dragging, the angle of axis is displayed.

Base axis/Station
Because drag the model, base model or station model need be added to operate the base 
axis or station. It provides the following example of base (BASE-XT).

 TCP Handle
This handle is to operate the position of TCP, it displayed on the TCP frame.
The distance while dragging, that is set by grid setting. For details, refer to the "Grid Setting".

• The operable robot is only a robot of a current controller. To operate the robot besides 
the current controller, it is necessary to change the current controller.

• The operable robot is only a robot of a VRC controller.

 

Angle of axis 

NOTE

     

Travel axis 

Cad Tree dialog 

Rotate axis 

304/847



8.10  Teaching

HW0485348

TCP handle is displayed at the position of all robots of the current controller, but all except for 
a robot included in a control group of a current job will be semi-transparent displayed. But, the 
operation of the semi-transparent handle is also possible.

Procedure
• Display the operation handle

To display the TCP handle, click the icon of the operation handle bar.

TCP handle (axis) …  

TCP handle (face) …  

TCP handle (rotation) …  
• Operate the operation handle

To operate the handle, drag the handle to move. When a mouse cursor comes to the han-
dle, the handle is highlighted. And, during dragging, the traveling distance (or rotating 

• The operable robot is only a robot of a current controller. To operate the robot besides 
the current controller, it is necessary to change the current controller.

• The operable robot is only a robot of a VRC controller.

     

X axis rotation 

TCP handle (axis) 

Y axis rotation 

TCP handle (face) TCP handle (rotation) 

Z axis rotation X axis 

Y axis 

Z axis 

XY face 

YZ face 

XZ face 

     

Robot not included a  
control group 

Robot included in a control group 

Semi-transparent display 

NOTE
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amount) is displayed. When the coordinate system is "Tool", traveling distance is the rela-
tive value from drug start position. Otherwise, traveling distance is absolute value.

For example, to move as follows, drug the green handle to the following direction.

When drag the handle (face), TCP moves on the same plane as the dragged face.

     

Semi-transparent 
display Highlighted handle 

Traveling distance 

   
Drag 

   

Drag 
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When drag the handle (rotation), TCP rotates on the same direction as the dragged ring.

• Select the Coordinate
The following coordinates are available to operating TCP handle. On the [Home] tab, in 
the [Operation Handle] group, select the coordinate by the combo box.

• Base coordinate and Robot coordinate
Robot always moves by the same posture as a base coordinate and a robot coordi-
nate.

When operating the handle (rotation) by a base coordinate, a robot coordinate and the 
user coordinate, the handle doesn't rotate together, but a robot moves.

    
Drag 

NOTE
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• Tool coordinate
Robot always moves by the same position and posture as TCP.

• User coordinate
Robot always moves by the same posture as a selected user coordinate.

When selects USER AXIS, the following dialog box is displayed.

• Synchronized operation
When operate the Operation handle, the selected robot and another robot can move to 
keep their TCP the same relative position.
On the [Home] tab, in the [Operation Handle] group, click the [Synchronized] button, 

   

   
User 
coordinate 
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and operate the operation handle.

A double arm robot moves as follows.

The above is an example of the TCP handle (axis), but TCP handle (face) and TCP 
handle (rotation) can also do synchronized operation.

• Guide Line
The guide line helps to recognize the TCP position at the XY-plane. A vertical broken 
line is displayed to the XY-plane from the TCP handle.
When some operation handle is displayed, on the [Home] tab, in the [Operation Han-
dle] group, click the [Display Settings] button and the [Guide Display] button, the guide 
line is displayed.

When the [Guide Display] button is enabled, a vertical broken line is displayed to the 
XY-plane from the TCP handle

   

Drag the green handle to the right 

R1 and R2 move 
to the right 

   

Drag the red 
handle down R1 and R2 

move down 

 

 

309/847



8.10  Teaching

HW0485348

.

 Elbow Handle
When a double arm robot is included in a current controller and one of TCP handles (axis, 
face, or rotation) are displayed, the elbow handle is also displayed at the same time. When 
drags the elbow handle, the elbow angle can be changed. When a mouse cursor comes to the 
handle, the handle is highlighted. And, during dragging, the rotating amount is displayed.
The angle while dragging, that is set by grid setting. For details, refer to the "Grid Setting".
When drags like a left figure, robot moves as a right figure. 

The guide line of the current controller (VRC controller) is displayed only.

 
Guide Line 

NOTE
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 OLP Drag
When drag to the model, the TCP of the robot is moved to the position of mouse cursor. A pink 
marker is shown to a point on the model at the mouse cursor location.

Procedure

1. Click the icon  .
2. Click the robot model to operate.

Click 
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3. Drag on the model. TCP of the robot is moved to the position of mouse cursor
To operate another robot, proceed the step 2. But, only a robot in the current controller 
can be selected..

• The operable robot is only a robot of a current controller. To operate the robot besides 
the current controller, it is necessary to change the current controller.

• The operable robot is only a robot of a VRC controller.
• When drag at the location outside the reach of TCP, robot does not move. When mouse 

is outside the reach of TCP, robot stops at that position.

 

 

 

 
 

 

 

Side view 

Side view 

Side view 

Start dragging 

Dragging 

Finish dragging 

TCP moves on 
the model 

NOTE
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 Model Handle
Model handle appears at the origin position of the model. When operates the model handle, 
Model is moved.
The distance while dragging, that is set by grid setting. For details, refer to the "Grid Setting".

Procedure
• Display the Model handle

1) To display the Model handle, click the icon of the operation handle bar.

Model handle (axis)… 

Model handle (face)… 

Model handle (rotation)… 
2) Select the model to operate

Click the model to operate. Model handle appears as follows.

• FLOOR model cannot be operated.
• When click the robot model, robot position is moved.

     

X axis rotation 

Model handle (axis) 

Y axis rotation 

Model handle (face) Model handle (face) 

Z axis rotation 

X axis 

Y axis 

Z axis 

XY face 

XZ face 
YZ face 

NOTE

   

Click the model 
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3) Release of handle
To finish operating the model, click a FLOOR model or the space where model 
doesn't exist on the cell screen (light-blue space of the following figure). 

And, to operate another model, proceed the step 2. Then, Model handle is 
appears at the selected model and it is the target model.

• Operate the handle
To operate the handle, drag the handle to move. When a mouse cursor comes to the han-
dle, the handle is highlighted. And, during dragging, the traveling distance or rotating 
amount is displayed.

• Model handle (axis)
When drag the colored model handle (axis), the model is moved to the handle direc-
tion.
For example, the model is moved to the Y axial direction of model coordinates.First, 

When hide the operation handle bar or change to another operation handle, the operation 
is finished.

 

The space where 
model doesn't exist 

   

Click 

Target model 

SUPPLE
-MENT

   

Highlighted handle 

Semi-transparent display 

Traveling distance 
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drag the green handle to the following direction.

Release the mouse at the position you want to place and the model will be placed.

• Model handle (face)
When drag the handle (face), the model moves on the same plane as the dragged 
face.
For example, the model is moved on the XY plane of the model coordinates.First, drag 
the red handle to the following direction.

The following dialog is displayed and input the traveling distance manually.

When the [OK] button is clicked, the operation is fixed. When the [Cancel] button is 

 

Drag 

Drag 
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clicked, the operation is canceled and the model returns to the original position.

• Model handle (rotation)
When drag the handle (rotation), the model rotates on the same direction as the 
dragged ring.
For example, the model is rotated around X axis of the model coordinates.First, drag 
the blue handle to the following direction.

The following dialog is displayed and input the rotating amount manually.

When the [OK] button is clicked, the operation is fixed. When the [Cancel] button is 
clicked, the operation is canceled and the model returns to the original position.

• Model Copy
When the [Ctrl] key of a keyboard is pressed during handle operating, a model returns 

 

Drag 
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to the original location and only the handle moves.

When drag operation is ended, the following dialog is displayed and input the traveling 
distance manually.

When the [OK] button is clicked, the model is copied and copied model is displayed at 
the position of handle.

The parent of the copied model is the same as an original model. A serial number is 

 

Only the handle 
moves 

     

Copied model 
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added to the model name.

When the [Ctrl] key is released in the state with the [Ctrl] key was pressed in the drag-
ging, a model moves to the location of the handle again. Then, the model is not copied 
and drug operation is the usual model handle.

8.10.3 Visual Path Edit Function

Each step position is displayed and is connected with a line. And, drag the marker, the job is 
edited intuitively.

 RESTRICTION
• Visual path edit function is available only the current job of the current controller.
• Each step position is displayed and is connected with a line or a curve simply. So, visual 

path is different from the trace of playback. And, visual path is not supported the position 
level.

• Relative job is not supported.
• In the case of coordinated job, the operation target is only robot selected in the robot 

selection combo box. And, even paint use, functions for paint use cannot be used.
• Only following move instruction is supported.

• MOVJ
• MOVL
• MOVC
• MOVS
• SYMOVJ
• SYMOVL
• SYMOVC
• SVSPOTMOV
• SMOVL
• SMOVC
• SMOVS
• +MOVL
• +MOVJ
• +MOVC
• +MOVS
• +SMOV
• +SMOVX

• If the curve of MOVC, SYMOVC, +MOVC, and SMOVC cannot calculated (ex. Lack of 

 

Copied model 

Target model 
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teaching point), the path is connected with a line.
• The line is drawn in order of step number. Visual path is not supported when the 

sequence is changed by the control instruction.
• When the CTP is set by variable, visual path is not supported.
• When job has any error (ex. Robot cannot reach the teaching point), visual path is not dis-

played.
• The following function cannot be used in PLAY mode. Change to the TEACH mode.

• Step move by clicking the move instruction marker
• Modify/Add the teaching point by TCP handle 
• Modify the anticipation value by dragging the SPYON/SPYOF marker
• Modify the PAINTSET tags by double-click
• Modify the instruction, add the instruction or delete the instruction by the right-but-

ton menu
• P variable is not supported by visual path edit.

 Setting
On the [Controller] tab, in the [Job] group, click the [Visual Path Edit] button and select the 
[Settings] menu, the visual path edit setting dialog is displayed.
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Items of paint instruction can be set only the use of controller is paint.

Move Instruction

Enable Shows/Hides the move instruction marker.

Cone height (mm) Sets the height of move instruction marker.

Cone diameter (mm) Sets the diameter of move instruction marker.

Z-Axis Offset (mm) Set the display position of the Z-direction (tool coordinates) of 
move instruction marker.

Color Sets the color of move instruction.

Opacity Sets the opacity of move instruction.

Turn the marker 
upside down

Move instruction marker is turned upside down.

Path

Line weight (mm) Sets the line weight of path.

Enable work area only Selects whether the path of work area is displayed only or 
not.

Color

Movement section Sets the color of movement section.

Paint section
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Auto The color of paint section is selected automatically.
The color is selected by the paint condition file number. The 
color setting is loaded from the "vpecolor.ini" in the controller 
folder.

Manual The color of paint section is the selected color.

Opacity Sets the opacity of path.

Aux Instruction

Enable Shows/Hides the aux instruction marker.

Marker size (mm) Sets the size of aux instruction marker.

Opacity Sets the opacity of aux instruction marker.

Max display number Sets the max number of aux marker between steps. When the 
number of aux instruction is over the max number, the display 
is skipped.

User Definition

Instruction Inputs the instruction.

Color Sets the color of the aux instruction marker.

Add Register the instruction name and color.

Upd Updates the selected line of the list to the instruction and 
color.

Del Delete the selected line in the list.

Paint Instruction

Enable Shows/Hides the paint instruction marker.
Target instruction are SPYON, SPYOF,   PAINTSET, and 
PAINTEND.

SPYON/SPYOF

Marker size (mm) Sets the size of SPYON/SPYOF instruction marker.

Opacity Sets the opacity of SPYON/SPYOF instruction marker.

Color Sets the color of SPYON/SPYOF instruction marker. It can be 
set every gun number.

PAINTSET/PAINTEND

Marker size (mm) Sets the size of PAINTSET/PAINTEND instruction marker.
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 Show/Hide the Visual Path
On the [Controller] tab, in the [Job] group, click the [Visual Path Edit] button, the visual path is 
displayed.

Visual path of the current job of current controller is displayed. Click this button again, visual 
path is hidden.
In the combo box to the right of the [Visual Path Edit] button, robots included in the current job 
are listed. The path of the selected robot is displayed.

 

Step position is displayed as cone. Each step position is connected with a line or a curve sim-

Opacity Sets the opacity of PAINTSET/PAINTEND instruction marker.

Color Sets the color of PAINTSET/PAINTEND instruction marker. It 
can be set every gun number.

Step Sets the step of spin box.

OK The setting is saved and this dialog is closed.

Cancel The setting is not saved and this dialog is closed.

 

 

Robot select combo box 
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ply. The color of move instruction is changed into the work area between SPYON and SPYOF.

Show/Hide setting of marker is can be changed in the ribbon menu. When the marker is dis-
played, the menu is highlighted.

This marker means move instruction position. Step number is dis-
played.

This marker means SPYON/SPYOF instruction.

This marker means PAINTSET/PAINTEND instruction. Selected 
instruction can be displayed.

Display Visual Path Shows/Hides the visual path.

 

Move Instruction 

SPYON – SPYOF area 
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Click the move instruction marker, robot moves to the step positio.

In the case of coordinated job, the path of the selected robot in the combo box is displayed. 
But, when click a marker of move instruction marker, all robot in the job move to the each posi-
tion of the step. 

When use the coordinated move instruction (SMOVL, SMOVC and SMOVS), the slave robot 
moves coordinated with the master robot, the path is drawn based on the TCP of the master 

Display Move Instruc-
tions

hows/Hides the move instruction marker.

Display Aux Instructions Shows/Hides the aux instruction marker.

Display Work Instruc-
tions

Shows/Hides the paint instruction marker.
Target instruction are SPYON, SPYOF,   PAINTSET, and PAINTEND. 
This item is paint use only.

Display Work Area Only Selects whether the path of work area is displayed only or not. This 
item is paint use only.

In the case of coordinated job, even paint use, "Display Work Instructions" menu and 
"Display Work Area Only" menu cannot be used.

NOTE

 

Click 

 

 

             

Click 

Robot displaying the path 
All robot in the job move 
to the position 
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robot (e.g. the master robot is station, the path is drawn on the station-axis).
• When the case is the master is robot:

• When the case is the master is station:

When the rotation axis of the dual-arm robot is the station axis and the path of the job which 
doesn't have station control group is displayed, the path is displayed on the station axis. When 
the station axis rotates, the path rotates too. If the station axis is included in the control group 
of the job, it becomes a regular display.

 
 

             
The slave robot 
displaying the path 

All robot in the job move 
to the position 

Click another step 
marker 

Path follows the 
master robot 

             
The slave robot 
displaying the path 

Click another step 
marker 

Path follows the master 
station 

        

Station axis 
rotates 

The path rotates 
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When the mouse cursor is on the move instruction marker, the instruction is displayed. 

When the job is conveyor synchronization job, the visual path is displayed with CTP and LS 
value. Click the move instruction marker, robot moves to the step position and conveyor 
moves to the CTP position.

When the SPYON/SPYOF instruction has "ANT=" tag or "ANTDIS=" tag and last move 
instruction has "NWAIT" tag, the SPYON/SPYOF marker is positioned defined time or defined 
distance away. 

[Example]
Anticipation is not set

This operation cannot be used in PLAY mode.

When the CTP is set by variable, visual path is not supported.

NOTE

NOTE

 

Click 

CTP position 
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Anticipation is set (Positive)

Anticipation is set (Negative)

 Edit the Teaching Position
Uses the visual path edit function and Operation handle, the job can be edited easily.

Procedure
1. On the [Controller] tab, in the [Job] group, click the [Visual Path Edit] button, the visual 

path is displayed.
2. On the [Home] tab, in the [Operation Handle] group, click the [Handle Display] button, 

the operation handle bar is displayed. Select the Handle.

3. Click the move instruction marker. Robot moves to the step.

• This operation cannot be used in PLAY mode.
• MOVJ and SYMOVJ is not supported.
• Acceleration and deceleration of a robot aren't considered.

 
Marker is not displayed 

beyond the next step. 

 
Marker is not displayed beyond 

the previous step.

NOTE

       

Click 

Robot moves to 
the step 
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When multi step is registered the same position, Select dialog is displayed

4. Drag the operation handle while the keyboard key is pressed. When release the mouse 
button, the job is edited. When drag the operation handle without pressing the key, 
Robot moves but the job is not edited. To edit the job, click the move instruction marker 
again.
Following the keyboard assignment is available.

The operating coordinates of Operation handle is selected coordinates in the combo 
box in the [Operation Handle] group on the [Home] tab.

When the robot cannot moves to the handle position, the teaching point is changed.

In the case of coordinated job, by the selection of [Single] - [Synchronized] menu of the 

[Alt] key Modify the teaching point

[Ctrl] key Add the move instruction after the step.

[Alt] + [Ctrl] key Add the move instruction before the step.

       

[Alt] key + Drag 
Teaching point 
is edited. 

Path before editing 
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operation handle, it works as follows.

• Modifying teaching position according to the "[Alt] key + drag"

• Adding teaching position according to the "[Ctrl] key + drag" or "[Alt] + [Ctrl] key + 
drag"

 Edit Multiple Teaching Points
Multiple teaching points can be selected. Selected multiple teaching points can be moved in 
the same direction.

Procedure
1. Proceeds the step 1 to 3 of "Edit the Teaching Position".
2. Select the move instruction marker to move at the same time by the following opera-

tion.
[Operation 1: [Ctrl] key + Left-click]
Left-click by holding down the [Ctrl] key on the marker of the move instruction, selec-
tion state of the marker is switched.

Single
Teaching position of the robot displaying the path is 
updated only. Teaching positions of the other robots 
in the job are not changed.

Synchronized Movement of all robot by the synchronized opera-
tion is reflected in the teaching position.

Single

Teaching position of the robot displaying the path is 
reflected only. Teaching positions of the other 
robots are registered in the same location of the 
step selected at the time of start of operation.

Synchronized Movement of all robot by the synchronized opera-
tion is reflected in the new teaching position.

This operation cannot be used in PLAY mode.

 

 

NOTE
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e.g. When select a non-selected state marker

When execute the same operation on the marker in the selected state, it becomes to 
non-selected state.

When selecting one of the teaching points which are teaching the same position, dialog 
to specify whether to switch the selection state of any step is displayed.

[Operation 2: [Shift] key + drag (Rectangle)]
Left-click and drag by holding down the [Shift] key, green rectangle appears. Move 
instruction markers displayed within the rectangle are selected.

When any of move instruction markers is selected and left-click anywhere on the cell 
screen, all of the selection is canceled.

             

[Ctrl] key + Left-click 
Marker changes to yellow, it 
becomes to selected state 

             

Mouse operation starts Markers change to yellow, 
they become to selected 

Mouse operation end 

NOTE
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3. Proceeds the step 4 of "Edit the Teaching Position".

When any of the teaching point is out of operating range, the operation is canceled.

 Edit the contents of instruction
Click the right button on the move instruction marker and select the [Edit this Instruction] in the 
right-button menu, Edit function of the simple pendant is executed.

•  When multiple selections, move instruction cannot be added by the "[Ctrl] key + drag" 
operation or "[Alt] key + [Ctrl] key + drag" operation.

• For multiple selected teaching point, axial rotation handle of the operation handle cannot 
be used.

• Teaching points that the tool number is different cannot be selected at the same time.

 

 

 

[Alt] key + Drag to the red direction 

Selected markers move 
to the same direction 

Select multiple markers 

NOTE

                         

Click the right button 
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Double-click the PAINTSET marker, Paint Condition Setting dialog is displayed. When click 
the [OK] button, the setting is saved. When click the [Cancel] button, the setting is not saved.

When the SPYON/SPYOF instruction has "ANT=" tag or "ANTDIS=" tag and last move 
instruction has "NWAIT" tag and drag the SPYON/SPYOF marker, the anticipation setting can 
be edited. When release the button, the setting dialog is displayed. When click the [OK] but-
ton, the setting is saved. When click the [Cancel] button, the setting is not saved.

This operation cannot be used in PLAY mode.

 

Drag 

NOTE
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 Right-button menu
Click the right button on the move instruction marker, right-buttom menu is displayed. Follow-
ing operation is available.

Edit this Instruction Edit this move instruction
(Execute the edit function of simple pendant.) 

Insert Teaching Point at 
previous

Insert teaching point at previous

Insert Teaching Point at 
next

Insert teaching point at next

Insert Paint Instruction 
here

Insert SPYON/SPYOF instruction

Remove this Instruction Delete the move instruction or SPYON/SPYOF instruction
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When delete the instruction, the following dialog is displayed. When click the [OK] button, the 
instruction is deleted. When click the [Cancel] button, the instruction is not deleted.

This operation cannot be used in PLAY mode.NOTE
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8.11 Collision Detection

This function displays the collision between some models.
When the collision is detected, the model is displayed in red, and the robot pulse data and the 
executing job name is displayed in the collision log.

To use the Collision detection, the following settings are needed.
1. The model (work, robot, etc.) group is registered as "Collision model group".
2. To detect collision, the model group pairing is registered as "Collision pair".
3. Select the Collision pair, and start the Collision Detection.

For details, please refer to section " 13.3  Collision Detection Setting ".

8.11.1 Collision Detection Dialog

In this dialog, set up to detect collision, and operate the start/end the collision detection.
On the [Simulation] tab, in the [Collisions] group, click the [Collision Detection] button, the 
[Collision Detection] dialog appears.

    

1.Register the collision  
model group. 

Reset the collision log, or 
copy the collision log to  
clipboard. 
When the data need be 
outputted in the form of 
tab delimited, select the 
[ExcelOption] on the 
copy dialog. 

Collision log list 
When the collision log is 
clicked, the robot moves 
the interfering position. 

2.Register the collision 
pair. 

4.Start/End the collision 
detection. 

3.Select the collision 
pair to be used. 
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Collision Detection dialog option

Item Description

Collision Color (RED) The interfering model is displayed in red.

Playback without 
Redraw

To reduce the time to check collision, Redraw is skipped on playback.

Move Collision Step

When the collision log is clicked, the robot moves the interfering posi-
tion, and the cursor location in the virtual pendant moves to the step 
number position recorded in that log.
When this operation is used, set the teach mode.

Check period

MotoSim EG-VRC detects the collision per checking period on play-
back.
High: Collision detection is executed per 1 segment of controller.
Medium: Collision detection is executed per 50msec.
Low: Collision detection is executed per 100msec.

By using the simplified model creation function and the collision detection function, near 
miss check is possible.
For details of the simplified model creation function, please refer to "11.17 Creating Simpli-
fied Model".

• The function is not available for hidden model.
• Near miss check option may need time to process.
• Default setting of check period is "High". If "Medium" or "Low" is selected, the time 

required to execute playback is shorten, but collision cannot be detected when the robot 
moves fast. Please select the check period according to the robot speed.

• [Playback without Redraw] and [Move Collision Step] can not use depending on the sys-
tem version of controller. Please refer to section " 15.8  List of Function depending on 
the system version of controller ".

SUPPLE
-MENT

NOTE
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8.11.2 Collision Model Group Setting

 Collision Model Group Display
The model (work, robot, etc.) group is registered as "Collision model group".
To display the Collision Model Group dialog box, click the [ModelGroup] button on the Colli-
sion setting dialog box.

Collision Model Group 

Item Description

Collision Model Group 
List

The registered collision model group is displayed.
When the collision model group is selected, the models of the collision 
model group are highlighted.

Add The new collision model group is created.

Edit
The collision model group selected in the list is edited.
When the collision model group in the list is double-clicked, that can be 
edited.

Copy The new collision model group is created based on the collision model 
group selected in the list.

Del The collision model group selected in the list is deleted.

Del All All collision model group selected in the list are deleted.

   

Collision Model Group 
List 
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 Auto-registration of the collision model group
The collision model group of robot is registered automatically in following case. Edit it if 
needed.

• When the new controller is created
• When the old cell (before MotoSim EG-VRC ver2.60) is opened.

 Collision Model Group Detail Display
The models (work, robot, etc.) are registered/deleted to the collision model group.
To display the Collision Model Group Detail dialog box, click the [Add] button, the [Edit] button, 
or the [Copy] button on the Collision Model Group dialog box

• The tool model is not added. Click the [Edit] button, and add the tool model if needed.
• The time to check collision depends on the number of model and the complexity of 

model.
All robot models are registered by Auto-registration. If some robot models need not be 
checked, narrow down the models of the collision model group at the Collision Model 
Group Detail Dialog Box.

NOTE
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.

Collision Model Group Detail

Item Description

Pick Enable

On the [Home] tab, in the [Model] group, click the [Select Model] but-
ton. Select the model in the MotoSim EG-VRC, that model is added to 
the [Model List].

Add from CadTree Select the model on the CadTree, and click the [Add from CadTree] 
button, that model is added to the [Model List].

A child model is also 
registered simultane-
ously

When the model is added, the child model of that is also registered 
simultaneously.
For example, If the "SAKU" is selected in the CadTree and the [Add 
from CadTree] button is clicked, the child models "SAKU1", "SAKU2", 
"SAKU3", "SAKU4", "SAKU5", and "SAKU6" are also added.
("SAKU" is dummy model, so it is not added.)

Del The selected model in the [Model List] is deleted.

Del All All models in the [Model List] are deleted.
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8.11.3 Collision Definition Setting

 Collision Definition Dialog
To detect collision, the model group pairing is registered as "Collision pair".
To display the Collision Definition dialog box, click the [Add] button, and the [Edit] button on 
the Collision Detection dialog box.
Collision Detection function check if master interfere slaves. So, select one model group as 
Master, and Select one or more model group(s) as Slave.

Collision Definition

Item Description

Collision model group 
list

The registered collision model group is displayed in the list.
When the collision model group is selected, the models of the collision 
model group are highlighted.
To check the collision model group, set the Attribute items "Master" or 
"Slave".

Playback stop by colli-
sion detection

Set the robot action when collision occurs. If this is checked, playback 
is stopped when collision is detected in playback. When the playback 
is continued without interruption, do not check this, and register the 
collision definition.

   

Collision model group 
list 

Select the model group to 
check collision. 
Master is only one model 
groups. 
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8.12 Sensing Option Setting

When the Sensing option is used, to detect the point where the wire of robot has contact with 
the work, the searching operation (Staring Point Detection function / Search function) is avail-
able.
Please refer to "INSTRUCTIONS FOR BASIC OPERATION OF STARTING POINT DETEC-
TION FUNCTION" / "INSTRUCTIONS FOR SEARCH FUNCTION" of each the controller for 
details.

• This function can not be used for the FS100 controller.
• When this function is used, "Starting point detecting function" of option function in main-

tenance mode need be checked "use".
• When this function is used, turn off the servo simulation.On the [Simulation] tab, in the 

[Playback] group, click the [Servo Emulation] button. 

• Sensing function (SRCH tag of MOV* instruction) can be simulated, but sensing result is 
not the real one.

• The master model of sensing gets deeply into the slave one depending on the moving 
speed of sensing.

NOTE
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Procedure
It explains the procedure for setting the sensing option between the wire of robot (Model 
name: wire) and the work (Model name: work).

1. The wire (Model name: wire) is added at the torch head of robot.
In this case, the "CYLINDER" is used for the parts of wire.

2. On the [Simulation] tab, in the [Settings] group, click the [Sensing Setting] button, the 
[Sensing Option Setting] dialog appears.

3. Select [Master] in the [Model List] group.
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4. On the [Home] tab, in the [Model] group, click the [Select Model] button. Click the "wire" 
model, "wire" is displayed at [Model].

5. Click the [Add] button, the "wire" is set to the [Master] in the [Model List] group.

6. Select [Slave] in the [Model List] group, and set the "work" to the [Slave] as Step 4 and 
5.

7. Click the [OK] button.
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8.13 Spray Model for Paint

8.13.1 Spray Model

The Spray Model for Paint function allows creating the spray model easily. The spray model is 
displayed and hidden automatically, when the SPYON or SPYOF instruction is executed.

Paint Panel

Item Description

[Gun No.] spin box 
(1 to 3) Paint gun number.

[Tool No.] spin box Specifies the tool number to set the paint gun number.

"(a)TCP distance" 
edit box Distance from the paint spray outlet (nozzle).

"(b)Valid distance" 
edit box Effective range to apply paint from the nozzle.

"(c)Max Diameter" 
edit box Maximum width of the paint spray face.

"(d)Mini Diameter" 
edit box Minimum width of the paint spray face.
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Procedure
1. Select the controller for the spray model setting.
2. On the [Simulation] tab, in the [Settings] group, click the [Paint Setting] button, the 

[Paint Panel] dialog appears. 
Set the Gun No. and Tool No. to according to the job.

3. Click the [OK] button or the [Apply] button, and then the spray model is created.
4. When the playback is executed, the spray model related to the Gun No. of SPYON or 

SPYOF instruction is displayed and hidden automatically.

8.13.2 Paint Simulation

It can be checked visually whether the spray model has arrived at the workpiece.
Color is displayed in SPYON ~ SPYOF section during playback.

 Restriction
• Paint Simulation is not available when multiple robots exist in one controller.
• It is not possible to output the state of painting to 3DPDF file or AVI file.

"(e)Nozzle Position" 
edit boxes Nozzle position viewed from the flange.

"(e)Nozzle Posture" 
edit boxes Nozzle posture viewed from the flange.

[TCP calculation] 
check box

Automatically calculates tool dimensions according to the input infor-
mation.

[Transparent] check box Displays paint model in translucent color.

"Model division" 
combo box Number of divided paint spray faces.

[TCP distance] button Paint color from nozzle to TCP.

[Valid distance] button Paint color from nozzle to the end of the valid painting distance.

[Display model] 
check box Displays the created spray model.

This function can not used with two or more robot system.

Paint Panel

Item Description

NOTE
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• It is not possible to simulate overcoating with multiple guns.
• When using the masking function, the playback speed will be slow.

Item Description

Gun No. (1-3) Sets painting gun number.

Paint Enable When enabled, It is displayed visually whether the spray model has 
arrived at the workpiece.

Pick When enabled, the target model can be picked.

A child model is also 
registered simultane-
ously

When the model is added, the child model of that is also registered 
simultaneously.

Top Sets the color when painting the maximum.

Bottom Sets the color immediately after start of painting.

Over Sets the color when painting over the top.

Gradation Specify the stage from the bottom to the top.
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Procedure
1. Select the controller for which paint settings are set.
2. On the [Simulation] tab, in the [Settings] group, click the [Paint Setting] button, the 

Paint Panel dialog appears. Select the [Paint Setting] tab.

3. Sets the each items.
Please set the painting gun number regarding to the job.

4. Press the [Apply] button or the [OK] button to complete the paint settings.
5. When playback, the target model is colored with the painting contents linked to the 

painting gun number of SPYON, SPYOF command. 

Check All All target models are checked.

Clear All All target models are unchecked.

Model List
Displays a list of target models.
Check ON: painting target
Check OFF: Not target

Masking When enabled, color is not applied to the target model when there is 
an obstacle between the application target model and the paint gun tip.

Del Deletes the selected model from the list.

Add from CadTree Adds the model selected in CadTree.

Item Description
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8.14 Speed Graph Function

This function displays on a graph the robot TCP speed during playback.

8.14.1 Basic usage

The procedure for using the Speed Graph function is as follows.

8.14.2 Trace Settings

To display the speed in the graph, this function uses the data from the robot TCP trace.  
Therefore, the Trace function must be enabled and set to the robot TCP in order to use this 
function.For more details about the Trace function, please refer to section " 13.2  Trace Func-
tion " of the MotoSimEG-VRC Operation Manual.

Procedure
1. On the [Simulation] tab, in the [Monitor] group, click the [Trace] button, the [Trace Man-

ager] dialog appears. To use the speed graph, you will need to set the trace to the TCP 
model: <ControllerName>-R01_tcp (example: DX100-R01_tcp). By default, the trace 
<ControllerName>-trace1 is already set to the TCP of the controller's R1 robot.

• This function cannot be used in conjunction with the High-Speed Playback function.  For 
details on the High-Speed Playback function, please refer to section " 7.5.4  Refresh 
Interval " of the MotoSimEG-VRC Operation Manual.

• This function doesn't support multiple controllers or a controller with multiple robots.
• The speed displayed in this function is the speed of the TCP of the R1 robot of the cur-

rent controller selected at the time the Speed Graph dialog was displayed.

NOTE

Trace Settings

Graph Settings

Playback

Graph Operations
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If it does not exist or was changed, please create a trace for the model "[controller 
name]-R01_tcp".

2. To verify the settings, double-click on the trace "<ControllerName>-trace1" or select it 
and press the [Edit] button.  In the "Trace Property" dialog, if it not already set, select 
the "<Controller_Name>-R01_tcp" model in the "Model" field.
To display the speed relative to a moving work piece, change the "Parent" field from 
"world" to the model representing the work piece.
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8.14.3 Graph Settings

Set the graph settings before displaying the graph.
On the [Simulation] tab, in the [Monitor] group, click the [Speed Graph] button, the [Speed 
Graph] dialog appears.

Press the [Settings] button to display the "Graph Settings" dialog.

If the following message displays, the settings for the current controller are not set prop-
erly.  Please verify the graph settings.

 

NOTE
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 Graph Settings Dialog
In this dialog, display parameters such as I/O signals, line color, line thickness, scale, etc. can 
be set. Up to 5 I/O signals can be displayed.  The same I/O signal cannot be set multiple 
times.

 I/O Signal Setting Dialog
The "I/O Signal Setting" dialog is used to select the I/O signal to plot on the speed graph.

Graph Settings [Graph Settings]

Item Description

Refresh Interval Sets the rate at which the Speed Graph is updated. 
(0.004 to 0.4 sec)

Speed Units Sets the speed units for the Y-axis.

Gradations Sets the number of gradation lines along the X and Y axes.

Y-axis auto-scaling 
during playback

When checked, the Y-axis scaling is automatically adjusted during 
playback to display the full range of the speed.

 

Check to display 
this data Open the dialog to 

select the I/O signal 

Set the line thickness 
Set the line color 

Check to adjust the 
Y-axis scaling during 
playback 

                             

Select between Input or 
Output signals 

Select the signal 
number 

351/847



8.14  Speed Graph Function

HW0485348

8.14.4 Playback

During playback, the speed is plotted on the speed graph.  The graph can display up to 200.0 
seconds of data.  Playback data beyond 200.0 seconds will not be displayed.  Also note that 
graph operations cannot be done during playback. 

8.14.5 Graph Operations

After playback is complete, various operations can be done with the speed graph.

Mouse Operations

Keyboard Operations

Click on the graph Move the cursor position (yellow line) to the clicked position.  
The robot in the MotoSimEG-VRC window will also move to 
the position corresponding to the cursor position.

Mouse Wheel Roll the mouse wheel to change the X-axis scaling factor.

[Ctrl] key + Mouse Wheel Roll the mouse wheel to change the Y-axis scaling factor.

Drag the scrollbar Drag the bottom scrollbar to horizontally pan (X-axis) the 
graph in the display area.

[←] [→] keys Move the cursor position by one segment.  

[Ctrl] + [←] [→] keys Move the cursor position rapidly.  

[Home] key Move the cursor and the display area to X=0.0

[End] key Move the cursor and the display area to X=Max.

 

Display of robot 
speed and step 
number change 

Fit the whole playback 
within the display area 

Copy the graph data 

Display the graph 
settings dialog 

Display of the data at 
the cursor position 

Display of the I/O 
signals 

Cursor (yellow line) 
position 
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 Graph Data Copy
When the [Copy] button from the "Speed Graph" dialog is pressed, the "Copy Data" dialog dis-
plays.  Press the [File] button to save the data to a text file.  Press the [Clipboard] button to 
copy the data to the Windows clipboard so that the data can be paste in another application.
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8.15 Running an External Software

To run an external software with MotoSim EG. On the [Home] tab, in the [Tools] group, click 
the [External Software] button, the [Launcher] dialog appears and perform the settings 
explained in the list below.  

Launcher Dialog Box

Item Description

[Add] button

Select [Add] to register the software to run; the Launcher Setting dialog box 
appears.
Press the [Browse] button on the right of the Path edit box.  Select the desired 
program (executable file), and press [OK].  (The file name will be automatically 
entered in the Name edit box.)  

[Edit] button Edits the settings of the registered software. 

[Delete] button Deletes the registered software.

 

Path name of 
the external 
program to run.

File name opened by the software specified 
in the Path edit box. (Directly editable.)

Executable file name 
of the path: ".EXE" 
(directly editable.)
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8.16 Job Browser

Job Browser supported the selection the job. Job Browser is available for the NX100, DX100, 
FS100, DX200, YRC1000 and YRC1000micro. 
On the [Home] tab, in the [Teching] group, click the [Job Browser] button, the [Job Browser] 
dialog appears.

 When starting Job Browser for the first time
When starting Job Browser for the first time, the bellow dialog appears. Open the Search tab 
in the Job Browser, search the job, and set the job to the root of the job tree.

“Keyword”
column

Double-click the desired software in the “Keyword” column to run the external 
software.  

This function can not use depending on the system version of controller. Please refer to 
section " 15.8  List of Function depending on the system version of controller ".

Launcher Dialog Box

Item Description

Double-click to run the software.

NOTE
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 Main Window

 Sub Window
Job information and contents are displayed at the sub window. Job Browser enables the user 

Job Browser

Item Description

Controller Select the controller.

Job Tree tab Job Tree tab shows the job hierarchy as a tree.

Search tab Search the job in the controller on the Search tab.

Bookmark tab Bookmark tab shows the registered jobs as bookmark.

Select Job Set the selected job in the tree or list to the virtual pendant.

Close Close the Job Browser.
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to selectively hide and display the sub window.

Sub window

Item Description

Contents

Display the contents of the selected job. The line of the Contents list can be 
selected. When set the job to the virtual pendant, the cursor is set to the 
selected line.
Double-click the line, the job can be set to the virtual pendant. (The cursor is 
set to the selected line.)

Job Info The job header of the selected job is displayed.

Name The name of selected job is displayed.

Comment The comment of selected job is displayed.

Date The date of selected job is displayed.

Group The control group of selected job is displayed.

StepNo The steps number of selected job is displayed.
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 Right-click menu

Right-click menu

Item Description

Set Selected Job to Root The selected job is set to the root of Job tree.
The current job tree is cleared.

Add to Bookmark / Remove 
from Bookmark

The selected job is added to (removed from) the Bookmark.

Job Data Update The selected job data is updated. The node is closed.

Contents Display/Hide the Contents window.

Job Info Display/Hide the Job Info window.

Expand The Job tree is expanded from the selected 
node.

Set Master Job to Root Set the master job set in the virtual pendant to the root of Job 
tree. If the master job is not set, The root of Job tree is not set.

During the expansion, the follow dialog box 
is displayed. Do not execute the playback.NOTE
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 Job Tree Tab
Display the hierarchy structure of jobs as tree structure. The target instructions are CALL JOB, 
JUMP JOB and PSTART JOB. The tree is displayed until eight-level. And the tree can be 
expanded. The root of tree is set the follow jobs.

• The selected job on the Job tree
• The selected job in the list (Search tab/Bookmark tab)
• Master job in the virtual pendant
• Current job in the virtual pendant

 Search Tab
Press the [Search] button, jobs in the virtual controller is searched and the appropriate jobs 
are displayed in the list. A keyboard search is available. When the text box is empty, All jobs 

Set Current Job to Root Set the current job set in the virtual pendant to the root of Job 
tree. If the current job is not set, The root of Job tree is not 
set.

Right-click menu

Item Description
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are displayed.

 Bookmark Tab
The selected job in the tree/list can be registered as bookmark.
It is useful for registering jobs with much reference number of times.
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8.17 Model Library

Model Library supports the model importing. Model Library dialog shows the preview of model 
registered with a library.
On the [Home] tab, in the [Model] group, click the [Model Library] button, the [Model Library] 
dialog appears.

8.17.1 Introduction

To import the model, drag and drop the model icon, or double-click the model icon. The type of 
model are "Work" and "Tool". It is different in the behavior when importing the model.
And, it's possible to add a model of a cell to the model library from the [CadTree] dialog.

Model Library

Category Changes the category of the models.

Edit Edits the information of model (e.g. arrangement information) 
registered with the model library.
For details, refer to section " 8.17.7  Edit Model of Model 
Library ".

Del Deletes the model from the model library.
For details, refer to section " 8.17.8  Delete Model of Model 
Library ".

When the model icon is dragged to the cell screen, the model in the mouse location is 
highlighted. For highlighting object, refer to section " 6.4  Pick Settings ".

 

SUPPLE
-MENT
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8.17.2 Model Import (Work Type)

The model of peripheral equipment (e.g. Work, work table, controller and etc.) becomes "Work 
Type". When the model icon is dragged and dropped, the model is added at the highlighted 
position in the mouse location. And, the highlighted model becomes the parent model (in an 
exceptional case, when the FLOOR is highlighted, "world" becomes the parent model).?When 
the model icon is double-clicked, the model is added at the origin of world coordinates.

Procedure
1. Drag and drop the model.

2. When the FLOOR is highlighted, the parent model is "world".

3. Drag and drop the new model on the added model.
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4. The new model is added and the selected becomes the parent model. 

8.17.3 Model Import (Tool Type)

The model of tool (e.g. torch, servo gun and etc.) becomes "Tool Type". When the "Tool Type" 
model is dragged and dropped to the robot, the model is added at flange or TCP automati-
cally. When the model icon is double-clicked, the tool model is added to the first robot of the 
cell.
And, when the "Tool Type" model is imported, the tool setting dialog is displayed. When the 
tool number is selected, the tool data registered with the model library is reflected to the con-
troller.

Procedure
1. Drag and drop the model icon at the robot.
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2. Tool setting dialog appears. When select the tool number and press the [OK] button, 
the tool data is reflected to the controller. When press the [Cancel] button, the tool data 
is not reflected.

3. The tool model is displayed. When the tool data is set, TCP flame moves to the tip of 
tool.

Tool data setting dialog

Tool Selects the tool number.

ToolData The tool data of model is displayed.

OK The tool data is reflected to the selected number.

Cancel The tool data is not reflected.

When importing a model in which more than one tool data is registered, the setting dialog 
is displayed as many times as the number of tool data registered.

    

SUPPLE
-MENT
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8.17.4 Model Script Data Import

If model script data is attached to the model data when importing from the model library, Moto-
Sim EG-VRC imports the model script. 

The imported model script is changed and saved as follows depending on the situation.

8.17.5 Add the model to the model library

The model of cell can be added to the model library.?Select the model in the [CadTree] dialog, 
display the right-click menu and select the [Add ModelLibrary...].
The image of the model library is automatically created with the current state of the target 
model. You can save the image by setecting the [Add ModelLibrary…] after adjusting the 
viewpoint.

Example:
1. Adjust viewpoint.

Situation Edited contents

Contains controller name Controller name is changed to the name of the target controller.

Script name with the 
same name exists

"_<n>" (n is a sequential number from 1) is added to the current script 
name and it is set to a name which does not duplicate.
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2.  When registering to the model library, the image of the target model is automatically 
created with the current viewpoint.

Some models, such as the following items, may remaine in the image.
Please disable these items before using this function.
• Operation Handle
• Cutting Plane
• CAM Function
• Cable Simulation
• Position Panel (Work Angles)
• Memo, MarkUp
• Model Name

 

NOTE
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Add Model Library

Category Selects the model category.
When the category does not exist, the new model category 
can be made by inputting directly.

Name Selects the model name displayed on the model library.

Create Folder Displays the model library folder creation dialog.

Layout Sets the model layout data. When there is the origin point of 
the model in a center, please input the data. (e.g. BOX model)
Layout data is used as the value of the offset. The model is 
located at the offset position from the mouse pick position.

Type Chooses the type, "WORK" or "TOOL".
It is different in the behavior when importing the model. For 
details, refer to section "8.16.2 Model Import (Work Type)" 
and "8.16.3 Model Import (Tool Type)".

FLANGE / TCP Selects which is the parent model, a flange of a robot or TCP.
When the model origin point is on the foundation side of the 
tool, choose "FLANGE". When it is on the tip of tool, choose 
"TCP".

ToolData Sets the tool data. This values are reflected to the controller 
when the model is imported. When the parent of the model is 
a flange of a robot or TCP, MotoSim EG-VRC judges as the 
"TOOL" type and the No.0 tool data of the controller is dis-
played.
If you click on the list, the tool data corresponding to the tool 
number is displayed.

367/847



8.17  Model Library

HW0485348

 

    Add Adds tool data. When the [Add] button is clicked, the select 
tool dialog box is displayed. 

Select the tool number to want to add and press the [OK] but-
ton, the tool number is added to the list. Up to 8 tool data can 
be added.

    Del Deletes tool data. When [Del] button is clicked, the tool data 
selected in the list is deleted.

Get ToolData When the parent of the model is a flange of a robot or TCP, 
this button is enable.
When the button is pressed, tool number select dialog is dis-
played. When select the tool number, the tool data of selected 
number is set to the ToolData.

Export Model script When there is a model script that uses the model to be regis-
tered, also save the script in the model library folder.

Tool Number Select Dialog

Tool Selects the tool number of the controller.

ToolData The tool data of selected number is displayed.

OK Tool data is reflected to the Add Model Library dialog.

Cancel Tool data is not reflected and this dialog is closed.

Add Model Library
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Each folder in the model library folder is divided into subfolders and content folders.
Subfolder .... Folder without model library data
Content folder .... Folder where model library data is stored

Create model library folder

Selected path The folder path of the model library selected on the tree 
is displayed.

Add The folder name input dialog is displayed, and a new 
subfolder is added under the folder selected in the tree.

Remove Deletes the folder selected in the tree.

Rename The folder name input dialog is displayed, and the name 
of the folder selected in the tree is changed.

Move parent The dialog for selecting the destination of the folder is 
displayed, and the folder selected on the tree is moved 
under the selected folder.

Close Closes the create model library folder dialog.
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By arranging subfolders according to the purpose, the model library data can be organized as 
in the example below.
e.g.)
  Conveyor/
      |--Type-A/
      |     |--CV_123/
      |          |--ITEM.bmp
      |          |--ITEM.ini
      |          |--Controller_DX200_MediumLarge.hsf
      |
      |--Type-B/
      |     |--CV_456/
      |          |--ITEM.bmp
      |          |--ITEM.ini
      |          |--Controller_YRC1000_MediumSmall.hsf

Hierarchical model library folders are hierarchically displayed in the combo box on the model 
library screen as follows.

Procedure
1. Selects the target model from [CadTree] dialog.

• One Model
Selects the target model in the state "open".

• Multi Models

 

Target model：WORK only 
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Selects the target model in the state "close". All child models are included.

2.  Displays the right-click menu on the [CadTree] dialog and select the [Add ModelLi-
brary...]. 

3. Sets the Category, Name, Layout and Type on the [Add ModelLibrary] dialog and 
presses the [OK] button.

4. Added model is displayed on the Model Library. The model icon is "NO IMAGE".

5. Adds the model icon image. Saves an icon picture of the bitmap file format in a <Model 
Name> folder of ModelLibrary. The file name is made ITEM.bmp. For location of Mod-

 

Target model：DAI and all child models 
WORK and AXIS 
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elLibrary folder, refer to the section " 1.7  Folder Configuration ".

6. When Model Library dialog is refreshed, the new model icon is displayed.

8.17.6 Model Script Output

When the "Export Model script" check box on the model library registration dialog is checked, 
model script containing the target model name is output.

When MOV, DUP, REF, and DEL commands are included in the output model script, a confir-
mation dialog as to whether to exclude or include these commands is displayed. Please select 
one.

When the output target model is a model that does not belong to the controller, such as con-
veyor or pallet, model scripts are searched for all controllers in the current cell and outputs 
model script data with output target model name specified.
When the output target model name is used for the model script of multiple controllers, the 

 MotoSim EG-VRC 

ModelLibrary 

<Category> Folder 

<Model Name> Folder 

ITEM.ini 

ITEM.bmp 

Model File 
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selection dialog of the target controller is displayed, so select the appropriate controller.
As described in Procedure 1, Multi Models, in " 8.17.5  Add the model to the model library ", 
you can register multiple models, but if the model to be registered has a parent-child relation-
ship and the model script is set only for the child model, the model script cannnot be output. 

8.17.7 Edit Model of Model Library

Selects the model icon and press the [Edit] button, the model data can be edited.
For detail of the edit dialog, refer to " 8.17.5  Add the model to the model library ".

8.17.8 Delete Model of Model Library

Selects the model icon and press the [Del] button, the model data can be deleted.

This operation cannot be undone.

  

   

NOTE
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8.17.9 Export the Model of Model Library to Other PC

The model of model library can be used on other PC.
The model of model library is managed the following <Model Name> Folder. 

When <Model Name> folder of one PC is copied to <Category> folder of other PC, the model 
can be used on the other PC. For the location of [ModelLibrary] folder, refer to " 1.7  Folder 
Configuration ".

8.17.10 Way to Use Model Library on Local Area Network

To create the model library folder on the local area network (LAN), models are shared by mul-
tiple PC.

Click the MotoSim EG-VRC button (  ), and select the [Option] menu. Option Setting dia-
logbox is displayed. Select the "Other" tab of the Option dialog box. Input the model library 
folder path in the "Library Path" edit box of "Model Library".

 MotoSim EG-VRC 

ModelLibrary 

<Category> Folder 

<Model Name> Folder 

 

ModelLibrary 

 

 

サーバーPC ServerPC 

NetWork 
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8.18 Simple PP

Simple PP dialog is the simple version of virtual pendant for teaching and playback.
On the [Controller] tab, in the [Job] group, click the [SimplePP] button, the [Simple PP] dialog 
appears.

 Main Display

In a cell with multiple controllers, it is necessary to select the controller to edit with the rib-
bon   before operating the Simple PP dialog box.

TEACH/PLAY button Changes the mode (TEACH / PLAY) of the controller.

NOTE

 

 

Refresh button 

Job Select button 

Displays selected motion 
type and speed to be  
added or modified. 

Controller name 

Job name and Control 
Group 

Tool number of the 
cursor line. 

Set the book mark 
or break point. 

SYNC check box 

Job Contents panel 
When click the right 
button, right-button 
menu is displayed. 
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START button Starts the playback. This button is highlighted during 
playback.

HOLD button Interrupts the playback.

SERVO button Turns the servo ON. This button is highlighted while 
servo power is ON.

Alarm button Resets the alarms. This button is highlighted while 
alarms occur.

Job Stack Display the Call Stack display.
For details, please refer to the section " Fig. 10.4)  Job 
Stack ".

Job Select button When click this button or press the [ALT] + [W] key, dis-
plays the Job Select dialog.
For details, refer to the section " 8.18.1  Job Select ".

Refresh button When the job is edited on the virtual pendant, click this 
button to refresh the job contents.

New button Displays the Job Create dialog.
For details, refer to the section " 8.18.2  Job Create ".

Copy button Displays the Job Copy dialog.
For details, refer to the section " 8.18.3  Job Copy ".

Delete button Displays the Job Delete dialog.
For details, refer to the section " 8.18.4  Job Delete ".
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Job Contents panel The robot moves to the step selected in the job contents 
panel if the [SYNC] check box (  ) is selected. 
When the cursor is on the CALL JOB: or JOMP JOB: 
instruction, and press the [Alt] + [Down] key, the called 
job is displayed.?When press the [Alt] + [Up] key, the 
previous job is displayed.Job Edit dialog box appears by 
double-clicking the selected job.

[Job Edit]
Modify the instruction in the edit box. Select either the 
[Add Line] or [Replace Line] button.

Add Line: Adds the new instruction under the cursor 
line.
Replace Line: Replaces the instruction of the cursor 
line.

Move button Displays the Interpolation dialog box. Please refer to the 
section " 8.18.12  Interpolation Setting ".

Add button Adds the new move instruction under the cursor line.
And, same operation is available with operation handle. 
Please refer to the section " 8.18.8  Teaching with Oper-
ation Handle ". 

Mod button Replaces the teaching position of the cursor line to cur-
rent position.

Del button Deletes the cursor line.

VPP button Displays the virtual pendant if the virtual pendant is not 
shown.
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 Right-button menu

Search Display the Search dialog. (Short cut key: [Ctrl] + [F])

Cut Selected area is cut. (Short cut key: [Ctrl] + [X])

Copy Selected area is copied. (Short cut key: [Ctrl] + [C])

Paste Cut area or copied area is pasted. (Short cut key: [Ctrl] 
+ [V])

Reverse Paste Cut area or copied area is pasted in reverse.
(Short cut key: [Ctrl] + [Shift] + [V])

Delete Selected area is deleted. (Short cut key: [Delete])

Replace Inform Informs of the selected area are replaced.
For details, please refer to the section " 8.18.7  Replace 
Inform ".

Set Default Inform Changes the content of the "Interpolation method" used 
by adding instructions as the contents of the selected 
line.

Setting BreakPoint Set/Delete the break point to the selected line. (Short 
cut key: [F9])
For details, please refer to the section " 10  Debug 
Function ".

Del All BreakPoint Delete all break point of the target controller.
For details, please refer to the section " 10  Debug 
Function ".

Disable All BreakPoint Disable all break point of the target controller.
For details, please refer to the section " 10  Debug 
Function ".

Enable All BreakPoint Enable all break point of the target controller.
For details, please refer to the section " 10  Debug 
Function ".

TeachPoint Tool Creates a teach point model and update or add steps 
from the teach point model.
For details, please refer to  " 8.18.10  Making Teach-
Point Model " or " 8.18.11  Create the Job from Teach-
Point Model ".

Shortcut List Display the shortcut list dialog.
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8.18.1 Job Select

Selects a job from job list, the job is displayed on the Simple PP dialog box.

Search A keyword search is available.
In the above dialog, input the "SE" on the edit box and 
click the [Search] button, "RESET-R1" and "H_CLOSE" 
is displayed on the job list. When the edit box is empty, 
All jobs are displayed.

Job list Select a job in this list to set to the simple PP dialog.

Preview Enable When enabled, the contents of the selected job is dis-
played.

OK button Sets the selected job to the simple PP dialog.

Cancel button Closes this dialog without job selection.

 

Job list 

When the job is not selected and check this 
item, the following message is displayed.NOTE
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8.18.2 Job Create

Creates a new job and displays on the simple PP dialog.

8.18.3 Job Copy

Copies the selected job and displays the new job on the simple PP dialog.

Job Name Inputs the job name.

Comment Inputs the comment of the job.

Control Group Select the control group from drop down list box.

OK button Creates the new job and displays on the simple PP dia-
log.

Cancel button Closes this dialog without creating a job.

 

Job list 
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8.18.4 Job Delete

Deletes the selected job.

Search A keyword search is available.
In the above dialog, input the "SE" on the edit box and 
click the [Search] button, "RESET-R1" and "H_CLOSE" 
is displayed on the job list. When the edit box is empty, 
All jobs are displayed.

Job list Select a job in this list to be copied.

New Name Inputs the new job name.

Preview Enable When enabled, the contents of the selected job is dis-
played.

OK button Copies the selected job and displays the new job on the 
simple PP dialog.

Cancel button Closes this dialog without copying a job.

When the job is not selected and check this 
item, the following message is displayed.NOTE
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Search A keyword search is available.
In the above dialog, input the "SE" on the edit box and 
click the [Search] button, "RESET-R1" and "H_CLOSE" 
is displayed on the job list. When the edit box is empty, 
All jobs are displayed.

Job list Select a job in this list to be deleted.

Preview Enable When enabled, the contents of the selected job is dis-
played.

OK button Deletes the selected job.

Cancel button Closes this dialog without deleting a job.

1.When the job is not selected and check this 
   item, the following message is displayed.

2.When the multiple jobs are selected and 
check this item, the following message is dis-
played.

NOTE
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8.18.5 Search

Search the keyword in the job.
When the cursor in the job contents panel, select the "Search" in the right-button menu or 
press the [Ctrl] key and [F] key, Search dialog is displayed.
When the cursor in the job contents panel and press the [F3] key, forward search is available. 
And press the [Shift] + [F3] key, back search is available.

8.18.6 Job Edit

When the line is selected and double-click or press the [Space] button, Job Edit dialog box is 
displayed. Modify the instruction in the edit box and select either the [Add Line] button or 
[Replace Line] button

Find what Inputs a keyword.

[Match case] check box When this is enabled, the large character is separated 
from the small character.

[Find Next] button The keyword is searched from current cursor position.

[Cancel] button This dialog is closed.

[Add Line] button Adds the new instruction under the cursor line. (Short 
cut key: [Shift] + [Enter] key)

[Replace Line] button Replaces the instruction of the cursor line. When the 
instruction of the cursor line is move instruction, teach-
ing point is not changed.
(Short cut key: [Enter] key)

[Cancel] button Close this display.
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8.18.7 Replace Inform

Informs of the selected area are replaced to the [Move] instruction.
When the lines are selected, select the "Replace Inform" in the right-button menu.

8.18.8 Teaching with Operation Handle

When the Simple PP and TCP handle of operation handle are displayed and double-click the 
TCP handle with pressing [Ctrl] key, teaching point is added. The instruction of Simple PP is 
reflected.
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8.18.9 Book Mark

Sets the book mark to the selected line. And, Jump to the book mark in the book mark dialog.
When the line is selected and press the [Ctrl] + [M] key, set/delete the book mark.

Press the [Ctrl] + [Shift] + [M] key, the book mark dialog is displayed.

Controller Select the controller to display the book mark.

Bookmark List When double-click the bookmark, the job and current 
line of simple PP and virtual pendant are changed to the 
book mark.
When double-click the Comment area, Set the Com-
ment to the bookmark.

[Delete] button Delete the selected book mark.

[Delete All] button Delete all book marks.
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8.18.10 Making TeachPoint Model

Create an AXIS6 model showing the teaching point position of each selected line of the job 
display area.
Select "Make TeachPoint Model" in the right-click menu in the job display area.

Select the parent model to register the teach point model.

Set the name of the teach point model to be created.

• Only the teaching points of the robot axis are target to create the teaching point model.
• The teaching points of the traveling axis and the station axis are out of the target of cre-

ating the teaching point model.

NOTE
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A teach point model is created and registered in CadTree.

 Create TeachPoint Model from Cooperative Job
After selecting the parent model, the selection dialog of the robot that creates the teaching 
point model is displayed.

When to create the teaching model, select "Yes". If not, select "No".
When select "Cancel", processing is aborted.

 

AXIS6 model 

AXIS6 model 
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8.18.11 Create the Job from TeachPoint Model

Based on the coordinate information of the registered teaching point model, the following two 
operations are possible.

1. Update arbitrary step of job from teach point model
2. Add the teach point from teach point model to arbitrary line of the job

 Update Step from TeachPoint Model
Select the step to update on the simple PP dialog and select [Teach point tool] - [Step update 
from teach point model] from the popup menu.

Since the teach point model selection dialog is displayed, select the teach point model to 
reflect.
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Select the inverse convert parameter to reflect the teaching point of the selected teach point 
model.

After confirming the inverse convert parameter, the teaching point information of the teach 
point model is reflected in the selected step.  And, the tool number of the selected step reflects 
the source tool number.

When the teaching points registered from the teach point model are out of the range of the 
robot, the "#ER" comment tag is added as shown below and it is displayed in red.

In the step that could not be reflected, the previous position information is retained.

 Add Step from TeachPoint Model
Select the step to add on the simple PP dialog and select [TeachPoint tool] - [Add step from 

• Model cannot be selected that does not include a teach point model or includes two or 
more teach point models.

• It cannot be selected if the number of teaching points selected for the teach point model 
is different from the number of steps selected by simple PP.

NOTE
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TeachPoint Model] from the popup menu.

Since the teach point model selection dialog is displayed, select the teach point model to 
reflect.

Select the inverse convert parameter to reflect the teaching point of the selected teach point 
model.

After confirming the inverse convert parameter, the teaching point information of the teach 

Model cannot be selected that does not include a teach point model or includes two or 
more teach point models.

 

NOTE
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point model is additionally inserted into the line after the selected line.

Instructions set in the Move field of simple PP are added for instructions to be additionally 
inserted.

 Update Job or Add Line for Cooperative Job
In step update job or addition line from teach point model to cooperative job, it is possible to 
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select whether to update (or add) for each robot targeted by the job.

Before teach point model selection, a confirmation dialog is displayed asking whether to 
reflect teach points for each robot.

When to reflect, select "Yes". If not, select "No".
When select "Cancel", processing is aborted.

As for the robot that selected "No", the step is updated (or additionally inserted) at the current 
position of the robot.
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8.18.12 Interpolation Setting

When [Move] button is clicked, the Interpolation Setting dialog is displayed.

Interpolation Displays a sample list of interpolation instructions for a 
job opened with simple PP.

Text Data Sets the content of the "Interpolation method" used by 
adding instructions. It is possible to rewrite speed tags, 
moving tag and etc. based on the template selected by 
interpolation selection. 

OK button Replaces the content of the "Interpolation method" used 
by adding instructions to the contents of "Text Data" and 
this dialog is closed.

Cancel button The content of the "Interpolation method" used by add-
ing instructions is not replaced and this dialog is closed.

• NS4.69-A5 Controller is not supported.
• Six types of interpolation instructions can be 

used: standard instruction, cooperative 
instruction, + MOV, EIMOV, SYMOV, and 
SVSPOTMOV.

• It is not supported for jobs of three or more 
robots.

• In cooperative jobs with two robots, interpola-
tion instructions including EIMOV can not be 
selected.

NOTE
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8.19 JobPad

JobPad shows the saved jobs from VRC and these job can be edited. the edited job can be 
loaded to VRC.
On the [Controller] tab, in the [Job] group, click the [JobPad] button. The [JobPad] dialog 
appears.

 Main Window

The displayed format is the text data saved in ex. memory. So, this format is different from 
that of virtual pendant and real pendant.

[New] button To create a new job, the [Job Crate] dialog is displayed.

[Open] button To select a job, the [Select Job] dialog is displayed.

[Check] button The displayed job is checked to load to VRC.

[Setting] button The [JobPad Setting] setting dialog is displayed.

NOTE
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 Job Create
When the [Create] button is clicked, the [Job Crate] dialog is displayed.

[Save] button The displayed job is loaded to VRC.

[Full Mode] check box To show the area before "NOP", turns this check box 
enabled.

[Show Log] check box To display the result of checking or loading, turns this 
check box enabled. The log area is displayed automati-
cally when click the [Check] button or [Save] button.

Controller Selects the VRC controller from drop down list.

Job Name Inputs the new job name.

Comment Inputs the comment of job.

Control Group Select the control group from drop down list.

[OK] button Create the new job and this dialog is closed.

[Cancel] button This dialog is closed.

Use only the character which can be input by a 
software keyboard for job name.

NOTE
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 Select Job
When the [Open] button is clicked, the [Select Job] dialog is displayed.

Controller Selects the VRC controller from drop down list.

Search Click the [Search] button after inputting the keyword, 
The job names including the keyword are displayed on 
the list.
When the edit box is empty, all job names are displayed.

Preview Enable When enabled, the contents of the selected job is dis-
played.

[OK] button Open the selected jobs and this dialog is closed. Multi-
ple jobs can be opened.

[Cancel] button This dialog is closed.

When the job is not selected and check this 
item, the following message is displayed.NOTE
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 Find
Press the [Ctrl] + [F] key of the keyboard when the cursor is in the job contents area of main 
window, the [Find] dialog is displayed. Keyword search is available.

 Replace
Press the [Ctrl] + [H] key of the keyboard when the cursor is in the job contents area of main 
window, the [Replace] dialog is displayed. Keyword replacing is available.

Find what Inputs a keyword.

[Match case] check box When this is enabled, the large character is separated 
from the small character.

[Find Next] button The keyword is searched from current cursor position.

[Cancel] button This dialog is closed.

Find what Inputs a target keyword.

Replace with Input a replacing keyword.

[Find Next] button The keyword is searched from current cursor position.

Replace The selected keyword is replaced and next keyword is 
searched from current cursor position.

Replace All All target keyword are replaced.

[Match case] check box When this is enabled, the large character is separated 
from the small character.

[Cancel] button This dialog is closed.
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 Error String
When double-click the line of the log window, string around the error occurrence part is 
reversed.
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 Input Support
To use the input support, job can be created easier. When input the initial character of instruc-
tion, the candidates are displayed on the popup list.

• Input support is case-sensitive.
• The candidates display depends on the language level of the virtual controller.
• About the structured language, the candidates (AND or OR) after the conditional state-

ment is not available.
• About the structured language, the candidates of the conditional statement is not avail-

able.
• The displayed format is the text data saved in ex. memory. So, WHILE, IFTHEN, AND 

and OR are displayed as WHILEEXP, IFTHENEXP, ANDEXP and OREXP by 
YRC1000, YRC1000micro, DX200 controller.

• The candidates after the EXPRESS of SET instruction is not available.
• ON/OFF and CONSTANT is not displayed.

NOTE

 

 
 

 

When input the “C”, the instruction 
started “C” is displayed. 

When input “CALL” and press the 
[Space] key, The candidates 
after “CALL” is displayed. 
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 Moultiple Jobs Editing
In the JobPad, multiple jobs can be opened to edit.
When the [Open] button is clicked the [Select job] dialog is displayed.

When multiple jobs are opened, displayed job is changed with the tab.

When job is closed, click the [x] button on the tab.
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 Setting
To make it easy for an analysis of a job, it's possible to change the font and change the color 
of the instruction.

To pick a keyword out by a space end, coloring is as follows.
    MOVJ C0001 EC0001 VJ=5.00  
    MOVJ C0001 EC0001 VJ=5.00  
A comment line is one color.
String of the log window is not colored.

Color Definition Defines the color. Sets the standard setting and detail 
setting use this definition.

Standard Setting Defines the font, back color and comment color used in 
standard.
Keyword not defined in the detail setting is used this set-
ting.

NOTE
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Detail Setting Defines the color each keyword.
On the Detail Setting, the color of multiple Inst/Tag can 
be changed at once.
Selects the item of Inst/Tag to change color with [Ctrl] 
key and mouse click.

Click the [Edit] button, and change the color on the 
Detail Setting dialog.
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 Check unsaved jobs
After editing the job, When close the Jobpad without saving with the [Save] button, the follow-
ing confirmation message is displayed.

When there are multiple jobs that have not been saved, multiple confirmation messages are 
displayed. The Job Pad is finished only when press all [OK] button only. When press [Cancel] 
button, the display of the Job Pad is maintained and you can perform the save operation by 
pressing the [Save] button.
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8.20 Layout Robot Function

The Layout Robot function automatically searches the robot position where the cycle time is 
minimalized.
On the [Tool] tab, in the [Teaching Assistance] group, click the [Layout Robot] button, Layout 
robot Dialog is displayed.

• This function does not support jobs using position type variables.
• This function is VRC controller function only.
• This function is one robot system only.
• This function is not supported to the mechanical mirror robot.

Job Select list box Selects the job to consider the placement.

Placement Consideration 
Result Display list

Valid placements are displayed in ascending order of 
cycle time.

NOTE
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 Placement Consideration
When press the start button, robot placement consideration starts. 
As shown in the figure below, the placement change and playback of the robot are repeated, 
and the results are displayed in the Placement Consideration Result Display list.

X Sets the X direction of the search range of the world 
coordinates. Search is executed in plus and minus 
direction of the specified value from the current position 
of the robot.

Y Sets the Y direction of the search range of the world 
coordinates. Search is executed in plus and minus 
direction of the specified value from the current position 
of the robot.

Z Sets the Z direction of the search range of the world 
coordinates. Search is executed in plus and minus 
direction of the specified value from the current position 
of the robot.

Grid Sets the pitch to execute a search.

Update monitor check box When enabled, robot is moved at the time of playback.
When disabled, placement consideration is possible in 
high speed.

Rough search by rough 
moving time

When planning layout, the moving time is calculated by 
simple calculation instead of playback.
When the following dialog is displayed, simple calcula-
tion cannot be used. (e.g. CALL JOB instruction) In this 
case, please turn off the check.  

When the check is turned on, the displayed travel time 
is approximate. After change layout, please play back 
and check it.

Start button When clicked, the placement consideration is started.

Stop button When clicked, the placement consideration is stopped.

OK button When clicked, the robot is moved to the selected place-
ment in the Placement Consideration Result Display list, 
and the selected job is shifted.

Close button When clicked, the layout robot dialog is closed.
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Valid placements are displayed in ascending order of cycle time.
When an alarm occurs during the play back, without the display in the Placement Consider-
ation Result Display list, consideration the following placement will start.

 Application of the Placement
When select a line of Placement Consideration Result Display list, the robot will move to the 
position. When click the [OK] button, confirm the position of the robot.

     

The arrangement is changed, 
robot goes through the same 
teaching points. 
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8.21 Cable Simulation

This function is a function to simulate the cable by registering cables in the cell.

 RESTRICTION
• In teach mode, move robot only with VPP JOG operation. (OLP, position panel, operation 

handle, and job synchronization, etc. cannot be used. Because this function simulates 
inertia and centrifugal force, the function that the robot moves momentarily cannot be 
used.)

• When the cable simulation is started, the cable is displayed at the position when the cable 
is registered. If connected to the robot, the robot will be in position when registering the 
cable.

• The model to be subjected to cable simulation is the model displayed on the screen at the 
start of cable simulation. After the simulation is started, models that have been edited 
(added, deleted, switched hide / see, etc.) are not reflected in the cable simulation. If edit-
ing is done, please disable the cable simulation once and then re-enable it.

• If the robot is replaced after cable registration, the arrangement of registered cables will 
not be changed. Please re-register the cable.

• When the robot moves at high speed, the cable may penetrate other models. Please 
adjust interpolation granularity.

• This function cannot be used simultaneously with online function.
• Cable model cannot be subjected to collision detection.
• 3DPDF and AVI output cannot be performed during cable simulation.

8.21.1 Start Cable Simulation

To start cable simulation, on the [Simulation] tab, in the [Cable Simulation] group, click the 
[Enable] button. When the [Enable] button is clicked, the button changes [Disable] button.

• This function does not guarantee the same behavior as the actual cable because it can-
not completely reproduce the characteristics and bending tendency of the actual cable 
with physical parameters. This function is only a guide.

• The cable deterioration due to friction cannot be simulated.
• It is not possible to simulate the load on the robot due to cable entrainment, etc.
• The disconnection detection function detects as a disconnection when it extends from 

the length of the initial cable over the threshold value. Disconnection detection due to 
other factors such as pinching is not carried out.

• This function is very computationally expensive, so the operation of MotoSim EG - VRC 
will be slow.

NOTE
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8.21.2 End Cable Simulation

To end cable simulation, on the [Simulation] tab, in the [Cable Simulation] group, click the [Dis-
able] button. When the [Disable] button is clicked, the button changes [Enable] button.

8.21.3 Cable Setting

On the [Simulation] tab, in the [Cable Simulation] group, click the [Cable Setting] button to dis-
play setting dialog.

Refresh of teaching Sets screen update interval during cable simulation 
except during playback.

Disconnect If the amount of misalignment between the joints of the 
cable exceeds the input value, it is judged to be broken.

Interpolation granularity Sets the number of calculations performed during 
screen update.
The higher the number of times, the higher the simula-
tion accuracy, but the slower the operation.

Cable list The registered cable list is displayed. By checking the 
check box, it becomes the cable subject to cable simula-
tion.
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 Cable Registration
Procedure

1. Click the [Add] button on the setting dialog.
2. "Make Cable" dialog and operation handle is displayed.

Add A new cable is registered.

Edit The selected cable is edited.

Delete The selected cable is deleted.

Close This dialog is closed.

 

Operation Handle 
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3. Operate the operation handle to create a section of the cable.

Double-click on the mouse to add a joint of the cable.
When dragging the operation handle, the distance and angle from the previous joint 
are displayed. Joint registration is possible when the display is white letters, but joint 
registration is not possible if the display is red.

        
 

 

Drag the operation 
handle to move. 

Double-click the 
operation handle. 

[Possible]            [Impossible] 
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4. It is also possible to change the position of the created joint by operating the operation 
handle.

5. The joint can be deleted by operating the operation handle.

6. Sets the items of "Make Cable" dialog.

When registering cables, please be sure not to cross with other models.

Name It is automatically entered.

Relation Robot At the start of cable simulation, move the robot's posi-
tion to the posture of cable registration. Be sure to 
check this when the cable is connected to the robot.

Controller To specify the target robot, select the controller name.

Robot To identify the target robot, select the robot name. 

Radius Enter the radius of the cable.

              

 

 

When click near the joint to 
edit, the operation handle 
moves. 

ALT key + drag moves 
the joint. 

         

 

When click near the joint 
to delete, the operation 
handle moves. 

When right-clicking on the handle, 
the “Delete” menu is displayed,  
and click that menu. 

NOTE
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7. When click the [OK] button, cable registration is completed.

Limit length of joint Sets the maximum pitch between cable joints.
When operating operation handle and operation handle 
moves over this pitch, characters are displayed in red.

Swing span of joint Sets the maximum joint angle between cable joints.
When operating operation handle and operation handle 
moves over this angle, characters are displayed in red.

Twist Span Sets the angle of the maximum articulation twist direc-
tion between cable joints.

Mass Sets the weight of cable per one meter. (Units: kg)

Softness Sets the softness of the cable.

Linear Damping Sets the attenuation value of translational motion.

Angular Damping Sets the attenuation value of the rotary motion.

Start Model Name Sets the model name of the starting point to which the 
cable is connected. Click the [GET] button to set the 
current model of the CadTree dialog.

End Model Name Sets the model name of the end point to which the cable 
is connected. Click the [GET] button to set the current 
model of the CadTree dialog.

Length of Cable The length of the cable is displayed.

Color Sets the cable color during cable simulation.
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8. After cable registration, when enable cable simulation, the cable will be displayed.

 Cable Editing
Procedure

1. On the "Setting" dialog, select the cable to edit from the cable list.
2. Click the [Edit] button.
3. After clicking the [Edit] button, it will be the same operation as registration.

 Cable Deleting
Procedure

1. On the "Setting" dialog, select the cable to delete from the cable list.
1. Click the [Delete] button.
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 Enable/Disable the Simulation of Cable
At the start of the cable simulation, set the simulation target.

Procedure
When checking cable of the list box on the setting dialog, it will be subject to simulation. When 
unchecking cable, it will be out of simulation.
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8.22 Path Planning

This function is to automatically generate a path that avoids work and obstacles between two 
teach points.
On the [Tool] tab, in the [Teaching Assistance] group, click the [Path Planning] button, the 
[Create Paths] dialog is displayed.

 RESTRICTION
• The supported controllers are YRC 1000, YRC 1000micro, DX 200 and FS 100.
• Only one robot configuration per controller is supported. It does not correspond to the 

configuration with the traveling axis or the station axis.
• Only 6 axis robots are supported.
• If there is a CALL or JUMP instruction between the start and end points of the planning, 

the teaching point at the called job is out of planning.

• This function performs random search.
• Different paths are generated each time it is executed.
• The path obtained by this function is not an optimal solution.

• When using the generated path on the actual machine, please play back with MotoSim 
EG-VRC beforehand to confirm that there is no problem.

• Under the following circumstances, paths that do not avoid interfering objects may be 
generated.

• Works including thin-shaped models may slip through.
• Because it does not consider internal turning, it may interfere during play-

back.
By using the simplified model creation function, it is possible to generate a 
path to automatically avoid work and obstacles. For details of the simpli-
fied model creation function, refer to " 11.17  Creating Simplified Model ".

• When interpolation is performed with MOVL, when play back the generated job, the seg-
ment over alarm may be generated.

• 

NOTE
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 Main Dialog

 Procedure
This explains the procedure to do path planning.
Various setting items can be changed by option setting. (" 8.22.1  Option Setting ")
(Path generation can also be performed with the default value)

1. Prepare a cell with a robot and interfering objects and, a job (e.g. TEST) having two 
teaching points, the start point and the end point.

2. Add PPF # (1) to the line comment of the move instruction is the start point of path gen-

Controller Select the controller registered in the cell.

Job List The list of jobs registered in the controller is displayed.

Options Change the path generation setting (PPF).
For details, refer to " 8.22.1  Option Setting ".

Generate Path(s) Execute path generation.

Close Close the dialog.
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eration.
• Multiple paths can be specified.
• It is also possible to change the type of setting (PPF) to be used for each start point 

where path generation is performed.

3. In order to perform efficient collision check in path planning, enable collision model 
group and collision pair setting for robot and work subject to collision check in advance. 
For details, refer to " 8.11  Collision Detection ".

4. Open the [Create Paths] dialog, select the job, and click the [Generate Path(s)] button.

While executing path generation, the following result display dialog is displayed. In 
addition to checking the time required for path creation, it is also possible to abort plan-
ning by clicking the [Abort] button.

Abort Interrupt path generation at that point in the middle.
After the path generation is completed, it changes to "Close" button.
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5. When the path generation is completed, a job is created in which a teaching point for 
avoiding interfering objects is added as follows.
(Refer to " 8.10.3  Visual Path Edit Function " for details to show the trajectory).

The generated job will be named PPEG_yyyymmdd_hhmmss.
6. f the path generation fails, "NG" is added next to the line comment PPF # (number) of 

the job.
If the situation is as follows, a message is displayed in the result display dialog.

 

When multiple search paths 
exist, average value is displayed 

In the final result, display the 
average value of individual results 
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In that case, review the settings and generate the path again.
• Failed to generate the path
• The start point or end point interferes with the work

(If both the start point and the end point interfere with work, a message indicating 
that the start point is interfering is displayed)

• When using search range limitation to be described later, the start point or end point 
is outside the set range
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8.22.1 Option Setting

 Setting Option(s) dialog

PPF list The list of PPF # (numbers) registered in the controller is displayed.
If select one from the list and double-click it, the path planning 
options dialog is displayed.

Edit Select one from the PPF list and open the path planning options 
dialog.

Add Add a new PPF # (number) with the default value and open the path 
planning options dialog so that items can be edited.

Delete Deletes the PPF # (number) selected from the PPF list.

Copy Copy the contents of the selected PPF # (number) from the PPF list 
and open the path planning options dialog so that items can be 
edited.

Close This dialog is closed.
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 Path Planning Options dialog

(1)PPF name The name of the PPF currently being set is displayed.

(2)Comment Arbitrary comments can be set, such as the purpose of setting 
contents.
The comment is displayed on the Setting Option(s) dialog.

(3)Num of Paths Specify how many paths are searched as the condition for fin-
ishing path creation.

(4)Time Specify how many seconds to search as the end condition of 
path generation.

 

(1) 

(3) 
(4) 

(5) 
(6) 

(2) 

(7) 
(8) 

(9) 

(10

If no path has been found when the specified time has 
elapsed, the search will be done until one is found.

NOTE
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(5)Path Select Indi-
cator

From the multiple paths found, specify the criteria for selecting 
which path to select. Select from the following three items.
[Minimum cycle time]:

When operating at 90% of the maximum speed of each axis 
of the robot, a path that minimizes cycle time is selected.

[Minimum distance of joints]:
a path that minimizes the movement amount of the joint 
angle is selected.

[Minimum num of points]:
a path that minimizes the number of teach points to be 
inserted in the job is selected.

(6)Resolution Sets the resolution of collision detection performed at path 
planning.
It is adjustable in three levels of Low, Standard and High.

(7)Motion Type Specifies the motion type to be inserted in the job.
MOVL or MOVJ can be specified.

(8)Speed Specify the speed of the move instruction to be inserted in the 
job.

(9)PL Specifies the positioning level of the move instruction to be 
inserted in the job.
If do not specify it, select NONE.

(10)Setting Target 
Robot(s)

Select a robot to set for Keeping Postural, Search Limit and 
Start / End Point.
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Keeping Postural tab
When MOVL is selected with the Motion Type of general setting, specify the range where the 
posture is maintained from the start point to the end point for the teaching point to be added by 
path planning.

 

(1) 
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(1)Keeping Postural The search range of path generation is based on a rectangu-
lar parallelepiped with a starting point and an end point diago-
nal. (Base coordinate system)
XYZ specifies whether to search within the range obtained by 
adding the margin amount to the reference. The minimum 
value is 500 mm.

The following figure shows the search range imitated by the 
BOX model. It is created so that the inner green BOX is within 
the difference between the start point and the end point. The 
user specifies how much to enlarge the range of this green 
BOX. When the default values XYZ are set to 500 respec-
tively, the outer black BOX becomes the search range.

To set the movable range of RxRyRzRe, put a check and acti-
vate it.
RxRyRzRe specifies whether to search within the range 
obtained by adding the margin amount to the difference 
between the start point and the end point. The minimum value 
is 20 deg.
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Search Limit tab

For the teach point generated by path planning, specify the search range of the joint angle.

(1)Joint Angle If change the setting from the default value, put a check and 
activate it.
Specify the movable range of the joint angle in %. The initial 
value is 95%.
Up to 100% can be specified.

 

(1) 
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Start / End Point tab
When the start point or the end point used in path planning is already in contact with the inter-
ferer, the path can be generated using the start / end point shifted by the specified shift 
amount.

Start Point

(1)Add Check the box to create a start point.

 

(1) 

(2) 

(3) 

(4) 
(5) 

(7) 

(8) 

(9) 

(6) 
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(2)Coordinates Select the coordinate system that specifies the shift amount.
In the robot coordinates, set the shift amount in the following coordi-
nates.

In the target coordinates, set the shift amount at AXIS 6 at the start 
point.

(3)Shift Amount Set the shift amount in the X, Y, and Z axis directions from the start 
point on the coordinate base of (2). (Units: mm)

(4)Motion Type Specify motion type of move instruction.
MOVL or MOVJ can be specified.

(5)Speed Set the moving speed.

(6)PL Specifies the positioning level of the move instruction to be inserted in 
the job.
If do not specify it, select NONE.

End Point

(7)Add Check the box to create an end point.

The end point is added to the job at motion type and speed set in the general set-
ting.

NOTE
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(8)Coordinate Select the coordinate system that specifies the shift amount.
In the robot coordinates, set the shift amount in the following coordi-
nates.

In the target coordinates, set the shift amount at AXIS 6 at the end 
point.

(9)Shift Amount Set the shift amount in the X, Y, and Z axis directions from the end point 
on the coordinate base of (8). (Units: mm)
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9 Online Function

When PC is connected to a real controller by Ethernet, the following operation becomes pos-
sible.

• Reconstructs a system configuration of a real controller in VRC
• Monitor the condition of a real controller
• Receive the files from a real controller and load to the VRC
• Save the files of VRC and send them to a real controller.

9.1 Automatic Construction

A system configuration of a real controller is reconstructed in VRC.

9.1.1 Create a New VRC Controller (Network)

When PC is connected to a real controller by Ethernet, a system configuration of a real con-
troller is reconstructed in VRC.

Procedure
1. On the [Controller] tab, in the [Setup] group, click the [New] button. To display the "Create 

• The "High-speed Ethernet Server Function" option of a real controller is required.
• This function is not available by NX100.
• For details on how to setup the network, refer to the following manuals.

     "DX200 Options: Instructions for High-speed Ethernet Server Function"
     "DX100 Options: Instructions for High-speed Ethernet Server Function"
     "FS100 Options: Instructions for High-speed Ethernet Server Function"

In Order to transmit with the host control function, the command remote must be set to 
valid. Using the programming pendant, under [IN/OUT] a [PSEUDO INPUT] menu set the 
[CMD REMOTE SEL] to enable. And, the mode of the programming pendant needs to be 
"REMOTE".

NOTE

NOTE
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Controller" dialog. Select "New VRC Controller (Network)" and press the [OK] button.

2. The "Connection Setting" dialog box appears. Select the controller kind and input the IP 
address of a real controller connected with PC. If desired you may change the default 
name for the controller.
Click the [OK] button, the files needed to construction are downloaded from a real control-
ler.

In Order to transmit with the host control function, the command remote must be set to 
valid. Using the programming pendant, under [IN/OUT] a [PSEUDO INPUT] menu set the 
[CMD REMOTE SEL] to enable. And, the mode of the programming pendant needs to be 
"REMOTE".

NOTE
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3. The "New Controller" dialog box appears. Select the system version from the list and click 
the "OK" button. Then the configuration will be executed automatically.

4. The Virtual Pendant will close and reboot in normal mode.  (This may take a few 
moments.)  The “Robot Setting” dialog will display.  A default robot name and model file 
should be pre-entered.  If required, enter a name for the robot and select a robot model file 
corresponding to the robot type.  (In the example below, the robot model is “VA01400-A00” 
the corresponding model is “VA01400-A00.mdl”.)  Robot models are found in the “Robot” 
folder under MotoSimEG-VRC install folder.  Click the [OK] button.  

When there are no system versions corresponded with that of a real controller in a list, 
please choose the close system version.

NOTE

431/847



9.2  Network Function

HW0485348

5. The robot will display with the selected model file.

9.2 Network Function

To connect PC to a real controller by Ethernet, execute the setting with this function.

Procedure
1. On the [Online] tab, in the [Connect] group, click the [Network] button.

2. Select the controller from the list, click the [Setting] button.

When initialized the robot controller, MotoSim EG-VRC set the absolute data auto-
matically. So absolute setting is not needed in MotoSim EG-VRC. 
Refer to " 7.1.4  Initializing the Controller (FS100) " for details.

NOTE
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3. The "Connection Setting" dialog box appears. Input the IP address and click the [OK] but-
ton.

4. The IP address is displayed on the list.

9.3 Monitor Function

The condition of a real controller is monitored. The mode, status, positions of the robots of the 
controller are displayed. During monitoring, the dialog beside [Simple PP], [Position Panel], 
[View Manager] and [Light Manager] cannot be displayed.

9.3.1 Connect

Connects PC to a real controller.

Procedure
1. On the [Online] tab, in the [Connect] group, click the [Network] button.

2. Select the controller from the list, click the [Connect] button.
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3. MotoSim EG-VRC starts to connect to IP address. When the icon turns to green, connec-
tion is completed.

4. When jog operation or playback is executed on a real controller, the robot position on the 
MotoSim EG-VRC is updated.

During the playback on a real controller, the current line is displayed on a [Simple PP] dia-

Item Description

ControllerName The controller name of VRC is displayed.

IP Address The IP address of a real controller is displayed.

Mode The mode of a real controller is displayed. ([TEACH] or [PLAY])

Status The status of a real controller are displayed. (Auto operation, Alarm 
occurred, etc.)

 
 

 

 

S-axis Jog Operation 
on a real controller 
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log. When changed task, the displayed job is changed.

9.3.2 Disconnect

Disconnects PC to a real controller.

Procedure
1. On the [Online] tab, in the [Connect] group, click the [Network] button.

2. Select the controller from the list, click the [Disconnect] button.

3. MotoSim EG-VRC starts to disconnect to IP address. When the icon turns to red, discon-
nection is completed.
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9.4 File Manager

The jobs and condition files of VRC and a real controller are displayed on the File Manager. 
The following operation becomes possible on File Manager.

• Opens the file by a text editor.
• Compares the files of VRC and a real controller
• Receive the files from a real controller and load to the VRC
• Save the files of VRC and send them to a real controller

9.4.1 File Manager Dialog

On the [Online] tab, in the [Connect] group, click the [File Manager] button. The [File Manager] 
dialog appears.

In Order to transmit with the host control function, the command remote must be 
set to valid. Using the programming pendant, under [IN/OUT] a [PSEUDO INPUT] 
menu set the [CMD REMOTE SEL] to enable. And, the mode of the programming 
pendant needs to be "REMOTE".

NOTE

 

 

 

Selects the controller  
name to connect. 

The IP address of a real 
controller is displayed. 

Selects the file type 
to display. 

When right-clicks on the list, 
the right click menu appears. 

The number of the file in the list 
or the selected files is displayed. 

The file names in VRC 
are displayed. 

The blue frame is shown 
around the selected list. 

The file names in a real 
controller are displayed. 
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 Menu

 Tool Button

  Right-button Click Menu

File

Copy The file selected by a list is copied to the other. When multiple file 
name are selected, batch-copying is executed. For details, refer to 
the section " 9.4.6  File Copy ".

Close The file manager dialog is closed.

Edit

File open The selected file is opened by an external application. For details, 
refer to the section " 9.4.4  File Open ".

Select all The all files on the list are selected.

View

Refresh The list of VRC and a real controller are refreshed.
When a new job is created, a job is copied or a job is deleted on a 
real controller after the file manager dialog is opened, click this menu 
to refresh the list.

Tool

File comparison The selected file is opened by an external application to file compari-
son. For details, refer to the section " 9.4.5  File Compare "".

Option The option dialog is displayed. For details, refer to the section " 9.4.2  
Option ".

The file selected by a list is copied to the other.
Menu: {File} - {Copy}

The all files on the list are selected.
Menu: {Edit} - {Select all}

The list of VRC and a real controller are refreshed.
Menu: {View} - {Refresh}

Copy The file selected by a list is copied to the other.
Menu: {File} - {Copy}

File open The selected file is opened by an external application.
Menu: {Edit} - {File open}

File comparison The selected file is opened by an external application to file compari-
son.
Menu: {Tool} - {File comparison}

Select all The all files on the list are selected.
Menu: {Edit} - {Select all}
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9.4.2  Option

Sets the option setting of the file manager.

Refresh The list of VRC and a real controller are refreshed.
Menu: {View} - {Refresh}

File Manager Option

File Open Application Sets the external application to open the file. NotoPad.exe is 
default setting. To set other application, set the full path of the 
external application and arguments of starting. A full path of a 
displayed file is substituted for "%1".

File Comparison Application Sets the external application to compare the files. If the set-
ting is not set, file comparison cannot be executed. Sets the 
full path of the external application and arguments of starting. 
A full path of a compared file of VRC is substituted for "%1". A 
full path of a compared file of a real controller is substituted 
for "%2".

Communication method Sets the method of communication to a real controller.
High-Speed Ethernet server is default.
The "FTP Function" option of a real controller is required. For 
Details, please refer to the following manulals.
"Instructions for FTP Function".
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9.4.3 Connect to a Real Controller

Connects to a real controller and displays the file list.

Procedure
1. Network setting is completed on the network connection dialog beforehand.

For details, refer to the section " 9.2  Network Function ".
2. On the [Online] tab, in the [Connect] group, click the [File Manager] button,  the [File Man-

ager] dialog appears. Selects the target controller from the [Select VRC].

3. The file list is displayed.

4. The file category can be changed.
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9.4.4 File Open

The selected file is opened by an external application.

Procedure
1. Select a file from the file list of VRC or a real controller, click the right-button  and select 

{File open} menu of the right-button click menu, or select the {Edit} - {File open} menu.

2. The selected file is opened by an external application. The executed application can be 
changed by option setting.

The selected file is downloaded to the temporary folder and opened. So, when the 
opened file is edited, that file is not loaded to VRC or a real controller.

NOTE
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9.4.5 File Compare

The selected file is opened by an external application to file comparison.

Procedure
1. Selects the file from the file list of VRC or a real controller, click the right-button and select 

{File comparison} menu of the right-button click menu, or select the {Tool} - {File open} 
menu.

2. The selected file of VRC and a real controller are saved, and these files are opened by an 
external application to compare.

To use this function, sets the setting of the external application to compare. For 
details, refer to the section " 9.4.2  Option ".

NOTE
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9.4.6 File Copy

The file selected by a list is copied to the other. When multiple file name are selected, batch-
copying is executed.

Procedure
1. Selects the file from the file list of VRC or a real controller.

• When click the file name with [Ctrl] key of the keyboard, multiple files are selected.

• When click the file name with [Shift] key of the keyboard, multiple files from first cursor to 
second cursor are selected.

• When the file is copied, the file is overwritten. The file cannot be restored.
• Transferable files to real controllers are following 8 types.

• JBI files
• TOOL.CND
• VAR.DAT
• UFRAME.CND
• VARNAME.DAT
• IONAME.DAT
• IOMNAME.DAT
• EXIONAME.DAT

NOTE
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• click the right-button and select {Select all} menu of the right-button click menu, or select 
the {Edit} - {Select all} menu, or click the   button, all files of the list are selected.

2. Click the right-button and select {Copy} menu of the right-button click menu, or select the 
{File} - {Copy} menu, or click the   button.

(1) When the file is copied from a real controller to VRC, the following dialog is dis-
played.

(2) When the file is copied from VRC to a real controller, the following dialog is dis-
played.

3. Click the [OK] button, file copy is executed. The progress dialog appears. When click the 
[Cancel] button, file copy is canceled.

(1) Copy the file from a real controller to VRC

(2) Copy the file from VRC to a real controller

In consideration of safety, copying to real controllers is possible only permitted 
files.MotoSim EG-VRC abort copying process if file list includes no permitted 
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files.Please redo the file selection, and try again copying process.

4. When the selected file cannot be saved or loaded, the following error dialog is displayed. 
When click the [Yes] button, the error file is ignored and the copy process is continued. 
When click the [No] button, the copy process is canceled.

5. When file copy can not be performed due to communication environment problem, the 
following error dialog is displayed.
When click the [Yes] button, the error file is ignored and the copy process is continued.
When click the [No] button, the copy process is canceled.
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10 Debug Function

Sets a break point to the job, it's possible to suspend job execution by the optional line and 
confirm the state of variable or IO.

10.1 Change to Debug Mode

To change to debug mode, on the [Simulation] tab, in the [Debug] group, click the [Enable] 
button. 

The button is changed to "Disable".
To change to usual mode, on the [Simulation] tab, in the [Debug] group, click the [Disable] but-
ton.

• When use the debug function, the cycle time and trajectory is different from those in 
usual mode.

• Debug function is available only with VRC controller.
• Debug function is not available with external device.

NOTE
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10.2 Set/Release the break point

To set/release the break point, the simple pendant is used. 

To set/release the break point, select the line to set the break point and press the [F9] key or 
"Setting BreakPoint" of the right-button menu.
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10.3 BreakPoint List

On the [Simulation] tab, in the [Debug] group, click the [Enable] button, break point list dialog 
is displayed.

Controller Selects the controller. The break point of the selected 
controller is displayed in the list.

JobName Job name is displayed.

Line Line number set the break point is displayed.

Instruction Instruction of the line number is displayed.

Enable The condition of break point is displayed. (Enable or 
Disable)

[Delete] button Deletes the selected breakpoint.
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When right-button click on the list, changes the condition of break point in the right-button 
menu.

The condition of break point can be checked by the icon in the simple pendant.

[Delete All] button Deletes all break points of the selected controller.

                  

Enable 

Disable 
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10.4 Job Stack

On the [Simulation] tab, in the [Debug] group, click the [Job Stack] button, break point list dia-
log is displayed.

Only when the playback is stopped by break point, the caller job is displayed in the job stack 
dialog.
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10.5 Debug Monitor

On the [Simulation] tab, in the [Debug] group, click the [Debug Monitor] button, debug monitor 
dialog is displayed.

 

The status of variables or IO can be checked in the debug monitor dialog.
To add the monitored data, click the [Add] button.
To change the monitored data, double-click or press the [F2] key.

10.5.1 Insert Monitoring Data

Click the [Add] button, the insert monitoring data dialog is displayed. Set the data to monitor.

[Add] button Displays the insert monitoring data dialog.

[Del] button Deletes the selected line.
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Following variable and IO can be monitored.

Variable: B, I, D, R, P, BP, EX

IO: IN, OT
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10.6 Operation in Break

Following operation on the simple pendant is available in break.

10.6.1 Execution

Press the [F5] key, the job is executed to next break point. If next break point is not set, the job 
is executed to the end.

And, when the job is executed by PSTART, the suspended task is restarted.
When the multi task is suspended, all suspended task are restarted.

     

Suspend by break point. 

F5 

The break point is set at 
line 8, so job is executed to 
line 8. 
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10.6.2 Step Over

Press the [F8] key, the job is executed to next line. When the stopped line is "CALL JOB", the 
called job is executed to the end. If the called job has break point, the execution is suspended 
by break point.

10.6.3 Step In

Press the [F11] key, the playback is executed to the top of the called job.

     

Suspend by break point. 
Called job is executed 
to the end and execution 
is suspended. 

F8 

     

Suspend by break point. 
The execution is suspended 
at the top of called job 
“SUB1”. 

F11 

453/847



10.6  Operation in Break

HW0485348

10.6.4 Step Out

Press the [SHIFT] + [F11] key, the playback is executed to the end of the called job.
If the called job has break point, the execution is suspended by break point.

      

Suspend by break point 
in the called job. 

SUB1 is called by line 3, 
so execution is 
suspended at line 4. 

SHIFT+F11 
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11 Model Editings

This chapter explains the operations for creating and editing the workpiece and tool models 
using the CAD functions.
A model is generally created by combining basic figures, such as cubes and cylinders; in addi-
tion to the general method, MotoSim EG-VRC supports the model creation by reading HSF 
and HMF data.  

11.1 Cad Tree

11.1.1 Outline of the Cad Tree

On the [Home] tab, in the [Model] group, click the [CadTree] button, the [Cad Tree] dialog 
appears.

 

 

  

            

 Model 
(MDL) dummy Robot 

Model 
(HMF,
HSF) 

Display     

Hide     

 Select display style of a model from the combo 
box. 
SeeAll : Displays the model and its frame. 
Model Only : Displays only the model. 
Frame Only : Displays only the frame. 
Hide All : Hides everything. 
Show Name : Add the model name to the  

current display setting. 
Wireframe : Changes the model display mode  

to wireframe 
*Note that in this dialog box, "frame" represents 
a coordinate axis of a model. 

Press to create 
a new model. 

Model selection display 
Note: Right-click the mouse on 

this display to open the 
menu for operation and 
edition of the model. 

Button to set 
model opacity. 

Select display/nondisplay the child model in the Cad Tree. 
：Displays the child model in the Cad Tree. 
：Hides the child model in the Cad Tree. 

*1) If a display style of a model (See, Hide, etc.) is selected in " " status,  
the model and their child models in lower layers will be displayed in the same style. 

*2) If a model is deleted in " " status, the model and their child models in lower layers  
will be deleted, except for "world", "Teacher", and the robot models. 

Button to layout 
the model. 

Button to 
change position. 

Sets the Position of the 
selected model in the tree. 

455/847



11.1  Cad Tree

HW0485348

11.1.2 Tree Structure

The Cad Tree displays a column of models in a tree structure.
As shown in the following diagram, a model in the level immediately above the subject model 
is the parent model of the subject model.

11.1.3 Opacity Settings

To set the model opacity, select the model in the Cad Tree and set the value using the spin 
button indicated in the following figure.
The maximum value of opacity is “1.00”.  Decreasing the value below the maximum value 
reduces the opacity, the model becomes translucent enabling to see other models through it.  
If the value is set to “0”, the model becomes completely transparent and can no longer be 
seen.  

world

Parent model of "dai", "FLOOR", 
"worldframe", and "H6".

dai

work

FLOOR

worldframe

H6

Parent model of "work".

 

Spin button to specify opacity. 
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11.1.4 Teacher

"Teacher" is a tool to create a target point (coordinate) at an arbitrary position, and is dis-
played as an AXIS6 frame on the screen.  It simplifies the use of OLP-related function and the 
relocation of parts.
To enable the Teacher, point the cursor to "Teacher" in the Cad Tree, and click on [Pos] to dis-
play the “Position Teacher” dialog box.  Specify the values in this dialog box. (For further detail 
on the "Position" dialog box, please refer to " 11.5  Positioning a Model "). 

11.1.5 Mouse-Driven Model Editing

 Right Mouse Button Operation
A pop-up menu for model editing operation appears by clicking the right mouse button at a 
location where a model is displayed.
However, note that the viewpoint operation menu appears when clicking the right mouse but-
ton where there is no model displayed or when the Cad Tree is not on the screen.  

 

 

(1) Select "Teacher". 

(2) Select [Pos]. 

Set the incremental value 

of the spin button  

Menu for model editing. 
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11.1.6 Position Input Area

Select the model in the tree, the position of model is displayed in the Position Input Area. 
When input the value, it is set to the position of model.

11.1.7 Layout function

The layout function is to arrange a model.
To use the layout function, click the [Layout] button of the [CadTree] dialog.

When the model whose position cannot be set is selected, the input area cannot be set 
the value.

[Pick Enable] check box Enables the mouse picking operation.

[Pick 2 Points] check 
box

The chosen model is parallel-shifted so that the 1st point of the model 
adjust with the 2nd picked position.

 
Set the incremental value 

of the spin button   

NOTE

    

Click 
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The layout dialog is displayed.

When each button of the layout panel is clicked, its function becomes effective. Its function is 

released by clicking again. But, the button   (Remove all reference coordinates) is exe-
cuted only when clicking the button.

Layout function is two modes as follows.
• Pick mode … The model is moved as fitting between the chosen points or faces.
• Ref coord mode … The model is moved or rotated depending on the reference coordi-

nate.

Each mode has the function as follows.
• Pick mode

This function cannot be operated during the playback

Mate the two points

The model is moved so that the selected 
two points become same position.

Mate the two faces

The model is moved so that the selected 
two faces become same position.

Mate the point and the center of circle 
(passing through 3 points)

The model is moved so that the selected the 
point and the center of circle (passing 
through the selected three points) become 
same position.

Mate the center of two circle (each 
circle passing through 3 points)

The model is moved so that the center of 
two circle (each circle passing through the 
selected three points) become same posi-
tion.

NOTE
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• Ref coord mode

• The model to which the point or face selected first is the target model.
• To specify the center of the circle, select the three point on the circumference of circle.
• When clicking in an area the selected point depends on the current "Pick Mode" settings. 

Please refer to " 6.4  Pick Settings " for details.

Create a reference coordinates

The reference coordinates is created.

Remove the reference coordinates

The reference coordinates is removed.

Remove all reference coordinates

All reference coordinates are removed.

Move model in the selected axial 
direction

The model is moved to the selected axial 
direction of the reference coordinates.

Rotate model about the selected axis

The model is rotated about the selected axis 
of the reference coordinates.

Mate the two faces by selected axis

The model is rotated about the selected axis 
of the reference coordinates so that the 
selected two faces become same position.

• The reference coordinate is temporary and is not saved to the cell. When the cell is 
closed, all reference coordinates are removed.

• On the [Home] tab, in the [Screen] group, click the [Frame Display] button to show/hide 
the reference coordinates.

NOTE

NOTE
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Procedure
• Mate the two points

The model is moved so that the selected two points become same position. For example, 
the two corner of two cuboid are matched as follows.

1) Click the button   (When the button has been clicked, it isn't necessary to 
click.).

2) Click the first point. The model to which the point clicked first is the target model. 
A red marker is shown to the location of the selected point.

3) Click the second point.

 

Click 

Click 
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4) The model moves at the same time as a mouse button is released.

 
• Mate the two faces

The model is moved so that the selected two faces become same position. For example, 
the two faces of two model are matched as follows.

1) Click the button   (When the button has been clicked, it isn't necessary to 
click.).

2) Click the first point of the face. The model to which the point clicked first is the 
target model. A red marker is shown to the location of the selected point.

The picked point is shown the red point like OLP function and the point is fixed at the same 
time as a mouse button is released. And, when moves the mouse during a mouse click, 
the pick target is moved.

SUPPLE
-MENT

 

 

Click 
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3) Click the second point.

The model moves at the same time as a mouse button is released and the follow-
ing dialog is displayed.

              
4) When click the [Yes] button, the model is reversed and the operation is finished.

When click the [No] button, the model is not reversed and the operation is fin-

 

Click 
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ished.

 
• Mate the point and the center of circle (passing through 3 points)

The model is moved so that the selected the point and the center of circle (passing 
through the selected three points) become same position. For example, the corner of the 
cuboid and the center of the upper face of the cylinder are matched as follows.

1) Click the button   (When the button has been clicked, it isn't necessary to 
click.).

2) Click the first point. The model to which the point clicked first is the target model. 
A red marker is shown to the location of the selected point.

The picked face is surrounded by the yellow-green frame like OLP function and the face is 
fixed at the same time as a mouse button is released. And, when moves the mouse during 
a mouse click, the pick target is moved.

SUPPLE
-MENT

 

Click 
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3) To specify the center of the circle, click the first point on the circumference of cir-
cle. A blue marker is shown to the location of the selected point.

4) Click the second point on the circumference of circle. A blue marker is shown to 
the location of the selected point.

5) Click the third point on the circumference of circle.

 

Click 

 

Click 

 

Click 
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The model moves at the same time as a mouse button is released.

• Mate the center of two circle (each circle passing through 3 points)
The model is moved so that the center of two circle (each circle passing through the 
selected three points) become same position. For example, the center of the bottom face 
of the cone and the center of the upper face of the cylinder are matched as follows.

1) Click the button   (When the button has been clicked, it isn't necessary to 
click.).

2) To specify the center of the first circle (target of operation), click the first point on 
the circumference of circle. A red marker is shown to the location of the selected 
point.

The picked point is shown the red point like OLP function and the point is fixed at the same 
time as a mouse button is released. And, when moves the mouse during a mouse click, 
the pick target is moved.

SUPPLE
-MENT

 

 

Click 
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3) Click the second point on the circumference of circle. A red marker is shown to 
the location of the selected point.

4) Click the third point on the circumference of circle. A red marker is shown to the 
location of the selected point.

5) To specify the center of the second circle, click the first point on the circumfer-
ence of circle. A blue marker is shown to the location of the selected point.

6) Click the second point on the circumference of circle. A blue marker is shown to 
the location of the selected point.

Click 

 

Click 
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7) Click the third point on the circumference of circle.

The model moves at the same time as a mouse button is released.

                
8) When click the [Yes] button, the model is reversed and the operation is finished.

When click the [No] button, the model is not reversed and the operation is fin-
ished.

 

The picked point is shown the red point like OLP function and the point is fixed at the same 
time as a mouse button is released. And, when moves the mouse during a mouse click, 
the pick target is moved.

 

Click 

SUPPLE
-MENT
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• Create a reference coordinates
The reference coordinates is created.

1) Click the   button (When the button has been clicked, it isn't necessary to 
click.).

2) Click the first point. This point becomes the origin of the reference coordinates. A 
yellow marker is shown to the location of the selected point.

3) Click the second point. This point means the X-axis direction of the reference 
coordinates. A blue marker is shown to the location of the selected point. 

4) Click the third point. This point means the XY-plane of the reference coordinates.

 

Click 

 

Click 

 

Click 
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The reference coordinates is created.

 
• Remove the reference coordinates

The reference coordinates is removed.

1) Click the button   (When the button has been clicked, it isn't necessary to 
click.).

2) Click the reference coordinates to delete.
3) The reference coordinates is removed.

• Remove all reference coordinates
All reference coordinates are removed.

1) Click the button  .
2) All reference coordinates are removed.

The picked point is shown the red point like OLP function and the point is fixed at the same 
time as a mouse button is released. And, when moves the mouse during a mouse click, 
the pick target is moved.

SUPPLE
-MENT

 

Click 
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• Move model in the selected axial direction
The model is moved to the selected axial direction of the reference coordinates. For 
example, the model is moved to the X-axis direction of the reference coordinates as fol-
lows.

1) Click the button   (When the button has been clicked, it isn't necessary to 
click.).

2) Click the blue arrow of the reference coordinates. The selected arrow is high-
lighted.

3) Click the model to move.

The following dialog is displayed and input the traveling distance manually.

 

 

Click 

 

Click 
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4) When the [OK] button is clicked, the model is moved to the X-axis direction of the 
reference coordinates as the inputted travel distance.

When the [Cancel] button is clicked, the operation is canceled.

• Rotate model about the selected axis
The model is rotated about the selected axis of the reference coordinates. For example, 
the model is rotated about the Z-axis of the reference coordinates as follows. 

1) Click the button   (When the button has been clicked, it isn't necessary to 
click.).

2) Click the red arrow of the reference coordinates. The selected arrow is high-
lighted.

 

 

Click 
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3) Click the model to rotate.

The following dialog is displayed and input the rotation angle manually.

4) When the [OK] button is clicked, the model is rotated about the Z-axis of the ref-
erence coordinates as the inputted rotation angle.

When the [Cancel] button is clicked, the operation is canceled.

The plane perpendicular to the selected axis of the reference coordinates cannot be selected.

 

Click 

NOTE
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• Mate the two faces by selected axis
The model is rotated about the selected axis of the reference coordinates so that the 
selected two faces become same position. The two normal vector is projected on the 
plane made by the selected axis of the reference coordinates and the model is rotated so 
that the direction of two projected vectors is matched.

For example, The model is rotated so that two faces of two model is matched about the Z-
axis of the reference coordinates as follows.

1) Click the button   (When the button has been clicked, it isn't necessary to 
click.).

2) Click the red arrow of the reference coordinates. The selected arrow is high-
lighted.

3) Click the first face. The model which this face belongs is the target.

 

 

Click 

 

Click 
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4) Click the second face.

The model is rotated so that two faces of two model is matched about the Z-axis 
of the reference coordinates.

• Reflecting pick movement amount to parent model
The procedure is explained by using "Arc_Sample_YAS.vcl"as an example. In this case, 
consider using a Mate the two points function to move the welding work in the direction of 
the red line in the figure below for each installation base.

1) Click the button   (When the button has been clicked, it isn't necessary to 
click.).

2) Click the first point. The model to which the point clicked first is the target model. 

The plane perpendicular to the selected axis of the reference coordinates cannot be selected.

 

Click 

NOTE
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A red marker is shown to the location of the selected point.

3) Click the second point. The following dialog is displayed.

When click the [Yes] button, the parent model of the movement target model also 
moves to the specified destination and the operation is completed.

When click the [No] button, only the movement target model is moved to the 

Click 
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specified destination and the operation is completed.

• Relative movement

This function moves the model currently selected by CadTree by the amount of move-
ment of pick operation.
The procedure is explained by using "Arc_Sample_YAS.vcl"as an example. In this case, 
consider using the point alignment function to move the selected Human model relative to 
CadTree.

1. Turn ON the [Pick Enable] check in the layout panel.

2. Click the button   (When the button has been clicked, it isn't necessary to click.).

This function can be used only for Mate the two points, Mate the point and the center of circle, 
and Move model in the selected axial direction.

NOTE

 

moving target 
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3. The model to which the point clicked first is the target model. A red marker is shown to 
the location of the selected point.

4. Click the second point.

5. As shown below, the Human model moves relative to the distance between the first 
and second points.

 

Click 

 

Click 
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11.1.8 Model display format

Set the display format of the model.

In the model display format setting pull-down, you can set “Display settings” and “Option to 
display additional model name or wireframe for display settings”.
The display settings can be selected from See All, Model Only, Frame Only, and Hide All. 
Options can be selected from ShowName and WireFrame.

The following is an example of the display status depending on the combination of display set-
tings and options.
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11.2 Creating a New Model

To start creating a new model, click on [Add] of the Cad Tree menu to display the Add Model 
dialog box.  

Procedure
1. Enter a name of the new model to be created in the Name edit box of the Add Model 

dialog box.  
(By default, the model name and the model file name are the same: the model file is
 created with the model name.) 

2. Click [OK] in the Add Model dialog box.  
A newly created model is displayed in the Cad Tree.  (Note that new model file does 
not contain any data at this point.)  

3. Double-click the new model name in the Cad Tree to edit the model. 
The file data editing dialog box (as shown below) appears; refer to " 11.3  Editing a Part 
" to edit the file data.  

4. When the creation of the model is completed, click [Close] to complete the file data 
editing.
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 Creating a Model from an Existing Model
A new model creation can be achieved not only by creating parts with the CAD function, but 
also with an existing model file.  In addition to those methods, a new model can also be added 
with the method explained in " 11.11  Reading a Model ".

Procedure
1. Click [Add] of the Cad Tree, or select {File} - {New Model} from the right-click menu of 

the Cad Tree.

2. The Add Model dialog box appears.  Press the [...] button on the left of the File Name 
edit box to select a file. 
 

3. Enter a new model name in the Name edit box of the Add Model dialog box.

4. Click [OK].  

5. If the model file path doesn't correspond to the "models" folder under the cell folder, the 
following dialog box will display and offer to copied model file to the "models" folder of 
the cell.

If the "Yes" button is clicked and a file with the same name already exists in the cell 
"models" folder.  The following dialog will display to ask for overwrite confirmation.

When adding LINE data (wire frame), it is recommended to use LINE data in the HMF for-
mat: adding LINE data in other format may take some time. 
If the LINE data is in a format other than HMF, convert the LINE data with “MDL2HMF.EXE” 
before adding the model.  (The MDL2HMF.EXE is located in a folder where MotoSim EG-VRC 
was installed).

 

 

NOTE
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 Creating a Dummy Model
Dummy model is a model with only the position and direction data and no modeling data 
(model file).  Normally, external servo track or rotation axis have a reference position that is 
fixed and unchangeable (even if it is changed, it returns to the original position when opening 
the cell next time).  
To avoid such problem, use a dummy model: create a dummy model, then register the exter-
nal axis as a child model of the dummy model.  This way, the reference position of the external 
axis or rotating axis can be moved by changing the reference position of the dummy model.

Procedure
1. Click [Add] on the Cad Tree dialog box, or select {File} - {New Model} from the right-

click menu of the Cad Tree.

2. The Add Model dialog box appears; enter a new model name in the Name edit box.  

3. Check the [Dummy Model] check box.

4. Click [OK].
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11.3 Editing a Part

MotoSim creates a model data file by combining basic figures such as cubes and cylinders: 
such figures are called "parts" in this manual.
The following sections explain on how to edit the parts using the file data editing dialog box of 
the Cad Tree.

11.3.1 Displaying the File Data Editing Dialog Box

In the Cad Tree, double-click the model to be edited, or select {Attribute} - {Edit File Data} to 
display the file data editing dialog box as follows:

File data editing dialog box

Item Description

[Add] button Displays a dialog box to edit the part selected in [Add Parts] combo 
box.  Also displays the added part on the cell window.

[Edit] button Displays a dialog box to edit the part selected in the parts list.  
(Multiple selection is not possible.)

[Delete] button Deletes the part selected in the parts list. 
(Multiple selection is not possible.)

[Move Parent] button Changes the parent of the part selected in the parts list.
Refer to " 11.9.1  Changing the Parent Model " for details.

 

Parts list. 

Select a part type. 
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11.3.2 Registering a Part

Procedure
1. Select a type of parts to be added in [Add Parts] combo box in the file data editing dia-

log box.  

2. Click [Add] to display the part on the cell window; the parts editing dialog box appears.

[ClipBoard...] button

Stores/Retrieves the data of the part selected in the parts list on the 
clipboard.  

[Close] button Closes the file data editing dialog box.

File data editing dialog box

Item Description
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3. See descriptions below to edit the part in the parts editing dialog box:

• Enter the values for model size, position, etc. with the spin buttons  or key-
strokes. (The incremental value of the spin buttons is specified in the Step combo 
box.)

• Click [Color...] to display the Color dialog box, and specify the color.
• To move the part to an arbitrary point with the Teacher, set the Teacher to the target 

position; click [Goto] in the "Teacher" section to move the part to the teacher coordi-
nate.  To move the part including the posture to the teacher, check the [POSE] 
check box and then click [Goto].  (For the details of the Teacher, refer to 
" 11.1.4  Teacher ".)

4. When all the settings for the model are completed in the parts editing dialog box, click 
[OK] to add the part to the model data file.

5. Create a model by repeating the steps 1 to 4 to register additional parts.

11.3.3 Part Types

This section explains on how to edit the parts according to the part type.
BOX, BOX 2, CYLINDER, CONE 2, SPHERE, PIPE 2 can use the layout function. It is possi-
ble to use four function: "Mate the two points", "Mate the two faces", "Mate the point and the 
center of circle" and "Mate the center of two circle". (For usage, please refer to the section " 
11.1.7  Layout function ".)

 BOX
The BOX is a rectangular parallelepiped part, which can be edited in the BOX Edit dialog box.

• The origin of the part is the center of the BOX part model.  

When use "Mate the two points", "Mate the two faces", "Mate the point and the center of circle" 
and "Mate the center of two circle", the red marker is not displayed if the part selected with the 
first point is not the part opened in the edit dialog.

NOTE

   
Origin of the part 
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 BOX2
The BOX2 is a rectangular parallelepiped part, which can be edited in the BOX2 Edit dialog 
box.

• The origin of the part is the vertex of the BOX2 part model.  

 CYLINDER
The CYLINDER is a cylindrical part, which can be edited in the CYLINDER Edit dialog box.

• Selecting the [Straight] check box links the values of the upper and lower diameters 
("U. Diameter" and "L. Diameter", respectively).  

• The value in "Number" edit box represents the number of sides to form a cylinder: the 
larger the number becomes, the more perfect the cylinder becomes. Therefore, when "3" 
is input, the number of side faces becomes three, forming a triangular cylinder.  

• The origin of the part is the center of the CYLINDER bottom.

   
Origin of the part 

     

Origin of the part 
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 CONE2
The CONE2 is a conic part, which can be edited in the CONE2 Edit dialog box.

• The origin of the part is the center of the CONE2 bottom.

 SPHERE
The SPHERE is a spherical part, which can be edited with the "SPHERE Edit" dialog box.

• The origin of the part is the center of the sphere.

    

 

 
Origin of the part 

     

Origin of the part 
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 PIPE2
The PIPE2 is a pipe part, which can be edited in the PIPE2 Edit dialog box.

• The values in "U. Thickness" and "L. Thickness" edit boxes respectively represent the 
thickness of upper and bottom faces of the pipe.

• Selecting the [Straight Cylinder] check box links the upper and lower diameters ("U. Diam-
eter" and "L. Diameter", respectively), and the upper and bottom face thickness.

• The origin of the part is the center of the PIPE2 bottom.

     

Origin of the part 
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 AXIS6
The AXIS6 is a part that may contain multiple frames (position and orientation data).  The 
frames can be used as a target point or for external axis setting.  In addition, press [Color…] to 
change the color, check "3 colors" to display in each color for X,Y,Z axis. The AXIS6 can be 
edited in the Frame Edit dialog box.

• To add a frames, press [Insert].  The frames are added to the "Index" list box. 
• To delete a frame, select the frame number in the "Index" list box, and press [Delete].
• To edit a frame, select the frame number in the "Index" list box and modify the values in 

the "Position" section.  The position can be displayed and modified relative to various 
coordinated system depending on the "Operation" mode.

"Operation" combo box settings

"Absolute" Displays the position with reference to the model frame.

"Relative" Displays the position with reference to the frame original 
position when initially selected in the "Index" list box.

"SelModel" Displays the position with reference to a selected model.  
When this mode is first selected the "Select Model" dialog 
will display to allow selection of the reference model.

The frame corresponding to the selected "Index" of the list box is highlighted in red in the 
main view.

NOTE

Model name 
Coordinate system (Changes 
according to the operation mode) 

AXIS6 model 
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 LINE
The LINE is a part that contains multiple points.  The points are links together by straight-line 
segments to form a continuous line.  It can be edited with the "LINE Edit" dialog box.  A mini-
mum of 2 points must be defined for the line to display.  Points can be inserted, edited or 
deleted in the same manner as the "FRAME Edit" dialog box.  (Please refer to the " AXIS6 " 
section for details).

 LINE2
The LINE2 is a part that may contains multiple lines each made of 2 points.  It can be edited 
with the "LINE2 Edit" dialog box.  The points with an odd index number are the starting points 
and those with an even index number are the end points.    The total number of defined points 
must be even to display all the segments.  Points can be inserted, edited or deleted in the 
same manner as the "FRAME Edit" dialog box.  (Please refer to the " AXIS6 " section for 
details).

Point 1
Point 2

Point 3

Point 4

Origin of the part

Point 5

Point 1

Point 2 Point 3

Point 4

Origin of the part

Start

End

End

Start
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 CUBE
The CUBE is a polyhedron part, which can be edited in the CUBE Edit dialog box.

• When a CUBE model is added, a model with four points appears on the screen, with the 
four points already registered in the CUBE Edit dialog box as shown below. 

• The apex of the figure at the bottom is registered as a point from No. 1, the point in the 
height direction is the last registered point in the model file form.  
The points at the apex of the bottom figure are arranged as follows:  

-When the height is set to Z-axis positive (+) direction: counterclockwise to Z-axis
 positive (+) direction. 
-When the height is set to Z-axis negavite (-) direction: clockwise to Z-axis positive
 (+) direction.

 FLOOR
The FLOOR is a floor part, which can be edited in the FLOOR Edit dialog box.

• The values "X Num" and "Y Num" edit boxes respectively represent the numbers of divid-
ing lines that divide the face in the X-direction and Y-direction. 

• The origin of the part is the center of the FLOOR model.  

100100

100

Z-axis

Y-axis

X-axis

Point 1Point 2

Point 3

Point 4

    

Origin of the part
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 FACE
The FACE is a face part, which can be edited in the Face Edit dialog box.

• Register apexes to create faces.  
Several faces can be created in one FACE part, however, there must be three or more 
points to create each face.  If the points are not in the same plane, the face will be divided 
into some triangles.  Therefore, unless these points are clearly on the same plane, create 
the FACE with units of three points.

Procedure
1. Select the [Pickup ON] check box. 

(Clear the check box to change the viewpoint on the screen.)  

2. Click the points 1, 2 and 3 as shown in the above figure.  
The frame of the clicked point is displayed in "Vertex List" box.  Click [Add Face>>] to 
create the FACE 1 defined by three points.

3. Click the points 4 to 6, and click [Add FACE>>] to create FACE 2.

4. Click the points 7 to 9, and click [Add FACE>>] to create FACE 3.

 

Point 1

Point 2
Point 3

Point 4

Point 5

Point 6

Point 8

Point 9

FACE 1

FACE 2
FACE 3

Point 7
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 “Teacher” Section of the Parts Editing Dialog Box
The parts BOX, CYLINDER, CONE2, PIPE2, AXIS6, SPHERE, LINE, LINE2 can be relocated 
by using the "Teacher" section of each editing dialog box.
When using the Teacher, it has to be previously set: refer to " 11.1.4  Teacher " for details.

“Teacher” section of the parts editing dialog box

Item Description

[Goto] button Moves the part to the Teacher position.

[POSE] check box Moves the part including the posture to the Teacher position.
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11.4 Editing a Model

A model can be cut, copied, pasted, etc. with commands under {Edit} of the Cad Tree.
Select a model from the Cad Tree, and edit the model with the commands described below:

 Cut
Cuts the selected model.

 Copy
Copies the selected model.

 Paste
Pastes the cut or copied model in an arbitrary place.Referred model file is same as pasted 
model.
When selecting {Copy} - {Paste} within the same cell, enter the model name to be copied.

 PasteFile
Pastes the cut or copied model in an arbitrary place. Then, the model file is pasted, and 
pasted model file is referred.
When selecting {Copy} - {Paste} within the same cell, enter the model name to be copied.

 Delete
Deletes the selected model.  However, the model file will not be deleted though the model is 
deleted from the Cad Tree and the cell window.
When deleting the currently selected model including its child models are to be deleted, set 
the display/nondisplay status (  or ) on the left of the model name to  in the Cad Tree, 
then select [Delete].  Note, however, that the "world", "Teacher", and robot model will not be 
deleted even if they are in the  status.

 DeleteFile
Deletes the selected model and referred model file. The model is deleted from the Cad Tree 
and the cell window and the model file. When the target model file is referred by another 
model, the target model file will be not deleted.

 Add
Creates a new model.  
Refer to " 11.1  Cad Tree " for details.

+ +

+
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 Rename
Changes the model name.
Note, however, that the names of "world", "Teacher", and the robot model names cannot be 
changed.

 Property
Specifies opacity, scale, and model type.  (The command {Property} is located under {Attri-
bute}.)

Property dialog box

Item Description

[Opacity] edit box Specifies the opacity of the model.

[Scale] edit box Specifies the scale of the model.

[Model Type] edit box Specifies a character string in the model.

[Back Plane Culling] 
check box

Set up whether the back plane of CAD data is shown or hidden.
When the back plane is shown, the CAD data is displayed according to 
that data.
When the back plane is hidden, display speed is faster.

[OK] button Applies the modifications, and closes the Property dialog box.

[Cancel] button Closes the Property dialog box without applying the modifications.

When the back plane is hidden, some parts of the CAD 
data may be lost.
When the CAD data need be displayed collect, check off 
the Back Plane Culling.

NOTE
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11.5 Positioning a Model

Position a model by specifying the values in the Position dialog box.
To display the Position dialog box, click on [Pos] button or select {Attribute} - {Set Position} 
menu item of the Cad Tree.

Position dialog box

Item Description

"Operation" combo box

“Absolute”
Displays the position with reference to the parent model, and 
moves the model.

“Relative”
Displays the position with reference to the selected model, and 
moves the model.

“SelModel”
Displays the Select Object dialog box; displays the position with ref-
erence to the model specified in the Select Object dialog box, and 
moves the model.

 

 

 

 

Set the incremental value of 
The spin button  
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[matrix] button

Allows to store or retrieve the data of the Position dialog box in the clip-
board. 

“Teacher” section

Move the model to the Teacher current position.
[Goto] button

Moves the model to the Teacher position.
[POSE] check box

When checked and the [Goto] button is used, the model also 
moves to match the Teacher orientation.

When using the Teacher, it has to be previously set: refer to " 11.1.4  
Teacher " for details.

“Pick” section

[Enable] check box
Enables the mouse picking operation.  
Pressing the [Shift] key enables or disables the "Pick Enable" 
mode.

[Pick two points] check box
The chosen model is parallel-shifted so that the specified point of 
the model may unite with the pick position of the 2nd point.

[Settings >>] or [<< Settings] buttons
Displays or hides the pick setting section.

“Move Mode” section

Determines the method to move to the picked point.
[Position] check box

The model is moved to the position (XYZ) of the picked point.
[Orientation] check box

The model is turned to match the orientation (Rx, Ry, Rz) of the 
picked point frame.

[Axis] check box
The model axis specified in the combobox is turned so that it 
matches the picked face normal.

[Reverse] check box
This setting is enable with [Orientation] or [Axis] mode. It can be 
use to change the direction of the picked face normal.

“Pick Mode” section Sets conditions determining the selected point in the clicked area.
Please refer to " Pick Mode Setting " for details.

“Pick Object” section
Sets the type of the object to be selected when clicking on the cell 
view. (Multiple items can be selected)
Please refer to " Pick Object Setting " for details.

[OK] button Applies the modifications, and closes the Position dialog box.

Position dialog box

Item Description
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The operating procedure of a two-point pick is explained concretely below.
1. With the first pick, the point to align is specified.

2. With the second pick, the movement place is specified.

3. The point specified as the first point moves to the position of the second point. 

[Cancel] button Closes the Position dialog box without applying the modifications.

Position dialog box

Item Description

 

First pick 

 

Second pick 
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11.6 Editing Multiple Models (Model List)

Multiple models can be edited in the Model List dialog box.  To open the dialog box, select 
{Edit} - {Models List} of the Cad Tree right-click menu.

Model List dialog box

Item Description

Model selection list box Displays the models registered in the cell.
The selected models are highlighted.  (Multiple selection is possible.)

[Delete] button
Deletes the models selected in the model selection list box.  The mod-
els on the cell window are also deleted, however, their model files still 
exist.

[Set Parent] button
Changes the parents of the models selected in the model selection list 
box.
Refer to " 11.9.1  Changing the Parent Model " for details.

[Move Parent] button
Moves the parents of the models selected in the model selection list 
box.
Refer to " 11.9.2  Moving the Parent Model " for details.

[Close] button Closes the Model List dialog box.

 

Model selection list box 
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11.7 Searching a Model

Search for a desired model with the Find dialog box.  To open the dialog box, select {Edit} - 
{Find} from the Cad Tree right-click menu.  
If the entered name exists, the model is selected in the Cad Tree.

 

 

Enter the model name.
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11.8 Saving and Reading a Model Group

A model and its parent-child relevant information can be saved as a set.
This can be done by creating a folder under [cell folder name\models] and naming it with the 
same name as the subject model, then by saving the following files in the new folder:

• The parent-child relevant information of the model (ModelInfo.dat).
• Subject model and its all the child models (*.mdl, *.hsf).

 Saving a Model Group

Procedure
1. Select a model with the status symbol (on the left of the selected model name)  in the 

Cad Tree set to .  

2. Select {Edit} - {Save Model Group] from the Cad Tree right-click menu. 
Select [Yes] to create a folder with the same name as the model selected in the step 1.  
The files of the model (selected in the step 1) and its child models are copied to the 
folder, and a parent-child relevant information file "ModelInfo.dat" is generated.

+

501/847



11.8  Saving and Reading a Model Group

HW0485348

 Reading a Model Group
Select {Edit} - {Load Model Group] from the Cad Tree right-click menu.  Select a “Mod-
elInfo.dat” file to read the saved model including its child models.
  

 Syntax of the ModelInfo.dat
MODEL

{
NAME=Camera_Dummy     //Logical name of the model
PARENT=world             //Parent model name
FILENAME=dummy               //File name
COLOR=RGB (0,0,255)       //Color of the model
HIDESEE=1                         //Display/nondisplay information
OPACITY=0.25                        //Opacity
AXIS6=4000.000,5500.000,2000.000,-1.57,0.00,-0.35     // Position of the model
}

If there is a model with the same name in the current cell, the second one will automatically be 
numbered.  (The number will be added after the name.)

NOTE
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11.9 Changing and Moving the Parent Model

11.9.1 Changing the Parent Model

The parent model of an arbitrary model can be changed with {Set Parent} under {Attribute} of 
the Cad Tree menu.
With this function, the relation (coordinate) between the selected model and its parent model 
is automatically changed, and the model position does not change.  Use this function in case 
of changing the parent model while keeping the model in the same position.

To use this function, select the desired model in the Cad Tree, then select {Attribute} - {Set 
Parent} from the Cad Tree right-click menu.

11.9.2 Moving the Parent Model

The parent model of an arbitrary model can be moved with {Move Parent} under {Attribute} of 
the Cad Tree menu.
Since the relation (coordinate) between the selected model and its parent model does not 
change with this function, the selected model position changes when it is moved to its new 
parent model with {Parent Move}.

To use this function, select the desired model in the Cad Tree, then select {Attribute} - {Move 
Parent} from the Cad Tree right-click menu.

11.9.3 Changing or Moving the parent model by dragging 
and dropping a mouse

Drag the target model with [CadTree] and drop it onto the new parent model, pop-up menu 
appears. Select [Set parent] or [Move parent] from the displayed pop-up menu, Changing par-
ent or Moving parent is possible.

 

Drag 
Drop 

Select [Set Parent] 
or [Move Parent] 
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With mouse drag and drop operation, dropping to child tree not allowed.

 

Drop to child tree not allowed 
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11.10Changing a Model File

The model file of an existing model can be changed with {ChangeFilePath} under {Attribute} of 
the Cad Tree menu.

To use this function, select a model to be changed in the Cad Tree, then select {Attribute} - 
{ChangeFilePath} from the Cad Tree menu.  Select the desired model file in a file selection 
dialog box to change the model file.
Note that the change will only take effect the next time the cell is open.  

The model files for "world", "Teacher", and robot models cannot be changed. NOTE
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11.11Reading a Model

A model appears on the cell by dragging and dropping its model file (in the HSF, HMF, MDL, 
3DS, or RWX format) to the cell window, and the model file is copied to the "models" folder.  
In this operation, a parent model can also be selected.

Procedure
1. Drag and drop an arbitrary model to the cell window; If the model file path doesn't cor-

respond to the "models" folder under the cell folder, the following dialog box will display 
and offer to copied model file to the "models" folder of the cell.

If the "Yes" button is clicked and a file with the same name already exists in the cell 
"models" folder.  The following dialog will display to ask for overwrite confirmation.

 

Drag and drop.

Model displayed on the cell.
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2. The Select Model Parent dialog will display.  Select the model that will become the par-
ent of the new model and press the [OK] button.  (By default the "world" model is 
selected.) 

When adding LINE data (wire frame), it is recommended to use LINE data in the HMF for-
mat: adding LINE data in other format may take some time. 
If the LINE data is in a format other than HMF, convert the LINE data with “MDL2HMF.EXE” 
before adding the model.  (The MDL2HMF.EXE is located in a folder where MotoSim EG-VRC 
was installed).

 

NOTE
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11.12Model Script

Model script allows manipulate models by the execution of a series of model commands.  The 
model script editor allows to write and manage the model script of the specified controller.  
The model script can be executed from the Model Script Editor or from an I/O Event during 
playback. (For details on I/O Events refer to section " 8.3  I/O Events "). 

11.12.1 Model Script Editor

To display the Model Script Editor select {Model} - {Model Script Editor} from the main menu.

Model Script Editor Dialog Box

Item Description

Controller Select the controller for which the scripts are to be edited.

Script List
Displays the list of scripts for the selected controller.
Select a script to display/edit its content in the right section of the 
dialog.

Script
Displays the name of the selected script.  
The script content in displayed in edit box below where the model 
commands can be added or modified.  
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11.12.2 Model Commands

Model commands can be used in model script to manipulate models in the cell.  Note that 
model names are case sensitive.  Make sure that the names are typed exactly like the name 
of the model appearing in the Cad Tree.

 Model Display

 Model Non-display

 Model Move 1 (Set Model Parent)

 Model Move 2

[Add] button
Adds a new script to the list.  
A dialog will display to enter the script name.  Enter a name and 
press OK.  The new script will be added to the list.

[Delete] button Deletes the script currently selected in the script list.

[Save]button
Save the script content to file.
Note: Scripts are saved to the “ModelScript.txt” file under each con-
troller folder. 

[Run]button Execute the script selected.

[Stop] button Stop the script selected.

[Close]button Closes the Model Script Editor dialog.

Notation SEE M1

Meaning Displays the model M1.

Notation HID M1

Meaning Hides the model M1.

Notation MOV M1 M2

Meaning Moves the model M1 in the Cad Tree to change its parent to M2. Without 
changing the model location on the display, the model relative position 
from its new parent (M2) is changed automatically.

Notation AXIS6 M1=10,20,30,0,0,0

Meaning Moves the model M1.  The position from the parent is changed to 
(10,20,30,0,0,0).

Model Script Editor Dialog Box

Item Description
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 Model Move 3

 Model Copy 1

 Model Copy 2

 Model Deletion

 Model Action

Notation ADDX6 M1=10,20,30,0,0,0

Meaning Moves the model M1.  The position from the parent is changed by adding 
(10,20,30,0,0,0) to the current position.

Notation DUP M1 M2

Meaning Copies (duplicates) the model M1 to create M2.

Note If MotoSim EG-VRC is saved without deleting the copied model, the 
description (information on arrangement, etc.) is written in to the cell.  
The copied model will reference the same model data file (.mdl) as the 
original model.

Notation REF M1 M2

Meaning Copies (references) the model M1 to create M2.

Note Even if MotoSim EG is saved without deleting the copied model, the 
description (information on arrangement, etc.) is not written in to the cell.

Notation DEL M1

Meaning Deletes the model M1.

Notation ACT M1 D S=P1 E=P2 T=T1,T2

Meaning Meaning?Model M1 moves from P1 to P2 in D direction between T1 and 
T2.
  D : One of the character X, Y, Z, Rx, Ry or Rz
  P1 : Movement start position (units:mm or deg.)
  P2 : Movement end position (units:mm or deg.)
  T1 : Movement starting time after this model script executed(units:msec)
  T2 : Movement ending time after this model script executed(units:msec)

  (E.G.) ACT M1 X S=0 E=1000 T=0,1000
   Model M1 moves from 0mm to 1000mm in X-axis direction between 0ms 
  and 1000ms

Note Only while a controller is moving, ACT command is executed.
If the time of ACT command is over the playback time, ACT command also 
stops at the time of a playback finishing. And, ACT command is not exe-
cuted by RCS controller.
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 I/O signal Output

 Starting Time of Each Command in Model Script
To specify the timing of executing each command, add "T=T1 ,T2" at the end of each com-
mand. Because commands besides ACT move momentarily, make T1 and T2 the same 
value.
(E.G.) MOV WORK world T=1000 ,1000

(Example for Executing Timing)

The executing timing of starting each command of above model script is as follows.

Notation1 OUT C1 #(20030)=ON

Meaning IO signal 20030 (Logical Name) of controller C1 turns ON

Notation2 OUT C1 IN#(1)=ON

Meaning General Input IO signal IN#(1) of controller C1 turns ON

Note  Only while a controller is moving, ACT command is executed.
If the time of ACT command is over the playback time, ACT command also 
stops at the time of a playback finishing. And, ACT command is not exe-
cuted by RCS controller.
General Input and External Input are supported only.

 
ACT KYUBAN Z S=0.000 E=-1150.000 T=0 ,2000      ① 

MOV WORK world T=2000,2000    ② 

ACT KYUBAN Z S=-1150.000 E=0.000 T=2100 ,4100 ③ 

ACT ROT1 Rx S=0.00 E=90.00 T=4300 ,5300  ④ 

ACT ROT2 Rx S=0.00 E=90.00 T=4300 ,5300  ⑤ 

ACT ROT3 Rx S=0.00 E=90.00 T=4300 ,5300  ⑥ 

ACT ROT4 Rx S=0.00 E=90.00 T=4300 ,5300  ⑦ 

OUT DX200 IN#(1)=ON T=5300 ,5300   ⑧ 

 

 ② 

0 2000 2100 4100 5300 4300 

③ ④ 

⑤ 

⑥ 

⑦ 

⑧ 

(ms) 

 ① 
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11.12.3 Display of script input assistance

As for the script, the edit that uses the manual edit and the “Script input assistance” dialog box  
can be done.
The “Script input assistance” dialog box  opens when the line edited in the “Model Script Edi-
tor” dialog box is double-clicked.

It explains the input item of each model instruction.

The model's display (SEE), the model's non-display (HID), and the model's deletion (DEL) 
The [model] is input. 

Model Script Editor Dialog Box

Item Description

Model instruction
The model instruction is selected. (The input item changes by the 
selected model instruction. )Please refer to the explanation of the 
following each model instructions for details.

Move time

Set the execution starting time and ending time of the model com-
mand.(units:msec)
In case of ACT command, the model moves smoothly between 
starting time and ending time.

I want to set the start time 
to end time of the previ-
ous

When enabled, the ending time of the latest line is set to the start-
ing time automatically.

step Set the increment value of the spin control.

[Add] button The edited model instruction is added to a selected line. (Former 
model instruction moves below by one line. )

[Change] button A selected line is changed by the edited model instruction.

[Cancel]button The script input assistance is closed without changing the edited 
content.
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The [model] is input by either the selection with the direct input or Cad Tree or .

The [Move time] is set by either the direct input or   . The increment value of   can be 
changed by step.

 The model's movement 1(MOV), the model's copy 1(DUP), and the model's copy 2(REF) 
[Model1] and [Model2] are input.

The [Model] is input by either the selection with the direct input or Cad Tree or .

The [Move time] is set by either the direct input or   . The increment value of   can be 
changed by step.

The model name is 
input. 

 

Model 1 and model 2 
are input. 
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 The model's movement 2(AXIS6) and the model's movement 3(ADDX) 
The [Model] and the [Position] are input.

The [Model] is input by either the selection with the direct input or Cad Tree or .

The [position] and the [Move time] are set by either the direct input or   .

The incremental value of  can be changed by step.

 

The Model is input. 

The Position is input. 

Set the incremental value of the 

spin button  
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 The model's action (ACT)
[Model], [Direction], [StartPos], [EndPos] and [Move time] are input.

The [Model] is input by either the section with the direct input or CAD Tree or  .

The [StartPos], [EndPos] and [Move time] are set by direct input or spin box   .

The increment value of spin box   can be changed by step.

 The I/O output (OUT)
The target controller of I/O output is selected by the drop down list.
The [Io kind], [ON/OFF], [Io no] and [Move time] are input.

The [Move time] is set by either the direct input or  .

The increment value of   can be changed by step.
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11.12.4 Execute Model Script while playback

To execute the model script while playback, Set one of the following.
• I/O Event

For details, refer to the section ." Fig. 8.3)  I/O Events "
• Comment of Job

Enter the following comment at the point where the model script is to be started.

'MDS:[Model Script Name]
(E.G.)

And, when enter the following comment in a job, the model script execution after this com-
ment waits for the previous model script completion. But job execution keeps.

'MDSWAIT
(E.G.)

   

Model script “SC4UNSET” execution waits 

for the previous model script “SC1UNSET” 

and “SC2UNSET” completion. 
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11.13Reduce HSF File

The number of polygons of the HSF file can be reduced.
On the [CadTree] dialog, select a model to reduce the polygon number. And, right-click on the 
model and select the [HSF Reduce] menu, the [Reduce HSF File] dialog is displayed. Input 
the Accuracy and click the [OK] button, the number of polygons of the HSF file is reduced.
When the accuracy is set to 100%, a model will be an original model. The number of polygons 
is reduced so that the accuracy is set as the small value.

This function is available only with the HSF data. When a file size is big, it takes time for 
reducing process.

    

NOTE
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11.14CAD Data Import <CadPack Option>

Loads the following CAD data format to the cell directly.

This function is accessible by:
a)The Add Model dialog of the [Cad Tree]

(For details, please refer to section " Creating a Model from an Existing Model ".)
b)Dragging and dropping the file over the cell display area.

(For details, please refer to section " 11.11  Reading a Model ".)

 CAD Data Import
Before importing CAD data, the "CAD Import" dialog will display. The healing settings in the 
dialog can be changed if required. (This dialog doesn't display when importing SAT file.)

To change the default settings related to the CAD Import, please refer to section " 12.7  CAD 
Import/Export <CadPack Option> ". 

To use this function (CadPack option), the MotoSim EG-VRC-CadPack is required.  (The 
MotoSim EG-VRC-CadPack is separate product from MotoSim EG-VRC.)

Format Extension Version Availability of 
CAM function

Scale 
conversion

IGES igs,iges -5.3  

STEP stp,step 203,214,242  

Inventor ipt V11-2020  

ProE / Creo prt, prt.*, asm, asm.* 16-Creo 6.0  

SolidWorks sldprt,sldasm 2003-2019  

CATIA V5 CATPart,CATProduct R8-R29(V5 – 6R2019)  

SAT sat R1-R29(2019 1.0)  

Parasolid x_t,x_b 9.0.* - 31.1.*  

DXF dxf 2.5-2020  

HSF hsf -20.80  

HMF hmf -20.80  

VRML wrl 2.0  

STL stl ―  

3DS 3ds ―  

RWX rwx ―  

PLY ply ―  

When adding a model with method a) Add Model dialog, it is necessary to select "All (*.*)" 
in the "File Type" section, in order to display all the file types and be able to select the 
IGES or SAT files.

NOTE

NOTE
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The figure below shows, the "CAD 
Import" dialog when the IGES data 
healing is disabled.  
This is the default setting.

The "CAD Import" dialog with the IGES 
data healing enabled.

CAD Import

“Enable Heal-
ing” section

When enabled, a healing algorithm is applied to the imported CAD data.
[Recreate surface] check box

The [Recreate surface] option is normally selected.
The [Recreate surface] is part of the normal healing process.  If it is 
unselected, this step will be skipped in the healing process.
If the surface regeneration doesn't give the intended results, unselect 
the "Recreate Surface" may improve the healing results. 

[Disable on error] check box
The [Disable on error] option is normally selected.
When the [Disable on error] is selected, the healing will be disabled if 
an error occurs during the healing process. 

Imports the 
work file for 
CAM teaching

Select this type when the model applies a CAM function. Do not select this 
type when the model is tool or peripheral equipment.
General CAD data are displayed  in the CadTree dialog, and the model 
for CAM teaching are displayed    .
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[High-Speed 
Mode] check 
box

When enabled, MotoSim EG-VRC reads only data necessary to drawing 
from CAD data, so it may takes higher. But, When "Imports the work file for 
CAM teaching" is enabled, this is disabled.

[Don't show this 
dialog next time] 
check box

If checked, the "IGES Import" dialog will no longer be displayed when an 
IGES file is imported. The "IGES Import" dialog display can be re-enable in 
the "Option Setting" dialog under the "CAD Import/Export" tab.  Please 
refer to section " 12.7  CAD Import/Export <CadPack Option> ".

[OK]button The IGES file import will proceed with the options set in the dialog.

[Cancel]button Cancel the IGES file import

The healing process attempts to repair any corrupted data of the imported CAD files. 
However, the processing time to import a file may increase significantly when healing is used.  
The performance may also vary depending on the extent and nature of the errors in the origi-
nal CAD file.  In some cases, result with healing may be worst than reading the file without 
healing.

CAD Import

IGES and STEP assembly format files are not supported 
High-Speed mode.

NOTE

NOTE
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11.15Changing the Coordinate Origin of CAD Data 
<CADPack Option>

Change the coordinate origin of external CAD data.
After [Cad Tree] is displayed, right-click on the work to change the coordinate origin and select 
the [set Originpos] menu. Then the [Origin Point] dialog is displayed, change the value of posi-
tion.

It is possible to change the coordinate origin of external CAD data as follows.

This function is available only with the data which enabled [Imports the work file for CAM 
teaching] at the time of reading of the following external CAD data.
CATIA, SOLIDWORKS, Pro/E, INVENTOR, IGES, STEP, SAT, Parasolid, DXF

 

NOTE
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11.16CAD Data Export 

Exports in IGES,SAT or HSF format the data of MDL models with their relative position from a 
selected base point.

 Procedure
1. Select in the Cad Tree the models to export.

• To select a single model:
Expand the model node so that there is no "+" icon on the left of the model name 
and select the model.

• To select multiple models
Collapse the node containing the desired models so that there is a "+" icon on the 
left of the model name.  All the child models in the collapsed branch will also be 
exported.

• When IGES or SAT data are exported (CadPack option), the MotoSim EG-VRC-Cad-
Pack is required.  (The MotoSim EG-VRC-CadPack is separate product from MotoSim 
EG-VRC.) 

• Only the model referring to 
• .mdl files composed of BOX, BOX2, CYLINDER, CONE2, SPHERE, PIPE2, AXIS6, 

LINE, LINE2 parts;
can be exported.

NOTE

 

The “SAT1” model will be
exported. 
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2. Right click on the CadTree to display the popup menu.  Then select "Export CAD 
File..."

3. In "Select Base Model" dialog, select the model to be used as the base point (origin) of 
the exported model and press the [OK] button.

4. In the "Save As" dialog, select the file type (IGES,SAT or HSF).  Enter a filename and 
press the [Save] button.

 

The child “SAT1” and “SAT2” model of 
the “POS” model will be exported. 
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5. If the "Export" dialog is set to display, the "Export" dialog will display to confirm the 
IGES/SAT export settings.  Change the settings as required, and then press [OK].  For 
more details please refer to the " Export " section above.

6. When the export is completed the following message will display.
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 Export
Before the CAD data of IGES or SAT format is exported, the "Export" dialog is displayed.  The 
export settings in the dialog can be changed if required.
To change the default settings related to the export, please refer to section " 12.7  CAD 
Import/Export <CadPack Option> ". 

 The settings selected in the "Export" dialog will not change the settings in the "Option 
Setting" dialog under the "CAD Import/Export" tab.

Export

[Units] radio button Sets the measuring units of the exported SAT or IGES files.

“Version (SAT Only)” 
section

Sets the SAT file version used in the exported file.Recommended 
value: 6 (Setting range: 4 to 29)

[Don't show this dia-
log next time] check 
box

If checked, the "IGES Import" dialog will no longer be displayed 
when an IGES file is imported. The "IGES Import" dialog display can 
be re-enable in the "Option Setting" dialog under the "CAD Import/
Export" tab.  Please refer to section " 12.7  CAD Import/Export 
<CadPack Option> ".

[OK]button The CAD export will proceed with the options set in the dialog.

[Cancel]button Cancel the CAD export.

NOTE
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11.17Creating Simplified Model

The simplified model creation function creates a simplified model with reduced polygon count. 
Specifying a simplified model for the target of interference check, performance can be 
improved.

 Creating Simplified Model from CadTree
To create a simplified model, click the right mouse button on the model of the [CadTree] dialog 
or on the model displayed on the screen, and select "Add simple model" from the pop-up 
menu. The "Create simple model" dialog is displayed.
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 Generation Parameter

Model Type Sets one of the model types.
  Poligon : convex polyhedron (default)
  AABB   : A rectangular parallelepiped with the same orientation
  OAB      : Rectangular parallelepiped whose orientation was 
                  adjusted according to inclusion model

Cut num Sets the number of cuts of the model's face in simplification model 
generation. The smaller the value, the rough model is generated.

Ratio of the number 
of polygons

Sets the ratio of the number of polygons in the simplification model 
to the number of polygons of the reference model. Because it is the 
reference of model generation, it is not guaranteed that it will always 
be proportionate to it.

+X, -X, +Y, -Y, +Z, -Z Sets whether to reflect the margin amount in the plus or minus direc-
tion of each axis.

Margin value Sets the margin amount between the simplified model and the refer-
ence model.
If 0 is specified, a simplified model with the same size as the refer-
ence model is generated.

Color Sets the color of the simplified model.

 

Specify whether the child 
models of the reference 
model are also subject to 
simplification 

Set generation parameter 
of simplified model 
For details, refer to 
“Reference” below 

Set the color attribute of 
the generated simplified 

[Clear] log button 

[Start simple model] 
button 

Log list 

Reference model for 
simplification 

When this is a small value, simplification may fail if a 
number of polygons of the reference model is small.

NOTE
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 Reference

• About the reference model for generating simplified models
The target models of this function are only the model displayed in the main screen. Hid-
den models are excluded.

• About name of the simplified models
The simplified model is added as a subtree item of the reference model.

Opacity Sets the opacity of the simplified model. 
[Transparent] 0%<------>100% [Opaque]

 The <model name> used for the simplified model name is as follows.
"Simple_XXXXXXXX [Margin number]"
Use the part of "XXXXXXXX" excluding the controller name "<model name> _XXXXXXX" 
of the reference model.

 

AABB OBB Polygon 

Target Model 

 

 

Model Name: 
Simple_<Model Name>#<Margin number> 

NOTE
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 Simplified model creation of collision model group
Simplified models can be created for interference model groups registered as targets.

On the "Collision Model Group" dialog displayed from the "Collision Detection" dialog, select 
the group for which simple models are created and select the [Create Simple Model] button.

 

 

The models registered in the collision 
model group are displayed in a list. 

“Create sub tree models” check box 
is unavailable.
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When generation of the simplified model is completed, the process returns to the collision 
model group dialog. And, the collision model group composed of the created simplified model 
is registered as "Simple_ <collision model group name>".

 By using the model group of the created simplified model for the collision pair, it is possible to 
improve the performance of collision check processing.

 Show / hide simplified model
To show / hide the created simplified model, select the target simplified model from the 
CadTree dialog, right-click and select the "Hide/See" menu in popup menu.

Also, select "Simple model" - "Show all simple model" or "Simple model" - "Hide all simple 
model" in the pop-up menu, all simplified models that exist in the subtree of the currently 
selected model are shown / hidden.
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 Delete simplified model
To delete a created simplified model, select the target simplified model from the CadTree dia-
log, right-click and select the "Edit" - "Delete" menu in popup menu.

Also, select "Simple model" - "Delete all simple models" in the popup menu, all simplified 
models that exist in the subtree of the selected model are deleted.
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12 Configuration Settings

Various configuration settings can be made in the Option Setting dialog box.

Click the MotoSim EG-VRC button (  ), and select the [Options] menu.

12.1 Graphical Settings

For the graphical settings, select the “Graphic” tab of the Option Setting dialog box.  

Graphic tab

Item Description

[Reset] button Restores all the values to the default setting.

[OK] button Applies the modifications, and closes the dialog box.

[Cancel] button Closes the dialog box without applying the modifications.
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12.1.1 Background Color

Specify the background color of the cell window in the “Background Color” section.  

12.1.2 Smooth Transition

Specify if a smooth transition is executed when changing viewpoint in the “Smooth Transition” 
section.

12.1.3 Display

Configure the graphic driver in the "Display" section. 

Item Description

"Top" color 
indication box

Displays the current color of the upper part of the background.
Press [color] to display the Color dialog box, and select the desired color.

"Bottom" color 
indication box

Displays the current color of the bottom part of the background.
Press [color] to display the Color dialog box, and select the desired color.

[Same Color] 
check box

Check this check box to set the “Bottom” background color to the same 
color as the “Top” background. 

Item Description

[Execute] check box Select to execute the smooth transition function when changing the 
viewpoint.

"Duration" edit box Specify the duration of the smooth transition.  (Editable when the [Exe-
cute] check box is selected.)

Item Description

"Driver" combo box

Select a graphic driver from the list: "OpenGL2" is selected by default.
The graphic drivers currently available are "OpenGL", "OpenGL2" and 
"WinGDI". 

[Axis Triad On] 
check box

Displays the coordinate axis below on the lower left of the cell window. 

[Perspective] 
check box Check this check box to display the cell in perspective.

To apply the change of graphic driver, reload the cell.NOTE
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12.1.4 Shadow

Set the following items for shadow display in the “Shadow” section.

12.1.5 Frame & AXIS6

Specify the Frame and Axis6 display property.

Item Description

[Show] check box Select to display shadows on the cell window.

"Color" indication box
Displays the current color of the shadows.
Press [color] to display the Color dialog box, and select a desired color.
(The [color] button is enabled when the [Show] check box is selected.)

"Resolution" edit box Enter the resolution value.
(Editable when the [Show] check box is selected.)

"Blurring" edit box Enter the value for the gradation effect.
(Editable when the [Show] check box is selected.)

Item Description

“Frame Length” spin 
box Enter the value of the frame and Axis6 length with the spin button.

Frame Color
Press [color] to display the Color dialog box, and select a desired color for 
Frame.
Check "3 colors" checkbox to display in each color for X,Y,Z axis.

User Frame Color
Press [color] to display the Color dialog box, and select a desired color for 
User Frame.
Check "3 colors" checkbox to display in each color for X,Y,Z axis.

"Always Display Axis6 
in Front" checkbox When checked, the Axis6 are displayed in front of all the other parts.

Axis6 Displayed in FrontRegular Display
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12.1.6 Level of Detail

When changing the scene viewpoint or during playback the level of detail can be decrease in 
order to obtain a smoother animation.  This function is useful to improve display performance 
of cell containing a large amount of data such as very detailed HSF model.

Item Description

Enable

When this item is checked, the level of detail will be reduced during view-
point change and playback.  The level of detail data will also be gener-
ated for the HSF models when required.

• When the displayed surface becomes rougher during viewpoint change or playback, 
depending on the data some model elements may not display.

• It is easier to distinguish the discrepancies between levels of detail when displaying the 
cell in "Flat Shading" (refer to section " 6.11  Changing the Rendering Mode ").

• When the function is enabled, a message offers to gen-
erate the level of detail data for the currently opened 
cell.  If the data was previously generated for this cell, it 
is not necessary to regenerate the data and you may 
press "Cancel".

• The generation of the level of detail data may take 
some time depending on the size of the model file.

NOTE

NOTE
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 Generating the Level of Detail Data
When the Level of Detail function is enabled, the level of detail data need to be generate for 
the function to work properly.  If an opened cell doesn't contain the level of detail data, a mes-
sage will prompt the user to confirm that the data should be generated at this time.

While generating the level of detail data, the "Generating Level of Detail" dialog will display the 
generation progress.  To stop the data generation, click on the "Abort" button.  Note that when 
aborting the generation, the current file processing will continue until completed, and then the 
generation will stop and data for the remaining file will not be created

 

 

 

 

 

Displayed surface  
become rough 
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.

When adding HSF model and the Level of Detail is enable, the level of detail data will auto-
matically be generated for the new model.  The "Generating Level of Detail" progress dialog 
will display but the process cannot be aborted.
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12.2 Markup Settings

To configure the lines and texts on the cell window, select the "Mark Up" tab of the Option Set-
ting dialog box.

Mark Up tab

Item Description

"Mark up" section

"Color" indication box
Displays the current color of the markup object (line and text).
Press [color] to display the Color dialog box, and select the desired 
color.

"Thickness" spin box
Directly enter the value or specify the value with the spin button  to 
specify the thickness of the markup line.
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"Text" section

"Font Name" combo box
Select a desired font for the text. 

"Size (pts.)" edit box
Specify the size of the font.

"Back Color" indication box
The color indication box displays the current markup text background 
color.
Press [color] to display the Color dialog box.  And select the desired 
background color.

[Reset] button Restores all the values to the default setting.

[OK] button Applies the modifications, and closes the dialog box.

[Cancel] button  Closes the dialog box without applying the modifications.

Mark Up tab

Item Description

When using two-byte characters for the text, make sure 
to select a font which can be displayed properly.

NOTE
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12.3 Robot Option Settings

When a robot axis reaches its limit position, the color of the axis changes.  

Robot Option tab

Item Description

"Pulse limit warning" 
section

[Execute in Teach] check box
Select to display the axis reaching its limit in a reverse color or a limit 
color in a teaching operation. 

[Execute in Play] check box
Select to display the axis reaching its limit in a reverse color or a limit 
color in a playback operation.

First
"Limit Value (%)" edit box

Directly enter the value to specify the limit value for the first limit 
axis check. 

"Limit Color" indicaiton box
Displays the current first limit color. Press [color] to display the Color 
dialog box, and select the desired color.

Second
"Limit Value (%)" edit box

Directly enter the value to specify the limit value for the second limit 
axis check. 

"Limit Color" indicaiton box
Displays the current second  limit color. Press [color] to display the 
Color dialog box, and select the desired color.
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"Multiple Controller 
Dialog" section

When enabled MotoSim EG-VRC will display a separate copy of  control-
ler related dialog or panel for each controller in the cell.  When a dialog is 
initially displayed, it is set to the currently selected controller.  Once dis-
played the dialog will always display the information for the same control-
ler, even if the current controller is changed.  To display multiple copy of a 
same dialog, display a first copy of the dialog, then change the current 
controller and display the dialog again.

File Save

When checked, the path information stored in the cell file are relative to 
the cell file folder. If unchecked, the full path starting from the driver root is 
stored in the cell file. A cell saved with relative path is easier to transfer to 
another computer. (To store the file refer to " 4.3  Storing a Cell ".)

[Reset] button Restores all the values to the default setting.

[OK] button Applies the modifications, and closes the dialog box.

[Cancel] button  Closes the dialog box without applying the modifications.

Robot Option tab

Item Description
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12.4 Language and Unit Settings

To configure the language and unit, select the "Lang / Unit" tab of the Option Setting dialog 
box.  

Lang / Unit tab

Item Description

"Language" section Select the [Japanese] or [English] radio button to configure the language.
To set from the main menu, select {View} - {English} or {Japanese}.

"Unit Settings" 
section

Select the units for each type of values.

"Length/Position" edit box
Indicates the unit of the length. 

"Angle" edit box
Indicates the unit of the angle. 

"Weight" edit box
Indicates the unit of the weight.

[Reset] button Restores all the values to the default setting.

[OK] button Applies the modifications, and closes the dialog box.

[Cancel] button  Closes the dialog box without applying the modifications.
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12.5 Other

12.5.1 Performance Settings

To configure the performance, set items of "Performance" .

Other tab

Item Description

[Reset] button Restores all the values to the default setting.

[OK] button Applies the modifications, and closes the dialog box.

[Cancel] button Closes the dialog box without applying the modifications.

Item Description

"Framerate Optimization" 
section

"None" radio button
All model data are displayed.

"Culling Threshold" radio button
Model data which displayed size is smaller than the 
selected pixel on the display are not displayed.

If the threshold is large, performance is 
improved. But, if the threshold is overlarge, the 
necessary model data are not displayed. Set up 
the threshold in accordance with the model data.

NOTE
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12.5.2 Model Library

To configure the model library, set items of "Model Library".

12.5.3 Default Cell Folder

To configure the model library, sets items of "Default Cell Folder".

12.5.4 CadTree Input Area

To configure the CadTree Position Input Area..

Item Description

"Model Library" section "Library Path" edit box
Sets the folder path of model library.
You can select a folder with the [...] button.

Item Description

"Folder Path" section "FolderPath” edit box
Sets the default folder path of cell.
You can select a folder with the [...] button.

Item Description

CadTree Input Area section "Display" check box
Sets whether to display the position input area.
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12.6 Mouse Customization

The mouse button allocation of viewpoint operation can be changed.
Presses the allocable mouse button and key in the edit box, the mouse button allocation of 
viewpoint operation is changed.
The allocable mouse button and key are as follows.

• Middle button(mouse)
• Right button(mouse)
• [CTRL] key
• [SHIFT] key

Mouse Customization

Scroll ･Zoom Presses the allocable mouse button and key in the edit box, the 
allocated key to Scroll?Zoom is displayed.

Rotate Presses the allocable mouse button and key in the edit box, the 
allocated key to Rotate is displayed.

Pan Presses the allocable mouse button and key in the edit box, the 
allocated key to Pan is displayed.

Free Zoom Presses the allocable mouse button and key in the edit box, the 
allocated key to Free Zoom is displayed.
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Show Viewpoint Operation Bar When enabled, viewpoint operation bar is displayed. 

Click the above button, viewpoint operation by right button is 
changed.
If unchecked, viewpoint operation bar is hidden.

[Reset] button Setting is changed into default.

[OK] button Setting is saved and this dialog is closed.

[Cancel] button Setting is canceled and this dialog is closed.

Mouse Customization
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12.7 CAD Import/Export <CadPack Option>

12.7.1  CAD Import

Option settings related to reading CAD format files.

To use this function (CadPack option), the MotoSim EG-CadPack is required.  (The Moto-
Sim EG-CadPack is separate product from MotoSim EG.)

“Enable Healing” 
section

When enabled, a healing algorithm is applied to the importedCAD data.

[Recreate sur-
face] check box

The [Recreate surface] option is normally selected.
The [Recreate surface] is part of the normal healing process.  If it is unse-
lected, this step will be skipped in the healing process.
If the surface regeneration doesn't give the intended results, unselect the 
"Recreate Surface" may improve the healing results. 

[Disable on 
error] check box

The [Disable on error] option is normally selected.
When the [Disable on error] is selected, the healing will be disabled if an 
error occurs during the healing process. 

NOTE
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12.7.2  IGES/SAT Export

Imports the work 
file for CAM teach-
ing

Select this type when the model applies a CAM function. Do not select this 
type when the model is tool or peripheral equipment.
General CAD data are displayed  in the CadTree dialog, and the model 
for CAM teaching are displayed  .

[High-Speed Mode] 
check box

When enabled, MotoSim EG-VRC reads only data necessary to drawing 
from CAD data, so it may takes higher. But, When "Imports the work file for 
CAM teaching" is enabled, this is disabled.

[Uses External 
Converter] check 
box

When enabled, CAD data is converted by outside CAD converter software 
and MotoSim EG-VRC imports the converted CAD data. When not 
enabled, MotoSim EG-VRC converts the CAD data.

[Don't show the 
[CAD Import] dia-
log] check box

When this option is selected, the "CAD Import" dialog will not display when 
an IGES file is read.

The healing process attempts to repair any corrupted data of the imported CAD files. However, 
the processing time to import a file may increase significantly when healing is used. The per-
formance may also vary depending on the extent and nature of the errors in the original CAD 
file. In some cases, result with healing may be worst than reading the file without healing.

Units Sets the measuring units of the exported SAT or IGES files.

Version (SAT 
Only)

Sets the SAT file version used in the exported file.
Recommended value: 6 (Setting range: 4 to 29)

[Don't show the 
[Export] dialog] 
check box 

When this option is selected, the "Export" dialog will not display when the 
"Export CAD file" function is used. 

IGES and STEP assembly format files are not supported 
High-Speed mode.

NOTE

For details on the CAD data import, please refer to section " 
11.13  Reduce HSF File ".

NOTE

NOTE

For details on the IGES, SAT data export, please refer to 
section " 11.15  Changing the Coordinate Origin of CAD 
Data <CADPack Option> ".

NOTE

548/847



12.8  Show Teach Point <CadPack Option>

HW0485348

12.8 Show Teach Point <CadPack Option>

To configure the Teach Point, the "Show Teach Point" tab of the Option Setting dialog box.

To use this function (CadPack option), the MotoSim EG-VRC-CadPack is required. (The Moto-
Sim EG-VRC-CadPack is separate product from MotoSim EG-VRC.)

GuideLine

[Show] check 
box

Select displaying the guide lines or not.

NOTE
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[Modify Color] 
button

Select the color of the guide line.

Teach Point No

[Show] check 
box

Select displaying the teach point no. or not.

[Modify Color] 
button

Select the color of the teach point no.

Show Teach Point

Style Frame only 

Arrow Only (S)  

Arrow Only (M)  

Arrow Only (L)  

Frame and Arrow (S)  

 

 

 

A teach point and a teach point 
are connected with a dotted line, 
and are displayed. 
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Style Frame and Arrow (M)  

Frame and Arrow (L)  

None

Length Change the frame length (Z-Axis) of teach point.

[Modify Color] 
button

Select the color of the frame length (Z-Axis)

[Show Teach 
Point Inverse 
Direction] check 
box

Select reversing the frame length (Z-Axis)or not.

[Reset] button Initialize the settings.

[OK] button The settings are saved and the dialog is closed.

[Cancel] button The settings are canceled and the dialog is closed.
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12.9 Backup

To configure the backup, select the "Back up" tab of the Option Setting dialog box.

12.9.1 Controller backup at the time of the Cell save

Sets whether to execute automatic backups of the controller at the time of cell saving.
When this function is enabled, the controller data is saved automatically as "[controller 
name]_[date and time]" at the time of cell saving.
Saved backup files are listed in the dialog. When the backup file is selected and the [Restore] 
button is clicked, the target controller is restored to a previous status.

This function is enabled by default as MotoSimEG-VRC Ver2018 or later.

Item Description

Controller backup at 
the time of the Cell 
save

When this item is enabled, the controller data is saved automatically at 
the time of cell saving.

History Count
Sets the maximum number of backup files. When the number of backup 
files reach this items, the oldest file is deleted and the newest file is 
saved.

Controller Selects the target controller to restore.

File List The backup files of the target controller are displayed.

NOTE

552/847



12.9  Backup

HW0485348

Restore The target controller is restored with the selected backup file.

Delete

The selected backup file is deleted.
When clicks the backup files on pressing the [CTRL] key or [SHIFT] key, 
multiple backup files are selected, then click [Delete] button, multiple 
backup files are deleted.

Item Description
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12.10Import and Export setting contents

You can output the setting contents to the INI file and read the setting contents recorded in the 
INI file.

This function is available only when the cell is not opened.

Item Description

Export
Output the setting contents to the INI file.
The default output destination is as follows.
C:\Users\Public\Documents\MOTOMAN\MotoSimEG-VRC\Settings

Import Read the setting contents recorded in the INI file.

NOTE
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13 Applied Operation

13.1 Teaching Using OLP Function

 What is OLP Function?
Normally, teaching operation uses the programming pendant to move the robot model to the 
target position.  The OLP (Off-Line Programming) function is a quick and efficient way to move 
the robot to a target position.  When the desired destination is located on a model, by using 
the OLP panel, the end of the tool (TCP) can conveniently be moved to the target position by 
simply clicking on the screen (for example, any point of a workpiece, etc.).

• When moving the robot tool end with the OLP function, the message "Cannot reach this 
point" may appear even if the robot is not too far from the target point.  This may happen 
when the tool end cannot be moved to the target point due to the shape or current pos-
ture of the robot.

• A point other than the target point may be selected depending on the point clicked and 
the view position.  When this occurs, use the programming pendant to move the robot or 
change the camera scope of the screen to click on the proper model.

SUPPLE
-MENT
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13.1.1 Teaching Operation Setup

The teaching operation is explained by using “Arc_Sample.vcl” as an example.

Procedure
1. Open “Arc_Sample.vcl”.

(If it is difficult to perform the teaching operation, hide the displayed models such as  
fence, controller, etc. by selecting the obstructing model and then setting its display 
property to “Hide All” in the combo box on the Cad Tree dialog box.)

2. On the [Home] tab, in the [Teaching] group, click the [OLP] button, the [OLP] dialog 
appears.
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3. Display the cell window so that the workpiece is visible as shown in the figure below.

13.1.2 Position Designation in Free Mode

In "Free" mode, the tool end (TCP) moves to the point of the model corresponding to the 
clicked position.

1. Set each item in the OLP dialog box as shown in the following figure.

2. Click on the following position of the workpiece model displayed in the cell window.

3. The tool end moves to the clicked position.

 

Check. 

Select. 

 

Click here.
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Click on another point, and the tool end moves to the clicked position.

13.1.3 Position Designation in Vertex Mode

In "Vertex" mode, the tool end (TCP) moves to the model vertex nearest to the clicked posi-
tion.

1. Set each item in the OLP dialog box as shown in the following figure.

2. Click on the following position of the workpiece model displayed in the cell window.

3. The tool end moves to the nearest vertex.
Click on a point near another vertex to check if the tool end moves to the nearest ver-

 

Check. 

Select. 

 

Click a side near
the corner.
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tex. 

13.1.4 Position Designation in Center Mode

In "Center" mode, the tool end (TCP) moves to the face or edge center nearest to the clicked 
position.
.

1. Set each item in the OLP dialog box as shown in the following figure.

2. Click on the following position of the workpiece model displayed in the cell window.

3. The tool end moves to the center point of the designated model face or edge.  
If the tool overlaps on the model, the tool direction is improper.  Use the programming 
pendant to correct the position afterward.
Click on another face to check if the tool end moves to the center of the designated 

 

Check. 

Select. 

 

Click the side face.
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model face. 

13.1.5 Position Designation in Edge Mode

IIn "Edge" mode, the tool end (TCP) moves to the edge point nearest to the clicked position.
.

1. Set each item in the OLP dialog box as shown in the following figure.

2. Cick on the following position of the workpiece model displayed in the cell window.

3. The tool end moves to the edge point nearest to the clicked position.  Click on another 
face point to check if the tool end moves to the closest edge.

 

Check. 

Select. 

 

Click here. 
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13.1.6 Designation with Orientation Mode

Orientation Move Mode can be used by itself or in combination with the Position Mode.  
Checking the [Orientation] checkbox rotates the tool end frame to align it with the target point 
frame.  If the [Position] mode is also check, the tool end will also move overlap the target 
frame.  Therefore, if you only want to change the orientation of the tool without moving it, 
make sure to uncheck the [Position] checkbox.

The target point frame appears when the left mouse button is pressed down on a model and is 
represented by 3 colored arrows.  The red arrow is the Z-axis and corresponds to the normal 
(or reversed normal) of the face where lies target point; the blue arrow is the X-axis and is 
defined by the face edge closest to the point; and the green arrow is the Y-axis and is orthog-
onal to the two other axis.

Procedure
1. Hide the T-shape workpiece and the stand to make it easier to create a new workpiece.

On the [Home] tab, in the [Model] group, click the [CadTree] button, the [CadTree] dia-
log appears.  To hide the lower hierarchy of the “DAI” tree. Confirm that the cursor is on 
the “DAI” model, then select “Hide All” in the Cad Tree dialog combobox to hide the 
model.

2. Select “world” in the Cad Tree and click on the [Add] button to add the BOX of the fol-
lowing specifications.
Model: WORK2

• That some geometries, such as lines or points, do not have sufficient information to gen-
erate a frame information.  In such cases, the tool end will maintain its original orienta-
tion.

• The direction of the Z-axis can be changed by selecting [Normal] or [Reverse] mode in 
the "Use Face:" section.

Width (W) 500 Depth (D) 500 Height (H) 50

NOTE
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3. Click on the [Pos] button in the Cad Tree to set the position as shown in the table 
below.

4. To see and understand the coordinate axis of “WORK2”, select “WORK2” in the Cad 
Tree, then select “SeeAll” to display the Frame of the coordinate axis on the “WORK2”.

5. Set each item in the OLP dialog box as shown in the following figure.

X (mm) 0 Y (mm) 0 Z (mm) 0

Rx (degree) 0 Ry (degree) 0 Rz (degree) 0

X (mm) 800 Y (mm) 0 Z (mm) 560

Rx (degree) 150 Ry (degree) -20 Rz (degree) 0

          

 

Check. 

Select. 
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6. Click on the position of the “WORK2” as shown below.

7. The tool end moves to the model vertex and the tool coordinate axis is aligned in the 
same direction as the target point frame that was displayed when the point was clicked.

If the [Orientation] checkbox is not checked, the direction of the tool coordinate axis will 
not be changed as shown below.

 Designation with Z-Axis Mode
Z-Axis Move Mode can be used by itself or in combination with the Position Mode.  Checking 
the [Z-Axis] checkbox rotates the tool end frame to align its Z-axis with the target point Z-axis.  
If the [Position] mode is also check, the tool end will also move overlap the target frame.  
Therefore, if you only want to change the orientation of the tool without moving it, make sure 
to uncheck the [Position] checkbox.

The target point Z-Axis appears when the left mouse button is pressed down on a model and 
is represented by a red arrows.  For a solid, the Z-axis corresponds to the normal (or reversed 

  

Click.
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normal) of the face where lies target point.  For a line, it corresponds to the line direction to the 
next closest point.

Procedure
The procedure is explained by using "WORK2", which has been used in "Designation with Ori-
entation Mode", as an example.

1. Move the robot to its home position.  

2. Set each item in the OLP dialog box as shown in the following figure.

3. Click on the face of the "Work2", and the tool Z-axis will turn so that the tool end is per-

• Points do not have sufficient information to generate Z-axis information.  In such cases, 
the tool end will maintain its original orientation. .

• The direction of the Z-axis can be changed by selecting [Normal] or [Reverse] mode in 
the "Use Face:" section.

NOTE

 

 

Check. 

Select. 
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pendicular to the clicked face of the model.

13.1.7 Position Designation with move slave function

When the [move slave] checkbox is checked, the [Move Slave] function is enabled. When a 
robot or station is moved, other slave robots from the same controller are moved with it so that 
their TCP maintain the same relative position to the moved robot or station. For example, this 
section describes the move slave function with SDA10D-A00.

1. Display the OLP dialog box and check the [Move Slave] checkbox.

 

 

Check 
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2. To display the "Set Slave Robots" dialog, click the […] button. Then set which robot are 
slave robots.

3. Click the arbitrary points of works in the MotoSim EG-VRC.

4. Then, slave robots are moved with it so that their TCP maintain the same relative posi-
tion to the moved robot or station.

When the function is enable, if one of the robot can not reach the proper position, all the 
robots are prevented from moving.

 

Click here 

NOTE
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13.1.8 Position Designation with Tool Child to Model Move

 Center of a Circle
Procedure
The procedure is explained by using "Robot+Station.vcl" as an example.

1. Sets each item of [OLP] as follows. Regardless of the setting status of the [Move 
Mode], by checking the [Pick Enable] with [Center of a Circle] selected, this mode is 
available.

 

Check 

Select 
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2. Pick three points of the work model by mouse.

3. The robot's TCP moves to the center of the circle obtained from 3 points.

 Two Points
Procedure
The procedure is explained by using "Robot+Station.vcl" as an example.

1. Sets each item of [OLP] as follows. Regardless of the setting status of the [Move 
Mode], by checking the [Pick Enable] with [Two Points] selected, this mode is avail-
able.
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2. Pick the following point of the torch model by mouse.

 

Check 

Select 
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3. Pick the following point of the work model by mouse.

4. The robot's TCP moves so that the points picked in step 2 and step 3 are matched.

 Two Faces
Procedure
The procedure is explained by using "Hand.vcl" as an example.
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1. Sets each item of [OLP] as follows. Regardless of the setting status of the [Move 
Mode], by checking the [Pick Enable] with [Two Faces] selected, this mode is available.

2. Pick the following point of the hand model by mouse.

 

Check 

Select 
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3. Pick the following point of the hako-2 model by mouse.

4. The TCP of the robot moves so that the surfaces to which the picked point is attached 
at step 2 and step 3.  After moving, the "Would you reverse the direction?" message 
box is displayed, so select whether to reverse. When [No] is selected, the result is as 
follows.

5. When [Yes] is selected, the result is as follows.
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13.1.9 Pick Object Filter

The "Pick Object" section allows setting the type of model that can be selected with mouse.
Use this section when pick operation cannot be executed properly because the objects over-
lap each other.  This setting filters which object types can be selected and enables proper pick 
operation.

Procedure
The procedure is explained by using “WORK2”, which has been used in " What is OLP Func-
tion? ", as an example.

1. Display the Cad Tree; hide the “WORK2” and display the “DAI”.

2. Select “DAI” in the Cad Tree to add the AXIS6 of the following specifications.
Model: DAI (AXIS6)     Frame No.: 0

The AXIS6 is inside the BOX. (To see AXIS6 make sure that the Axis6 are always 
displayed in front in the "Options" dialog.  Please refer to section " 12.1.5  Frame & 
AXIS6 "

X (mm) 0 Y (mm) 0 Z (mm) -100

Rx (degree) 0 Ry (degree) 0 Rz (degree) 0

 

Newly added
AXIS6
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3. Set each item in the OLP dialog box as shown in the following figure.

4. The tool does not move even though the “AXIS6” on the cell window is clicked.  If you 
click around the vertex of the BOX, however, the tool moves to the vertex.  This is 
because the [Frame] check box in the OLP dialog box has been cleared and only mod-
els are considered for selection.

 

Check. 

Select. 

 

Clicking of the AXIS6
does not move the tool.
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5. Check the [Frame] check box for the “Pick Object” and clear the [Model] check box.

6. Click on the AXIS6, and the tool moves to the vertex of the AXIS6.

It is recommended to use this function with both [Frame] and [Parts] checked for normal 
operation.

 

Uncheck. 

Check 

SUPPLE
-MENT
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13.1.10 Changing of Operation Object

Setting the "Operation Object" section in the OLP dialog box allows changing the object 
moved by the pick operation.  The "Operation Object" can be changed among.

Procedure
The procedure is explained by taking “CurModel” as an example.

1. Set each item in the OLP dialog box as shown in the following figure.

2. Display the Cad Tree to select “DAI”, or click on the  button to select the “DAI” 
model in the cell window.

 

The operation object of
when "CurModel" is selected

The operation object of
when "Teacher" is selected

 

Check. 

Select. 
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3. Select a model for the operation object.
• When the current model was selected with the Cad Tree

Click on the tool end in the cell window with the mouse, and the “DAI” moves to the 
tool end.

• When the current mode was selected with the  button
Check the [OLP Pick] check box, then click on the tool end on the cell window, and 
the “DAI” moves to the tool end.

13.1.11 Move to External Reference Point

When the Move to External Reference Point function is active, the robot will move so that the 
point clicked on a model (carried by the robot) is brought to the external reference point.  
This is useful for applications like sealing and spot welding where the parts are handled by the 
robot and brought to a fix point (distribution nozzle, spot gun) for processing. 

Procedure
The procedure is explained by using the "SpotWeld.vcl" as an example.

1. Open the "SpotWeld.vcl" located in the "Example" folder.  The cell display should look 
like the one shown below.

Perform the same operation when the [Teacher] radio button is selected for the “Operation 
Obj” section.

           

Click here.

SUPPLE
-MENT
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2.  On the [Home] tab, in the [Teaching] group, click the [OLP] button, the [OLP] dialog 
appears. Click on the [More >>] button.

3. Set the external reference point.

With the "Select Model" mode  , select the "hite" model by clicking on it.
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To set the external reference point, click on the [Select Reference] button, the [Select 
Model] dialog will display, select the "hite" model and press [OK].

The name of the selected reference model is displayed in the "Move to External Ref. 
Point" section.  Confirm that the "hite" model is selected.

4. Set each item in the OLP dialog box as shown in the following figure.

 

Click here 
(model:hite) 
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5. Click on the work piece at the shown position.

6. The robot will move the work piece target point to the external reference point.

To use the "Move to External Reference Point" mode, the "Operation Object" needs to be 
set to robot.

 

Check 

Select 

Check 

 

Click here. 

NOTE
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13.1.12 Synchronous Base Axis Move to Target Point

When a robot with servotrack/servotracks is moved with the OLP, the synchronous base axis 
move function allows the tool end (TCP) to move to the target point with the servotrack 
motion.
This operation function procedure is explained separately for robots with a single servotrack 
and robots with multiple servotracks.

 Robot with Single Servotrack
Procedure

1. For the robot with a single servotrack, the move method can be selected among:
• Front movement;
• Approach little by little; and
• Middle of attainment and front.

2. Select the [Active] check box in the “Synchronous base axis move” .

  

Check. 

Displays the selected move method. 
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3. Click on the [Method] in the OLP dialog box to display the “Synchronous base axis 
movement” dialog box, and set the move method.

Front Movement
The function enabled with the [Front movement] radio button allows the tool end to move to 
the target point after the servotrack moves in front of the target point.

Procedure
1. Select the [Front movement] radio button in the “Synchronous base axis movement” 

dialog box.

2. Click on the target point.
• If the target point exceeds the servotrack soft limit, a message is displayed and the 

servotrack moves to the soft limit.
• If the tool end (TCP) does not reach the target point, an error message is displayed 

but the servotrack moves in front of the target point.

 

Select the move method.

Input only when the 
[Middle of attainment
and front] radio button 
is selected.

            

Aimed point

Moving distance

After move

 

Select.
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Approach Little by Little
The function enabled with the [Approach little by little] radio button allows the servotrack to 
move only the distance between the target point and the position of the current tool end 
(TCP), then the tool end (TCP) moves to the target point.  In short, the servotrack and the tool 
end (TCP) move so that the current robot posture is maintained as much as possible.

Procedure
1. Select the [Approach little by little] radio button in the “Synchronous base axis move-

ment” dialog box.

2. Click on the target point.
• If the target point exceeds the servotrack soft limit, a message is displayed and the 

servotrack moves to the soft limit.
• If the tool end (TCP) does not reach the target point, an error message is displayed 

but the servotrack moves in front of the target point.

           

 Aimed point

� Distance to
    aimed point

The robot moves
the distance �

After
move

 

Select.
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Middle of Attainment and Front
The function enabled with the [Middle of attainment and front] radio button allows the ser-
votrack to move toward the target point step by step to search for the first position where the 
tool end (TCP) can attain the target point.  The servotrack then moves to the middle point 
between the first attainment and the front of the target point, and the tool end (TCP) moves to 
the target point.

Procedure
1. Select the [Middle of attainment and front] radio button in the “Synchronous base axis 

movement” dialog box.  In the “STEP” edit box, set the moving amount for each step 
taken toward the target point. 

2. Click on the target point.
• If the tool end (TCP) does not reach the target point even though the servotrack 

moves in front of the target point, the attainment is searched with the servotrack 
moving in such a direction that the target point will be further (up to the maximum 
soft limit) than the servotrack position before moving.  

         

Target point

After
move

The first attainment Front of the
target pointMiddle

point
The robot moves in the direction
of the target point step by step.

 

Select.

Sets the interval 
to search for the 
aimed point.

Target point� Searches for
    the attainment.

The original
position

� The end tool
     does not reach
     the aimed point.

In front of the
target point

� Searches
     again.
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• If the tool end (TCP) does not reach the target point, an error message is displayed 
and the servotrack returns to the original position before moving.

• If the tool end (TCP) does not reach the target point because the servotrack moves 
to the middle point between the first attainment and the front of the target point, the 
attainment is searched again with the servotrack moving in such a direction that the 
target point will be further than the middle point.

� Searches for 
    the attainment.

� Moves to the middle point.

�The end tool
    does not
    reach the
    target point.

In front of the
target point

Target point

The original position

� Searches
           again.

� The first
      attainment
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 Robot with Multiple Servotracks
For the robot with multiple servotracks, each servotrack moves the distance between the cur-
rent tool end (TCP) position and the target point, and the tool end (TCP) moves to the target 
point.

Procedure
1. Select the [Active] check box in the “Synchronous base axis move”.  For the multiple 

servotracks, the servotrack move methods cannot be selected since only one method 
is available.   

2. Click on the target point.
• If the target point exceeds the servotrack soft limit, a message is displayed and the 

servotrack moves to the soft limit.
• If the tool end (TCP) does not reach the target point, a message is displayed but the 

servotracks move the distance to the target point. 

           

After move

Aimed point

Moving distance of
the second servotrack

Moving distance of
the third servotrack

Moving distance of
the first servotrack

 

Select. 
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13.2  Trace Function

13.2.1 Changing Trace Object

The object normally traced is the tool end, however, the trace object can be changed.  
The trace object is changed to the flange in the following explanation. 

Procedure
The procedure is explained with the  “Arc_Sample.vcl” example.

1. On the [Simulation] tab, in the [Monitor] group, click the [Trace] button, the [Trace] dia-
log appears. 
The “Trace Manager” dialog will appear.  Trace can be added, edited or deleted.  For 
this exemple, the default trace will be edited.  

2. Display the trace property by double clicking on the “HP6_trace1” or by pressing the 
“Edit” button.  Press the [...] next to the “Model” field to display the “Select Model” dia-
log and select the model to be traced.  For this example, select the “HP6_flange” 
model.  Then click on the [OK] button.  Make sure that the “Model” edit box shows the 
selected model name and click on the [OK] button. 

Select 
“HP6_flange” 
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3. Execute an job.
On the [Simulation] tab, in the [Playback] group, click the [Start] button.

The following figure shows when the tracing point is a tool.

13.2.2 Changing Trace Parent

The tracking drawn by the trace function is normally created and drawn as a model having 
"world" as the parent.  Therefore, changing the name of the “Parent” in the Trace Configura-
tion dialog box will change the parent of the tracking.  This parent changing function is useful 
in the following cases:

• Tracing welding point positions when the robot holds and moves a workpiece to a fixed 
welding points.

• Points to be traced are set to welding points. 

Procedure
The procedure is explained with the “Arc_Sample.vcl” example.

1. On the [Home] tab, in the [Model] group, click the [CadTree] button, the [Cad Tree] dia-
log appears.  

  

Flange tracing

  

Tool end tracing
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To hide the “WORK” which is located on “DAI”, select “WORK” to set it to “Hide”.

2. Select “world” from the Cad Tree and click on the [Add] button to create the “YOU-
SETU” model.

3. Add the “CONE2” model to “YOUSETU”.

589/847



13.2  Trace Function

HW0485348

The following figures show “CONE2” and the layout setting.

4. Create the “WORK3” model that has “TCP” as the parent.
Select “HP6_tcp” from the Cad Tree, then click on the [Add] button.

5. Add the “BOX” model to “WORK3”.

 

YOUSETU  

Set the layout so that the model frame 
comes to this position.  

 

Create "WORK3" on TCP. 
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Set the BOX as follows.

6. On the [Simulation] tab, in the [Monitor] group, click the [Trace] button, the [Trace] dia-
log appears. 

7. Display the trace property by double clicking on the “HP6_trace1” or by pressing the 
“Edit” button.  Press the [...] next to the “Model” field to display the “Select Model” dia-
log and select the model to be traced.  For this example, select the “YOUSETU” model.  
Then click on the [OK] button.  Make sure that the “Model” edit box shows the selected 
model name.

8. Press the [...] next to the “Parent” field to display the “Select Model” dialog and select 
the model that will become the parent (and the reference coordinate frame) of the 
trace.  For this example, select the “WORK3” model.  Then click on the [OK] button.  
Make sure that the “Parent” edit box shows the selected model name.

9. The “Max. Points” field defines the maximum number of points that will be used by the 
trace, this affect the length of the trace.  (If the number of tracing points exceeds the set 
value, tracing points are deleted in order from the oldest.)
In this example, set the value to 2000.

10. The “Color” field displays the color of the trace.  Set any desired color by pressing the 
[...] button next to the color.

11. Click on the [OK] button to save the setting.

          

WORK3
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12. Using the Virtual Pendant, create a new job which welds four corners of a workpiece as 
shown in the following figure.  Teach the positions of each STEP with  MOVL instruc-
tions.  

13. Execute the job and the tracing track attached to “WORK3” will be displayed.  This 
helps to see which positions on the workpiece are to be welded.

As described above, changing the trace object and the parent with the Trace Configu-
ration dialog box can leave the moving track of the target point that can be easily read.

     
  Initial State Viewed from Side Initial State Viewed from Front

           

       

STEP 1 STEP 2 STEP 3

STEP 4 STEP 5
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13.3 Collision Detection Setting

This section explains to set up the collision detection and check the collision on the playback.
Follow the flowchart below to set up the collision detection.

 Collision model group registration
Procedure

1. On the [Simulation] tab, in the [Collision] group, click the [Collision Detection] button, 
the [Collision Detection] dialog appears.

2. Click the [ModelGroup] button on the Collision Detection dialog box, the Collision 
Model Group dialog box is displayed.

3. Click the [Add] button on the Collision Model Group dialog box, the Collision Model 
Group Detail dialog box is displayed.

By creating a simplified model of the model registered in the collision model group and 
using that model as the collision pair, the performance of collision check processing 
can be improved. The models registered in the collision model group can be easily cre-
ated from the [Create Simple model] button on the "Collision Model Group" dialog.

 Collision model group registration 

Collision definition registration 

Start collision detection 
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4. Enter the collision model group name to [Model Group], display the [CadTree] dialog 
box, and select the "DAI" in the CadTee dialog box.
Check the [A child model is also registered simultaneously] and click the [Add from 
CadTree] button, "DAI" and "WORK" is added to the model list. Click the [OK] button to 
save. 

5. To edit the collision model group of robot, Double-click "DX100-R01" on the Collision 
Model Group dialog box. The Collision Model Group Detail dialog box is displayed.

Delete the unnecessary model from model list. Click the   button and click the tool 
model on the MotoSim EG-VRC window. "Torch" is added. Click the [OK] button to 
save.

 Collision definition registration
1. Click the [Add] button on the Collision Detection dialog box, the Collision Definition dia-

log box is displayed.
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2. Enter "PAIR1" to the [Pair Name], Set Attribute of "DX100-R01" as "Master" and set 
Attribute of "WORK" as "Slave".

 Start collision detection
1. Check the "PAIR1" check box on the Collision Detection dialog box, and check the 

[Collision Check] check box.
2. To execute the job, on the [Simulation] tab, in the [Playback] group, click the [Start] but-

ton. When the collision occurs, the models turn red, and playback is stopped.
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13.4 Option Function Setting

The particular operation is available by setting option function.

Procedure
1. Start the controller in maintenance mode. On the [Controller] tab, in the [Boot] group, 

click the [Maintenance mode] button, the [Maintenance mode] dialog appears. For 
details refer to section "7.10 VRC Maintenance Mode".

2. Select {SYSTEM} - {SETUP} in the virtual pendant.

3. Select [OPTION FUNCTION] in the {SETUP} display.

MotoSim EG-VRC supports the function in the " 1.2.1  Optional Functionof controller " only.NOTE
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4. Set the function used to "USED".
For detail of each function, please refer to the controller "Operator's Manual".
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13.5 Dual-Arm robot Setting

When the Dual-Arm robot (ex. SDA10-A00) is used, the job used "Coordinated Instruction" 
and "Parallel Start Instruction" can be created in MotoSim EG-VRC. This section describes 
how to setup Dual-Arm robots and how to activate optional functions such as "Coordinated 
Instruction" or "Parallel Start Instruction" of each controller.

Follow the flowchart below to setup Dual-Arm robots.

Creating Controller with a New VRC 
Controller (no file) 

Controller Initialization 

Setting “Coordinated Instruction” and 
“Parallel Start Instruction” 

Setting the calibration 

Registration the group combination 

Setting the robot model 

START 

END 

Operation in the 
“Maintenance Mode” 

Operation in the 
“Normal Mode” 

After setting, start the controller in the maintenance mode. 

After setting, start the controller in the normal mode. 
 

Exiting the maintenance mode 
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13.5.1 Dual-Arm robot Setting (DX100)

Dual-Arms are composed of right arm, left arm and one torso. When defining the control group 
of the controller during the initialization, three control groups need to be set. There are two 
robot groups (R1 and R2) for the arms and one station group (S1) for the rotation of the torso.

To determine the robot model to select from the robot list, remove the "A00" part of the robot 
type and replace it by:

• X0* for the left arm robot (R1)
• Y0* for the right arm robot (R2)
• W0* for the torso rotation (S1)

For example for a SDA010D-A00 robot, the control groups should be set to SDA010D-X00, 
SDA010D-Y00 and SDA010D-W00.

Procedure
1. Proceed the step 1 and 2 of " 7.1.1  Create a New VRC Controller (no file) ". Select 

some system version of the "DX100". When the operation is finished, the controller 
starts in the maintenance mode.

2. Proceed all steps of " 7.1.3  Initializing the Controller (YRC1000, YRC1000micro, 
DX200, DX100, NX100) ". At the Step 3, set the control group to the following settings.
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The "MECHANICAL SPEC" screen and "MOTOR SPEC" don't need any change. 
Press [ENTER] to go to the next screen.

3. From the main menu, select {SYSTEM} - {SETUP}.
4. From the setup list, select {OPTION FUNCTION}.

5. Select the "Parallel Start Instruction" and set its value to "4 Tasks". When the confirma-
tion message displays, select "Yes" to make the change.

600/847



13.5  Dual-Arm robot Setting

HW0485348

6. Select the "Coordinated Instruction" and set its value to "Used". When the confirmation 
message displays, select "Yes" to make the change.

7. Close the controller "Maintenance Mode" by clicking the [Finish] button of the MotoSim 
EG-VRC "Instruction Guide" dialog.

8. To set the robot models , proceed the step 4 of " 7.1.1  Create a New VRC Controller 
(no file) ".

9. To set the calibration data of the controller, proceed "Set calibration data base on robot 
model layout" of " 7.6.3  Robot Calibration Setting ".

10. Change the security mode to "MANAGEMENT MODE" in the virtual pendant.
11. Select {SETUP} - {GRP COMBINATION}, add the group combination (ex. "R1+R2", 

"R1+R2",…)
For detail of group combination, please refer to the "Controller Options: Instructions for 
Independent/Coordinated control function" manual. 
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13.5.2 Dual-Arm robot Setting (FS100)

Dual-Arms are composed of right arm, base axis of right arm, left arm and base axis of left 
arm. When defining the control group of the controller during the initialization, four control 
groups need to be set. There are two robot groups (R1 and R2) for the arms and two base 
axis group (B1, B2).

To determine the robot model to select from the robot list, remove the "A00" part of the robot 
type and replace it by:

• X0* for the left arm robot (R1)
• S0* for the base axis of the left arm robot (B1)
• Y0* for the right arm robot (R2)
• S0* for the base axis of the right arm robot (B2)

For example for a SDA010F-A00 robot, the control groups should be set to SDA010F-X00, 
SDA010F-S00, SDA010F-Y00 and SDA010F-S00.

Procedure
1. Proceed the step 1 and 2 of " 7.1.1  Create a New VRC Controller (no file) ". Select 

some system version of the "FS100". When the operation is finished, the controller 
starts in the maintenance mode.

2. Proceed all steps of " 7.1.4  Initializing the Controller (FS100) ". At the Step 3, set the 
control group to the following settings.
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Then at the Step 4, set the connection to the following settings.

The "MECHANICAL SPEC" screen and "MOTOR SPEC" don't need any change. 
Press [ENTER] to go to the next screen.

3. From the main menu, select {SYSTEM} - {SETUP}.
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4. From the setup list, select {OPTION FUNCTION}.

5. Select the "DUAL ARM FUNCTION" and set its value to "Used". When the confirmation 
message displays, select "Yes" to make the change.

6. Close the controller "Maintenance Mode" by clicking the [Finish] button of the MotoSim 
EG-VRC "Instruction Guide" dialog.

7. To set the robot models , proceed the step 4 of " 7.1.1  Create a New VRC Controller 
(no file) ".

8. To set the calibration data of the controller, proceed "Set calibration data base on robot 
model layout" of " 7.6.3  Robot Calibration Setting ".

9. Change the security mode to "MANAGEMENT MODE" in the virtual pendant.
10. Select the {SETUP} - {GRP COMBINATION} menu in the virtual pendant.
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11. Press [SELECT], and select "ADD GROUP".

12. Set the "NO.1 CONTROL GROUP" to "R1", "NO.2 CONTROL GROUP" to R2 and 
"MASTER" to R1. Then click the [EXECUTE] button.

13. If the "R1+R2:R1" group combination set is created, the setting is finished.
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13.5.3  Dual-Arm robot Setting (NX100)

Dual-Arms are composed of right arm, left arm and one torso. When defining the control group 
of the controller during the initialization, three control groups need to be set. There are two 
robot groups (R1 and R2) for the arms and one station group (S1) for the rotation of the torso.

To determine the robot model to select from the robot list, remove the "A00" part of the robot 
type and replace it by:

• X0* for the left arm robot (R1)
• Y0* for the right arm robot (R2)
• W0* for the torso rotation (S1)

For example for a SDA10-A00 robot, the control groups should be set to SDA10-X00, SDA10-
Y00 and SDA10-W00.

Procedure
1. Proceed the step 1 and 2 of " 7.1.1  Create a New VRC Controller (no file) ". Select 

some system version of the "NX100". When the operation is finished, the controller 
starts in the maintenance mode.

2. Proceed all steps of " 7.1.3  Initializing the Controller (YRC1000, YRC1000micro, 
DX200, DX100, NX100) ". At the Step 3, set the control group to the following settings.

3. From the main menu, select {SYSTEM} - {SETUP}.
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4. From the setup list, select {OPTION FUNCTION}.

5. Select the "Parallel Start Instruction" and set its value to "4 Tasks". When the confirma-
tion message displays, select "Yes" to make the change.

6. Select the "Coordinated Instruction" and set its value to "Used". When the confirmation 
message displays, select "Yes" to make the change.

7. Close the controller "Maintenance Mode" by clicking the [Finish] button of the MotoSim 
EG-VRC "Instruction Guide" dialog.

8. To set the robot models , proceed the step 4 of " 7.1.1  Create a New VRC Controller 
(no file) ".

9. To set the calibration data of the controller, proceed "Set calibration data base on robot 
model layout" of " 7.6.3  Robot Calibration Setting ".

10. Change the security mode to "MANAGEMENT MODE" in the virtual pendant.
11. Select {SETUP} - {GRP COMBINATION}, add the group combination (ex. "R1+R2", 

"R1+R2",…)
For detail of group combination, please refer to the "Controller Options: Instructions for 
Independent/Coordinated control function" manual.
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13.6 External Axes Setting (Motor Gun)

The following example shows how to setup an 
external axis as a Motor Gun on a ES165N robot.  
By default external axis are setup to rotate around 
the Z-axis.  This example explains how to change 
the default behavior of the external axis to make 
the Motor Gun model move linearly along the Z-
axis. 

13.6.1 Initialization

Procedure:

Add a new controller with no CMOS.BIN according to the precedure of section 7.1.2 Create 
Controller with no CMOS.

1. When initializing the controller with the procedure of section 7.1.5 Initializing the Con-
troller, at the “CONTROL GROUP” screen (step 4), enter the information as follows:

Press [ENTER] to go to the next screen.
2. The “CONNECT” screen doesn’t need any change.  Press [ENTER] to continue to the 

external axis setup screens. 
3. The “AXIS CONFIG” defines the external axis mechanism type between “BALL-

SCREW”, “RACK&PINION” or “ROTATION“.  The available types depends on the 
machine type selected in the “CONTROL GROUP” screen.  In the case of “GUN”, the 
only choice is “BALL-SCREW”.  Press [ENTER] to go to the next screen.

608/847



13.6  External Axes Setting (Motor Gun)

HW0485348

4. In the “MECHANICAL SPEC” screen, define the “MOTION RANGE” (+ and -) of the 
axis.  The values are the soft limit of the external axis and will prevent the axis from 
moving outside of this range.
The “REDUCTION RATIO” is used to enter the ratio of the speed reducer.  Usually in 
the case of a Motor Gun there are none, so both values are set to 1.
The “BALL-SCREW PITCH” is the linear motion for one full revolution of the screw.  As 
a reference, most motors encoder have a resolution of 4096 pulses per revolution.  So 
in this example, a value of 4.096 mm/r means that the gun shaft will travel 0.001 mm 
for every pulse. 
Press [ENTER] to go to the next screen.

5. In the “MOTOR SPEC” screen, if you know which hardware will be used, you may 
enter it.  Otherwise, leave the default value.  For the “MOTOR” field, the choice will 
affect the encoder resolution.  The “SGMRS” motor series are fairly standard and have 
a encoder resolution of 4096 pulses/revolution.
Press [ENTER] to go to the next screen.
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6. In the “APPLICATION” screen, select “MOTOR GUN” as the application.
7. Continue the regular initialization procedure as per section 7.1.5 Initializing the Control-

ler.  To use the equipment model, follow the procedure in " 13.7  Registering the Equip-
ment Model " to initialize settings. When the equipment model is not used, Press the 
“Finish” button of the “Instruction Guide” window to reboot the controller in normal 
mode. 

13.6.2 Model setup and motion

By default in MotoSim EG-VRC, the external axis are setup with the “world” model as a parent 
and the axis will rotate around the Z-axis.  In the case of a Motor Gun the external axis need to 
be moved to the end of the robot and the motor motion change to move the model linearly 
along the Z-axis.

Procedure:

1.  Once the controller has been added to the cell.  The robot model will be displayed in 
the middle of the cell.  The external axis will not have any model attached to it and will 
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only be visible in the CADtree dialog. 

2. Display the CADTree dialog, then select the controller station (e.i. NX100-ST1).  Move 
this model to the robot TCP model (e.i. NX100-RB1_tcp) with the “Move Parent” func-
tion.

3. With the Virtual Pendant, define the robot TOOL.  This will change the robot TCP 
model (e.i. NX100-RB1_tcp) in MotoSim EG-VRC.

4. Add or create a model for the Motor Gun fixed part with the robot flange (NX100-RB1_-
flange) as the parent.

5. Add or create a model for  the Motor Gun mobile part with the station axis model 
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(NX100-ST1_ex1) as a parent.

6. At this point, if the station axis is moved, the model will rotate around the Z-axis instead 
of moving along it.  To change this, save and close the cell.

7. With a text editor (such as “Notepad”), open the cell file (*.vcl).
In the controller section, under the station (ST1) section add the following line:

AXIS1=(TYPE=Z);.

8. Save the text file and then reopen the cell file with MotoSim EG-VRC.   Confirm that the 

Note that the ratio and offset can also be modified in this manner.  This maybe useful if the 
Motor Gun specific hardware is unknown.

AXIS1=(TYPE=Z)(RATIO=1.0)(OFFSET=0.0);
where:

AXIS* : Axis No. of the robot (begins with 1.)
TYPE: Direction to move (X, Y, Z, Rx, Ry or Rz)
RATIO: The distance moved (mm or rad) for each pulse
OFFSET: The initial move amount (mm or rad)

 

Model of the Motor Gun 
fixed parts 

Model of the Motor Gun 
mobile parts 

NOTE

 CELL_INIT 
{ 
VERSION=1, 1, 0, 0 
 
CONTROLLER(0) 
{ 
PATH=%CELPATH%¥NX100; 
NAME=NX100; 
RB1 
 { 
 NAME=NX100-RB1; 
 FILE=%CELPATH%¥NX100¥RB1¥ES165N-A00.mdl; 
 } 
ST1 
 { 
 NAME=NX100-ST1; 
 FILE=dummy; 
 AXIS1=(TYPE=Z); 
 } 
TRACE 
 { 
 ROBOT=NX100-RB1; 
 } 
} 
... 

Add this line 
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Motor Gun axis is working properly.

If the model doesn’t move in the proper direction, you may need to adjust the orienta-
tion of the station axis 1 location frame (e.i. NX100-ST1_EX1-POS) and then readjust 
the Motor Gun mobile part model.
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13.7 Registering the Equipment Model

This section explains the setting of the preset motion range according to the equipment and 
the registration procedure of the robot model with equipment.

13.7.1 Operating Range Setting

With the maintenance mode of the virtual pendant, the preset range of motion can be set.

Procedure
1. Selects the virtual pendant main menu {SYSTEM} - {SETUP} - {OPTION FUNCTION}. 
2. Selects {LIMITS CUSTOMIZATION} of {OPTION FUNCTION}.

3. Select the item according to purpose. For Yaskawa standard equipment operating 
range, select [STANDARD]. 

• The equipment model is YASKAWA standard equipment.
• Equipment models are available only on some models.
• The preset operation range according to the equipment model can be used only the 

model provided with the YASKAWA standard equipment for the DX200 and YRC1000 
controllers.

NOTE
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13.7.2 Equipment Registration

[Robot Settings] is displayed after initializing the controller.
When use an equipment model instead of the standard robot model appearance, change the 
model file of the corresponding group.

Procedure
1. Selects the group of models used the equipment model in [Robot setting] dialog, and 

press the […] button of the model file. 

2. Select the model file from the [ExternalEquipment] folder of the robot model folder of 

615/847



13.7  Registering the Equipment Model

HW0485348

the corresponding model and press the [OK] button.
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13.8 Setting of spot welding simulation

Electric gun of an external axis is set to the robot, and it explains the procedure for simulating 
the spot welding.

13.8.1 Initialize

Procedure:
A new controller is registered by the operational procedure of " 7.1.1  Create a New VRC Con-
troller (no file) ".

1. When initializing the controller with the procedure of section 7.1.3 Initializing the Con-
troller, at the “CONTROL GROUP“ screen (Step3), enter the information as follows:
Please refer to " 7.1.3  Initializing the Controller (YRC1000, YRC1000micro, DX200, 
DX100, NX100) " for details of the controller's initialization.

• The simulation of the spot welding is a function that can be used only with YRC1000/
DX200/DX100. 
It doesn't deal with other controllers.

• The simulation of spot gun change system is not supported.
• The following function keys for spot welding using motor gun are not supported.

  Manual spot welding ([INTERLOCK] + [./SPOT])
  Manual dry spot welding ([INTERLOCK] + [2/GUN CLOSE])
  Pressurizing ([INTERLOCK] +[8/PRESSURE])
  Releasing ([INTERLOCK] +[9/RELEASE])

When the spot welding simulation is done with two or more robots, it is necessary to set 
gun according to the robot.
Please select "GUN-1" each S1 and S2 when systems are two robots.

NOTE

NOTE
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2. Each item of the connection etc. keeps not changing, either [enter] being pushed, and 
it advancing to the function specification of a set screen of an external axis. Each item 
of the “MECHANICAL SPEC“and the “MOTOR SPEC“ is set, [enter] is pushed, and it 
advances to the following screen.
Please refer to procedures 4 and 5 of " 13.6.1  Initialization " for the setting of each 
item.

3. "MOTOR GUN" is selected by the usage.

4. The initialization setting is done according to procedure of " 7.1.3  Initializing the Con-
troller (YRC1000, YRC1000micro, DX200, DX100, NX100) ".  The completion button of 
the “Controller Maintenance Mode Instructions ” is pushed.  A virtual pendant is 
restarted in the normal mode.

13.8.2 Setting of welded condition

It is variously set to simulate the spot welding.

Procedure:
1. To change the setting of the spot welding, the security mode is changed to "MANAGE-

MENT MODE". 
2. The main menu {SPOT WELDING} - {GUN PRESSURE} of a virtual pendant is 

selected.
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3. The setting of the gun pressurizing power is changed.
An appropriate value is input to this “TOUCH PRESS“ and “1ST PRESS“, the cursor is 
matched to the item of the “SETTING”, the [SELECT] or the [Space] key is pushed, and 
the “SETTING” is changed to "DONE".

4. The main menu {SPOT WELDING} - {GUN CONDITION} of a virtual pendant is 
selected.

This procedure does only necessary minimum setting. 
For detailed setting, please refer to each controller's “OPERATOR’S MANUAL (FOR SPOT 
WELDING USING MOTOR GUN)“.

NOTE
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5. The setting of the gun characteristic is changed.
An appropriate value is input to this “PUSLE“ and “TORQUE“, the cursor is adjusted to 
the item of the “SETTING”, the [SELECT] or the [Space] key is pushed, and the “SET-
TING” is changed to "DONE".

This procedure does only necessary minimum setting. 
For detailed setting, please refer to each controller's “OPERATOR’S MANUAL (FOR SPOT 
WELDING USING MOTOR GUN)“.

NOTE
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6. To make changed gun pressurizing power and gun characteristic effective, the servo is 
turned off once. After that, it comes to be able to execute the simulation of the spot 
welding by turning on the servo again.

1) The emergency stop button is pushed, it puts into the emergency halt condition, 
and the servo is turned off.

2) The emergency stop button is pushed, and the emergency halt condition is 
released.

3) The servo is turned on pushing servo ON button.

It becomes impossible to do the playback of the welding job normally if the setting is not 
reflected. 
Please execute the procedure of servo OFF and turning on when you change the setting.

 

 

  

SERVO ON Button EMERGENCY STOP Button 

NOTE
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13.8.3 Setting of welding machine

The welding machine can be simulated in MotoSim EG-VRC. 
It is necessary to set the communication time and the welding time with the welding machine 
to simulate the welding machine. 
On the [Controller] tab, in the [File Settings] group, click the [Welding Condition] button, the 
[Welding Condition]] dialog appears.

13.8.4 Making and control group setting of job

The control group of the job sets and it is necessary to set the group combination before mak-
ing the job is started. 
Please refer to each controller's "OPERATOR'S MANUAL (FOR SPOT WELDING USING 
MOTOR GUN)" for details.

13.8.5 Setting of simulation of electric gun

Please refer to " 13.5  Dual-Arm robot Setting " for the setting to simulate electric gun.

“Welding Condition” Dialog Box

Item Description

[Communication Time 
(msec)] edit box

A fixed value of each welding machine is set

[Welding Time (msec)]
edit box

The welding time of each welding condition number specified by the 
welding instruction is set.
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13.9 Setting of Conveyor Synchronization

Set the conveyor synchronization for the robot, and it explains the procedure for the simula-
tion of conveyor synchronization.

13.9.1 Overview Flowchart

Follow the flowchart below to create the environment.

• This function can not use depending on the system version of controller. Please refer to 
section " 15.8  List of Function depending on the system version of controller ".

• This function is available for 1 axis conveyor only. (2 axes and 3 axes conveyor can not 
be set conveyor synchronization.)

• This function can not use CMOS.BIN of a real robot.
• This function can not be used with high-speed playback function.Refer to section " 7.5.4  

Refresh Interval " about high-speed playback function.
• To simulate the job with high-speed picking, use the template function.

Refer to section " 4.1.1  Template Function " about template function.

NOTE

 

System Construction 

Controller Initialization 

Enabling of Conveyor Synchronization 

Setting of the file of the conveyor 

Conveyor registration 

Setting of the conveyor synchronization 

Location of the conveyor 

Creating and locating the works 

Operating the conveyor 

Teaching 

Display the move command with conveyor synchronization 

Playback of the job with conveyor synchronization 

Playback 
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13.9.2 System Construction

It explains the procedure from the new cell creation to creation the environment for creating 
the job with conveyor synchronization.

  Controller Initialization
Follow the procedure of section " 7.1.1  Create a New VRC Controller (no file) " to create a 
new VRC controller. After Creation, the cell is saved and closed.

 Enabling of Conveyor Synchronization
Procedure

1. On the [Controller] tab, in the [External Device] group, click the [Enable Conveyor 
Tracking] button.

2. When the confirmation dialog box appears, click the [Yes] button.

3. When the process is complete, the confirmation dialog box appears. Click the [OK] but-
ton.
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 Setting of the file of the conveyor
Procedure

1. Open the Cell, and Change the security mode to "MANAGEMENT MODE".
2. From the Virtual Pendant main menu select {ROBOT} - {SETUP}.

3. The setting of the conveyor condition is changed.
• Set the value depending on the real robot to [POS RESOLUTION] and [AVERAGED 

TRAVEL TIME], and Set [USED STATUS] to [USED].
• If the value of [POS RESOLUTION] is not set, [VERIFY ERROR (SENSOR PARAME-

TER)] alarm is occurred when [USED STATUS] is set to [USED].
• When [SEGMENT OVER] alarm is occurred during playback, change [AVERAGED 

TRAVEL TIME] to the value such as 200ms.

This procedure does only necessary minimum setting.
For detailed setting, please refer to each controller's "INSTRUCTIONS FOR CONVEYOR 
SYNCHRONIZED FUNCTION".

 

NOTE
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  Conveyor registration
Refer to section " 7.7.1  Adding a Conveyor " about conveyor registration.
If there is the user coordinates corresponding to the conveyor in the controller, the following 
dialog box appears. Click [Yes] button, the conveyor is located corresponding to the user 
frame position.

 Setting of the conveyor synchronization
Refer to section " 7.7.9  Conveyor Synchronization " about setting the conveyor synchroniza-
tion. Then, robots with conveyor synchronization function made automatically the user coordi-
nates at the target conveyor position with the user coordinates number corresponding to the 
conveyor number.
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  Location of the conveyor
Procedure

1. On the [Home] tab, in the [Model] group, click the [CadTree] button, the [CadTree] dia-
log appears. Select the conveyor model "CONVEYOR-NO [Conveyor Number] (ex. 
CONVEYOR-NO1) ".

2. Click the [Pos] button. Set the location of the conveyor, and click the [OK] button. Then, 
robots with conveyor synchronization function made automatically the user coordinates 
location corresponding to the conveyor location.

 Creating and locating the works
Works are set on the conveyor.

Procedure
1. Set "[Conveyor Name]_TCP" as the parent model by pointing the cursor to "[Conveyor 

Name]_TCP" in the Cad Tree, and the work models are created.

2. Works are set opposite the mark of the conveyor traveling direction (the triangle on the 
conveyor). When the line passes through the conveyor origin position (If STP is set 
other than zero by SYSTART command, when the line passes through the position set 
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by STP), conveyor synchronization gets start running.

13.9.3 Teaching

  Operating the conveyor
The ways of operating the conveyor are Operation by conveyor operation panel or operation 
by position panel.
Refer to section " 7.7.8  Conveyor Operation Panel " and " 7.7.5  Moving a Device " for detail.

  Teaching the conveyor synchronized move instructions (SYSTART, 
SYEND, SYMOV*)

Teach the conveyor synchronized move instructions by the virtual pendant. Please refer to 
"INSTRUCTIONS FOR CONVEYOR SYNCHRONIZED FUNCTION" of each the controller for 
details.

• Click the [INFORM LIST] button of the virtual pendant, the command list dialog is dis-
played. Click the [SENSOR] button in the displayed dialog, SYSTART command and 
SYEND command are available.

The position of conveyor in [Position] is reflected LS offset value of the each robot. When 
the other robot is selected, the position of conveyor in [Position] is changed, without the 
displayed conveyor is not operating.

NOTE
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• Click the [SHIFT] button and the [MOTION TYPE] button of the virtual pendant, MOV* 
command is changed to SYMOV* command. Then, click the [MOTION TYPE] button, 
the motion type is changed (SYMOVJ-> SYMOVL->SYMOVC). And, set the details.

13.9.4 Playback

  Playback of the job with conveyor synchronization
Procedure

1. On the virtual pendant, move the cursor in the job to the first step. Set the robot posi-
tion to the position of starting the job.

2. On the job panel of the conveyor, move the cursor in the job to the first step. Set the 
conveyor position to the position of starting the job.

3. On the [Simulation] tab, in the [Playback] group, click the [Start] button

The [START] button of the virtual pendant can not use the conveyor synchronization. 
Please execute the job with the above procedure.

  

NOTE
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13.10High-Speed Picking Simulation Function

This function is able to easily simulate "Conveyor Synchronized Function", "Conveyor Syn-
chronized Function with Shift Functions" and "Continuous Operation Conveyor Synchronized 
Function".

13.10.1 Overview Flowchart

Follow the flowchart below to create the environment.The procedure is explained with the 
template cell "MPP3 S_PICKING".

 Creating a new cell from the template
Follow the procedure of section " 4.1.1  Template Function " to create a new VRC controller. 
Select the "MPP3S_PICKING" in the template list, and create a new cell.
A cell available to the high-speed picking simulation is created automatically.

 Location of the conveyors
If needed, the location of the conveyors is changed.
In the high-speed picking simulation function, the MPP3 robot picks the works from CON-
VEYOR-NO1, and places the works on the CONVEYOR-NO2.

• This function can be only used with the cells created from the template cell "MPP3_PICK-
ING", "MPP3H_PICKING" and "MPK2_PICKING". This function can not be used with the 
other cells.

• This function can not be used with high-speed playback function.
Refer to section " 7.5.4  Refresh Interval " about high-speed playback function.

• Please do not modify the master job of a template cell.
• High-Speed picking cell before Ver5.10 can not be used.

NOTE

 Creating a new cell from the template 

Location of the conveyors 

Setting the size and speed of the conveyors 

Automatic creation of the works 

Automatic creation of the pallets 

Playback 
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Procedure
1. On the [Home] tab, in the [Model] group, click the [CadTree] button, the [CadTree] dia-

log appears. 
Select the conveyor model "CONVEYOR-NO [Conveyor Number] (ex. CONVEYOR-
NO1) ".

2. Click the [Pos] button. Set the location of the conveyor, and click the [OK] button.
Then, the user coordinates location of MPP3 robot (a light blue FRAME) is changed 
automatically corresponding to the conveyor location.

3. When the location about X direction of the conveyors is changed, the following setting 
is needed.
The synchronous starting position and the teaching position of a SYPICK/SYPLACE 
command are changed to suit a conveyor position. The synchronous starting position 
and the teaching position are specified with the following user variables.
    D000 : The synchronous starting position of SYPICK (STP)
    D001 : The teaching position of SYPICK (CTP)
    D002 : The synchronous starting position of SYPLACE (STP)
    D003 : The teaching position of SYPLACE (CTP)

For example, when the conveyor for pick is moved -1000 mm in the X direction, the 
synchronous starting position and the teaching position of SYPICK are added 1000 
mm.

1) Select the {VARIABLE} - {DOUBLE} menu on the virtual pendant.
2) Add 1000000 to the value of D000 and D001.

   

D000, D001, D002 and D003 are set by the micrometer.NOTE
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1350mm 

1000mm 

When the work gets to the teaching position specified by 
SYPICK (1000 mm), the MPP3S robot starts picking the 
work. When the conveyor is moved -1000 mm in the 
traveling direction, the teaching position is needed to 
add 1000 mm. 

The user coordinates is set 
on the conveyor origin 
position. The difference 
from the origin position to 
the robot is 1000 mm. 

The robot positions on picking at above 
teaching position (in the user coordinates) 
are set to from P001 to P300. 
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 Setting the size and speed of the conveyors
If needed, the location of the conveyors is changed.
For details of the Conveyor Setting dialog, refer to section " 7.7.1  Adding a Conveyor " about 
conveyor registration.

Procedure
1. On the [Contoller] tab, in the [External Device] group, click the [Conveyor Settings] but-

ton, the [Conveyor Setting] dialog appears.

2. Select the conveyor number to change.
3. Set the [L(mm)], [D(mm)], [H(mm)] of Model info.
4. Set the [Speed (mm/s)] of Motion info, and click the [OK] button.

 Location of the works
Set the information (ex. size of work, work interval on the conveyor, ...) , and models are cre-
ated automatically.

Procedure
1. On the [Contoller] tab, in the [External Device] group, click the [Conveyor Settings] but-

ton, the [Conveyor Setting] dialog appears.

2. Select the conveyor No.1, and click the [More] button to display [Model Creation for 
High-Speed Picking] section.

3. Set the work size to the [Width(mm)] and [Height(mm)].
4. Set the works position on the conveyor in the [Pick Position] list.
5. Click the [Make] button, the work models are added on the CONVEYOR-NO1.

For example, to set the works on the conveyor as below, the following procedure is 
operated.

• Works size : Width 100mm × Height 100mm
• The number of works : 5
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• Work interval : 200mm

(1) Set the [Work] as below,
[Width(mm)]     100.000
[Height(mm)]    100.000

(2) Set the [Work Position Batch Input] as below,
[X(mm)]    200.000
[Y(mm)]        0.000
[R(deg)]        0.000
[Number]      5

Uncheck the [Alternation Y] checkbox and the [Alternation R] checkbox.
(3) Click the [Input Work Position] button, and click the [OK] button in the displayed con-

firmation dialog box. The work locations are set in the [Pick Position] list.
(4) Click the [Make] button.

For detail of the dialog, refer to " Location of the works " in the section "11.9.2 Advanced 
Setting".

 Location of the pallets
Set the information (ex. size of pallet, work interval on the pallet, ...) , and models are created 
automatically.

Procedure
1. On the [Contoller] tab, in the [External Device] group, click the [Conveyor Settings] but-

   

200mm 

100mm 

200mm 200mm 200mm 
100mm 

Travel Direction 
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ton, the [Conveyor Setting] dialog appears.

2. Select the conveyor No.2, and click the [More] button to display [Model Creation for 
High-Speed Picking] section.

3. Set the pallet size to the [W(mm)] and [L(mm)].
4. Set the works position on the conveyor in the [Pick Position] list.
5. Set the pallet interval on the conveyor and the number of interval to the [X(mm)] and 

[Number].
6. Click the [Make] button, the pallet models are added on the CONVEYOR-NO2.

For example, to set the pallets on the conveyor as below, the following procedure is 
operated.

• Pallet size : Width 110mm × Length 130mm
• The number of pallets : 5
• Pallet interval : 200mm
• 1 work per pallet

(1) Set the [Pallet] as below,
[W(mm)]    110.000
[L(mm)]      130.000

(2) Set the first line of [Place Position] list as below,
[X(mm)]    -50.000
[Y(mm)]       0.000
[Z(mm)]       0.000
[R(deg)]       0.00

(3) Set the [Interval] in the [Pallet Position] section as below,
[X(mm)]    200.000
[Number]      5

(4) Click the [Make] button.

For detail of the dialog, refer to " Location of the pallets " in the section "11.9.2 Advanced 

 
200mm 

130mm 

110mm 

Travel Direction 
X 

Y 
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Setting".

 Playback
1. On the [Simulation] tab, in the [Playback] group, click the [Reset] button.

2. On the [Simulation] tab, in the [Playback] group, click the [Start] button.

The [START] button of the virtual pendant can not use high-speed picking simulation func-
tion. Please execute the job with the above procedure.

  

NOTE
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13.10.2 Advanced Setting

This section describes other settings used by high-speed picking simulation function.

 Location of the works
1.  In the [Conveyor setting] dialog, the width and height is set to [Work].

2. In the [Conveyor setting] dialog, to edit the [Pick Position] list, various work locations 
are enabled. The works are located on the conveyor, as many as of the number of lines 
in the [Pick Position] list.

• When the value is set to the [Y(mm)] in the [Pick Position] list as below, the works are 
located from side to side.

 

Height Width 

Width 

            

50mm 

-50mm 

Travel Direction 
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• When the value is set to the [R(deg)] in the [Pick Position] list as below, the rotated 
works are located.

3. The [Pick Position] list can be set automatically with [Work Position Batch Input].

• When the values are set to the [Y(mm)] and [R(deg)] of the [Interval] and the [Input 
Work Position] button is clicked, that values are set to the [Y(mm)] and [R(deg)] of all 
lines in the [Pick Position] list.

If the [Input Work Position] button is clicked with the above setting, the works are 
located as below.

• The upper limit of the number of works is 300. 
• Once works increases, the playback might be slower.

             

30° 

-30° 

Travel Direction 

NOTE
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• When the [Alternation Y] checkbox and the [Alternation R] checkbox are checked and 
the [Input Work Position] button is clicked, the values are set to the [Y(mm)] and 
[R(deg)] of all lines in the [Pick Position] list with alternating positive and negative val-
ues.

If the [Input Work Position] button is clicked with the above setting, the works are 
located as below.

 Location of the pallets
1.  In the [Conveyor setting] dialog, the length of W direction and L direction are set to 

[Pallet].

2. In the [Conveyor setting] dialog, the number of pallets and the intervals are set to [Pal-
let].

3. In the [Conveyor setting] dialog, the work locations on a pallet are set to the [Place 
Position] list. This setting is applied to the all pallets. Set the locations of the center of 
works from pallet origin position to the [Place Position] list.

      

 

L W  
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X 

Y 
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• When one work is placed on the pallet, set the value to the [Place Position] list as 
below.
Set the value "width of work × (-0.5)" to the [X(mm)] of the first line.

• When two works are placed on the pallet back and forth, set the values to the [Place 
Position] list as below.
Set the value "width of work × (-0.5)" to the [X(mm)] of the first line, and  set the value 
"width of work × (-1.5) - the width of clearance" to the [X(mm)] of the second line.  In 
the below setting, the width of clearance is 1mm.

• When two works are placed on the pallet right and left, set the values to the [Place 
Position] list as below.
Set the value "width of work × 0.5 + the width of clearance" to the [Y(mm)] of the first 
line, and  set the value "width of work × (-0.5) - the width of clearance" to the [Y(mm)] 
of the second line.

• When two works are placed on the pallet one above the other, set the values to the 
[Place Position] list as below.
Set 0 to the [Z(mm)] of the first line, and set "height of work" to the [Z(mm)] of the sec-
ond line.
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• When one work are rotated and placed on the pallet, set the values to the [R(deg)] in 
the [Place Position] list as below.

 Changing the timing of stream
If the [Start(mm)] in the [Conveyor Setting] dialog is changed, the timing of stream of works 
(CONVEYOR-NO1) or pallets (CONVEYOR-NO2) can be changed.
To set the timing of pallets slower than that of works, shift the [Start(mm)] of the CONVEYOR-
NO2 to the minus direction. To set the timing of pallets faster than that of works, shift the 
[Start(mm)] of the CONVEYOR-NO2 to the plus direction. Note that the [Start(mm)] of the con-
veyors is set the negative value certainly. And, the same setting is enabled in setting the 
[Start(mm)] of the CONVEYOR-NO1.

• When the [Start(mm)] of the CONVEYOR-NO2 is shifted to the minus direction, the timing 
is as below.

• When the [Start(mm)] of the CONVEYOR-NO2 is shifted to the plus direction, the timing is 
as below.

Procedure
1. On the [Contoller] tab, in the [External Device] group, click the [Conveyor Settings] but-

ton, the [Conveyor Setting] dialog appears.

2. Set the [Start(mm)] of the [Motion info], and click the [OK] button.
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 Hand control signal setting
When the SYPICK/SYPLACE instructions are used, it needs that the general output signals 
are allocated for hand #1 to #4, to turn the hand (ex. vacuum pads) ON/OFF. That allocation is 
set in the [HAND CONTROL SIGNAL] display of the virtual pendant.

In the template "MPP3S_PICKING", OT OUTPUT 1 is allocated for Hand #1.
If needed, set the values to the [ON TIME] and the [OFF TIME].
For details, please refer to "FS100 OPTIONS INSTRUCTIONS SUPPLEMENTARY FOR 
CONVEYOR SYNCHRONIZED FUNCTION CONTINUOUS OPERATION CONVEYOR SYN-
CHRONIZED FUNCTION".
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13.10.3 High-Speed Picking Simulation for Multiple Controllers

High-Speed Picking Simulation for Multiple Controllers
This section explains to add the controller to the high-speed picking simulation cell.
This section uses the following cell to explain the environment setting.

 Sample
• Two MPP3S and two conveyors
• Ten works
• Five pallets (Two works per one pallet)

 

1000 ㎜ behind 

1000mm 1000mm 

800mm 800mm 

The synchronous starting position and 
the teaching position of Robot2 are 
same as Robot1. 

 
Creating a new cell from the template 

Adding the robot 

Setting the conveyor synchronization 

Distributing the work 

Setting the I/O Event 

Playback 
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 Creating a new cell from the template
Follow the procedure of section " 13.10.1  Overview Flowchart " to create a new cell from the 
template "MPP3S_PICKING". In this case, the position, size and speed of the conveyor are 
default.

 Adding the robot
Copy the controller and change the location of robot.

Procedure
1. Follow the procedure of section " 7.2  Copying a Controller " to copy the "FS100-1" 

controller.

2.  On the [Home] tab, in the [Model] group, click the [CadTree] button, the [CadTree] dia-
log appears.
Select the added robot (ex. FS100-2-R01).
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3. Click the [Pos] button. Set the location of the robot, and click the [OK] button.

 Setting the conveyor synchronization
Set the conveyor synchronization of the added robot for CONVEYOR-NO1 and CONVEYOR-
NO2.

Procedure
1. On the [Controller] tab, in the [External Device] group, click the [Conveyor Condition 

File] button, the [Conveyor Synchronization] dialog appears. 

2. Select the added controller name.
3. Set the Condition File No.1 to the CONVEYOR-NO1 and the Condition File No.2 to the 

Be sure to locate the added robot to become the downstream side to the flow 
direction of a conveyor.

  

 

NOTE
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CONVEYOR-NO2, and click the [OK] button.

 Distributing the work
Set the distributing sequence of works for the added controller.
Distributing sequence is finished by re-executing the auto-creation the works and pallets.

Procedure
1. On the [Controller] tab, in the [External Device] group, click the [Conveyor Setting] but-

ton, the [Conveyor Setting] dialog appears.
2. Click the [More] button, to display [Model Creation for High-Speed Picking] section.
3. Select the conveyor No.1, and click the [Make] button.
4. Select the conveyor No.2, and click the [Make] button.

 Setting the I/O Event
To change the parent of work model with the action of picking, the I/O event is registered to 
the added controller. For details of the I/O event, refer to section " 8.3  I/O Events ".

Procedure
1. On the [Simulation] tab, in the [I/O Settings] group, click the [I/O Event Manager] but-
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ton, the [I/O Events] dialog appears. 
2. The following I/O events are registered to the added controller.

 Playback
1. On the [Simulation] tab, in the [Playback] group, click the [Reset] button.

2. On the [Simulation] tab, in the [Playback] group, click the [Start] button.

13.10.4 Advanced Setting for Multiple Controllers

 Distributing the work
For multiple controllers, distributing sequence is finished by re-executing the auto-creation the 
works and pallets. Then, the number of picked works becomes equal by each robot.
For example, when two controllers exist, robot1 and robot2 pick by turns.

Controller I/O Signal Condition Event
FS100-2 OUT#0001 (#30030) ON SCRIPT : SYPICK
FS100-2 OUT#0001 (#30030) OFF SCRIPT : SYPLACE
FS100-2 OUT#0005 (#30034) ON SCRIPT : SYINIT

The [START] button of the virtual pendant can not use high-speed picking simulation func-
tion. Please execute the job with the above procedure.

NOTE
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Ex.) One work is picked per one pallet by two controllers.(1 and 2 mean robot number)

Ex.) Two works are picked per one pallet by two controllers.(1 and 2 mean robot number) 

Ex.) Three works are picked per one pallet by two controllers.(1 and 2 mean robot number) 

 Changing the position of the limit switch
The synchronous starting position and the teaching position of a SYPICK/SYPLACE com-
mand are based on the limit switch of the conveyor.
In the high-speed picking simulation, the user coordinates of the controller are treated as a 
limit switch. UF#1 is for the conveyor 1 and UF#2 is for the conveyor 2. So, the position of the 
limit switch is changed by editing the user coordinates.
This section explains the procedure of changing the limit switch of robots2 into the conveyor 
starting point position with the cell created in the section " 13.10.3  High-Speed Picking Simu-
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lation for Multiple Controllers ".

 Procedure

1. Seletct "FS100-2" with the ribbon  .
2. On the [Controller] tab, in the [File Settings] group, click the [User Frame] button, the 

[Set User Frame] dialog appear.
3. Change the X value of UF#1 and UF#2 into -2000mm.
4. Adjust the synchronous starting position and the teaching position of a SYPICK/

SYPLACE command. Then, user coordinates were changed into -2000 mm, so the 
synchronous starting position and the teaching position of a SYPICK/SYPLACE com-
mand are added 1000 mm.

(1) Select the {VARIABLE} - {DOUBLE} menu on the virtual pendant.
(2) Change the value of D000, D001, D002 and D003 into 1800000.

5. Execute the distributing works.
(1) On the [Controller] tab, in the [External Device] group, click the [Conveyor Setting] 

button, the [Conveyor Setting] dialog appears.
(2) Click the [More] button, to display [Model Creation for High-Speed Picking] section.
(3) Select the conveyor No.1, and click the [Make] button.
(4) Select the conveyor No.2, and click the [Make] button.

6. Execute the playback.

2000mm 

1800mm 

User coordinates (the position of limit switch) 
is changed from -1000㎜ to -2000㎜. 

The synchronous starting position and 
the teaching position are added 1000㎜. 
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13.10.5 Specifications of template cell "MPP3S_PICKING"

 Job for high-speed picking simulation
To simulate high-speed picking, the "SYPICK-SYPLACE" job is used.

0000 NOP
0001 DOUT OT#(1) OFF
0002 DOUT OT#(5) OFF
0003 TIMER T=0.010
0004 DOUT OT#(5) ON                         //initialize of work model location
0005 SET I000 1                                    //initialize of work counter
0006 SET I001 301                                //initialize of pallet counter
0007 SET I003 1                                    //initialize of counter for B variable
0008 CVQUE CV#(1)                             //clear conveyor queue (pick)
0009 CVQUE CV#(2)                             //clear conveyor queue (place)
0010 SYEND CV#(1)
0011 SYEND CV#(2)
0012 MOVL C00000 V=1000.0              //move to the standby position
0013 *LOOP
0014 SYPICK P[I000] V=4000.0 CV#(1) SFTA:P000 STP=800.000 OL=0.0
 CTP=D000 HAND#1 T=0.100 FLAG:B000
0015 CVQUE CV#(1)                             //clear the queue per picking
0016 SYPLACE P[I001] V=4000.0 CV#(2) SFTA:P000 STP=800.000 OL=0.0
 CTP=D001 HAND#1 T=0.100 FLAG:B000
0017 JUMP *CONTINUE IF B[I003]=0   //clear the queue per pallets
0018 CVQUE CV#(2)
0019 *CONTINUE
0020 INC I000                                        //add 1 to work counter
0021 INC I001                                        //add 1 to pallet counter
0022 INC I003                                        //add 1 to B variable counter
0023 JUMP *LOOP IF I000<=I002        //determine if SYPICK continues
0024 MOVL C00001 V=1000.0             //move to the standby position
0025 END
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 Variable allocation list
In this template cell, the below variables are used.

 IO allocation list
In this template cell, the below IO signals are used.

Variable Default Description

I000 1 I000 is used to the counter to access P001 to P300. It is ini-
tialized to 1 at the beginning of job, and be added 1 with 
each execution of SYPICK.

I001 301 I001 is used to the counter to access P301 to P600. It is ini-
tialized to 301 at the beginning of job, and be added 1 with 
each execution of SYPLACE.

I002 10 I002 is compared with I000 for loop condition for the job.
In creating the work models, it is set the number of works.

I003 1 I003 is used to the counter to access B001 to B300. It is ini-
tialized to 1 at the beginning of job, and be added 1 with 
each execution of SYPLACE.

D000 800000 D000 is set the teaching position of SYPICK instruction (unit: 
micrometer). Edit it if needed.

D001 800000 D001 is set the teaching position of SYPLACE instruction 
(unit: micrometer). Edit it if needed.

P000 X0, Y0, Z-150
Rx0, Ry0, Rz0

P000 is set the value of [SHIFT(A)] of SYPICK/SYPLACE 
instruction. Edit it if needed.

P001 - P300 ― From P001 to P300 are used for [P-VAR ROBOT] of SYPICK 
instruction. 
In creating the work models, it is set the picking position 
based on the user frame #1.

P301 - P600 ― From P301 to P600 are used for [P-VAR ROBOT] of 
SYPLACE instruction.
In creating the pallet models, it is set the picking position 
based on the user frame #2.

B001 - B300 ― From B001 to B300 are used for determining if clear the 
queue of conveyor after the SYPLACE instruction.
Conveyor queue is cleared at the timing of changing the 
place position to the next pallet. The timing is calculated by 
the number of robot and the number of works per one pallet. 
When the pallet model is created, the above timing is calcu-
lated and stored.

Variable Default Description
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OT1 OFF OT1 is used to turn the hand ON/OFF with SYP-
ICK?SYPLACE instruction. It outputs ON with SYPICK 
instruction, and outputs OFF with SYPLACE instruction. 
Then the model script [SYPICK] or [SYPLACE] is called by 
IO event, the work model is replaced.

OT5 OFF OT5 outputs ON at the beginning of the job. Then the model 
script [SYINIT] is called by IO event, the work models loca-
tions are initialized.
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13.11Converting a MotoSim EG cell to MotoSim EG-VRC

MotoSim EG-VRC can convert and load files created by MotoSim EG but cannot playback the 
job and the robot operations are limited.  The MotoSim EG robot should be replace by the 
VRC corresponding robot type.  You can transfer the robot tooling and jobs to the new control-
ler.

Procedure

1. Click the MotoSim EG-VRC button (  ), and select the [Open] - [Open] menu.
2. In the “File Type” field select “MotoSim EG cell (*.cel)”.  And then select the MotoSim 

EG cell to be converted.  Press [Open].

3. When the convertion confirmation message below appears, select “Yes” to convert the 
file to a “MotoSim EG-VRC (*.vcl)” file.  The cell will display normally but the robot is 
still a “MotoSim EG” robot and will have limited operation.
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4. On the [Controller] tab, in the [Setup] group, click the [New] button, the new controller 
can be created.  

In the “Create Controller with...” dialog select “No CMOS.BIN file”.  Proceed to add  the 
controller as per the procedure of section 7.1.2 “Create Controller without CMOS.BIN 
file”.
In the initialization step at the “CONTROL GROUP” screen, select the robot type that 
matches the “MotoSim EG” robot of the cell.
Complet the procedure.

5. Once the VRC controller and robot has been added, transfer all robot tooling model 
from the MotoSim EG robot to the VRC robot using the models “Set Parent” function 
from the CAD tree.  (For details, refer to section " 11.9.2  Moving the Parent Model ".)

New VRC robot Old MotoSimEG robot 
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6. You can set the location of the VRC robot to overlap the MotoSim EG robot. (For 
details, refer to section " 11.5  Positioning a Model ".)

7. Delete the “MotoSim EG” robot from the cell.  (For details, refer to section " 7.3  Delet-
ing a Controller ".)  Save the cell. 

8. Using “Windows Explorer”, copy the job files (.JBI) and condition files (TOOL.CND, 
UFRAME.CND...) from the MotoSim EG robot folder to the VRC controller “Storage 
Card” folder.

9. Load the transfered files into the VRC controller.  (For details, refer to section " 15.3.3  
Load controller data to MotoSim EG-VRC ")

Unlike Windows, the VRC controller is case sensitive for the file names.  Condition file 
names need to be entered with all capital letters or they will not be detected in the “Storage 
Card” folder.  If this is not the case, rename the file name with Windows Explorer so that 
the names are written in capital letters.

Overlapping 
robot 

NOTE
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13.12Spot High Speed Spec Function

Set the spot high speed spec function for the robot, and it explains the procedure for the sim-
ulation of spot high speed spec function

• This simulation of the spot high speed spec function is a function that can be used only 
with the following controller.

Controller Types : YRC1000/DX200/DX100
System Version  : DX200 : Since DN1.40-00

DX100 : Since DS3.93-00
• This simulation of the spot high speed spec function is a function that can be used only 

with the following robots
YRC1000/DX200  Only spot welding model. 
DX100.

• The simulation of spot gun change system is not supported.
When the CMOS.BIN of the real controller is used to create the environment, delete the 
guns other than S1 by the Maintenance Mode of the virtual pendant.

Ex.) When the gun change system has S1, S2, S3, and S4, S2, S3, and S4 have to 
be deleted. To delete the guns other than S1, select the {SYSTEM} - {SET-
TING} - {CONTROL GROUP} with the Maintenance Mode of the virtual pen-
dant.

NOTE

 

 

 

 

About S2, S3, and S4, Select  
{DETAIL} – {SELECT} – {NONE} to  
delete the gun. 
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Procedure
1. A new controller for the simulation of the spot welding is registered by the operational 

procedure of " 13.7  Registering the Equipment Model ". In this case, select the control-
ler and robot as the above NOTE.

2. On the [Controller] tab, in the [Boot] group, click the [Maintenance mode] button, the 
[Maintenance mode] dialog appears. 

3. From the Virtual Pendant main menu select {SYSTEM} - {SETUP} - {OPTION FUNC-
TION}.

4. In the case of YRC1000, proceed the step 7 next.
In the case of DX200/DX100, Select the "Spot High Speed Spec" and set its value to 
"Used". When the confirmation message displays, select "Yes" to make the change

5. In the case of DX200, proceed the step 7 next.
In the case of DX100, Select the "Detail" of "Gun Arm Control".
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6. Select the "Func." and set its value to "Enable". When the confirmation message dis-
plays, select "Yes" to make the change.

7. Click the "End" button of the "VRC Maintenance Mode" dialog.
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13.13Setting of Paint workpiece supplying system 
"MOTOFEEDER"(NX100)

The MOTOFEEDER is the turntable-typed workpiece supplying equipment with the external 
2-axis structure.
The operation including the paint operation can be performed by setting the initial settings, 
and creating paint programs.
This section describes the procedure from the initial settings to the playback.

The procedure of MOTOFEEDER registration is as below.

• MOTOFEEDER can be used only with the bellow controller.
Controller :          NX100
System Version : NS5.35-45

• Only one MOTOFEEDER can be registered per controller.

NOTE

 

Controller Initialization 

Relocation of robot and MOTOFEEDER 

Master job Registration 

System Construction 

Paint job creating and registering 

Teaching 

Playback 

Playback the paint job 

MOTOFEEDER model setting 
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13.13.1 Controller Initialization

The large rotary axis S1 and small rotary axis S2 are set as station axes. 
When the controller is initialized, the control group is set as one robot (R1) and two station 
axes (S1, S2).

 

Procedure
1. Proceed to the step 1and 2 of " 7.1.1  Create a New VRC Controller (no file) " to create 

a new VRC controller".
Select "NS5.35-45" system version from "NX100". Then, Proceed to the step 3 and 
press the [Maintenance Mode Startup] button, the controller starts up in maintenance 
mode.

2. Follow the procedure of section " 7.1.3  Initializing the Controller (YRC1000, 
YRC1000micro, DX200, DX100, NX100) ".
When asked for the "Control Group", select the model to suit the actual robot system 
as a guide for the following table.
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•  Registration of R1
MOTOFEEDER is registered in combination with EPX1250 or EPX2050, so select 
"EPX1250-A00*" or "EPX2050-A3**", "EPX2050-A5**", or "EPX2050-B5**". For With-
Manipulator Specification, EPX1250 is available only.

•  Registration of S1
Select "MF418A-S1".

•  Registration of S2
For High-Speed Rotation Specification, select "MF218A-S2". For Heavy Load Specifica-
tion, select "MF418A-S2".

3. Set the value in the Connect display as a guide for the following table.

Actual robot system Model registration on the VRC controller

R1 S1 S2

Arm Length: 1600mm, With Manipulator, 
High-Speed Rotation Specification

EPX1250

MF418A-S1

MF218A-S2

Arm Length: 1800mm, With Manipulator, 
High-Speed Rotation Specification

EPX1250

Arm Length: 1400mm, Without Manipulator, 
High-Speed Rotation Specification

EPX1250 / EPX2050

Arm Length: 1600mm, Without Manipulator, 
High-Speed Rotation Specification

EPX1250 / EPX2050

Arm Length: 1800mm, Without Manipulator, 
High-Speed Rotation Specification

EPX1250 / EPX2050

Arm Length: 1600mm, With Manipulator, 
Heavy Load Specification

EPX1250

MF418A-S2

Arm Length: 1800mm, With Manipulator, 
Heavy Load Specification

EPX1250

Arm Length: 1400mm, Without Manipulator, 
Heavy Load Specification

EPX1250 / EPX2050

Arm Length: 1600mm, Without Manipulator, 
Heavy Load Specification

EPX1250 /EPX2050

Arm Length: 1800mm, Without Manipulator, 
Heavy Load Specification

EPX1250 / EPX2050
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• EPX1250

• EPX2050

4. Set "ROTATION DIRECTION" of S1 and S2 to "REVERSE" in the motor spec display.

5. Set "APPLICATION" to "PAINT" in the application display. Then, press the [ENTER] 
button as default setting again, until controller initializing is finished.

 SV CN 1 2 3 4 5 6 7 8 9 

R1 #1  - 1 2 3 4 5 6 - - 

S1 #1  1 - - - - - - - - 

S2 #1  -  - - - - - 1 - 

TU BRK 1 2 3 4 5 6 7 8 9 CN 1 2 3 4 5 6 7 8 9 

#1  - 1 2 3 4 5 6 - - CV - 1 1 1 1 1 1 - - 

#1  1 - - - - - - - - CV 1 - - - - - - - - 

#1  1  - - - - - - - CV -  - - - - - 1 - 

 SV CN 1 2 3 4 5 6 7 8 9 

R1 #1  1 2 3 4 5 6 - - - 

S1 #1  - - - - - - 1 - - 

S2 #1  -  - - - - - 1 - 

TU BRK 1 2 3 4 5 6 7 8 9 CN 1 2 3 4 5 6 7 8 9 

#1  1 2 3 4 5 6 - - - CV 1 1 1 1 1 1 - - - 

#1  - - - - - - 1 - - CV - - - - - - 2 - - 

#1  -  - - - - - 1 - CV -  - - - - - 3 - 
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13.13.2 MOTOFEEDER model setting

After controller setting is finished, the Robot Settings dialog box is displayed. Set the MOTO-
FEEDER model to "Robot Model File" of ST1.

Procedure
1. Robots\NX100\MF-Family" folder under the MotoSim EG-VRC install folder contains 

Robot models of MOTOFEEDER. Select the model file (robotinf.dat) to "Robot Model 
File" of ST1 as a guide for the following table.

Model registration on the VRC controller Model File Folder

Arm Length: 1600mm, With Manipulator, High-Speed Rotation Specifi-
cation

MF216A

Arm Length: 1600mm, With Manipulator, High-Speed Rotation Specifi-
cation (with spindle unit)

MF216A_SPINDLE

Arm Length: 1800mm, With Manipulator, High-Speed Rotation Specifi-
cation

MF218A

Arm Length: 1800mm, With Manipulator, High-Speed Rotation Specifi-
cation(with Spindle unit)

MF218A_SPINDLE

Arm Length: 1400mm, Without Manipulator, High-Speed Rotation 
Specification

MF214B

Arm Length: 1400mm, Without Manipulator, High-Speed Rotation 
Specification(with spindle unit)

MF214B_SPINDLE

Arm Length: 1600mm, Without Manipulator, High-Speed Rotation 
Specification

MF216B

Arm Length: 1600mm, Without Manipulator, High-Speed Rotation 
Specification(with spindle unit)

MF216B_SPINDLE

Arm Length: 1800mm, Without Manipulator, High-Speed Rotation 
Specification

MF218B

Arm Length: 1800mm, Without Manipulator, High-Speed Rotation 
Specification(with spindle unit)

MF218B_SPINDLE

Arm Length: 1600mm, With Manipulator, Heavy Load Specification MF416A
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2. After set "Robot Model File" of S1, press the [OK] button without setting "Robot Model 
File" of S2.

3. Virtual pendant restarts. Then, the "The initialization file of a controller is loaded" dialog 
box is displayed, press the [OK] button.

13.13.3 Relocation of robot and MOTOFEEDER

When the robot is displayed, relocate the robot model and MOTOFEEDER model in the 
CADTREE dialog box.
The robot model and MOTOFEEDER model are registered as below.
When relocate them, relocate the dummy model of MOTOFEEDER as below.

 With Manipulator Specification

 Without Manipulator Specification

13.13.4 Master job Registration

The paint operation of MOTOFEEDER and robot is performed with the prepared control job 
and the created paint job. The prepared job calls the created paint job. So, the prepared Job 
needs to be registered as Master Job.
The prepared control job has already loaded, register it as below.

Arm Length: 1800mm, With Manipulator, Heavy Load Specification MF418A

Arm Length: 1400mm, Without Manipulator, Heavy Load Specification MF414B

Arm Length: 1600mm, Without Manipulator, Heavy Load Specification MF416B

Arm Length: 1800mm, Without Manipulator, Heavy Load Specification MF418B

The dummy model "(Controller Name)-MF" is cre-
ated. Robot model and MOTOFEEDER model are 
registered under the dummy model.

The dummy model "(Controller Name)-MF" is cre-
ated. MOTOFEEDER model is registered under 
the dummy model. Robot model is registered under 
the world model.
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Procedure
1. Select {JOB} - {CTRL MASTER} on the virtual pendant.
2. Press the [Space] key at MASTER of MASTER JOB, select "SETTING MASTER JOB" 

and press the [Space] key.
3. Select "MASTER.JBI", and press the [Space] key.

13.13.5 Paint job creating and registering

Create the paint job as usage. (Refer to manual "MOTOFEEDER OPERATING INSTRUC-
TIONS" about the procedure of creating the paint job.)
To perform the operation including the MOTOFEEDER motion, register the created paint job 
in the registration table.

Procedure
1. Select {JOB} - {JOB REGISTRATION} on the virtual pendant.
2. Press the [Space] key at "JOB NAME" and select the paint job from job list.

Set the paint job for the small rotary axis A: No. 0001, and set the paint job for the small 
rotary axis B: No. 0002.

 Without Spindle Unit Specification
The job "SAMPLE1" has already loaded. (Control Group: R1 + S2)
Set the "SAMPLE1" to No.001 and No.002, you can see the MOTOFEEDER motion of "SAM-
PLE1".

 

Select {TABLE NUMBER: 1} 

Register the paint job for the 
small rotate axis A 

Register the paint job for the 
small rotate axis B 
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 With Spindle Unit Specification
The job "SAMPLE2" has already loaded. (Control Group: R1)
Set the "SAMPLE2" to No.001 and No.002, you can see the MOTOFEEDER motion of "SAM-
PLE2".

13.13.6 Playback the paint job

On the [Simulation] tab, in the [Monitor] group, click the [I/O Monitor] button and select the 
[Operation Panel] menu. The [MOTOFEEDER-IOBOX] dialog appears.

Item Description

[START] button The large rotary axis rotates, and the paint job is executed.

[COMPLETE] button The large rotary axis rotates. But, the paint job is not executed.

[Close work injection door] 
checkbox

Check this check box, the input of safeguarding is "ON". When exe-
cute playback, this check box needs to be checked.

[Continuation of a button 
push] button

Check this check box, keep the START button or the COMPLETE but-
ton pressed.
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13.14Setting of Paint workpiece supplying system 
"MOTOFEEDERII"(DX200)

The MOTOFEEDER II is the turntable-typed workpiece supplying equipment with the external 
2-axis structure.
This section explains the procedure for creating an environment for initial setting of MOTO-
FEEDER II and teaching painting operation.

The procedure of MOTOFEEDERII registration is as below.

• MOTOFEEDERII can be used only with DX200.
• Only one MOTOFEEDERII can be registered per controller.NOTE

 

Controller Initialization 

Relocation of robot and MOTOFEEDERII 

Master job Registration 

System Construction 

Paint job creating and registering 

Teaching 

Playback 

Playback the paint job 

MOTOFEEDERII model setting 
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13.14.1 Controller Initialization

The large rotary axis S1 and small rotary axis S2 of MOTOFEEDERII are set as station axes. 
When the controller is initialized, the control group is set as one robot (R1) and two station 
axes (S1, S2).

Procedure
1. Proceed to the step 1and 2 of " 7.1.1  Create a New VRC Controller (no file) " to create 

a new VRC controller". Select "DX200" to controller type. Then, Proceed to the step 3 
and press the [Maintenance Mode Startup] button, the controller starts up in mainte-
nance mode.

2. Follow the procedure of section " 7.1.3  Initializing the Controller (YRC1000, 
YRC1000micro, DX200, DX100, NX100) ". When asked for the "Control Group", select 
the model to suit the actual robot system as a guide for the following table.

■ Registration of R1
MOTOFEEDER is registered in combination with MPX-series.
■ Registration of S1
Select "MFDS1".
■ Registration of S2
For High-Speed Rotation Specification, select "MFDS2-20KG". For Heavy Load Speci-
fication, select "MFDS2-40KG".

3. Set "APPLICATION" to "PAINT" in the application display. Then, press the [ENTER] 
button as default setting again, until controller initializing is finished.

13.14.2 MOTOFEEDERII model setting

After controller setting is finished, the Robot Settings dialog box is displayed. Set the MOTO-

Actual robot system Model registration on the VRC controller 

R1 S1 S2 

High-Speed Rotation Specification MPX Series MFDS1 MFDS2-20KG 

Heavy Load Specification MFDS2-40KG 
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FEEDERII model to "Robot Model File" of S01.

Procedure
1. Selects S01 from the list and presses the [Another Type] button.
2. From the dropdown list on the Robot Model Setting dialog, selects the robot model that 

matches the real robot configuration.
3. Presses the [OK] button on the Robot Model Setting dialog.
4. Presses the [OK] button without setting "Robot Model File" of S02.
5. Virtual pendant restarts. Then, the "The initialization file of a controller is loaded" dialog 

box is displayed, press the [OK] button. 

13.14.3 Relocation of robot and MOTOFEEDERII

To relocate the robot and MOTOFEEDERII, please refer to section " 13.13.3  Relocation of 
robot and MOTOFEEDER ".

13.14.4 Master job Registration

To register the master job, please refer to section " 13.13.4  Master job Registration ".

13.14.5 Paint job creating and registering

Create the paint job as usage. (Refer to manual "MOTOFEEDERII OPERATING INSTRUC-
TIONS" about the procedure of creating the paint job.)

13.14.6 Playback the paint job

To playback the paint job, please refer to section " 13.13.6  Playback the paint job ".
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13.15Setting of Paint workpiece supplying system 
"MOTOFEEDER TILT"

The MOTOFEEDER TILT is the turntable-typed workpiece supplying equipment with the 
external 5-axis structure.
This section explains the procedure for creating an environment for initial setting of MOTO-
FEEDER TILT and teaching painting operation.

The procedure of MOTOFEEDER TILT registration is as below.

• MOTOFEEDER TILT can be used only with DX200.
• Only one MOTOFEEDER TILT can be registered per controller.NOTE

Controller Initialization 

Relocation of robot and MOTOFEEDER TILT

Master job Registration 

SSyysstteemm  CCoonnsstt rruucctt iioonn  

TTeeaacchhiinngg

Paint job creating and registering 

MOTOFEEDER TILT model setting 
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13.15.1 Controller Initialization

The large rotary axis S1 and small rotary axis S2/S3 of MOTOFEEDER TILT set as station 
axes. When the controller is initialized, the control group is set as one robot (R1) and three 
station axes (S1, S2, S3).

Procedure
1. Proceed to the step 1and 2 of " 7.1.1  Create a New VRC Controller (no file) " to create 

a new VRC controller". Select "DX200" to controller type. Then, Proceed to the step 3 
and press the [Maintenance Mode Startup] button, the controller starts up in mainte-
nance mode.
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2. Follow the procedure of section " 7.1.3  Initializing the Controller (YRC1000, 
YRC1000micro, DX200, DX100, NX100) ". When asked for the "Control Group", select 
the model to suit the actual robot system as a guide for the following table.

■Registration of R1
MOTOFEEDER is registered in combination with MPX-series.
■Registration of S1
Select "MTDS1-A0".
■Registration of S2
Select "MTDS2S3-VT-A0".
■Registration of S3
Select "MTDS2S3-VT-A0".

3. Set "APPLICATION" to "PAINT" in the application display. Then, press the [ENTER] 
button as default setting again, until controller initializing is finished.

13.15.2 MOTOFEEDER TILT model setting

After controller setting is finished, the Robot Settings dialog box is displayed. Set the MOTO-
FEEDER TILT model to "Robot Model File" of S01.

Procedure
1. Selects S01 from the list and presses the [Another Type] button.
2. From the dropdown list on the Robot Model Setting dialog, selects the robot model that 

matches the real robot configuration.
3. Presses the [OK] button on the Robot Model Setting dialog.
4. Presses the [OK] button without setting "Robot Model File" of S02/S03.
5. Virtual pendant restarts. Then, the "The initialization file of a controller is loaded" dialog 

box is displayed, press the [OK] button.

Model registration on the VRC controller

R1 S1 S2 S3

MPX Series MTDS1-A0 MTDS2S3-VT-A0 MTDS2S3-VT-A0
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13.15.3 Relocation of robot and MOTOFEEDER TILT

To relocate the robot and MOTOFEEDER TILT, please refer to section " 13.13.3  Relocation of 
robot and MOTOFEEDER ".

13.15.4 Master job Registration

To register the master job, please refer to section " 13.13.4  Master job Registration ".

13.15.5 Paint job creating and registering

Create the paint job as usage. (Refer to manual "MOTOFEEDER TILT OPERATING 
INSTRUCTIONS" about the procedure of creating the paint job.)
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13.163DPDF Output Function

This function outputs 3D PDF file containing the animation of a playback and the viewpoint 
control function. The information on the 3DPDF (e.g. title, company name, etc.) can be set 
with an output setting dialog.

*1 Acrobat Reader is registered trademarks or trademarks of Adobe Inc. in the United 
States and/or other countries.

 RESTRICTION
• Only the current job is displayed on the job contents list. As for peripheral equipment 

(conveyor, press and gantry), only animation is played.
• When CALL JOB or PSTART is used, it can not move to the step in the job of called job.
• As for trace line, the trace lines are displayed when finishing the playback. To display the 

trace lines, the kind of line in the trace property needs to be set to "Normal" or "Thick".
• Operation of the ribbon menu under recording is limited as same as the time of a play-

back.
• It does not correspond to changing the color of the pulse limit warning or the interference 

check.
• It does not correspond to a cutting plane, a memo, a dimension line, and a markup, and 

target a point arrow of CAM function.
• The model which exists after the end of a playback is the target of animation. The model 

deleted during a playback (by the model command etc.) is not contained.
• The data of LINE and LINE2 format of MDL form cannot be displayed.
• Template file can use "3DPDF_Template_A4_US.pdf" , "3DPDF_Template_A4_no_job-

list_US.pdf" , "3DPDF_Template_A4_steptime_US.pdf" and “3DPDF_Template_A4_-
full3D_US.pdf” only. If editing this file, 3DPDF is not outputted correctly.

• Do not delete the "3DPDF_Template_A4_US.pdf" ,"3DPDF_Template_A4_no_job-
list_US.pdf" , "3DPDF_Template_A4_steptime_US.pdf" and “3DPDF_Template_A4_-
full3D_US.pdf”.

• NS4.69-A5 Controller is not supported.
• To use the 3DPDF function, Driver is set to "OpenGL" or "OpenGL2". It is in [Options] dia-

log - [Graphic] tab - [Display].

• To open the outputted 3DPDF file, Acrobat Reader is needed. The outputted 3DPDF files 

are not guaranteed to open on any PDF viewers other than Acrobat Reader*1.
• Some Acrobat Reader version can not open the 3DPDF file. Please use the latest ver-

sion.
• If the animation is long, it takes a long time to open the 3DPDF files.

Only as a guide, when the animation is about three minute, it takes 30 seconds to open 
the 3DPDF file. This depends on the PC specifications.

NOTE
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13.16.1 Output Setting

On the [Simulation] tab, in the [Output] group, click the [Output Settings] of the [3DPDF]. [Out-
put setting of 3DPDF] dialog is displayed.

Set each items on the [Output setting of 3DPDF] dialog.

Output setting of 3DPDF

Item Description

Format Sets the file name of 3DPDF format. PDF file in the 
\Users\Pubilc\Documents\MOTOMAN\MotoSim EG-VRC\Tem-
plate\3DPDF folder is displayed. When installing MotoSim EG-
VRC, "3DPDF_Template_A4_US.pdf" , "3DPDF_Tem-
plate_A4_no_joblist_US.pdf" and "3DPDF_Template_A4_step-
time_US.pdf" are copied to the 3DPDF folder. 
"3DPDF_Template_A4_US.pdf" is set by default.

Image path Sets the JPG file of the logo image.
When this is not set, the logo of YASKAWA is displayed.

Title1 Sets the contents of title 1.
NOTE : A string longer than the number of characters
             restriction can't be used.

Title2 Sets the contents of title 2.
NOTE : A string longer than the number of characters
             restriction can't be used.
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Company Sets the company name.
NOTE : A string longer than the number of characters
             restriction can't be used.

Unit Sets the unit name.
NOTE : A string longer than the number of characters
             restriction can't be used.

Additioal Information Sets the additional information. This is displayed as [Item] : 
[Data].
  [Item] : Sets the item name.
  [Data] : Sets the data.
[Add] button

  When input the [Item] and [Data] and press the [Add] button, 
the item is added to the list.

[Upd] button
When click the item of the list, the item is reflected to [Item] 
and [Data]. When change the contents of [Item] or [Data] and 
press the [Upd] button, the item of the list is changed.

[Del] button
When click the item of the list and press the [Del] button, the 
item of the list is deleted.

NOTE : A total characters number of [Item] and [Data] has to be 
            below the number of characters restriction.

Speed of animation Sets the speed of the animation.

Frame Rate Sets the number of the frame displayed per 1 second. 10 fps is 
set by default. If the 3DPDF operation is so slow, set this less 
than 10 fps. In this case, the animation is jumpy.

Smoothing When enabled, The gap of the same model between frames is 
interpolated linearly. This is enabled by default.

Data compressing When enabled, the 3D data is compressed. This is enabled by 
default.

Save as Default This setting of the cell is saved as a default setting of MotoSim 
EG-VRC.

Restore Default This setting of the cell is restored by a default setting of Moto-
Sim EG-VRC.

Enable Playback When disenabled, 3DPDF which can only use viewpoint opera-
tion is created. The default is enabled.
When disenabled, only "3DPDF_Template_A4_full3D_US.pdf" 
template is selected.

Output setting of 3DPDF

Item Description

676/847



13.16  3DPDF Output Function

HW0485348

The relation of each setup items and the screen of 3DPDF are as follows.

13.16.2 Outputting 3DPDF

Procedure
1. Select the controller and the job to output the job contents list. 
2. On the [Simulation] tab, in the [Output] group, click the [3DPDF] of the [3DPDF]. 

The process of 3DPDF outputting is executed. During the process, the following dialog 
is displayed.

During playback, click the [3DPDF] of the [3DPDF] in the [Output] group on the [Simu-
lation] tab, the playback can be stopped. Then, the following dialog is displayed. Press 
the [Yes] button, the animation until stopping the playback is outputted. And Press the 

• When the cell is a new created cell or created by MotoSim EG-VRC before Ver2015, a 
default setting of MotoSim EG-VRC is loaded. When this setting dialog is opened or a 
3DPDF file is created, the setting is saved in the cell folder. The setting in the cell folder 
will be loaded after that.

• The number of characters restriction of each item changes with the selected 3DPDF for-
mat.

NOTE

 
 

 

Additional 
Informantion 

Title1 Title2 Image Path 

Company 

Unit 
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[No] button, the process of 3DPDF outputting is finished.

3. When finished the recording, the 3DPDF file is created in the cell folder and that file is 
named as "cell name".pdf. If the file already exists, the following dialog is displayed. 
When overwrite it, press the [OK] button. When want not to overwrite it, enter the new 
file name and press the [OK] button.

4. When the 3DPDF file creation is finished successfully, the following dialog is displayed. 
Press the [Yes] button, the cell folder is opened. Press the [No] button, the cell folder is 
not opened.

13.16.3 Display and Operation of 3DPDF

 3DPDF file which created by "3DPDF_Template_A4_US.pdf" as a format
When open the 3DPDF file which created by 3DPDF_Template_A4_US.pdf as a format, it will 
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be displayed as follows.

Press the each button of [View Control] (the [Default] button, the [Top] button, the [Side] button 
and the [Front] button), the viewpoint of 3D view area is changed.
Press the [Play] button, the animation is played. Then, if check the [Repeat], the animation is 
played repeatedly. 
Press the [Reset] button, the robot moves to the start position of the animation.
When the controller is changed by the drop-down list, the contents of job name, control group, 
job list, and playback time are changed.
Click the move instruction in the job contents list, the robot moves to the teaching point. And, 
the information of the clicked line is displayed in the instruction view area.
The playback time of the job displayed in the job contents list is displayed in the lower right-
hand corner of the page.

3DPDF file which created by "3DPDF_Template_A4_no_joblist_US.pdf" as a for-
mat
When open the 3DPDF file which created by 3DPDF_Template_A4_no_joblist_US.pdf as a 

 
 

 

Playback time 

Job contents list 

View control button 
(Default, Top, 
Side, Front) 

Reset button 

Repeat mode 

3D view area 

Job and Control group 

Instruction view 
area 

Play button 

Controller 
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format, it will be displayed as follows.

3DPDF file which created by "3DPDF_Template_A4_steptime_US.pdf" as a for-
mat
When open the 3DPDF file which created by "3DPDF_Template_A4_steptime_US.pdf" as a 
format, it will be displayed as follows.

 

Job contents list 
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Job contents list will be displayed in the order of "step number", "Cycle time between steps" 
and "job contents". Other items is equivalent to format "3DPDF_Template_A4_JP.pdf".

RESTRICTION
•  When the job execution order is changed (e.g. CALL instruction, JUMP instruction), the 

step between the cycle time will be displayed as follows.
• When there is the CALL instruction in the current job, time spent in the CALL instruction is 

added to the next step time.
• When the same steps are executed multiple times (e.g. Label instruction and JUMP 

instruction), the cycle time between steps of first time is displayed.
• When the step has not executed according to the instruction (e.g. JUMP instruction), 

cycle time between steps of that is blank display.
• When stop in the middle of the play back at the time of 3DPDF output, cycle time between 

steps of step execution has been completed is displayed only.

In 3D view area, the viewpoint can be changed by mouse operation. The assignment of the 
viewpoint operation mode is as follows.

Viewpoint Operation Mode Mouse Operation

Rotate Press-and-hold the left button and drag

Zoom Rotate the scroll wheel
or
Press-and-hold the right button and drag upward or down-
ward
or
Press the Shift key of the keyboard and press-and-hold 
the left button or the right button and drag upward or 
downward

 

Job contents 
Step number Cycle time 

between steps 
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To display 3D view as full screen, right-click on the 3D view area and display the right-click 
menu, and select the [Full Screen Multimedia].

To end full screen, right-click on the 3D view area and display the right-click menu and select 
the [End Full Screen Multimedia], or press the [Esc] key of the keyboard.

Parallel Press the Ctrl key of the keyboard and press-and-hold the 
left button and drag
or
Press-and-hold the left button and the right button and 
drag

Zoom in Press the Ctrl key of the keyboard and press-and-hold the 
right button and drag

Viewpoint Operation Mode Mouse Operation
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3DPDF file which created by "3DPDF_Template_A4_full3D_US.pdf" as a format
When open the 3DPDF file which created by 3DPDF_Template_A4_full3D_US.pdf as a for-
mat, it will be displayed as follows.

 NOTE
• When left-click on the 3D view area, the model may be selected. By the setting of the 

Acrobat Reader, the model will be not selected.

Procedure
1) Select [Edit] - [Prefernces…], and the [Prefernces] dialog is displayed.
2) In the [3D & Multimedia], Uncheck the [Enable selection for the Hand tool] of the 

[3D Tool Options].

• When playing the animation, the robot and the other models in the 3D view area may be 
displayed as bounding box. By the setting of the Acrobat Reader, the bounding box will be 
not displayed.

Procedure
1) Select [Edit] - [Prefernces…], and the [Prefernces] dialog is displayed.
2) In the [3D & Multimedia], Set [None] to [Optimization Scheme for Low Framerate] 

of the [Auto-Degrade Options].

• When playing the animation in a 3DPDF output from a cell containing a model script, the 
model script may cause the display to be distorted at the switching between showing and 
hiding of the model. By the setting of the Acrobat Reader, you can avoid this.
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Procedure
1) Select [Edit] - [Prefernces…], and the [Prefernces] dialog is displayed.
2) In the [3D & Multimedia], Set [None] to [Optimization Scheme for Low Framerate] 

of the [Auto-Degrade Options].

• Enabling the following 3D graphic board settings for Acrobat Reader may improve 3DPDF 
performance. For the setting method when using NVIDIA 3D graphic board, refer to " 
1.3.1  3D Graphic Board Setting ".
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13.17AVI Output Function

This function outputs AVI file containing the animation of a playback. The video resolution can 
be set with an output setting dialog. If operate the viewpoint during playback, the state is also 
reflected to the animation.

RESTRICTION
• The frame rate of AVI file changes by refresh interval of MotoSim EG-VRC. When refresh 

interval becomes small, the frame rate becomes big, so the animation becomes smoothly. 
But, the file size becomes big.

• When changing a viewpoint quickly, a minute movement of viewpoint can't be replicated 
right sometimes.

• Operation of the ribbon menu under recording is limited as same as the time of a play-
back.

• It does not correspond to changing the color of the pulse limit warning or the interference 
check.

• It does not correspond to a trace line, a cutting plane, a memo, a dimension line and a 
markup, and target a point arrow of CAM function.

• The model which exists after the end of a playback is the target of animation. The model 
deleted during a playback (by the model command etc.) is not contained.

• Showing and Hiding the weld spark model can't be replicated.
• There is a possibility that a PC will be heavily by lack of a memory depending on the 

length of the animation.

13.17.1 Output Setting

On the [Simulation] tab, in the [Output] group, click the [Output settings] of the [AVI].
 [Output setting of AVI] dialog is displayed.

• To Open the outputted AVI file, the video playback software is needed. And, installation of 
a codec is needed depending on PC.

• A file size becomes big depending on the length of animation.
• Animation is played in time a playback takes actually, not playback time in the virtual con-

troller.

NOTE
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Set each items on the [Output setting of AVI] dialog.

13.17.2 Outputting AVI

Procedure
1. Select the controller and the job to output the job.
2. On the [Simulation] tab, in the [Output] group, click the [AVI] of the [AVI]. The process 

of AVI outputting is executed. During the process, the following dialog is displayed.

When AVI file output is started, the frame of recording area is displayed on the Moto-

Resolution

Sets the resolution of AVI. Selectable resolution are as fol-
lows.

• 1280x720
• 1024x768
• 640x480
• 320x240

Recording area is the specified size rectangle, and which 
center is the center of view area of MotoSim EG-VRC.
When AVI file output is started, the frame of recording 
area is displayed. For details, refer to the section " 13.17.2  
Outputting AVI ".

When the resolution becomes big, the image quality becomes delicately, but the file size 
becomes big.

 

Recording area 

NOTE
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Sim EG-VRC window. The animation in this frame is saved to a AVI file.

Depending in the aspect ratio of MotoSim EG-VRC window, vertical lines or horizontal 
lines are not displayed in the window sometimes as below. In this case, the area out-
side the window is saved to the AVI file.

                        

During playback, click the [AVI] of the [AVI] in the [Output] group pm the [Simulation] 
tab, the playback can be stopped. Then, the following dialog is displayed. Press the 
[Yes] button, the animation until stopping the playback is outputted. And press the [No] 
button, the process of AVI outputting is finished.

3. When finished the recording, the AVI file is created in the cell folder and that file is 
named as "cel name".pdf. If the file already exists, the following dialog is displayed. 
When overwrite it, press the [OK] button. When want not to overwrite it, enter the new 

• The frame of output area cannot be changed. (e.g. mouse drag operation, etc.)
• When the window size is changed, the frame of output area is changed.
• The frame of output area is not saved to the AVI file.

NOTE
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file name and press the [OK] button.

4. AVI file creation is started, and the following dialog is displayed. During AVI file cre-
ation, the recorded contents is played back. And, MotoSimEG -VRC can't be operated 
any more entirely until output processing is completed.

5. When the AVI file creation is finished successfully, the following dialog is displayed. 
Press the [Yes] button, the cell folder is opened. Press the [No] button, the cell folder is 
not opened.

6. Outputted file can be played back by the video playback software.
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13.18Working Trace Function

13.18.1 Changing Trace Object

The tracking drawn by the working trace function is normally created and drawn as a model 
having "world" as the parent. Therefore, changing the name of the "Parent" in the Working 
Trace Configuration dialog box will change the parent of the tracking. For example, work is on 
the station and turns and the robot welds this work, if the parent is set to work, the working 
trace is drawn on the work.

Procedure
The procedure is explained with the "1con4robot.vcl" example.

1. On the [Simulation] tab, in the [Monitor] group, click the [Working Trace] button, the [Work-
ing Trace Manager] dialog appears.

2. Edit the setting of "WT3".
Select "WT3" on the list and click the [Edit] button.

3. Click the [...] button beside the "Parent" field to display the "Select Object" dialog box. 
Select "work" and click the [OK] button.

When the playback is canceled, the "work" model parent might be "DX100-R01".
NOTE
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4. Check the [Enable] check box, and click the [OK] button.

5. Edit the setting of "WT4".
For "WT4", execute same procedure from Step.2 to Step.4.
When the setting is completed, click the [Close] button of the [Working Trace Manager] 
dialog.
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6. Insert the comments to start drawing the working trace.
On the virtual pendant, show the "MASTER" job, and move the cursor to the step where 
R3 and R4 starts welding. "POS LEVEL" of that step is changed "PL=0". And, the following 
comments is inserted to the next of that step.
'DRW:WT3=ON
'DRW:WT4=ON

7. Insert the comments to start drawing the working trace.
Move the cursor to the step where R3 and R4 finishes welding. And, the following com-
ments is inserted to the next of that step.
'DRW:WT3=OFF
'DRW:WT4=OFF

8. Start playback.
When start playback, the working trace is move according to the movement of "work".
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13.19Simulation of Mechanical Mirror Robot

The mechanical mirror robot is changed the parameters of SVxG0 - 5 (motor rotation direction 
specified).
When the motor rotation direction is reversed, the robot in the MotoSimEG-VRC is displayed 
to the specified value in the opposite direction.
But, for the following models, it is displayed in consideration of the motor rotation direction.

• EPX2050-A5
• EPX2800-A0
• EPX2800R-A0
• EPX2900-A0
• UH0100D-J20
• UH0100Y-A20
• UH0100Y-A22
• UH0100Y-A24
• UH0100Y-A30
• UH0100Y-A32
• UH0100Y-A34
• UH0100Y-A40
• UH0100Y-A42
• UH0100Y-A44

When this function is used, the operation of the robot in the position panel and the OLP 
operation still guarantees, but the others does not guarantees.

NOTE
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 Inverts the Parameter
Inverts the parameter of S axis, R axis, B axis, and T axis.
When the traveling axis is inverted, executes the same operation for traveling axis.
UH-series models only invert the parameter of SV1G0000.
After changing parameters, please re-start of MotoSimEG-VRC.

E.G. Two EPX2900-A0 is placed face-to-face

[Robot Controller to Normal Display] 

 

[Robot Controller to Mirror Display] 
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In spite of the same pulse, the 
configured EPX2900-A0 moves 
in the same direction. 
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13.20Setting of arc welding simulation

To simulate the arc welding, it needs to set the response time of welding machine.
On the [Controller] tab, in the [File Settings] group, click the [Arc Welding Condition] button, 
the [Arc Welding Condition] dialog appears.

• This setting is avalable when the use of the controller is "Arc" only.
• The simulation of the arc welding is a function that can be used only with YRC1000/

DX200/DX100.It doesn't deal with other controllers.

Arc Welding Condition

Item Description

“Response Time(msec)” 
edit box

Sets the response time of welding machine.

NOTE
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13.21Rearranging Travel Axis Function

This function changes robot's travel axis order registered in CadTree, and allows you to 
change the order in which the user moves the travel axis.

 RESTRICTION
This function is not supported 1-axis.

Procedure
1. Expand the model tree view of the robot model registered in Cad Tree, select a model 

described as "_base" at the end, and right click on this to display a popup menu.

2. When clicking [Rearrange Driving Axis] in the popup menu, a dialog for selecting the 
following sorting order will be displayed (2 patterns for 2-axes, 6 patterns for 3-axes). 
Select the order you want to change from the list and press OK.

696/847



13.21  Rearranging Travel Axis Function

HW0485348

3. For example, change the order of X → Y → Z to Z → X → Y. Please confirm that 
CadTree is as follows before and after change. In addition, rearranging can execute 
repeatedly.

4. When saving and reloading the cells, MotoSimEG-VRC assembles the travel axis in a 
sorted state.
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13.22Retrofit Function

This function supports job conversion when replacing from existing controller to new control-
ler. The main functions are as follows.

1. Converts job from source robot to destination robot
2. Checks robot configuration at teach point
3. Collects the log of the trajectory by the playback of the job of source robot and destina-

tion robot and displays the difference information in the report.
4. Supports the following modification so that the trajectory of destination robot 

approaches the trajectory of source robot
• Teach point modification

Move the teaching point of the job by the amount of deviation so that the trajectory 
of destination robot approaches the trajectory of source robot

• PL modification
Sets the PL tag to the movement command having a large deviation

• Speed modification
Sets the slow speed to the movement command having a large deviation

• Gun axis modification
In the case of a robot with the motor gun, the teaching point is added so that the tra-
jectory of destination robot approaches the trajectory of source robot

 Preparation
• Create a cell in which the source and destination controllers are registered.

 NOTE
• When applying the created job on the actual controller, please check or modify the posi-

tion by jog operation before playback.
• Only one axis robots are supported.
• This function supports R1, B1, S1 (gun axis) only. Positioner, multiple robot system and 

gun change system are not supported.
• It does not correspond to change of electric gun. Therefore, the motor gun position data 

are not changed.
• If there is a CALL or JUMP instruction, the called job is excluded from conversion.
• The tool number of the destination job reflects the tool number of the source job. How-

ever, only R1 is supported.
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13.22.1 Overview Flowchart

Follow the flowchart below to use retrofit function.

 

Creating a cell containing the 
source controller and destination 
controller 

Selecting source robot and 
destination robot 

Job conversion 

Collection of trajectory 
information 

Reporting of trajectory difference 

Job  
Modification 

Confirming position and form 
after conversion 

Setting of safety fence 
model and collision check 
(13.21.2) 

Gun axis 
modification 

13.21.3 

13.21.4 
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13.22.2 Setting of Safety Fence Model and Collision Check

As a result of job conversion, the robot and the surrounding fence may interfere.
With the retrofit function, a model of the safety fence around the robot can be created easily, 
and the interference with the safety fence can be checked at the time of collection of trajectory 
information.
On the [Tool] tab, in the [Retrofit] group, click the [Safety fence setting] button, the [Safety 
fence interference setting] dialog appears.

Procedure
1. Selects the robot to place the safety fence. Select the robot specified as the conversion 

destination.

 

 

 

Selects the place 
to generate the 
safety fence 
model. 

Selects the target robot. 
Sets the position of the safety fence by 
the distance from the robot. (Units: mm) 

Sets the width of 
the safety fence 
model.  
(Units: mm) 

Sets the height of the safety 
fence model.(Units: mm) 

Selects the color 
of the safety 
fence model. 

A safety fence model is created, and collision 
groups and collision pairs are registered. 

 

700/847



13.22  Retrofit Function

HW0485348

2. Selects the direction to place the safety fence around the robot. A safety fence is cre-
ated in the checked direction.

3. Sets the location where the safety fence is to be placed, and the width and the height 
of the safety fence. Sets the distance from the robot position.
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4. Selects the color of the model of the safety fence and clicks the "Safety fence creation 
and interference setting" button. The following models, collision groups, collision pairs 
are created.
        Safety fence model : SafetyFence
        Collision group        : SafetyFenceGroup
        Collision pair           :SafetyFencePair

The collision with the placed safety fence can be checked on the "Job Conversion and 
Analyze" dialog or the "Trajectory difference report" dialog. Please refer to " 13.22.3  
Job Conversion and Analysis " and " 13.22.4  Trajectory Difference Report ".

13.22.3 Job Conversion and Analysis

Jobs are converted from the source controller to the destination controller.
On the [Tool] tab, in the [Retrofit] group, click the [Job conversion and analysis] button, the 
[Job conversion and Analyze] dialog appears.
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Procedure
1. Selects the source robot and the destination robot and sets the job conversion param-

eters.

When "Reflect tool size" is checked, tool data of the conversion source robot is trans-
ferred to the conversion target robot. When the robot layout is different or when the 

Robot selection screen

Source Selects the conversion source robot.

Destination Selects the conversion target robot.

Reflect tool size When enabled, the tool data of the source robot is reflected in the 
destination robot.

Reference 
coordinates

Selects the reference coordinates for job conversion from the follow-
ing three coordinate systems.
    Base coordinates, Robot coordinates, User coordinates
For user coordinates, sets the user frame number to be referenced 
at the conversion source and conversion destination.

Relative job conver-
sion mode

When converting a job, the conversion source jobs are converted to 
a relative job, they are loaded to the conversion destination robot, 
and they are converted to a standard job. Selects the conversion 
operation mode.
    Previous Step Regarded: 

Effective for a job of which the B-axis does not pass the point 
0 degree. (i.e., in the case of an operation performed with the 
B-axis pointed downward.)

    Type Regarded: 
Effective when there is little difference in external shape of the 
robot.

    Previous Step Regarded (Minimum R-axis movement): 
Effective for a job of which the B-axis passes the point 0 
degree.

Next Transits to the job conversion screen.
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robot coordinates are different in position (the offset value of the robot model is differ-
ent), please convert the job based on the user frame. For the offset value of the robot 
model, please refer to " 15.9  List of Manipulator Models and Offset Values Supported 
by MotoSim EG-VRC ". Please set the user frame to the same position on two robots.

After setting, clicks the [Next] button.

 

User frames located at the same position 
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2. Selects the jobs to convert and presses the [Conversion >>] button to convert the jobs. 

Job conversion screen

Select All Selects all jobs of the conversion source robot.

Job list of source robot Displays the list of jobs of the conversion source robot.

Job list of destination 
robot

Displays the list of jobs of the conversion destination robot.

Conversion >> Converts jobs checked in the job list of the source robot to the desti-
nation robot. The selected jobs are converted to a relative job, they 
are loaded to the conversion destination robot, and they are con-
verted to a standard job.

Before Transits to the robot selection screen.

Next Transits to the position / configuration confirmation screen.

 

Job list of source 
robot Job list of  

destination robot 

Log display area 
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After completion, clicks the [Next] button.

3. A list of jobs selected on the job conversion screen is displayed. Please check the 
robot position and configuration at each step.

Position / configuration confirmation screen

Tolerance of angular 
difference

Sets the allowable reference value for detecting the abnormal transi-
tion of the angle between steps.

 

Job list 
Job content list 

Log display area 
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• When the angular difference between steps exceeds the angle specified in " Tolerance 
of angular difference" as a result of job conversion, the job name and the relevant part 
are displayed in red as follows.

• The name of the job that does not contain the move instruction is grayed out.

• When selecting a step row, the robot moves to the corresponding step position.

If there is no problem, clicks the [next] button.

Job list Displays the list of jobs to be converted.

Job content list Displays the content of the job registered in the conversion destina-
tion robot. When selecting a step row, the robot moves to the corre-
sponding step position.

Before Step
Next Step

Searches forward or backward steps from the current selection line 
and move the cursor to that step. The robot moves to the corre-
sponding step position.

Before Transits to the job conversion screen.

Next Transits to the trajectory information collection screen.

Position / configuration confirmation screen

 

 

Both the source robot and destination robot 
move to the teaching position of the selected 
movement command. 
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4. Analyzes the trajectory of the job. Selects the job from the job displayed in the job list 
and clicks [Start] button. Playback of the selected job and collection of trajectory infor-
mation are started.

Trajectory information collection screen.

Job list Displays the list of jobs to be converted.

Check collision When enabled, at the start of verification, the collision detection dia-
log is displayed and the collision check function with "Safety Fence 
Pair" is activate. When collision with "Safety Fence" model occurs 
during trajectory verification, it will be recorded in the log.
In the trajectory verification, collision check for models other than 
"Safety Fence" can also be performed. However, check OFF the 
"Playback stop by collision detection" in the collision definition dia-
log.

Ignore CALL JOB/
UMP

When enabled, the CALL instruction and JUMP instruction 
described in the job are ignored.

Ignore WAIT When enabled, the WAIT instruction described in the job is ignored.

Ignore PAUSE When enabled, the PAUSE instruction described in the job is 
ignored.

Difference tolerance 
range

Sets the allowable range value. This value is used for the distance 
difference tolerance range check that is performed after the log col-
lection of the job is completed.

Start Starts collecting trajectory information for the jobs checked from the 
job list.

Before Transits to the position / configuration confirmation screen.

 

Job list 

Lob display area 
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• When clicks [Start] button with [Check collision] enabled, trajectory analysis is per-
formed while checking collision. When collision occurs, "NG" is displayed in the Colli-
sion column of the job list.

• The name of the job that does not contain the move instruction is grayed out. That can-
not be checked.

When the trajectory analysis is completed, the following dialog is displayed. When 
clicks the [Yes] button, the trajectory difference report dialog is displayed. When clicks 
the [No] button, that dialog is not be displayed.

13.22.4 Trajectory Difference Report

The trajectory difference report dialog displays the results analyzed on the job conversion and 
analysis dialog. In addition, Jobs of the destination robot can be modified. On the [Tools] tab, 
in the [Retrofit] group, click the [Difference report] button, the [Trajectory difference report] dia-
log appears.

When the job contains a CALL, JUMP, WAIT, or PAUSE instruction, it cannot be analyzed 
correctly. Normally set each "*** Ignore" checkbox to be enabled and start verification.

NOTE
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Procedure
1. Selects a job from the job list and display the difference information. On the Report tab, 

the contents of the selected job are listed. 
2. On the Report tab, the contents of the selected job are listed. For each step, the differ-

ence in distance between the transit point of the source robot and the transit point of 
the destination robot is displayed.

Trajectory difference report dialog - Report tab

Sync display When enabled, when the step line of the job is selected, the position 
of the robot is displayed synchronously.

Check collision When enabled, at the start of reanalysis, the collision detection dia-
log is displayed and the collision check function with "Safety Fence 
Pair" is activate. When collision with "Safety Fence" model occurs 
during reanalysis, it will be recorded in the log and collision occur-
rence step lines in the report list are displayed in yellow.
In the trajectory verification, collision check for models other than 
"Safety Fence" can also be performed. However, check OFF the 
"Playback stop by collision detection" in the collision definition dia-
log.

Difference tolerance 
range

Sets the effective range of the distance tolerance between the tran-
sit point of the source robot and the transit point of the destination 
robot. For steps with a distance difference outside this range, the let-
ters on the report screen are displayed in red. However, even if the 
distance difference is outside the range, it will not be out of range 
when it is close to the route point.

 

Job list 

Report list 
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Disp original trace 
model

The trajectory information collected at the time of trajectory analysis 
is displayed superimposed on the trace line of the modified trajec-
tory.

Job list Displays a list of jobs with trajectory information.

Tolerance check Checks whether the distance difference is within the effective range 
from the trajectory information of the job displayed in the job list and 
displays the result on the job list in the list.

Report list The contents of the job selected in the job list are displayed.
For step rows, the following difference information on each distance 
is displayed.
    dL : Distance difference of point
        + value: The path point of the destination robot is farther 
                      from the teaching point than the source robot
        - value : The path point of the destination robot is closer 
                      to the teaching point than the source robot
    dX : X coordinate difference of point
    dY : Y coordinate difference of point
    dZ : Z coordinate difference of point
    dT : Arrival time difference
If dT is a negative value, it means that it has arrived earlier.
The step row whose dL value exceeds the "Difference tolerance 
range" is displayed in red.

Sync teaching point When enabled, the robot moves to the position of the teaching point 
of the step selected in the report list.

Sync trace path point When enabled, the robot moves to the position of the route point of 
the step selected in the report list.

Trajectory difference report dialog - Report tab

 

Source 

After 

Before 
modification 
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• When clicks [Reanalysis] button with [Check collision] enabled, trajectory analysis is 
performed again while checking collision. When collision with "Safety Fence" model 
occurs, "NG" is displayed in the Collision column of the job list and collision occurrence 
step lines in the report list are displayed in yellow.

Display of original data 
difference

When enabled, the distance difference information of the trajectory 
information before modification is displayed. As shown below, the 
difference information before the job modification and the difference 
information after the job modification are displayed for each step.

Reanalysis For the job for which the difference report is displayed, start play-
back again and collect the trajectory information.

Delete log information Deletes the trajectory information of the jobs checked in the job list. 
That jobs are also deleted from the job list.

Approval the path on 
the teaching point side

When the trajectory is closer to the teaching point than the route 
point of the source robot, it is not target to correction.
When checking OFF, all teach points are corrected so that they fall 
within the effective range of the route difference. 

When clicks [Reanalysis] button with [Check collision] enabled, please disable the "Play-
back stop by collision detection" function on the Collision Definition Dialog.
For details, please refer to section " 8.11  Collision Detection ".

Trajectory difference report dialog - Report tab

 

The difference information 
after the job modification 

The difference information before 
the job modification 

NOTE
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• The movement instruction, speed tag, and PL tag can be edited on the report list. Dou-
ble-click the step to edit with the mouse. When clicks [Reanalysis] button after comple-
tion of editing, trajectory information is collected and verified with the contents of the 
edited job.

3. On the graphic screen, checks the difference state of the trajectory path point. When 
the step row of the report list is selected in a state whether either "Sync teaching point" 
or "Sync trace path point" is checked, the source robot and destination robot move to 
the target step position.

 

Double-click 
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• When "Sync teaching point" is checked

• When "Sync trace path point" is checked

When uncheck the "Sync display" checkbox beside the source robot name and destination 
robot name, even if select a step line from the report list, the robots do not move to the 
position of the teaching point of the step selected in the report list.

 

TCP frame is displayed at 
teach point 

 

TCP frame is displayed at the 
route point of each robot 

SUPPLE
-MENT
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4. Jobs with steps outside the effective range can be modified. Modify the job in the Job 
correction tab.

Trajectory difference report dialog - Job correction tab

Teaching point Modifies the teaching points from the difference information 
between the route point of the source robot and the destination 
robot to reduce the difference of the route points as follows. Please 
set the maximum correction amount as necessary. This amount is 
the upper limit of correction amount.

Corrected distances are as follows.
• When the distance difference is within the maximum correction 

amount, the teaching point is moved by the distance difference.
• When the distance difference exceeds the maximum correction 

amount, the teaching point is moved by the maximum correction 
amount.

PL Sets the PL (positioning level) tag for the movement instruction to 
reduce the difference of the path points. The PL number specified 
by the start PL number is set. For PL setting, PL=0?PL=8 can be 
specified.

Original teaching point 

Route point of the 
source robot 

Route point of the source robot 

Modified teaching point 
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Speed Reduces the speed and reduce the difference of the route points.
Subtract the value of V or VJ at each step by the amount of modifi-
cation specified for subtraction value.

Continuous trial mode When enabled, modification and trajectory verification are repeated 
until the following conditions are satisfied for the selected modifica-
tion method.

• Teaching point
In all steps to be corrected, it is modified until the accumulated 
amount of the modified distance reaches the maximum correction 
amount.

• PL
In all steps to be corrected, it is modified until PL=0 is set.

• Speed
In all steps to be corrected, It is modified until it cannot be sub-
tracted by the subtraction value.

When multiple modification method is enabled, the next modification 
method is executed if it is judged that the above conditions are not 
satisfied by the currently method. Priority order of modification 
method is order of teach point, PL, speed.

When disabled, according to the priority order of the modification 
method, one of the modification methods is executed once. When 
all of them are selected and the continuous trial mode is unchecked, 
only the teaching point modification is executed.
When implement PL only, turn off the checkpoint of teaching point or 
turn ON only PL and turn continuous trip mode off.
To modify the PL only, uncheck the teaching point or check only the 
PL and uncheck the continuous trial mode.

Maintaining correction 
state

This setting is effective only when continuous trial mode is enabled.
When enabled, even if the modification method is switched, modifi-
cation is executed based on the job at that time.
When disabled, the job is returned to the initial state before switch-
ing the modification method, and then next modification is executed.

Job backup Back up the jobs checked in the job list to an arbitrary folder.

Job restore For jobs checked in the job list, returns to the job file saved in an 
arbitrary folder.

Start For jobs checked in the job list, starts correction of the job.

Trajectory difference report dialog - Job correction tab
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5. For robots for motor gun applications, gun axis modification can be executed. In the 
gun axis correction, a movement instruction for TCP modification is inserted before and 
after the SVSPOTMOV instruction, and the route point is modified so as to approach 
the trajectory of the source robot. Enters TCP correction amount and clicks [Start] but-
ton.

Trajectory difference report dialog - Gun axis correction tab

TCP correction 
amount

It is used to set the TCP position of the movement instruction 
inserted before and after the SVSPOTMOV instruction. A movement 
instruction is inserted at the position shifted from the position of the 
SVSPOTMOV instruction by the TCP correction amount in the -Z 
direction of the TOOL coordinate system.

Insert instruction Sets the instruction to be inserted before and after the SVSPOT-
MOV instruction. The insert movement instruction can be changed 
from [Edit] button.

Start Starts the gun axis modification process.

Clear gun axis correc-
tion information

Deletes the line of the instruction added by gun axis correction.
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The inserted movement instruction is the movement instruction displayed in the "Insert 
instruction". The teaching point of the movement instruction is the point shifted in the -
Z direction of the TOOL coordinate system.

 When the SVSPOTMOV instruction is contiguous, no movement instruction is added 
between SVSPOTMOV instructions.

Because the movement instruction is additionally inserted, the number of steps does 
not match between the job before correction and the job after correction. Therefore, dif-
ferential display and job correction cannot be executed for jobs with gun axis correc-
tion.To execute difference display or job correction again for jobs with gun axis 
correction, please delete the added movement instruction by clicking the [Clear gun 
axis correction information] button. Because gun axis correction information is deleted, 
please execute gun axis correction again after difference display and job correction.

 

Before correction 

After correction 

Inserted movement 
instruction 

Movement instruction inserted by 
gun axis correction 

TCP correction 
amount 

The trajectory of the 
destination robot 

The trajectory of the 
source robot 

 

Inserted movement 
instruction 
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13.23 Motor Load Estimate

The estimate torque (the unit: The rated torque is displayed as 100%) and speed (the unit: 
rpm) of each axis are displayed after the playback of the robot in a wavy graph.
And, an arbitrary DUTY calculation in the section and the step of the job can be retrieved from 
the wavy graph.

On the [Tool] tab, in the [Estimate] group, click the [Motor Load Estimate] button, the [Motor 
Load Estimate] dialog appears.

• YASKAWA does not warrant the result of this function. It should be used only as a guide. 
Because it is affected by Tool settings, Load condition of real robot, Lubricated condition 
of grease, and Temperature. 
Configure the following items of Tool setting collectly, Weight, Position of the center of 
gravity, and Inertia moment. Especially, when Weight item of Tool setting is set lower 
than real tool weight, this function makes wrong results.

• A wavy graph is an estimated torque when the job is executed. Therefore, the torque in 
the interruption (ex. the emergency stop) is not included.

• The graph display and DUTY calculation of this function can be used only with the robot 
axes. Travel axes and external axes cannot be used. Although it is possible to use it 
even in the job which added traveling axis and external axis to the robot, but robot axes 
are only displayed by the graph and DUTY calculation.

• This function cannot be used with two or more robot system other than a dual-arm robot.
• This function can be used only with the specified system version of controllers, and this 

function can be used only with target robots of Motor Load Estimate with that system 
version. Please refer to section "13.5 List of Function depending on the system version 
of controller".

NOTE
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The vertical scale of left-side is torque, and right-side is speed.

Motor Load Estimate

Item Description

[SpeedGraph] check box The speeds of each axis are displayed.

[GraphSetting] button The display range (horizontal axis and spindle) in a wavy graph and 
the re-drawing intervals and the torque threshold are set.

[Save] button The torque data every drawing time set with HartBeat is saved in text 
file (.TXT). Please refer to “7.5.4  Refresh Interval”.

[Close] button The Torque Estimate display is closed.

 
 

 

 

Select the robot that displays 
the torque estimate. 

Torque estimate 
display area. 

Search the step 
of the job. 

Select the axis that displays the 
torque estimate. 
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Procedure
1. On the [Tool] tab, in the [Estimate] group, click the [Motor Load Estimate] button, the 

[Motor Load Estimate] dialog appears.

2. Select the robot that displays the torque estimate.
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3. The job is executed, and the torque estimate of the selected robot is displayed.

4. Select the axis that displays the torque estimate in the check box of the axis. (The axis 
can be selected even before the job is executed.)
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5. Check the [SpeedGraph] box, the graphs of each axis speed are displayed with a dot-
ted line.

 Duty calculation
1. Check the [DUTY Calc] check box.
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2. Pick the measurement beginning point.

3. Pick the measurement end point.

 

Pick the measurement 
beginning point. 

 

Pick the measurement 
end point. 
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4. The measurement result is displayed.

 Step Search
1. Check the [STEP Search] box.

2. Pick the point where it wants to search the step.

 

 

 

Pick the point where it 
wants to search the step. 
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3. The step number is displayed, and robot moves to the searched position.
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 Torque Threshold Setting
To set the torque threshold, the threshold is displayed on the graph. It can be checked 
whether the presumed torque of each axis is over the threshold value during the playback has 
been exceeded.

1. Click the [GraphSetting] button, and enter the value of [Torque Threshold] in the dialog.

2. The Threshold value is displayed in the graph area with a dotted red line.

3. After the playback of a job, if the presumed torque exceeded the threshold value, the 
dialog will be displayed as follows.

 

 

Torque Threshold 
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 Graph Setting
The display range (horizontal axis and spindle) in the torque estimate display area (wavy 
graph) and the re-drawing intervals are set.

Graph Setting

Item Description

Side Maximum value (ms) of a horizontal axis in a wavy graph and the 
number of scales are set.

Length(Torque)
Maximum value (%) of the spindle in a torque wavy graph and the 
number of scales are set. The number of scale is as common as 
Length(Speed).

Length(Speed)
Maximum value (rpm) of the spindle in a speed wavy graph and the 
number of scales are set. As for the number of scales, a setup of 
Length(Torque) is reflected.

Refresh interval (1-20) The interval of the re-drawing time of a wavy graph is set.

Torque Threshold(%) The threshold of torque is set.

[OK] button A set value of each item is reflected. (The Graph Setting doesn't 
close. )

[Close] button The Graph Setting is close.
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  Target robots for Moter Load Estimate
YRC1000

Model Name Robot Type Remarks

AR700 1-06VX8-A00 Added at Ver2018
AR900 1-06VX7-A00 Added at Ver2018
AR1440 1-06VXH12-A00 Added at Ver2018
AR1440E 1-07VXHE6-A00 Added at Ver2020SP1
AR1730 1-06VXH25-A01 Added at Ver2018
AR2010 1-06VXH25-A11 Added at Ver2018
AR3120 1-06VXHL20-A00 Added at Ver2020SP1
GP4 1-06VX4-A00 Added at Ver2021
GP7 1-06VX7-A00 Added at Ver2018
GP8 1-06VX8-A00 Added at Ver2018
GP12 1-06VXH12-A00 Added at Ver2018
GP12 1-06VXH12-C00 Added at Ver2020SP1
GP20HL 1-06VXHL20-A00 Added at Ver2020SP1
GP25 1-06VXH25-A00 Added at Ver2018
GP25 1-06VXH25-A50 Added at Ver2020SP1
GP25 1-06VXH25-C00 Added at Ver2020SP1
GP25 1-06VXH25-F40 Added at Ver2020SP1
GP25-12 1-06VXH25-A10 Added at Ver2018
GP25-12 1-06VXH25-C10 Added at Ver2021
GP35L 1-06VXL35-A00 Added at Ver2018
GP50 1-06VX50-A00 Added at Ver2018
GP88 1-06VX88-A00 Added at Ver2018
GP88 1-06VX88-C00 Added at Ver2021
GP110 1-06VX110-A00 Added at Ver2018
GP110 1-06VX110-C00 Added at Ver2021
GP110B 1-07VXB110-A00 Added at Ver2018
GP110H 1-06VXH110-A00 Added at Ver2020SP1
GP165R 1-06VR165-A00 Added at Ver2018
GP180 1-06VX180-A00 Added at Ver2018
GP180 1-06VX180-C00 Added at Ver2021
GP180-120 1-06VX180-120-A00 Added at Ver2018
GP180-120 1-06VX180-120-C00 Added at Ver2021
GP180H 1-06VXH180-A00 Added at Ver2020SP1
GP200R 1-06VR200-A00 Added at Ver2018
GP200S 1-06VXH200-A00 Added at Ver2020SP1
GP215 1-06VX215-A00 Added at Ver2018
GP215 1-06VX215-C00 Added at Ver2021
GP225 1-06VX225-A00 Added at Ver2018
GP225 1-06VX225-C00 Added at Ver2021
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GP225H 1-06VXH225-A00 Added at Ver2020SP1
GP250 1-06VX250-A00 Added at Ver2018
GP250 1-06VX250-C00 Added at Ver2021
GP280 1-06VX280-A00 Added at Ver2018
GP300R 1-06VR300-A00 Added at Ver2020SP1
GP400 1-06VX400-A00 Added at Ver2018
GP400R 1-06VR400-A00 Added at Ver2018
GP400R 1-06VR400-A10 Added at Ver2020SP1
GP600 1-06VX600-A00 Added at Ver2018
HC10 1-06VXHC10-A00 Added at Ver2018
HC10DT 1-06VXHC10-A10 Added at Ver2018
HC10DT
Dust-Proof/Drip-
Proof 

1-06VXHC10-B10 Added at Ver2021

HC10DTF YR-1-06VXHC10-F10 Added at Ver2021
HC20DT 
Dust-Proof/Drip-
Proof

YR-1-06VXHC20-B10 Added at Ver2021

PH130F 1-06VXF130-A00 Added at Ver2020SP1
PH130RF 1-06VRF130-A00 Added at Ver2018
PH200R 1-06-VRY200-J00 Added at Ver2020SP1
PH200R 1-06-VRY200-K00 Added at Ver2020SP1
PH200R 1-06-VRY200-L00 Added at Ver2020SP1
PH200RF 1-06-VRF200-J00 Added at Ver2020SP1
PH200RF 1-06-VRF200-J10 Added at Ver2020SP1
PH200RF 1-06-VRF200-K00 Added at Ver2020SP1
PH200RF 1-06-VRF200-K10 Added at Ver2020SP1
PH200RF 1-06-VRF200-L00 Added at Ver2020SP1
PH200RF 1-06-VRF200-L10 Added at Ver2020SP1
PL190 1-04-LXH190-A00 Added at Ver2021
PL320 1-04-LXH320-A00 Added at Ver2021
PL500 1-04-LXH500-A00 Added at Ver2020SP1
PL800 1-04-LXH800-A00 Added at Ver2021
SP80 1-06VX88-A00 Added at Ver2018
SP100 1-06VX110-A00 Added at Ver2018
SP100B 1-07VXB110-A00 Added at Ver2018
SP110H 1-06VXH110-A00 Added at Ver2020SP1
SP130 1-06VX140-A00 Added at Ver2020SP1
SP150R 1-06VR165-A00 Added at Ver2018
SP165 1-06VX180-A00 Added at Ver2018
SP165-105 1-06VX180-120-A00 Added at Ver2018
SP180H 1-06VXH180-A00 Added at Ver2020SP1
SP180H-110 1-06VXH180-A10 Added at Ver2020SP1

Model Name Robot Type Remarks
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YRC1000micro

DX200

SP185R 1-06VR200-A00 Added at Ver2018
SP210 1-06VX225-A00 Added at Ver2018
SP225H 1-06VXH225-A00 Added at Ver2020SP1
SP225H-135 1-06VXH225-A10 Added at Ver2020SP1
SP235 1-06VX250-A00 Added at Ver2018

Model Name Robot Type Remarks

GP4 1-06VX4-A00 Added at Ver2021
GP7 1-06VX7-A00 Added at Ver2018
GP8 1-06VX8-A00 Added at Ver2018
GP12 1-06VXH12-A00 Added at Ver2018
HC10DT 1-06VXHC10-A10 Added at Ver2018
HC10DT
Dust-Proof/Drip-
Proof

1-06VXHC10-B10 Added at Ver2021

HC10DT 
Hand-Carry

1-06VXHC10-C11 Added at Ver2021

HC10DTF YR-1-06VXHC10-F10 Added at Ver2021
HC20DT
Dust-Proof/Drip-
Proof 

YR-1-06VXHC20-B10 Added at Ver2021

MotoMINI 1-06VX05-A00 Added at Ver2018
SG400 1-04SX400-A00 Added at Ver2020SP1
SG650 1-04SX650-A00 Added at Ver2020SP1

Model Name Robot Type Remarks

ES200RDII ES200RD-J00 Added at Ver2018SP1
MA1440 MA01440-A00 Added at Ver2019
MA2010 MA02010-A00 Added at Ver2018SP1
MH5LSII MH005LS-J00 Added at Ver2019
MH24 MH00024-A00 Added at Ver2017SP1
MH24-10 MH00024-A10 Added at Ver2018SP1
MH50II-20 MH00050-J10 Added at Ver2018SP1
MH80II MH00080-J00 Added at Ver2018SP1
MH110 MH110-A00 Added at Ver2018SP1
MH180 MH180-A00 Added at Ver2015
MH225 MH225-A00 Added at Ver5.10
MH250II MH00250-J00 Added at Ver2016SP1
MH280II H00280-J00 Added at Ver2018SP1
MH400II MH00400-J00 Added at Ver2018SP1

Model Name Robot Type Remarks
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MH600 MH00600-A00 Added at Ver2018SP1
MHP45L MHP045L-A00 Added at Ver2020
MHP45L MHP045L-B00 Added at Ver2020
MPL160II MPL0160-J00 Added at Ver2019
MPL800II MPL0800-J00 Added at Ver2018SP1
MPX1150 MPX1150-A00 Added at Ver2017
MPX1150 MPX1150-C00 Added at Ver2017
MPX3500 MPX3500-A00 Added at Ver2016SP3
MPX3500 MPX3500-A00_WALL Added at Ver2016SP3
MPX3500 MPX3500-A10 Added at Ver2016SP3
MPX3500 MPX3500-A10_WALL Added at Ver2016SP3
MPX3500 MPX3500-B00 Added at Ver2016SP3
MPX3500 MPX3500-B00_WALL Added at Ver2016SP3
MPX3500 MPX3500-B10 Added at Ver2016SP3
MPX3500 MPX3500-B10_WALL Added at Ver2016SP3
MPX3500 MPX3500-C00 Added at Ver2016SP3
MPX3500 MPX3500-C00_WALL Added at Ver2016SP3
MPX3500 MPX3500-C10 Added at Ver2016SP3
MPX3500 MPX3500-C10_WALL Added at Ver2016SP3
MPX3500 MPX3500-F00 Added at Ver2016SP3
MPX3500 MPX3500-F00_WALL Added at Ver2016SP3
MPX3500 MPX3500-F10 Added at Ver2016SP3
MPX3500 MPX3500-F10_WALL Added at Ver2016SP3
MS80WII MS0080W-J00 Added at Ver2019
MS100 MS100-A00 Added at Ver2018SP1
MS165 MS165-A00 Added at Ver2015
MS210 MS210-A00 Added at Ver5.10
UP400RD UP400RD-J00 Added at Ver2018SP1
UP400RD UP400RD-J10 Added at Ver2018SP1
VS100 VS00100-A00 Added at Ver2015SP3

Model Name Robot Type Remarks
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DX100

FS100

Model Name Robot Type Remarks

EP4000D EP4000D-J72 Added at Ver2.80
EP4000D EP4000D-K72 Added at Ver2.80
EP4000D EP4000D-L72 Added at Ver2.80
EPH130D EPH130D-A00 Added at Ver2.80
EPH130RLD PH13RLD-A00 Added at Ver2.80
EPH4000D EPH400D-JA0 Added at Ver2.80
EPH4000D EPH400D-KA0 Added at Ver2.80
EPH4000D EPH400D-LA0 Added at Ver2.80
ES165D ES0165D-A00 Added at Ver2.60
ES200D ES0200D-A00 Added at Ver2.72
HP20D HP0020D-A00 Added at Ver2.81
MH5LS MH005LS-A00 Added at Ver2.80
MH5S MH0005S-A00 Added at Ver5.00
MH50 MH00050-A00 Added at Ver5.00
MH80 MH0080-A00 Added at Ver5.00
MH165 MH00165-A00 Added at Ver2.72
MH200 MH00200-A00 Added at Ver2.80
MH215 MH00215-A00 Added at Ver2.80
MH250 MH00250-A00 Added at Ver2.80
MH250 MH00250-B00 Added at Ver2.80
MPK2 MPK0002-B01 Added at Ver2.60
SDA5D SDA005D-A00 Added at Ver4.00
SDA10D SDA010D-A00 Added at Ver2.80
SDA10D SDA010D-B00 Added at Ver2.80
SDA20D SDA020D-A00 Added at Ver2.81
SIA5D SIA005D-A00 Added at Ver4.00
SIA10D SIA010D-A00 Added at Ver2.81
SIA20D SIA020D-A00 Added at Ver2.60
SIA20D SIA020D-Y00 Added at Ver2.81

Model Name Robot Type Remarks

MHJ MH0000J-A00 Added at Ver2.80
MH3F MH0003F-A00 Added at Ver2.72
MH5F MH0005F-A00 Added at Ver2.60
MH5LF MH005LF-A00 Added at Ver2.80
MH12 MH12-A00 Added at Ver2019
MPK2F MPK002F-A00 Added at Ver2.60
MPP3 MPP0003-A00 Added at Ver2.60
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MPP3S MPP003S-A00 Added at Ver4.10
SDA5F SDA005F-A00 Added at Ver4.00
SDA10F SDA010F-A00 Added at Ver2.80
SIA5F SIA005F-A00 Added at Ver4.00
SIA10F SIA010F-A00 Added at Ver2.81
SIA20F SIA020F-A00 Added at Ver2.60

Model Name Robot Type Remarks
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13.24Life Estimate

Life estimate value of each reducer (Unit: Hour) is displayed when playback is executed.

• YASKAWA does not warrant the result of this function. It should be used only as a guide. 
Because it is affected by Tool settings, Load condition of real robot, Lubricated condition 
of grease, and Temperature. 
Configure the following items of Tool setting collectly, Weight, Position of the center of 
gravity, and Inertia moment. Especially, when Weight item of Tool setting is set lower 
than real tool weight, this function makes wrong results.

• This function estimates the life of reducers from the normal result of playback. There-
fore, the result of playback with interruption (ex. the emergency stop) is not included.

• This function can be used only with the robot axes. (external axes are not included.)
• This function cannot be used with two or more robot system other than a dual-arm robot.
• This function can be used only with the specified system version of controllers, and this 

function can be used only with target robots of Life Estimate with that system version. 
Please refer to section "13.5 List of Function depending on the system version of con-
troller".

Life Estimate

Item Description

[Save CSV] button The result of Life Estimate, the used torque data, the used gravity 
moment, and the used speed data are saved in text file (.csv).

NOTE

 
 

 

 

Select the robot that displays the 
life estimate. 
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Procedure
1. On the [Tool] tab, in the [Estimate] group, click the [Life Estimate] button, the [Life Esti-

mate] dialog appears.

2. Select the robot estimated the reducer life.

3. The job is executed, and Average speed[rpm], Maximum speed[rpm], Average 
torque[Nm], Maximum torque[Nm], and Speed Reducer Life[Hr] are displayed.

[Clipboard] button The result of Life Estimate, the used torque data, the used gravity 
moment, and the used speed data are copied to the clipboard.

[Close] button The Life Estimate display is closed.

Reducer life time calculated by this function is that when the robot repeats this movement 
with this cycletime. The displaying areas exist for 7 axes, but the displaying areas of the 
Speed Reducer Life are displayed "0", when the axes are not working, the axes do not 
exist, or the axes are not included in Life Estimate.
If the robot has overhaul time, the value of Speed Reducer Life is displayed as [xxx  over] 
(xxx is overhaul time), when it exceed overhaul time.

Life Estimate

Item Description

NOTE
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 Axis is not working. Axes do not exist. Axes are not included 
in Life Estimate. 
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  Target robots of Life Estimate
YRC1000

Model Name Robot Type Remarks

AR700 1-06VX8-A00 Added at Ver2018
AR900 1-06VX7-A00 Added at Ver2018
AR1440 1-06VXH12-A00 Added at Ver2018
AR1440E 1-07VXHE6-A00 Added at Ver2020SP1
AR1730 1-06VXH25-A01 Added at Ver2018
AR2010 1-06VXH25-A11 Added at Ver2018
AR3120 1-06VXHL20-A00 Added at Ver2020SP1
GP4 1-06VX4-A00 Added at Ver2021
GP7 1-06VX7-A00 Added at Ver2018
GP8 1-06VX8-A00 Added at Ver2018
GP12 1-06VXH12-A00 Added at Ver2018
GP12 1-06VXH12-C00 Added at Ver2020SP1
GP20HL 1-06VXHL20-A00 Added at Ver2020SP1
GP25 1-06VXH25-A00 Added at Ver2018
GP25 1-06VXH25-A50 Added at Ver2020SP1
GP25 1-06VXH25-C00 Added at Ver2020SP1
GP25 1-06VXH25-F40 Added at Ver2020SP1
GP25-12 1-06VXH25-A10 Added at Ver2018
GP25-12 1-06VXH25-C10 Added at Ver2021
GP35L 1-06VXL35-A00 Added at Ver2018
GP50 1-06VX50-A00 Added at Ver2018
GP88 1-06VX88-A00 Added at Ver2018
GP88 1-06VX88-C00 Added at Ver2021
GP110 1-06VX110-A00 Added at Ver2018
GP110 1-06VX110-C00 Added at Ver2021
GP110B 1-07VXB110-A00 Added at Ver2018
GP110H 1-06VXH110-A00 Added at Ver2020SP1
GP165R 1-06VR165-A00 Added at Ver2018
GP180 1-06VX180-A00 Added at Ver2018
GP180 1-06VX180-C00 Added at Ver2021
GP180-120 1-06VX180-120-A00 Added at Ver2018
GP180-120 1-06VX180-120-C00 Added at Ver2021
GP180H 1-06VXH180-A00 Added at Ver2020SP1
GP200R 1-06VR200-A00 Added at Ver2018
GP200S 1-06VXH200-A00 Added at Ver2020SP1
GP215 1-06VX215-A00 Added at Ver2018
GP215 1-06VX215-C00 Added at Ver2021
GP225 1-06VX225-A00 Added at Ver2018
GP225 1-06VX225-C00 Added at Ver2021
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GP225H 1-06VXH225-A00 Added at Ver2020SP1
GP250 1-06VX250-A00 Added at Ver2018
GP250 1-06VX250-C00 Added at Ver2021
GP280 1-06VX280-A00 Added at Ver2018
GP300R 1-06VR300-A00 Added at Ver2020SP1
GP400 1-06VX400-A00 Added at Ver2018
GP400R 1-06VR400-A00 Added at Ver2018
GP400R 1-06VR400-A10 Added at Ver2020SP1
GP600 1-06VX600-A00 Added at Ver2018
HC10 1-06VXHC10-A00 Added at Ver2018
HC10DT 1-06VXHC10-A10 Added at Ver2018
HC10DT
Dust-Proof/Drip-
Proof 

1-06VXHC10-B10 Added at Ver2021

HC10DTF YR-1-06VXHC10-F10 Added at Ver2021
HC20DT 
Dust-Proof/Drip-
Proof

YR-1-06VXHC20-B10 Added at Ver2021

PH130F 1-06VXF130-A00 Added at Ver2020SP1
PH130RF 1-06VRF130-A00 Added at Ver2018
PH200R 1-06-VRY200-J00 Added at Ver2020SP1
PH200R 1-06-VRY200-K00 Added at Ver2020SP1
PH200R 1-06-VRY200-L00 Added at Ver2020SP1
PH200RF 1-06-VRF200-J00 Added at Ver2020SP1
PH200RF 1-06-VRF200-J10 Added at Ver2020SP1
PH200RF 1-06-VRF200-K00 Added at Ver2020SP1
PH200RF 1-06-VRF200-K10 Added at Ver2020SP1
PH200RF 1-06-VRF200-L00 Added at Ver2020SP1
PH200RF 1-06-VRF200-L10 Added at Ver2020SP1
PL190 1-04-LXH190-A00 Added at Ver2021
PL320 1-04-LXH320-A00 Added at Ver2021
PL500 1-04-LXH500-A00 Added at Ver2020SP1
PL800 1-04-LXH800-A00 Added at Ver2021
SP80 1-06VX88-A00 Added at Ver2018
SP100 1-06VX110-A00 Added at Ver2018
SP100B 1-07VXB110-A00 Added at Ver2018
SP110H 1-06VXH110-A00 Added at Ver2020SP1
SP130 1-06VX140-A00 Added at Ver2020SP1
SP150R 1-06VR165-A00 Added at Ver2018
SP165 1-06VX180-A00 Added at Ver2018
SP165-105 1-06VX180-120-A00 Added at Ver2018
SP180H 1-06VXH180-A00 Added at Ver2020SP1
SP180H-110 1-06VXH180-A10 Added at Ver2020SP1

Model Name Robot Type Remarks
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YRC1000micro

SP185R 1-06VR200-A00 Added at Ver2018
SP210 1-06VX225-A00 Added at Ver2018
SP225H 1-06VXH225-A00 Added at Ver2020SP1
SP225H-135 1-06VXH225-A10 Added at Ver2020SP1
SP235 1-06VX250-A00 Added at Ver2018

Model Name Robot Type Remarks

GP4 1-06VX4-A00 Added at Ver2021
GP7 1-06VX7-A00 Added at Ver2018
GP8 1-06VX8-A00 Added at Ver2018
GP12 1-06VXH12-A00 Added at Ver2018
HC10DT 1-06VXHC10-A10 Added at Ver2018
HC10DT
Dust-Proof/Drip-
Proof

1-06VXHC10-B10 Added at Ver2021

HC10DT 
Hand-Carry

1-06VXHC10-C11 Added at Ver2021

HC10DTF YR-1-06VXHC10-F10 Added at Ver2021
HC20DT
Dust-Proof/Drip-
Proof 

YR-1-06VXHC20-B10 Added at Ver2021

MotoMINI 1-06VX05-A00 Added at Ver2018
SG400 1-04SX400-A00 Added at Ver2020SP1
SG650 1-04SX650-A00 Added at Ver2020SP1

Model Name Robot Type Remarks
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DX200

Model Name Robot Type Remarks

ES200RDII ES200RD-J00 Added at Ver2018SP1
MA1440 MA01440-A00 Added at Ver2019
MA2010 MA02010-A00 Added at Ver2018SP1
MH5LSII MH005LS-J00 Added at Ver2019
MH24 MH00024-A00 Added at Ver2017SP1
MH24-10 MH00024-A10 Added at Ver2018SP1
MH50II-20 MH00050-J10 Added at Ver2018SP1
MH80II MH00080-J00 Added at Ver2018SP1
MH110 MH110-A00 Added at Ver2018SP1
MH180 MH180-A00 Added at Ver2015
MH225 MH225-A00 Added at Ver5.10
MH250II MH00250-J00 Added at Ver2016SP1
MH280II H00280-J00 Added at Ver2018SP1
MH400II MH00400-J00 Added at Ver2018SP1
MH600 MH00600-A00 Added at Ver2018SP1
MHP45L MHP045L-A00 Added at Ver2020
MHP45L MHP045L-B00 Added at Ver2020
MPL160II MPL0160-J00 Added at Ver2019
MPL800II MPL0800-J00 Added at Ver2018SP1
MPX1150 MPX1150-A00 Added at Ver2017
MPX1150 MPX1150-C00 Added at Ver2017
MPX3500 MPX3500-A00 Added at Ver2016SP3
MPX3500 MPX3500-A00_WALL Added at Ver2016SP3
MPX3500 MPX3500-A10 Added at Ver2016SP3
MPX3500 MPX3500-A10_WALL Added at Ver2016SP3
MPX3500 MPX3500-B00 Added at Ver2016SP3
MPX3500 MPX3500-B00_WALL Added at Ver2016SP3
MPX3500 MPX3500-B10 Added at Ver2016SP3
MPX3500 MPX3500-B10_WALL Added at Ver2016SP3
MPX3500 MPX3500-C00 Added at Ver2016SP3
MPX3500 MPX3500-C00_WALL Added at Ver2016SP3
MPX3500 MPX3500-C10 Added at Ver2016SP3
MPX3500 MPX3500-C10_WALL Added at Ver2016SP3
MPX3500 MPX3500-F00 Added at Ver2016SP3
MPX3500 MPX3500-F00_WALL Added at Ver2016SP3
MPX3500 MPX3500-F00 Added at Ver2016SP3
MPX3500 MPX3500-F00_WALL Added at Ver2016SP3
MS80WII MS0080W-J00 Added at Ver2019
MS100 MS100-A00 Added at Ver2018SP1
MS165 MS165-A00 Added at Ver2015
MS210 MS210-A00 Added at Ver5.10
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UP400RD UP400RD-J00 Added at Ver2018SP1
UP400RD UP400RD-J10 Added at Ver2018SP1
VS100 VS00100-A00 Added at Ver2015SP3

Model Name Robot Type Remarks
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DX100

FS100

Model Name Robot Type Remarks

EP4000D EP4000D-J72 Added at Ver2.80
EP4000D EP4000D-K72 Added at Ver2.80
EP4000D EP4000D-L72 Added at Ver2.80
EPH130D EPH130D-A00 Added at Ver2.80
EPH130RLD PH13RLD-A00 Added at Ver2.80
EPH4000D EPH400D-JA0 Added at Ver2.80
EPH4000D EPH400D-KA0 Added at Ver2.80
EPH4000D EPH400D-LA0 Added at Ver2.80
ES165D ES0165D-A00 Added at Ver2.60
ES200D ES0200D-A00 Added at Ver2.72
HP20D HP0020D-A00 Added at Ver2.81
MH5LS MH005LS-A00 Added at Ver2.80
MH5S MH0005S-A00 Added at Ver5.00
MH50 MH00050-A00 Added at Ver5.00
MH80 MH0080-A00 Added at Ver5.00
MH165 MH00165-A00 Added at Ver2.72
MH200 MH00200-A00 Added at Ver2.80
MH215 MH00215-A00 Added at Ver2.80
MH250 MH00250-A00 Added at Ver2.80
MH250 MH00250-B00 Added at Ver2.80
SDA5D SDA005D-A00 Added at Ver4.00
SDA10D SDA010D-A00 Added at Ver2.80
SDA10D SDA010D-B00 Added at Ver2.80
SDA20D SDA020D-A00 Added at Ver2.81
SIA5D SIA005D-A00 Added at Ver4.00
SIA10D SIA010D-A00 Added at Ver2.81
SIA20D SIA020D-A00 Added at Ver2.60
SIA20D SIA020D-Y00 Added at Ver2.81

Model Name Robot Type Remarks

MHJ MH0000J-A00 Added at Ver2.80
MH3F MH0003F-A00 Added at Ver2.72
MH5F MH0005F-A00 Added at Ver2.60
MH5LF MH005LF-A00 Added at Ver2.80
MH12 MH12-A00 Added at Ver2019
MPK2F MPK002F-A00 Added at Ver2.60
MPP3 MPP0003-A00 Added at Ver2.60
MPP3S MPP003S-A00 Added at Ver4.10
SDA5F SDA005F-A00 Added at Ver4.00
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13.25Collaborative Mode

Singularity Limit and Speed Limit are enabled when collaborative mode is enabled with collab-
orative robot (MOTOMAN-HC Series).
Same as release condition of real robot controller, MotoSim set collaborative mode to enable 
when new controller with collaborative robot is made. It is possible to enable or disable collab-
orative mode on the button of the ribbon menu.

To enable or disable collaborative mode, on the [Controller] tab, in the [Robot] group, click the 
[Collaborative Mode] button and select [Enable Collaborative Mode] or [Disable Collaborative 
Mode].

SDA10F SDA010F-A00 Added at Ver2.80
SIA5F SIA005F-A00 Added at Ver4.00
SIA10F SIA010F-A00 Added at Ver2.81
SIA20F SIA020F-A00 Added at Ver2.60

This function can be used only HC series robot and controller version after YRC1000 
ver.4.21 or YRC1000micro ver.2.44.

Model Name Robot Type Remarks

NOTE
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13.26Remote Laser Function

Setting files of controller, creating a JOB and play back the JOB can be performed on remote 
laser function.

To enable Remote Laser function, on the [Controller] tab, in the [Robot] group, click the 
[Remote Laser] button.

• This function can be used only after YRC1000 version 4.00, and controller application is 
“ARC” or “GENERAL”.

• It is not possible to use conveyor synchronization function at the same time on the same 
controller.

• When controller is created from CMOS or ALL.PRM, click [Remote Laser] after creating 
controller to enable remote laser function.

• Jobs that include remote laser instructions can be played back, but the laser trajectory 
cannot be seen on the MotoSim screen.

NOTE
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14 Troubleshooting

14.1  Start of MotoSim EG-VRC

 Fails in the start of MotoSim EG-VRC
Problem
The following messages are displayed and fail in the start of MotoSim EG-VRC.

• MotoSimEG-VRC.exe – Entry Point Not Found

• MotoSimEG-VRC.exe – System Error

Solution
When MotoSim EG-VRC of multiple versions are installed in your PC, it occurs.
Please uninstall MotoSim EG-VRC of the old version.
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14.2  Creating and Editing a Cell

 MotoSim EG-VRC stops at 3/4 of the start sequence of the cell.
Problem
MotoSim EG-VRC stops at 3/4 of the start sequence of the cell.

Solution
When the CAD models of large size are included in the cell, the reading of the models may 
take time.
Please wait until the cell start.

 Error message “fffffff0” is displayed, and fails in the start of the con-
troller.

Problem
When a cell including a controller started, error message “fffffff0” is displayed and fails in the 
start of the controller.
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Solution
Please check the following.

• After rebooting your PC, please check whether the cell can start.

• Please start Task Manager, and check whether the CPU utilization rate and the memory 
utilization rate do not become nearly 100%.
When it becomes nearly 100%, please close unnecessary application.

• Please check whether the cell folder of MotoSim EG-VRC is not saved in a deep hierar-
chical directory.
When you have been saving the cell folder in a deep hierarchical directory, please move 
the cell folder in another directory.

• Please check whether the cell folder of MotoSim EG-VRC has been saved in a folder with 
access rights.
When there is not access right, please move the cell folder in a folder with access rights.

• Please check whether a sample cell can start.
When you cannot start a sample cell, please install MotoSim EG-VRC after the uninstalla-
tion.

The pass of a cell folder is to up to 259 characters in path name including a folder name.NOTE
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14.3  Controller and Robot Settings

 Virtual programming pendant can not be operated
Problem
Virtual programming pendant can not be operated after creating a controller.

Solution
Please check the following.

•  After rebooting your PC, please check whether you can operate the virtual programming 
pendant.

•  Please check whether the message "Windows Defender Firewall has blocked some fea-
tures of this app " is not displayed when you started a cell.
When "Windows Defender Firewall has blocked some features of this app " is displayed, 
please click on "Allow access".

•  After having invalidated an anti-virus software, and reboot the controller.
Please check whether you can operate the virtual programming pendant.

•  When problem does not solve by the above, please create the controller again.
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 Error message "3220" is displayed and fails in the job file reading.
Problem
Error message “3220” is displayed and fails in the job file reading.

Solution
Error message "3220" means syntax error of a job file.
Please check whether there is not a mistake in the syntax of the job file.

Error message "3220" may occur when a setting of controller is insufficient.
Please create a controller using CMOS.BIN file of the controller that you made the job file.
Please refer to section " 7.1.2  Create VRC Controller (using CMOS.BIN file or ALL.PRM file) " 
about detail procedure of creating a controller using CMOS.BIN file.

14.4 Online Function

 Fails in the Ethernet connection to the real controller
Problem
Fails in the Ethernet connection to the real controller. 
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Solution
Please check the following.
[Real Controller]

• Make sure that the LAN cable is connected.

• Make sure that the IP address is set correctly.

• Select [SYSTEM INFO] – [NETWORK SERVICE] in the main menu of programming pen-
dant and check that the device name on the displayed screen is set to [Ethernet].

• Select [IN/OUT] – [PSEUDO INPUT SIG] in the main menu of programming pendant and 
enable the CMD REMOTE SEL.
The CMD REMOTE SEL is enabled in the following procedures.

1. Change the mode of the real controller to the "TEACH" mode.
2. Click on "INTER LOCK" button and "SELECT" button.

• Make sure that the mode of the real controller becomes the “REMOTE” mode.

[PC]
• Make sure that the LAN cable is connected.

• Make sure that the IP address is set correctly.

• Make sure the IP address setting of the target controller is correct in MotoSim EG-VRC.
Please refer to section " 9.2  Network Function " about detail procedure of setting IP 
address.
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 Error message "9001" is displayed and fails in the communication 
with the real controller.

Problem
Error message "9001" is displayed and fails in the communication with the real controller.

Solution
Error message “9001” means communication error by the receive timeout. 
It occurs when communication setting of PC and the real controller are wrong.

For details, please refer to section “Fails in the ethernet connection with the real controller” of 
troubleshooting.

 Error message “2140” is displayed and fails in the file reading
Problem
Error message “2140” is displayed and fails in the file reading.

Solution
Error message “2140” means the file reading error.

It is necessary to turn off the servo power of the real controller when you read a file such as 
[TOOL.CND] or [VARNAME.DAT].
Please turn off servo power of the real controller.

14.5  Model Editings

 Error message “Floating point overflow” is displayed and fails in 
importing the CAD model.

Problem
Error message "Floating point overflow" is displayed and fails in importing the CAD model.
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Solution
1. Click on application button of MotoSim EG-VRC.

2. Click on [Options] button of contextmenu.

3. Click on [CAD Import / Export] tab of the Option Setting dialog.
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4. Uncheck [Uses External Converter] checkbox and click on [OK] button.
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15 Appendix

15.1  Data Format

This section describes the formats of model data files and cell data files.

 Model File (*.mdl)
There are eight parts available for MotoSim EG as described later in " Each Part Format " of 
this section.
Data unit system is in millimeters (mm) and real numbers are available.  Use decimal point as 
required.

Model Color Settings
The color of each model can be set by using the basic color code function or using RGB.
The following describe each setting.

• RGB
RGB is created with the format RGB (0, 0, 0).
Each color proportion can be set by a number from 0 to 255.

Basic Color Code (QB Color) Function
Setting a number from 0 to 15 displays its corresponding color.
For example, setting BOX (4, 2) creates a red BOX model.

Number Color Number Color
0 Black 8 Gray
1 Blue 9 Light blue
2 Green 10 Light green
3 Cyan 11 Light cyan
4 Red 12 Light red
5 Magenta 13 Light magenta
6 Yellow 14 Light yellow
7 White 15 Light white

RGB (0, 0, 0)
Sets the proportion of blue.
Sets the proportion of green.
Sets the proportion of red.

<E.g.> RGB(255,255,255)
RGB(255,0,0)
RGB(0,255,0)
RGB(0,0,255)
RGB(0,0,0)

Color: White
Color: Red
Color: Green
Color: Blue
Color: Black
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Each Part Format
• BOX (color, num): Box form model

Described with data of width, length, height, X, Y, Z, Rx, Ry and Rz.
<Sample>

• BOX2 (color, num): Box form model
Described with data of width, length, height, X, Y, Z, Rx, Ry and Rz.
<Sample>

• CYLINDER (color, num): Cylinder form model
Described with data of lower face diameter, upper face diameter, height, number of 
divided faces, X, Y, Z, Rx, Ry and Rz.
<Sample>

BLOCK
{
BOX(RGB(255,0,0),2) Description
{
100.000,100.000,100.000,0.000,0.000,0.000 Width, length, height, 0, 0, 0
0.000,0.000,0.000,0.000,0.000,0.000 X, Y, Z, Rx, Ry, Rz
}
}

BLOCK
{
BOX2(RGB(255,0,0),2) Description
{
100.000,100.000,100.000,0.000,0.000,0.000 Width, length, height, 0, 0, 0
0.000,0.000,0.000,0.000,0.000,0.000 X, Y, Z, Rx, Ry, Rz
}
}

BLOCK
{
CYLINDER(RGB(255,0,0),2) Description
{
200.000,100.000,16.000,100.000,0.000,0.000 Lower face dia. height, No. of divided 

faces, upper face dia., 0, 0
0.000,0.000,0.000,0.000,0.000,0.000 X, Y, Z, Rx, Ry, Rz
}
}
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• CONE2 (color, num): Cone form model
Described with data of bottom diameter, height, number of divided faces, X, Y, Z, Rx, Ry 
and Rz.
<Sample>

• SPHERE(color,num): Spherical model
Described with data of diameter, number of divided faces, X, Y and Z.
<Sample>

• PIPE2 (color, num): Pipe form model
Described with data of lower face diameter, bottom plate thickness, upper face diameter, 
upper plate thickness, height, number of divided faces, X, Y, Z, Rx, Ry and Rz.
<Sample>

BLOCK
{
CONE2(RGB(255,0,0),2) Description
{
200.000,100.000,16.000,0.000,0.000,0.000 Bottom dia., height, No. of divided faces, 

0, 0, 0
0.000,0.000,0.000,0.000,0.000,0.000 X, Y, Z, Rx, Ry, Rz
}
}

BLOCK
{
SPHERE(RGB(255,0,0),2) Description
{
100.000,30.000,0,0,0,0 Diameter, No.of devided face, 0, 0, 0, 0
0.000,0.000,0.000,0,0,0 X, Y, Z, 0, 0, 0
}
}

BLOCK
{
PIPE2(RGB(255,0,0),2) Description
{
100.000,100.000,100.000,10.000,100.000,16.
000

Lower face dia., bottom plate thickness, 
upper face dia., upper plate thickness, 
height, No. of divided faces

0.000,0.000,0.000,0.000,0.000,0.000 X, Y, Z, Rx, Ry, Rz
}
}
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• AXIS6 (color, num): Model having information only of position and posture
Described with data of X, Y, Z, Rx, Ry and Rz.
“num” sets the number of target points.
<Sample>

• LINE(color,num): Continuous line model
Described with data of X, Y and Z.
"num" sets the number of points.
<Sample>

• LINE2(color,num): Segmented line model
Described with data of X, Y and Z.
"num" sets the number of points.
<Sample>

BLOCK
{
AXIS6(RGB(255,0,0),3) Description
{
0.000,0.000,0.000,0.000,0.000,0.000 Point1 (X, Y, Z, Rx, Ry, Rz)
100.000,0.000,0.000,0.000,0.000,0.000 Point2 (X, Y, Z, Rx, Ry, Rz)
200.000,0.000,0.000,0.000,0.000,0.000 Point3 (X, Y, Z, Rx, Ry, Rz)
}
}

BLOCK
{
LINE(RGB(255,0,0),3) Description
{
0.000,0.000,0.000 Point1 (X, Y, Z)
100.000,200.000,300.000 Point2 (X, Y, Z)
500.000,235.000,111.000 Point3 (X, Y, Z)
}
}

BLOCK
{
LINE2(RGB(255,0,0),4) Description
{
253.000,353.000,686.000 Segment 1 Start (X, Y, Z)
89.000,254.000,79.000 Segment 1 End (X, Y, Z)
413.000,3.000,99.000 Segment 2 Start (X, Y, Z)
917.000,524.000,-48.000 Segment 2 End (X, Y, Z)
}
}
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• CUBE (color, num): Polygonal cube model
Data of polygonal cube are described with data of bottom and height.
A rectangular parallelepiped is composed of four points and one height, therefore, num is 
5 in this case.
<Sample>

• FLOOR (color, num): Floor form model
Describes a plane meshed data string.
Described with data of number of divided faces (vertical and horizontal) and frame data of 
floor end point.

<Sample>

BLOCK
{
CUBE(RGB(255,0,0),5) Description
{
0.000,0.000,0.000 Start point1 (X, Y, Z)(= End point 4)
100.000,0.000,0.000 End point1 (X, Y, Z)(= Start point 2)
100.000,100.000,0.000 End point2 (X, Y, Z)(= Start point 3)
0.000,100.000,0.000 End point3 (X, Y, Z)(= Start point 4)
0.000,0.000,100.000 Offset value (X, Y, Z)
}
}

BLOCK
{
FLOOR(RGB(255,0,0),3) Description
{
6.000,6.000,0.000 No. of divided faces (X division No., Y 

division No., 0)
-1500.000,-3000.000,0.000 Floor end point1 (X, Y, Z)
1500.000,3000.000,0.000 Floor end point2 (X, Y, Z)
}
}
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• FACE (color, num): Face model
Describes a face with the frame data of X, Y, and Z of each point.
In this case the face model is composed of three points on the face and the data for X, Y, 
Z, Rx, Ry and Rx, num is 4.
<Sample>

BLOCK
{
FACE(RGB(255,128,0),4) Description
{
0.000,0.000,0.000,0.000,0.000,0.000 X, Y, Z, Rx, Ry, Rz

Face is created with the following three 
points.

200.000,300.000,300.000,3,0,0 Point1 (X, Y, Z)
-200.000,300.000,300.000,0,0,0 Point2 (X, Y, Z)
-200.000,300.000,-300.000,0,0,0 Point3 (X, Y, Z)
}
}
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 Cell File
When constructing a cell, a cell file is created.  The following describe an example of a cell file

CELL_INIT
{
VERSION=1, 0, 0, 0

CONTROLLER(0)
{
PATH=%CELPATH%\NX100;
NAME=NX100;
RB1

{
NAME=HP6;
FILE=%CELPATH%\NX100\RB1\robotinf.dat;
}

TRACE
{
ROBOT=HP6;
}

}

MANIPULATOR
{
}

NSIMVIEW
{
CAMERAPOSITION=1.806423,3.445533,2.179023;
CAMERATARGET=0.594751,0.020004,0.705908;
CAMERAUPVECTOR=-0.161379,-0.341156,0.926049;
CAMERAFIELD=2.237789,1.568312;
USERVIEW

{
NO=0
NAME=
CAMERAPOSITION=0.000000,0.000000,0.000000;
CAMERATARGET=0.000000,0.000000,0.000000;
CAMERAUPVECTOR=0.000000,0.000000,0.000000;
CAMERAFIELD=0.000000,0.000000;
}

...
USERVIEW

{
NO=9
NAME=
CAMERAPOSITION=0.000000,0.000000,0.000000;
CAMERATARGET=0.000000,0.000000,0.000000;
CAMERAUPVECTOR=0.000000,0.000000,0.000000;
CAMERAFIELD=0.000000,0.000000;
}

}

NSIMLIGHT
{
LIGHT

{
NO=0
DEFINE=1;
ONOFF=1;
TYPE=0;
COLOR=RGB(255,255,255);
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LIGHTPOSITION=0.000000,0.000000,0.000000;
LIGHTTARGET=0.000000,0.000000,0.000000;
SCALLING=100.000000;
}

...
LIGHT

{
NO=4
DEFINE=0;
ONOFF=0;
TYPE=0;
COLOR=RGB(255,255,255);
LIGHTPOSITION=0.000000,0.000000,0.000000;
LIGHTTARGET=0.000000,0.000000,0.000000;
SCALLING=100.000000;
}

}

}
MODEL_INIT
{
MODEL

{
NAME=FLOOR;
PARENT=world;
FILENAME=%CELPATH%\models\floor.mdl;
COLOR=RGB(0,0,255);
HIDESEE=1;
OPACITY=0.50;
SCALE=1.000000;
AXIS6=0,0,0,0,0,0;
}

MODEL
{
NAME=Teacher;
PARENT=world;
FILENAME=dummy;
COLOR=RGB(0,0,255);
HIDESEE=256;
OPACITY=1.00;
SCALE=1.000000;
AXIS6=0,0,0,0,0,0;
}

MODEL
{
NAME=HP6;
PARENT=world;
FILENAME=%CELPATH%\NX100\RB1\robotinf.dat;
COLOR=RGB(0,0,255);
HIDESEE=1;
OPACITY=1.00;
SCALE=1.000000;
AXIS6=0,0,450,0,0,0;
}

MODEL
{
NAME=HP6_LK0;
PARENT=HP6_rm;
FILENAME=%CELPATH%\NX100\RB1\HP6_LK0.hsf;
COLOR=RGB(0,0,255);
HIDESEE=1;
OPACITY=1.00;
SCALE=1.000000;
AXIS6=0,0,-450,90,0,90;
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}
MODEL

{
NAME=HP6_LK1;
PARENT=HP6_link1;
FILENAME=%CELPATH%\NX100\RB1\HP6_LK1.hsf;
COLOR=RGB(0,0,255);
HIDESEE=1;
OPACITY=1.00;
SCALE=1.000000;
AXIS6=0,0,0,90,0,90;
}

...
MODEL

{
NAME=HP6_LK6;
PARENT=HP6_link6;
FILENAME=%CELPATH%\NX100\RB1\HP6_LK6.hsf;
COLOR=RGB(0,0,255);
HIDESEE=1;
OPACITY=1.00;
SCALE=1.000000;
AXIS6=0,0,0,0,0,0;
}

MODEL_RB
{
NAME=HP6_rm;
HIDESEE=1;
OPACITY=1.00;
}

MODEL_RB
{
NAME=HP6_link1;
HIDESEE=1;
OPACITY=1.00;
}

...
MODEL_RB

{
NAME=HP6_link6;
HIDESEE=1;
OPACITY=1.00;
}

MODEL_RB
{
NAME=HP6_flange;
HIDESEE=1;
OPACITY=1.00;
}

MODEL_RB
{
NAME=HP6_tcp;
HIDESEE=257;
OPACITY=1.00;
}

}
PAIR_INIT
{
}
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1) VERSION Command
• VERSION=1, 0, 0, 0

Describes the MotoSim EG version.

2) CONTROLLER Command
The CONTROLLER command describes data concerning controllers.

• CONTROLLER(0)
Describes the Controller No. 0.
When more than one controller is used, the controllers are provided with numbers 
CONTROLLER(0), CONTROLLER(1), CONTROLLER(2) .

• PATH=%CELPATH%\NX100;
Describes the directory path to which the CONTROLLER refers.
This directory needs a “VRC.BIN” file.

• NAME=NX100;
Describes the name of the CONTROLLER.

• Control Group sub-commands (RB1, BS1,ST1)
The control group sub-commands describes data concerning control groups.  There are 
three type of control group RB for robot, BS for base station and ST for station.  The type 
is followed by an index number.

• NAME=HP6;
Describes the name of the control group.

• FILE=%CELPATH%\NX100\RB1\robotinf.dat;
Describes the directory path contraining the robot models and file containing infor-
mation on how the models are assemble together to make the robot.

• TRACE sub-command
Describes that trace points are displayed at playback.  

• ROBOT=HP6;
Name of the robot (control group) being traced.

• MODEL=HP6_tcp;
Name of  the model being traced.  If not specified, the robot TCP model is traced.

• PARENT=world;
Describes the name of the parent model.  If not specified, the parent is the “world” 
model.

• POINTS=1000;
Description of the maximum number of trace points.  If not specified, the value is  
1000.

3) MANIPULATOR Command
The MANIPULATOR command describes functions to move models according to a robot axis 
value.  Mainly used to move secondary link model of a robot.

4) NSIMVIEW Command
The NSIMVIEW command describes data related to the camera viewpoint.
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5) NSIMLIGHT Command
The NSIMLIGHT command describes data related to the light type and position.

6) MODEL_INIT Command
The MODEL_INIT command describes data concerning models.

• MODEL
Describes a MODEL.

• NAME=HP6-A00;
Describes the name of the MODEL.

• PARENT=world;
Describes the PARENT model of the MODEL.

• FILENAME=%CELPATH%\HP6-A00\HP6-A00-MDL.mdl;
Describes the directory path and MODEL file name to which the MODEL refers.
If no MODEL file exists, "dummy" is described.

• COLOR=RGB(0,0,255);
Describes the color of the MODEL.

• HIDESEE=1;
Describes the display bit of the MODEL.

• OPACITY=1.00;
Describes the opacity of the MODEL.

• SCALE=1.000000;
Describes the scale factor of the MODEL.

• AXIS6=0,0,450,0,0,0;
Describes the relative coordinates to the MODEL PARENT.

• MODEL_RB
Describes a robot joint model.  Robot joints model define the frame of a robot joint.  Only 
the NAME, HIDESEE and OPACITY values are defined (see above for description).

Default Models are:
• world

Starting point for all models.  It does not appear.
• worldframe

Displays the world position with a frame.
• Teacher

Displays a frame to create a target coordinate on any point.
• FLOOR

Displays world XY plane.

7) PAIR_INIT Command
The PAIR_INIT command describes pairs of models that are checked for collision when the 
collision detection function is active.
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15.2 Reading the CAD Data with MotoSim EG-VRC

The CAD data must be converted into a form readable for MotoSim EG-VRC before starting 
the reading operation.  The following flowchart shows the data conversion operations required 
for MotoSim EG-VRC.

The CAD converters "PolyTrans" and "Inovate" are not included with MotoSim EG-VRC.  
Prepare such application software before the operation.  
        PolyTrans: Okino Computer Graphics (http://www.okino.com)
        Inovate: IRONCAD (http://www.ironcad.com)

User system Intermediate
CAD file

Intermediate
CAD file

Commercial
CAD converter MotoSim EG

CATIA V5,
SolidWorks,
and other 
output-enabled
CAD data  

HSF
format

HSF
format

Commercial
CAD converter

Other 
CAD data

Data formats
IGES, VRML,
DXF, etc.

NOTE
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15.3 Storage Card

The FD/CF function of the Virtual Pendant is used to save or load MotoSim EG-VRC data 
such as edited jobs, condition files, etc. 

15.3.1 Folder Structure

The folder used to save or load data files is the “Storage Card” folder located under the con-
troller folder of the cell (for example in the figure below: \Cells\Test\NX100).  Data saved or 
loaded are put in this folder.  Like with the real controller, it is possible to create sub-folder 
under the “Storage Card” folder, and also load/save data from those folders.

When the button in the virtual pendant is clicked, the target folder can be opened.

 
MotoSimEG－VRC 

CELLS 

TEST 

MODELS 

RB1 

TEST.VCL 

NX100 

RB2 

Storage Card 

Storage folder of file 
saved/loaded with the 
FC/CF Storage function 

system 
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15.3.2 Save controller data created with MotoSim EG-VRC 

Procedure
1. Select {FD/CF} - {SAVE} from the Virtual Pendant main menu.

2. Select the type of data to be saved.  For the figure below, {JOB} was selected.  The list of 
files (in this case, the list of jobs) will display.

3. Select the files to be saved by moving the cursor on the file name and, press the [Space-
bar] on the keyboard or click [Select] in the Virtual Pendant keypad.  The selected files will 
be marked by a star ★ mark on there left.
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4. Press [Enter].  Select [Yes] in the confirmation dialog box that will display.  The selected 
files will be saved in the “Storage Card”.

15.3.3 Load controller data to MotoSim EG-VRC

Procedure
1. Select {FD/CF} - {LOAD} from the Virtual Pendant main menu.

2. Select the type of data to be saved.  For the figure below, {JOB} was selected.  The list of 
files in the “Storage Card” folder (in this case, the list of jobs) will display.

Files cannot be overwritten.  If the files already exist, an error message will display. 
First delete the existing file or select a different folder, then proceed with the save 
operation.

Unlike Windows, the VRC controller is case sensitive for the file names.  File names need 
to be entered with all capital letters or they will not be detected in the “Storage Card” folder.  
If this is not the case, rename the file name with Windows Explorer so that the names are 
written in capital letters.

NOTE

NOTE
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3. Select the files to be loaded by moving the cursor on the file name and, press the [Space-
bar] on the keyboard or click [Select] on the Virtual Pendant keypad.  The selected files will 
be marked by a star ★ mark.

4. Press [Enter].  Select [Yes] in the confirmation dialog box that will display.  The selected 
files will be loaded to the MotoSim EG-VRC controller.

Job files cannot be loaded, if they already exist in the controller.
In such case, first rename or delete the existing job, then proceed with the load operation.

NOTE
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15.4 Standard function about YRC1000

:Enable, :Display only, :Disable 

Main Menu Main Menu Item Menu Menu Item Corresp
ondence

JOB JOB JOB 

EDIT 

DISPLAY JOB HEADER 

ENABLE STEP NO 

ENABLE TOOL NO 

ARC INFORMATION
(ARC) 

TIME MEASUREMENT 

WELD LINE TABLE
(ARC) 

UTILITY SETUP SPECIAL RUN 

PARALLEL SHIFT JOB 

MIRROR SHIFT 

PAM 

ARC SHIFT CANCEL
(ARC) 

SELECT JOB 

CREATE NEW JOB 

MASTER JOB 

JOB CAPACITY 
JOB REGISTRATION
(PAINT, SEALING) 

CYCLE 

JOB EDIT(PLAY) 

PLAY EDIT JOB LIST 

SECURITY_JOB LIST 

USED CONDITION 
SEARCH (ARC) 

VARIABLE 

IN/OUT EXTERNAL INPUT 

EXTERNAL OUTPUT 
GENERAL PURPOSE 
INPUT 

GENERAL PURPOSE 
OUTPUT 
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SPECIFIC INPUT 

SPECIFIC OUTPUT 

RIN 

REGISTER 

AUXILIARY RELAY 
INTERNAL CONTROL 
STATUS 

PSEUDO INPUT SIG 

NETWORK INPUT 

NETWORK OUTPUT 

ANALOG OUTPUT 

SV POWER STATUS 

LADDER PROGRAM 

I/O ALARM 

I/O MESSAGE 

REMOTE 

TERMINAL 

IO SIMULATION LIST 

SERVO ON FACTOR 

RB STOP FACTOR MON-
ITOR 

USER GROUP INPUT 

USER GROUP OUTPUT 

ROBOT CURRENT POSITION 

COMMAND POSITION 

SERVO MONITOR 

WORK HOME POS 

SECOND HOME POS 

DROP AMOUNT 

POWER ON/OFF POS 

TOOL 

INTERFERENCE 

SHOCK SENS LEVEL 

USER COORDINATE 

HOME POSITION 

MANIPULATOR TYPE 

ANALOG MONITOR 

OVERRUN&S-SENSOR 

Main Menu Main Menu Item Menu Menu Item Corresp
ondence
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LIMIT RELEASE 

ARM CONTROL 

SHIFT VALUE 

SOFTLIMIT SETTING 

SHOCK SENS LV. (CUR-
RENT) 

SYSTEM INFO VERSION 

MONITORING TIME 

CONTROLLER INFOR-
MATION 

ALARM HISTORY 

ALM CONT. CUSTOMIZE 

I/O MSG HISTORY 

LOGDATA 
USER DEFINITION 
MENU 

SECURITY 

EX. MEMORY LOAD 

SAVE 

VERIFY 

DELETE 

FOLDER 

PARAMETER 

SETUP TEACHING COND. LANGUAGE LEVEL 

INSTRUCTION INPUT 
LEARNING 

MOVE INSTRUCTION 
SET POSITION 

BUZZER WHEN POSI-
TION TEACHING 

STEP ONLY CHANGING 

RECT/CYLINDRICAL 

TOOL NO. SWITCH 

TOOL NO. INTLK FOR 
STEP ENTRY 

CHECK AT P-VAR TOOL 
NO. CHANGE 

POS. TEACH ONLY JOG 
CONTROL GROUP 

JOB UNDELETE FUNC-
TION 

Main Menu Main Menu Item Menu Menu Item Corresp
ondence
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TEST RUN CONTROL 

MANUAL SPEED 
SELECT (TEST RUN) 

USER ALARM CAPAC-
ITY 

PROMP BEF OVER-
WRITE POS VARIABLE 

DATA RESET INSTRUCTION 

OPERATE COND. SPEED DATA INPUT 
FORM 

CYCLE SWITCH IN 
TEACH MODE 

CYCLE SWITCH IN PLAY 
MODE 

CYCLE SWITCH IN 
LOCAL MODE 

CYCLE SWITCH IN 
REMOTE MODE 

SET CYCLE ON POWER 
ON 

SECURITY MODE 
WHEN POWER ON 

JOB STEP WHEN 
POWER ON 

GENERAL OUT KEEP 
WHEN POWER ON 

SV ON READY OFF AT 
DSW RELEASED 

OPERATE ENABLE EXTERNAL START 

PP START 

EXTERNAL MODE 
SWITCH 

EXTERNAL CYCLE 
SWITCH 

PP CYCLE SWITCH 

EXTERNAL SERVO ON 

PP SERVO ON 

DSW SERVO ON 

FUNCTION ENABLE MASTER JOB CHANGE 

RESERVED START 

RESERVED START JOB 
CHANGE 

JOB SELECT WHEN  
PLAY MODE 

Main Menu Main Menu Item Menu Menu Item Corresp
ondence

774/847



15.4  Standard function about YRC1000

HW0485348

JOB SELECT WHEN 
REMOTE AND PLAY 

I/O-VARIABLE CUSTOM-
IZE FUNCTION 

GENERAL I/O NAME 
DISP. ON JOB 

ANTICIPATION FUNC-
TION 

ALL AXES ANGLE DISP 
FUNCTION 

PENDANT BUZZER 
FUNCTION 

JOG COND. 

PLAYBACK COND. CHECK/MACHINE LOCK 

MASTER CALLING UP 

INITIAL MOVE SPEED 
OF ROBOT 

START METHOD AFTER 
ABSO OVER 

SIGNAL NO. WHEN 
DROP VALUE OVER 

FUNCTION COND. 

DISPLAY COLOR COND. 

LOGDATA COND. 

DATE/TIME 

SET WORD 

RESERVE JOB NAME 

USER ID 

SET SPEED 

KEY ALLOCATION 

SIMULTANEOUS KEY 
HELP 

JOG KEY ALLOC. 

WRONG DATA LOG 

ENERGY SAVING FUNC-
TION 

ENCODER MAINTE-
NANCE 

SETTM SETUP 

SPEED OVERRIDE SET-
TING 

SAFETY FUNC. TIMER DELAY SET 

SAFETY LOGIC CIRCUIT 

Main Menu Main Menu Item Menu Menu Item Corresp
ondence
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SLC SIGNAL DISPLAY 

SLC SIGNAL DISPLAY 
SET 

SPIN COMMENT SET 

TOTAL CRC DISPLAY 

DISPLAY 
SETUP 

ARC WELDING
(ARC, JIG-
LESS ARC)

ARC START COND.  *1

ARC END COND.  *1

ARC AUX COND. 

POWER SOURCE 
COND. 

ARC WELD DIAG. 

WEAVING 

ARC MONITOR 

ARC MONITOR (SAMPL) 

APPLI COND.(JIGLESS 
ARC) *2

HANDLING HANDLING DIAG. 

SPOT WELD-
ING (SPOT) WELD DIAGNOSIS 

I/O ALLOCATION 

GUN CONDITION 
SPOT POWER SOURCE 
COND. 

TIP DRESS SUPERVI-
SION 

APPLI COND. 

SPOT WELD-
ING
(MOTOR GUN)

SPOT SUPERVISION 

CLEARANCE SETTING 

PRESSURE 

GUN PRESSURE 

TIP DRESS CONDITION 

TIP DRESS SUPERVI-
SION 

GUN CONDITION 

GUN DETAIL SETTING 

WELDER IF 

Main Menu Main Menu Item Menu Menu Item Corresp
ondence
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I/O ALLOCATION 

PRSSR ERR DETECT 

PRSSR ERR DETECT 
HIST 

APPLI COND. 

GENERAL WEAVING 

GENERAL DIAG. 

PAINT
(PAINT, 
PAINT(NP)

PAINT SYS CONFIG 

PAINTING SPECIAL 

PAINT CONDITION 

CALIBRATION CONFIG 

TIME CHART CONFIG 

TIME CHART 

PAINT DATA CONFIG 

PAINT OUTPUT TEST 

SEALING SEAL SYS CONFIG 

SEAL SPECIAL 

SEAL CONDITION 
SEAL CALIBRATION 
CONFIG 

DEVICE CALIB. CONFIG 

SPEED TRACK. CONDI-
TION 

CORRECTION TABLE 
CONFIG 

APPLICATION DATA 
CONFIG 

Maintenance mode
SYSTEM INITIALIZE 

SETUP LANGUAGE 

CONTROL GROUP 

APPLICATION 

OPTION BOARD 

IO MODULE 

CMOS MEMORY 

DATE/TIME 

OPTION FUNCTION  *3

VERSION 

Main Menu Main Menu Item Menu Menu Item Corresp
ondence
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*1 Graphical setting display is not supported.
*2 WELDING SPEED PRIORITY can be used only.
*3 Please refer to section " 1.2.1  Optional Functionof controller " for the list of each 

optional function.

CONTROLLER INFOR-
MATION 

ALARM HISTORY 

SD ACCESS 

TIMESTAMP 
INFORMATION 

SECURITY 

FILE 

EX. 
MEMORY 

TOOL 

DISPLAY 
SETUP 

Main Menu Main Menu Item Menu Menu Item Corresp
ondence
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15.5 Standard function about YRC1000micro

:Enable, :Display only, :Disable 

Main Menu Main Menu Item Menu Menu Item Corresp
ondence

JOB JOB JOB 

EDIT 

DISPLAY 

UTILITY SETUP SPECIAL RUN 

PARALLEL SHIFT JOB 

MIRROR SHIFT 

PAM 

SELECT JOB 

CREATE NEW JOB 

MASTER JOB 

JOB CAPACITY 

CYCLE 

JOB EDIT(PLAY) 

PLAY EDIT JOB LIST 

SECURITY_JOB LIST 

VARIABLE 

IN/OUT EXTERNAL INPUT 

EXTERNAL OUTPUT 
GENERAL PURPOSE 
INPUT 

GENERAL PURPOSE 
OUTPUT 

SPECIFIC INPUT 

SPECIFIC OUTPUT 

RIN 

REGISTER 

AUXILIARY RELAY 
INTERNAL CONTROL 
STATUS 

PSEUDO INPUT SIG 

NETWORK INPUT 

NETWORK OUTPUT 

ANALOG OUTPUT 

SV POWER STATUS 
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LADDER PROGRAM 

I/O ALARM 

I/O MESSAGE 

REMOTE 

TERMINAL 

IO SIMULATION LIST 

SERVO ON FACTOR 

RB STOP FACTOR MON-
ITOR 

USER GROUP INPUT 

USER GROUP OUTPUT 

ROBOT CURRENT POSITION 

COMMAND POSITION 

SERVO MONITOR 

WORK HOME POS 

SECOND HOME POS 

DROP AMOUNT 

POWER ON/OFF POS 

TOOL 

INTERFERENCE 

SHOCK SENS LEVEL 

USER COORDINATE 

HOME POSITION 

MANIPULATOR TYPE 

ANALOG MONITOR 

OVERRUN&S-SENSOR 

LIMIT RELEASE 

ARM CONTROL 

SHIFT VALUE 

MANUAL BRAKE 
RELEASE 

SOFTLIMIT SETTING 

SHOCK SENS LV. (CUR-
RENT) 

SYSTEM INFO VERSION 

MONITORING TIME 

CONTROLLER INFOR-
MATION 

ALARM HISTORY 

Main Menu Main Menu Item Menu Menu Item Corresp
ondence
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ALM CONT. CUSTOMIZE 

I/O MSG HISTORY 

LOGDATA 

USER DEFINITION 
MENU 

SECURITY 

EX. MEMORY LOAD 

SAVE 

VERIFY 

DELETE 

FOLDER 

PARAMETER 

SETUP TEACHING COND. LANGUAGE LEVEL 

INSTRUCTION INPUT 
LEARNING 

MOVE INSTRUCTION 
SET POSITION 

BUZZER WHEN POSI-
TION TEACHING 

STEP ONLY CHANGING 

RECT/CYLINDRICAL 

TOOL NO. SWITCH 

TOOL NO. INTLK FOR 
STEP ENTRY 

CHECK AT P-VAR TOOL 
NO. CHANGE 

POS. TEACH ONLY JOG 
CONTROL GROUP 

JOB UNDELETE FUNC-
TION 

TEST RUN CONTROL 
MANUAL SPEED 
SELECT (TEST RUN) 

DATA RESET INSTRUCTION 

OPERATE COND. SPEED DATA INPUT 
FORM 

CYCLE SWITCH IN 
TEACH MODE 

CYCLE SWITCH IN PLAY 
MODE 

CYCLE SWITCH IN 
LOCAL MODE 

Main Menu Main Menu Item Menu Menu Item Corresp
ondence
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CYCLE SWITCH IN 
REMOTE MODE 

SET CYCLE ON POWER 
ON 

SECURITY MODE 
WHEN POWER ON 

JOB STEP WHEN 
POWER ON 

GENERAL OUT KEEP 
WHEN POWER ON 

SERVO ON READY OFF 
WHEN DSW RELEASE 

OPERATE ENABLE EXTERNAL START 

PP START 

EXTERNAL MODE 
SWITCH 

EXTERNAL CYCLE 
SWITCH 

PP CYCLE SWITCH 

EXTERNAL SERVO ON 

PP SERVO ON 

DSW SERVO ON 

FUNCTION ENABLE MASTER JOB CHANGE 

RESERVED START 

RESERVED START JOB 
CHANGE 

JOB SELECT WHEN  
PLAY MODE 

JOB SELECT WHEN 
REMOTE AND PLAY 

I/O-VARIABLE CUSTOM-
IZE FUNCTION 

GENERAL I/O NAME 
DISP. ON JOB 

ANTICIPATION FUNC-
TION 

ALL AXES ANGLE DISP 
FUNCTION 

PENDANT BUZZER 

JOG COND. 

PLAYBACK COND. CHECK/MACHINE LOCK 

MASTER CALLING UP 

INITIAL MOVE SPEED 
OF ROBOT 

Main Menu Main Menu Item Menu Menu Item Corresp
ondence
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START METHOD AFTER 
ABSO OVER 

SIGNAL NO. WHEN 
DROP VALUE OVER 

FUNCTION COND. 

DISPLAY COLOR COND. 

LOGDATA COND. 

DATE/TIME 

SET WORD 

RESERVE JOB NAME 

USER ID 

SET SPEED 

KEY ALLOCATION 

SIMULTANEOUS KEY 
HELP 

JOG KEY ALLOC. 

WRONG DATA LOG 

ENERGY SAVING FUNC-
TION 

ENCODER MAINTE-
NANCE 

SETTM SETUP 

SAFETY FUNC. TIMER DELAY SET 

SAFETY LOGIC CIRCUIT 

SLC SIGNAL DISPLAY 

SLC SIGNAL DISPLAY 
SET 

SPIN COMMENT SET 

TOTAL CRC DISPLAY 

DISPLAY 
SETUP 

GENERAL WEAVING 

GENERAL DIAG. 

Maintenance mode
SYSTEM INITIALIZE 

SETUP LANGUAGE 

CONTROL GROUP 

OPTION BOARD 

IO MODULE 

CMOS MEMORY 

Main Menu Main Menu Item Menu Menu Item Corresp
ondence
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DATE/TIME 

OPTION FUNCTION  *3

VERSION 

CONTROLLER INFOR-
MATION 

ALARM HISTORY 

SD ACCESS 

TIMESTAMP 
INFORMATION 

SECURITY 

FILE 

EX. 
MEMORY 

TOOL 

DISPLAY 
SETUP 

Main Menu Main Menu Item Menu Menu Item Corresp
ondence
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15.6 Standard function about DX200

:Enable, :Display only, :Disable 

Main Menu Main Menu Item Menu Menu Item Corresp
ondence

JOB JOB JOB 

EDIT 

DISPLAY 

UTILITY SETUP SPECIAL RUN 

PARALLEL SHIFT JOB 

MIRROR SHIFT 

PAM 

ARC SHIFT CANCEL
(ARC) 

SELECT JOB 

CREATE NEW JOB 

MASTER JOB 

JOB CAPACITY 

JOB REGISTRATION
(PAINT) 

CYCLE 

JOB EDIT(PLAY) 

PLAY EDIT JOB LIST 

VARIABLE 

IN/OUT EXTERNAL INPUT 

EXTERNAL OUTPUT 

UNIVERSAL INPUT 

UNIVERSAL OUTPUT 

SPECIFIC INPUT 

SPECIFIC OUTPUT 

RIN 

REGISTER 

AUXILIARY RELAY 

CONTROL INPUT 

PSEUDO INPUT SIG 

NETWORK INPUT 

NETWORK OUTPUT 

ANALOG OUTPUT 
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SV POWER STATUS 

LADDER PROGRAM 

I/O ALARM 

I/O MESSAGE 

TERMINAL 

IO SIMULATION LIST 

SERVO ON FACTOR 

RB STOP FACTOR MON-
ITOR 

ROBOT CURRENT POSITION 

COMMAND POSITION 

SERVO MONITOR 

WORK HOME POS 

SECOND HOME POS 

DROP AMOUNT 

POWER ON/OFF POS 

TOOL 

INTERFERENCE 

SHOCK SENS LEVEL 

USER COORDINATE 

HOME POSITION 

MANIPULATOR TYPE 

ANALOG MONITOR 

OVERRUN&S-SENSOR 

LIMIT RELEASE 

ARM CONTROL 

SHIFT VALUE 

SOFTLIMIT SETTING 

SHOCK SENS LV. (CUR-
RENT) 

SYSTEM INFO VERSION 

MONITORING TIME 

CONTROLLER INFOR-
MATION 

ALARM HISTORY 

I/O MSG HISTORY 

LOGDATA 

USER DEFINITION 
MENU 

Main Menu Main Menu Item Menu Menu Item Corresp
ondence
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SECURITY 

EX. MEMORY LOAD 

SAVE 

VERIFY 

DELETE 

FOLDER 

PARAMETER 

SETUP TEACHING COND. LANGUAGE LEVEL 

INSTRUCTION INPUT 
LEARNING 

MOVE INSTRUCTION 
SET POSITION 

BUZZER WHEN POSI-
TION TEACHING 

STEP ONLY CHANGING 

RECT/CYLINDRICAL 

TOOL NO. SWITCH 

TOOL NO. INTLK FOR 
STEP ENTRY 

CHECK AT P-VAR TOOL 
NO. CHANGE 

POS. TEACH ONLY JOG 
CONTROL GROUP 

JOB UNDELETE FUNC-
TION 

TEST RUN CONTROL 

MANUAL SPEED 
SELECT(TEST RUN) 

DATA RESET INSTRUCTION 

OPERATE COND. SPEED DATA INPUT 
FORM 

CYCLE SWITCH IN 
TEACH MODE 

CYCLE SWITCH IN PLAY 
MODE 

CYCLE SWITCH IN 
LOCAL MODE 

CYCLE SWITCH IN 
REMOTE MODE 

SET CYCLE ON POWER 
ON 

SECURITY MODE 
WHEN POWER ON 

Main Menu Main Menu Item Menu Menu Item Corresp
ondence
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JOB STEP WHEN 
POWER ON 

GENERAL OUT KEEP 
WHEN POWER ON 

OPERATE ENABLE EXTERNAL START 

PP START 

EXTERNAL MODE 
SWITCH 

EXTERNAL CYCLE 
SWITCH 

PP CYCLE SWITCH 

EXTERNAL SERVO ON 

PP SERVO ON 

DSW SERVO ON 

FUNCTION ENABLE MASTER JOB CHANGE 

RESERVED START 

RESERVED START JOB 
CHANGE 

JOB SELECT WHEN  
PLAY MODE 

JOB SELECT WHEN 
REMOTE AND PLAY 

I/O-VARIABLE CUSTOM-
IZE FUNCTION 

GENERAL I/O NAME 
DISP. ON JOB 

ANTICIPATION FUNC-
TION 

ALL AXES ANGLE DISP 
FUNCTION 

CURSOR MOVE BY 
TOUCH(JOB) 

JOG COND. 

PLAYBACK COND. CHECK/MACHINE LOCK 

MASTER CALLING UP 

INITIAL MOVE SPEED 
OF ROBOT 

START METHOD AFTER 
ABSO OVER 

SIGNAL NO. WHEN 
DROP VALUE OVER 

FUNCTION COND. 

DISPLAY COLOR COND. 

LOGDATA COND. 

Main Menu Main Menu Item Menu Menu Item Corresp
ondence
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DATE/TIME 

RESERVE JOB NAME 

USER ID 

SET SPEED 

KEY ALLOCATION 

JOG KEY ALLOC. 

WRONG DATA LOG 

ENERGY SAVING FUNC-
TION 

ENCODER MAINTE-
NANCE 

SETTM SETUP 

SAFETY FUNC. M-SAFETY SIGNAL 
ALLOC 

TIMER DELAY SET 

SAFETY LOGIC CIRCUIT 

TOTAL CRC DISPLAY 

DISPLAY 
SETUP 

ARC WELDING
(ARC, JIG-
LESS ARC)

ARC START COND.  *1

ARC END COND.  *1

ARC AUX COND. 

POWER SOURCE 
COND. 

ARC WELD DIAG. 

WEAVING 

ARC MONITOR 

ARC MONITOR (SAMPL) 

APPLI COND.(ARC) 

APPLI COND.(JIGLESS 
ARC) *2

HANDLING HANDLING DIAG. 

SPOT WELD-
ING (SPOT) WELD DIAGNOSIS 

I/O ALLOCATION 

GUN CONDITION 

SPOT POWER SOURCE 
COND. 

TIP DRESS SUPERVI-
SION 

Main Menu Main Menu Item Menu Menu Item Corresp
ondence
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APPLI COND. 

SPOT WELD-
ING
(MOTOR GUN)

SPOT SUPERVISION 

CLEARANCE SETTING 

PRESSURE 

GUN PRESSURE 

TIP DRESS CONDITION 

TIP DRESS SUPERVI-
SION 

GUN CONDITION 

GUN DETAIL SETTING 

WELDER I/F 

I/O ALLOCATION 

APPLI COND. 

GENERAL WEAVING 

GENERAL DIAG. 

PAINT 
(PAINT, 
PAINT(NP))

PAINT SYS CONFIG 

PAINTING SPECIAL 

PAINT CONDITION 

CALIBRATION CONFIG 

TIME CHART CONFIG 

TIME CHART 

PAINT DATA CONFIG 

PAINT OUTPUT TEST 

Maintenance mode
SYSTEM INITIALIZE 

SETUP LANGUAGE 

CONTROL GROUP 

APPLICATION 

OPTION BOARD 

IO MODULE 

CMOS MEMORY 

DATE/TIME 

OPTION FUNCTION  *3

VERSION 

SECURITY 

Main Menu Main Menu Item Menu Menu Item Corresp
ondence
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15.6  Standard function about DX200
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*1 Graphical setting display is not supported.
*2 WELDING SPEED PRIORITY can be used only.
*3 Please refer to section " 1.2.1  Optional Functionof controller " for the list of each 

optional function.

FILE 

EX. 
MEMORY LOAD 

DEVICE 

FOLDER 

TOOL 

DISPLAY 
SETUP 

Main Menu Main Menu Item Menu Menu Item Corresp
ondence
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15.7 Standard function about DX100

:Enable, :Display only, :Disable 

Main Menu Main Menu Item Menu Menu Item Corresp
ondence

JOB JOB JOB 

EDIT 

DISPLAY 

UTILITY SETUP SPECIAL RUN 

PARALLEL SHIFT JOB 

MIRROR SHIFT 

PAM 

SPEED OVERRIDE 

COND ADJUSTMENT 

SELECT JOB 

CREATE NEW JOB 

MASTER JOB 

JOB CAPACITY 

CYCLE 

JOB EDIT(PLAY) 

PLAY EDIT JOB LIST 

VARIABLE 

IN/OUT EXTERNAL INPUT 

EXTERNAL OUTPUT 

UNIVERSAL INPUT 

UNIVERSAL OUTPUT 

SPECIFIC INPUT 

SPECIFIC OUTPUT 

RIN 

CPRIN 

REGISTER 

AUXILIARY RELAY 

CONTROL INPUT 

PSEUDO INPUT SIG 

NETWORK INPUT 

NETWORK OUTPUT 

ANALOG OUTPUT 
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SV POWER STATUS 

LADDER PROGRAM 

I/O ALARM 

I/O MESSAGE 

TERMINAL 

IO SIMULATION LIST 

ROBOT CURRENT POSITION 

COMMAND POSITION 

SERVO MONITOR 

WORK HOME POS 

SECOND HOME POS 

DROP AMOUNT 

POWER ON/OFF POS 

TOOL 

INTERFERENCE 

SHOCK SENS LEVEL 

USER COORDINATE 

HOME POSITION 

MANIPULATOR TYPE 

ANALOG MONITOR 

OVERRUN&S-SENSOR 

LIMIT RELEASE 

ARM CONTROL 

SHIFT VALUE 

SOFTLIMIT SETIING 

SYSTEM INFO VERSION 

MONITORING TIME 

ALARM HISTORY 

I/O MSG HISTORY 

USER DEFINITION 
MENU 

SECURITY 

EX. MEMORY LOAD 

SAVE 

VERIFY 

DELETE 

FOLDER 

Main Menu Main Menu Item Menu Menu Item Corresp
ondence
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PARAMETER 

SETUP TEACHING COND. DATA RESET INSTRUCTION 

LANGUAGE LEVEL 

INSTRUCTION INPUT 
LEARNING 

MOVE INSTRUCTION 
SET POSITION 

BUZZER WHEN POSI-
TION TEACHING 

STEP ONLY CHANGING 

RECT/CYLINDRICAL 

TOOL NO. SWITCH 

TOOL NO. INTLK FOR 
STEP ENTRY 

CHECK AT P-VAR TOOL 
NO. CHANGE 

POS. TEACH ONLY JOG 
CONTROL GROUP 

JOB UNDELETE FUNC-
TION 

OPERATE COND. SPEED DATA INPUT 
FORM 

CYCLE SWITCH IN 
TEACH MODE 

CYCLE SWITCH IN PLAY 
MODE 

CYCLE SWITCH IN 
LOCAL MODE 

CYCLE SWITCH IN 
REMOTE MODE 

SET CYCLE ON POWER 
ON 

SECURITY MODE 
WHEN POWER ON 

JOB STEP WHEN 
POWER ON 

GENERAL OUT KEEP 
WHEN POWER ON 

OPERATE ENABLE EXTERNAL START 

PP START 

EXTERNAL MODE 
SWITCH 

EXTERNAL CYCLE 
SWITCH 

PP CYCLE SWITCH 

Main Menu Main Menu Item Menu Menu Item Corresp
ondence
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EXTERNAL SERVO ON 

PP SERVO ON 

DSW SERVO ON 

FUNCTION ENABLE MASTER JOB CHANGE 

RESERVED START 

RESERVED START JOB 
CHANGE 

JOB SELECT WHEN 
PLAY MODE 

JOB SELECT WHEN 
REMOTE AND PLAY 

I/O-VARIABLE CUSTOM-
IZE FUNCTION 

GENERAL I/O NAME 
DISP. ON JOB 

ANTICIPATION FUNC-
TION 

ALL AXES ANGLE DISP 
FUNCTION 

JOG COND. 

PLAYBACK COND. CHECK/MACHINE LOCK 

MASTER CALLING UP 

INITIAL MOVE SPEED 
OF ROBOT 

START METHOD AFTER 
ABSO OVER 

SIGNAL NO. WHEN 
DROP VALUE OVER 

FUNCTION COND. 

DISPLAY COLOR COND. 

DATE/TIME 

RESERVE JOB NAME 

USER ID 

SET SPEED 

KEY ALLOCATION 

JOG KEY ALLOC. 

WRONG DATA LOG 

ENERGY SAVING FUNC-
TION 

ENCODER MAINTE-
NANCE 

DISPLAY 
SETUP 

Main Menu Main Menu Item Menu Menu Item Corresp
ondence
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ARC WELDING ARC START COND.  *1

ARC END COND.  *1

ARC AUX COND. 
POWER SOURCE 
COND. 

ARC WELD DIAG. 

WEAVING 

ARC MONITOR 

ARC MONITOR (SAMPL) 

APPLI COND.  *2

HANDLING HANDLING DIAG. 

ARC WELDING 
(JIGLESS ARC) ARC START COND.  *1

ARC END COND.  *1

ARC AUX COND. 

POWER SOURCE 
COND. 

ARC WELD DIAG. 

WEAVING 

ARC MONITOR 

ARC MONITOR (SAMPL) 

SPOT WELD-
ING (SPOT) WELD DIAGNOSIS 

I/O ALLOCATION 

GUN CONDITION 

SPOT POWER SOURCE 
COND. 

APPLI COND. 

GENERAL WEAVING 

GENERAL DIAG. 

SPOT WELD-
ING
(MOTOR GUN)

WELD DIAGNOSIS 

GUN PRESSURE 

PRESSURE 

I/O ALLOCATION 

GUN CONDITION 

CLEARANCE SETTING 

TIP INSTALLATION 

Main Menu Main Menu Item Menu Menu Item Corresp
ondence
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15.7  Standard function about DX100
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*1 Graphical setting display is not supported.
*2 WELDING SPEED PRIORITY can be used only.
*3 Please refer to section " 1.2.1  Optional Functionof controller " for the list of each 

optional function.

SPOT POWER SOURCE 
COND. 

APPLI COND. 

Maintenance mode
SYSTEM INITIALIZE 

SETUP LANGUAGE 

CONTROL GROUP 

APPLICATION 

OPTION BOARD 

IO MODULE 

CMOS MEMORY 

DATE/TIME 

OPTION FUNCTION  *3

VERSION 

SECURITY 

FILE 

EX. 
MEMORY LOAD 

SAVE 

SYSTEM RESTORE 

DEVICE 

FOLDER 

TOOL 

DISPLAY 
SETUP 

Main Menu Main Menu Item Menu Menu Item Corresp
ondence

797/847
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15.8 List of Function depending on the system version 
of controller

 YRC1000

Function
Version

YAS4.21-00

Motor load estimate 
Life estimate 
Reset Job 
Cycle time display 
Step end points display in the 
trace points 

Collision step movement 

Conveyor synchronization 

Open the storage card folder 

Job Browser 

Lap Time Panel 

Working Trace 

Online Function 

Simple PP 

JobPad 

Layout Robot 

Remote Laser Function 

Singularity Limit of 
Collaborative Mode 
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 YRC1000micro

Function
Version

YBS2.44-00

Motor load estimate 

Life estimate 

Reset Job 

Cycle time display 

Step end points display in the 
trace points 

Collision step movement 

Conveyor synchronization 

Open the storage card folder 

Job Browser 

Lap Time Panel 

Working Trace 

Online Function 

Simple PP 

JobPad 

Layout Robot 

Singularity Limit of 
Collaborative Mode 
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 DX200

Function
Version

DN2.87-00

Motor load estimate 

Life estimate 

Reset Job 

Cycle time display 

Step end points display in the 
trace points 

Collision step movement 

Conveyor synchronization 

Open the storage card folder 

Job Browser 

Lap Time Panel 

Working Trace 

Online Function 

Simple PP 

JobPad 

Layout Robot 

800/847



15.8  List of Function depending on the system version of controller
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 DX100

Function
Version

DS3.93-00

Motor load estimate 

Life estimate 

Reset Job 

Cycle time display 

Step end points display in the 
trace points 

Collision step movement 

Conveyor synchronization 

Open the storage card folder 

Job Browser 

Lap Time Panel 

Working Trace 

Online Function 

Simple PP 

JobPad 

Layout Robot 
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 FS100

Function
Version

FS3.20A-00 FS3.20B-00 FS3.20C-00 FS2.00-00

Motor load estimate    

Life estimate    

Reset Job    

Cycle time display    

Step end points display in the 
trace points    

Collision step movement    

Conveyor synchronization    

Open the storage card folder    

Job Browser    

Lap Time Panel    

Working Trace    

Online Function    

Simple PP    

JobPad    

Layout Robot    
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 NX100

Function
Version

NS4.75-00 NS5.35-45 NS4.69-A5

Motor load estimate   

Life estimate   

Reset Job   

Cycle time display   

Step end points display in the 
trace points   

Collision step movement   

Conveyor synchronization   

Open the storage card folder   

Job Browser   

Lap Time Panel   

Working Trace   

Online Function   

Simple PP   

JobPad   

Layout Robot   
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15.9  List of Manipulator Models and Offset Values Supported by MotoSim EG-VRC
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15.9 List of Manipulator Models and Offset Values 
          Supported by MotoSim EG-VRC

 YRC1000

Model Name Robot Type
(Model File Name) Offset Value (mm) Remarks

AR700 1-06VX8-A00 330 Added at Ver2016SP2
AR900 1-06VX7-A00 330 Added at Ver2016SP2
AR1440 1-06VXH12-A00 450 Added at Ver2016SP2
AR1440E 1-07VXHE6-A00 450 Added at Ver2018SP2
AR1730 1-06VXH25-A01 505 Added at Ver2017
AR2010 1-06VXH25-A11 505 Added at Ver2017SP1
AR3120 1-06VXHL20-A00 540 Added at Ver2019SP1
GP4 1-06VX4-A00 330 Added at Ver2021
GP7 1-06VX7-A00 330 Added at Ver2016SP2
GP7 1-06VX7-F00 330 Added at Ver2020
GP8 1-06VX8-A00 330 Added at Ver2016SP2
GP8 1-06VX8-F00 330 Added at Ver2019SP2
GP12 1-06VXH12-A00 450 Added at Ver2016SP2
GP12 1-06VXH12-C00 450 Added at Ver2019
GP12 1-06VXH12-F00 450 Added at Ver2019SP1
GP20HL 1-06VXHL20-A00 540 Added at Ver2019SP1
GP25 1-06VXH25-A00 505 Added at Ver2017
GP25 1-06VXH25-A50 505 Added at Ver2019SP1
GP25 1-06VXH25-C00 505 Added at Ver2018SP2
GP25 1-06VXH25-F40 505 Added at Ver2019
GP25-12 1-06VXH25-A10 505 Added at Ver2017SP1
GP25-12 1-06VXH25-C10 505 Added at Ver2021
GP25SV 1-06VXHSV25-A60 505 Added at Ver2020SP1
GP35L 1-06VXL35-A00 540 Added at Ver2017SP1
GP50 1-06VX50-A00 540 Added at Ver2017SP1
GP50 1-06VX50-C00 540 Added at Ver2019
GP50 1-06VX50-F00 540 Added at Ver2019SP2
GP88 1-06VX88-A00 540 Added at Ver2017SP1
GP88 1-06VX88-C00 540 Added at Ver2021
GP110 1-06VX110-A00 540 Added at Ver2017SP1
GP110 1-06VX110-C00 540 Added at Ver2021
GP110B 1-07VXB110-A00 540 Added at Ver2017SP1
GP110H 1-06VXH110-A00 540 Added at Ver2019
GP165R 1-06VR165-A00 450 Added at Ver2017SP1
GP180 1-06VX180-A00 650 Added at Ver2017SP1
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GP180 1-06VX180-C00 650 Added at Ver2021
GP180 1-06VX180-F00 650 Added at Ver2019SP2
GP180-120 1-06VX180-120-A00 650 Added at Ver2017SP1
GP180-120 1-06VX180-120-C00 650 Added at Ver2021
GP180H 1-06VXH180-A00 650 Added at Ver2019
GP200R 1-06VR200-A00 450 Added at Ver2017SP1
GP200R 1-06VR200-C00 450 Added at Ver2021
GP200S 1-06VXS200-A00 650 Added at Ver2019
GP215 1-06VX215-A00 650 Added at Ver2017SP1
GP215 1-06VX215-C00 650 Added at Ver2021
GP225 1-06VX225-A00 650 Added at Ver2017SP1
GP225 1-06VX225-C00 650 Added at Ver2021
GP225H 1-06VXH225-A00 650 Added at Ver2019
GP250 1-06VX250-A00 650 Added at Ver2017SP1
GP250 1-06VX250-C00 650 Added at Ver2021
GP280 1-06VX280-A00 650 Added at Ver2017SP1
GP300R 1-06VR300-A00 600 Added at Ver2020SP1
GP400 1-06VX400-A00 900 Added at Ver2017SP1
GP400R 1-06VR400-A00 1000 Added at Ver2017SP1
GP400R 1-06VR400-A10 1000 Added at Ver2020SP1
GP600 1-06VX600-A00 900 Added at Ver2017SP1
GP600 1-06VX600-C00 900 Added at Ver2019
GP600 1-06VX600-F00 900 Added at Ver2019SP1
HC10 1-06VXH10-A00 275 Added at Ver2017
HC10DT 1-06VXH10-A10 275 Added at Ver2018
HC10DT 1-06VXH10-B10 275 Added at Ver2019SP2
HC10DTF 1-06VXHC10-F10 275 Added at Ver2020
HC20DT 1-06VXHC20-B10 380 Added at Ver2020
PH130F 1-06VXF130-A00 730 Added at Ver2018SP1
PH130RF 1-06VRF130-A00 600 Added at Ver2017SP1
PH200R 1-06VRY200-J00 740 Added at Ver2019SP1
PH200R 1-06VRY200-K00 740 Added at Ver2019SP1
PH200R 1-06VRY200-L00 740 Added at Ver2019SP1
PH200RF 1-06VRF200-J00 758 Added at Ver2018SP1
PH200RF 1-06VRF200-J10 758 Added at Ver2018SP1
PH200RF 1-06VRF200-K00 758 Added at Ver2018SP1
PH200RF 1-06VRF200-K10 758 Added at Ver2018SP1
PH200RF 1-06VRF200-L00 758 Added at Ver2018SP1
PH200RF 1-06VRF200-L10 758 Added at Ver2018SP1
PL190 1-04LXH190-A00 880 Added at Ver2021
PL320 1-04LXH320-A00 880 Added at Ver2021
PL500 1-04LXH500-A00 880 Added at Ver2019SP2

Model Name Robot Type
(Model File Name) Offset Value (mm) Remarks

805/847



15.9  List of Manipulator Models and Offset Values Supported by MotoSim EG-VRC

HW0485348

PL800 1-04LXH800-A00 880 Added at Ver2021
SP80 1-06VX88-A00 540 Added at Ver2017SP1
SP100 1-06VX110-A00 540 Added at Ver2017SP1
SP100B 1-07VXB110-A00 540 Added at Ver2017SP1
SP110H 1-06VXH110-A00 540 Added at Ver2019
SP130 1-06VX140-A00 540 Added at Ver2019
SP150R 1-06VR165-A00 450 Added at Ver2018
SP165 1-06VX180-A00 650 Added at Ver2017SP1
SP165-105 1-06VX180-120-A00 650 Added at Ver2018
SP180H 1-06VXH180-A00 650 Added at Ver2019
SP180H-110 1-06VXH180-A10 650 Added at Ver2019SP1
SP185R 1-06VX180-120-A00 450 Added at Ver2018
SP210 1-06VX225-A00 650 Added at Ver2017SP1
SP225H 1-06VXH225-A00 650 Added at Ver2019
SP225H-135 1-06VXH225-A10 650 Added at Ver2019SP2
SP235 1-06VX250-A00 650 Added at Ver2018
UH100Y UH0100Y-A20 379 Added at Ver2020SP1
UH100Y UH0100Y-A21 379 Added at Ver2020SP1
UH100Y UH0100Y-A22 379 Added at Ver2020SP1
UH100Y UH0100Y-A23 379 Added at Ver2020SP1
UH100Y UH0100Y-A24 379 Added at Ver2020SP1
UH100Y UH0100Y-A25 379 Added at Ver2020SP1
UH100Y UH0100Y-A30 379 Added at Ver2020SP1
UH100Y UH0100Y-A31 379 Added at Ver2020SP1
UH100Y UH0100Y-A32 379 Added at Ver2020SP1
UH100Y UH0100Y-A33 379 Added at Ver2020SP1
UH100Y UH0100Y-A34 379 Added at Ver2020SP1
UH100Y UH0100Y-A35 379 Added at Ver2020SP1
UH100Y UH0100Y-A40 379 Added at Ver2020SP1
UH100Y UH0100Y-A41 379 Added at Ver2020SP1
UH100Y UH0100Y-A42 379 Added at Ver2020SP1
UH100Y UH0100Y-A43 379 Added at Ver2020SP1
UH100Y UH0100Y-A44 379 Added at Ver2020SP1
UH100Y UH0100Y-A45 379 Added at Ver2020SP1

Model Name Robot Type
(Model File Name) Offset Value (mm) Remarks
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 YRC1000micro

Model Name Robot Type
(Model File Name) Offset Value (mm) Remarks

GP4 1-06VX4-A00 330 Added at Ver2021
GP7 1-06VX7-A00 330 Added at Ver2016SP2
GP7 1-06VX7-F00 330 Added at Ver2020
GP8 1-06VX8-A00 330 Added at Ver2016SP2
GP12 1-06VX12-A00 450 Added at Ver2018
HC10 1-06VXHC10-A00 275 Added at Ver2021
HC10DT 1-06VXHC10-A10 275 Added at Ver2018
HC10DT 1-06VXHC10-B10 275 Added at Ver2019SP2
HC10DTF 1-06VXHC10-F10 275 Added at Ver2020
HC10DT 
HANDCARRY TYPE

1-06VXHC10-C11 1049 Added at Ver2020SP1

HC20DT 1-06VXHC20-B10 380 Added at Ver2020
MotoMINI 1-06VX05-A00 103 Added at Ver2017SP1
SG400 1-04SX400-A00 -60 Added at Ver2020
SG650 1-04SX650-A00 -70 Added at Ver2020
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 DX200

Model Name Robot Type
(Model File Name) Offset Value (mm) Remarks

EPX1250II EPX1250-J00 310 Added at Ver2018SP1
ES165RDII ES165RD-J00 450 Added at Ver5.10
ES200RDII ES200RD-J00 450 Added at Ver5.11
MA1440 MA1440-A00 450 Added at Ver4.00
MA1440 MA1440-A10 450 Added at Ver2015
MA2010 MA02010-A00 505 Added at Ver5.20
MA2010 MA02010-A10 505 Added at Ver5.20
MC2000II MC02000-J00 680 Added at Ver2015SP1
MH5SII MH0005S-J00 330 Added at Ver2016
MH5LSII MH005LS-J00 330 Added at Ver5.11
MH12 MH12-A00 450 Added at Ver4.00
MH24 MH00024-A00 505 Added at Ver5.20
MH24-10 MH00024-A10 505 Added at Ver2016
MH50II MH00050-J00 540 Added at Ver5.10
MH50II-20 MH00050-J10 540 Added at Ver5.11
MH50II-35 MH00050-J20 540 Added at Ver5.10
MH80II MH00080-J00 540 Added at Ver5.20
MH110 MH110-A00 540 Added at Ver5.10
MH180 MH180-A00 650 Added at Ver4.01
MH180 MH180-C00 650 Added at Ver2015SP3
MH180-120 MH180-A10 650 Added at Ver2015SP3
MH215II MH00215-J00 650 Added at Ver2016SP3
MH225 MH225-A00 650 Added at Ver4.01
MH250II MH00250-J00 650 Added at Ver2016SP1
MH280II MH00280-J00 650 Added at Ver5.11
MH400II MH00400-J00 900 Added at Ver5.20
MH600 MH00600-A00 900 Added at Ver2015SP2
MHC130II MHC0130-J00 0 Added at Ver2018
MHP45L MHP045L-A00 800 Added at Ver2020
MHP45L MHP045L-B00 800 Added at Ver2020
MLT1700 MLT1700-F20 673 Added at Ver2018SP2
MN100 MN00100-J02 0 Added at Ver2018SP1
MPL80II MPL0080-J00 540 Added at Ver5.11
MPL100II MPL0100-J00 650 Added at Ver2015
MPL160II MPL0160-J00 880 Added at Ver2015
MPL300II MPL0300-J00 880 Added at Ver2015
MPL500II MPL0500-J00 880 Added at Ver2017SP2
MPL800II MPL0800-J00 880 Added at Ver2015SP3
MPO10 MPO0010-A00     0 Added at Ver2015SP1
MPO10 MPO0010-C00     0 Added at Ver2015SP1
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MPO10 MPO0010-F00     0 Added at Ver2015SP1
MPX1150 MPX1150-A00 430 Added at Ver2017
MPX1150 MPX1150-C00 430 Added at Ver2017
MPX1950 MPX1950-A00 500 Added at Ver2018SP2
MPX1950 MPX1950-B00 500 Added at Ver2018SP2
MPX2600 MPX2600-A00 600 Added at Ver2017
MPX2600 MPX2600-A00_CEIL 600 Added at Ver2018
MPX2600 MPX2600-A00_WALL 600 Added at Ver2018
MPX3500 MPX3500-A00     0 Added at Ver2015SP1
MPX3500 MPX3500-A00_WALL     0 Added at Ver2016SP3
MPX3500 MPX3500-A10     0 Added at Ver2015SP1
MPX3500 MPX3500-A10_WALL     0 Added at Ver2016SP3
MPX3500 MPX3500-B00     0 Added at Ver2016SP3
MPX3500 MPX3500-B00_WALL     0 Added at Ver2016SP3
MPX3500 MPX3500-B10     0 Added at Ver2016SP3
MPX3500 MPX3500-B10_WALL     0 Added at Ver2016SP3
MPX3500 MPX3500-C00     0 Added at Ver2015SP1
MPX3500 MPX3500-C00_WALL     0 Added at Ver2016SP3
MPX3500 MPX3500-C10     0 Added at Ver2015SP1
MPX3500 MPX3500-C10_WALL     0 Added at Ver2016SP3
MPX3500 MPX3500-F00     0 Added at Ver2015SP1
MPX3500 MPX3500-F00_WALL     0 Added at Ver2016SP3
MPX3500 MPX3500-F10     0 Added at Ver2015SP1
MPX3500 MPX3500-F10_WALL     0 Added at Ver2016SP3
MS80WII MS0080W-J00 540 Added at Ver2015SP3
MS100 MS100-A00 540 Added at Ver5.10
MS165 MS165-A00 650 Added at Ver4.01
MS210 MS210-A00 650 Added at Ver4.01
MSC35 MSC0035-A00 0 Added at Ver2018SP1
UH100DII UH0100D-J20 379 Added at Ver2020SP1
UH100DII UH0100D-J21 379 Added at Ver2020SP1
UP400RDII UP400RD-J00 1000 Added at Ver2015
UP400RDII UP400RD-J10 1000 Added at Ver2016SP1
VA1400II VA01400-J00 450 Added at Ver2015
VS100I VS00100-A00 540 Added at Ver2015SP3

Model Name Robot Type
(Model File Name) Offset Value (mm) Remarks
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 DX100  

Model Name Robot Type
(Model File Name) Offset Value (mm) Remarks

DX1350D DX1350D-A00 480 Added at Ver2.60
EP4000D EP4000D-J72 740 Added at Ver2.72
EP4000D EP4000D-K72 740 Added at Ver2.72
EP4000D EP4000D-L72 740 Added at Ver2.72
EPH130D EPH130D-A00 730 Added at Ver2.45
EPH130RLD PH13RLD-A00 600 Added at Ver2.72
EPH4000D EPH400D-JA0 758 Added at Ver2.80
EPH4000D EPH400D-JB0 758 Added at Ver2.72
EPH4000D EPH400D-KA0 758 Added at Ver2.80
EPH4000D EPH400D-KB0 758 Added at Ver2.72
EPH4000D EPH400D-LA0 758 Added at Ver2.80
EPH4000D EPH400D-LB0 758 Added at Ver2.72
ES165D ES0165D-A00 650 Added at Ver2.00
ES165D-100 ES0165D-A10 650 Added at Ver2.81
ES165RD ES165RD-A00 450 Added at Ver2.20
ES200D ES0200D-A00 650 Added at Ver2.00
ES200RD-120 ES200RD-A10 450 Added at Ver2016
ES280D-230 ES0280D-A10 650 Added at Ver2.21
HP20D HP0020D-A00 505 Added at Ver2.00
HP20D-6 HP0020D-A10 505 Added at Ver2.40
HP20RD HP020RD-A00 305 Added at Ver2.21
IS300D IS0300D-A00 0 Added at Ver2.21
MA1400 MA01400-A00 450 Added at Ver2.00
MA1800 MA01800-A00 555 Added at Ver2.10
MA1900 MA01900-A00 505 Added at Ver2.00
MC2000 MC02000-A00 680 Added at Ver2.40
MFL2200D-2650 MFL050D-C20 827 Added at Ver2.45
MFL2200D-3600 MFS050D-A00 0 Added at Ver5.20
MFL2400D-2400 MFL080D-C10 955 Added at Ver2020SP1
MFS2500D-4000 MFS060D-A00 0 Added at Ver4.00
MH5 MH00005-C00 330 Added at Ver2.21
MH5 MH00005-E00 330 Added at Ver2.24
MH5 MH00005-E10 330 Added at Ver2.24
MH5L MH0005L-C00 330 Added at Ver2.21
MH5LS MH005LS-A00 330 Added at Ver2.60
MH5S MH0005S-A00 330 Added at Ver2.60
MH6 MH00006-A00 450 Added at Ver2.00
MH6 MH00006-C00 450 Added at Ver4.00
MH6-10 MH00006-A30 450 Added at Ver2.21
MH6S MH0006S-A00 450 Added at Ver2.10
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MH50 MH00050-A00 540 Added at Ver2.00
MH50-20 MH00050-A10 540 Added at Ver2.10
MH50-35 MH00050-A20 540 Added at Ver2.21
MH80 MH00080-A00 540 Added at Ver2.24
MH165 MH00165-A00 650 Added at Ver2.25
MH165 MH00165-B00 650 Added at Ver2.25
MH165-100 MH00165-A10 650 Added at Ver2.81
MH200 MH00200-A00 650 Added at Ver2.80
MH215 MH00215-A00 650 Added at Ver2.21
MH250 MH00250-A00 650 Added at Ver2.40
MH250 MH00250-B00 650 Added at Ver2.40
MH400 MH00400-A0E 900 Added at Ver2.81
MPK2 MPK0002-A00 500 Added at Ver2.24
MPK2 MPK0002-B01 420 Added at Ver2.24
MPL80 MPL0080-A00 540 Added at Ver2.21
MPL100 MPL0100-A00 880 Added at Ver2.20
MPL160 MPL0160-A00 880 Added at Ver2.10
MPL300 MPL0300-A00 880 Added at Ver2.20
MPL500 MPL0500-A00 880 Added at Ver2.21
MPL800 MPL0800-A00 880 Added at Ver2.20
MS80 MS00080-A00 540 Added at Ver2.00
MS80W MS0080W-A00 540 Added at Ver2.40
MS80W MS0080W-B00 540 Added at Ver2.40
MS120 MS00120-A00 680 Added at Ver2.24
VD20S RVD800S6A1 508.5 Added at Ver2.27
VD35D-G4A RVD1230D6A1 556.5 Added at Ver2.27
VD35S-G4A RVD1230S6A1 556.5 Added at Ver2.27
VD40D RVD2200D6A1 624 Added at Ver2.72
VD40S RVD2200S6A1 624 Added at Ver2.72
VD95D RVD1450D6D1 679 Added at Ver2.27
SDA5D SDA005D-A00 900 Added at Ver2.22
SDA10D SDA010D-A00 1200 Added at Ver2.10
SDA10D SDA010D-B00 550 Added at Ver2.10
SDA20D SDA020D-A00 550 Added at Ver2.10
SIA5D SIA005D-A00 309.5 Added at Ver2.45
SIA10D SIA010D-A00 360 Added at Ver2.10
SIA20D SIA020D-A00 410 Added at Ver2.10
SIA20D SIA020D-Y00     0 Added at Ver2.21
SIA30D SIA030D-A00 598 Added at Ver2.81
SIA50D SIA050D-A00 540 Added at Ver2.00
UP120ED-165 UP120ED-A10 525 Added at Ver2.21
UP350D UP0350D-A00 900 Added at Ver2.10

Model Name Robot Type
(Model File Name) Offset Value (mm) Remarks
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 FS100

UP350D-600 UP0350D-B30 900 Added at Ver2.24
UP400RD UP400RD-A00 1000 Added at Ver2.81
UP400RD UP400RD-A10 1000 Added at Ver2016SP1
VA1400 VA01400-A00 450 Added at Ver2.00
VS50 VS00050-A00 540 Added at Ver2.00

Model Name Robot Type
(Model File Name) Offset Value (mm) Remarks

BMDA3 BMDA003-A01 460 Added at Ver4.10
CSDA5F CSDA05F-B1A 500 Added at Ver5.10
CADA10F CSDA10F-A1A 1200 Added at Ver5.10
HP20F HP0020F-A00 505 Added at Ver2.81
MHJ MH0000J-A00 240 Added at Ver2.40
MH3BM MH003BM-A00 350 Added at Ver2.80
MH3F MH0003F-A00 290 Added at Ver2.40
MH5BM MH005BM-A00 362 Added at Ver2016SP3
MH5F MH0005F-A00 330 Added at Ver2.40
MH5LF MH005LF-A00 330 Added at Ver2.60
MH6F MH0006F-A00 450 Added at Ver2.81
MH6SF MH006SF-A00 450 Added at Ver2016SP3
MH12 MH12-A00 450 Added at Ver2016SP1
MPK2F MPK002F-A00 420 Added at Ver2.60
MPK2F-5 MPK002F-A20 420 Added at Ver2.70
MPL160 MPL0160-A00 880 Added at Ver2.70
MPP3 MPP0003-A00     0 Added at Ver2.40
MPP3H MPP003H-A00     0 Added at Ver5.11
MPP3S MPP003S-A00     0 Added at Ver4.10
SDA5F SDA005F-A00 900 Added at Ver2.45
SDA10F SDA010F-A00 1200 Added at Ver2.40
SDA20F SDA020F-A00 550 Added at Ver5.10
SIA5F SIA005F-A00 309.5 Added at Ver2.70
SIA10F SIA010F-A00 360 Added at Ver2.44
SIA20F SIA020F-A00 410 Added at Ver2.44

Model Name Robot Type
(Model File Name) Offset Value (mm) Remarks
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 NX100  

Model Name Robot Type
(Model File Name) Offset Value (mm) Remarks

DA20 DA20-A00 559
DIA10 DIA10-A00 1037
DIA20 DIA20-A00 1050 Added at Ver2.10
DX1350N DX1350N-A00 480
EA1400N EA1400N-A00 450
EA1400N 
Ceiling Mounted Type

EA1400N-A10 450

EA1800N EA1800N-A00 555
EA1900N EA1900N-A00 505
EA1900N 
Ceiling Mounted Type

EA1900N-A10 505

ECD2500D-3700 ECD80D-A00     0 Added at Ver2.20
ECR200 ECR200-A00 735
ECR3J ECR3J-A00 290 Added at Ver2.20
ECR400R-200 ECR400R-A10 1005 Added at Ver2.20
ECR400R-400 ECR400R-B00 1005 Added at Ver2.20
ECS15DWN-1400 ECS15DN-D10 770 Added at Ver2016SP3
ECS600N ECS600N-A01 730 Added at Ver2.21
EH80 EH80-A00 540
EH130 EH130-A00 650
EH130 EH130-A20 650
EH200 EH200-A00 730
EH200-150 EH200-A10 730
EP4000N EP4000N-J00 740
EP4000N EP4000N-J10 740
EP4000N EP4000N-J30 740
EP4000N EP4000N-J40 740
EP4000N EP4000N-J50 740
EP4000N EP4000N-J60 740
EP4000N EP4000N-K00 740
EP4000N EP4000N-K10 740
EP4000N EP4000N-K30 740
EP4000N EP4000N-K40 740
EP4000N EP4000N-K50 740
EP4000N EP4000N-K60 740
EP4000N EP4000N-L00 740
EP4000N EP4000N-L10 740
EP4000N EP4000N-L30 740
EP4000N EP4000N-L40 740
EP4000N EP4000N-L50 740
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EP4000N EP4000N-L60 740
EPH130 EPH130-A00 730
EPH130 EPH130-C24 730
EPH130R EPH130R-A00 600
EPH130RL EPH130RL-A00 600
EPH130RL EPH130RL-A54 600
EPH130RL-85 EPH130RL-A34 600
EPH130RL-85 EPH130RL-A60 600 Added at Ver1.42
EPH4000 EPH4000-J01 758
EPH4000 EPH4000-J11 758
EPH4000 EPH4000-J31 758
EPH4000 EPH4000-J41 758
EPH4000 EPH4000-J51 758
EPH4000 EPH4000-J60 758
EPH4000 EPH4000-J71 758 Added at Ver1.42
EPH4000 EPH4000-J81 758 Added at Ver1.20
EPH4000 EPH4000-JA0 758
EPH4000 EPH4000-K01 758
EPH4000 EPH4000-K11 758
EPH4000 EPH4000-K31 758
EPH4000 EPH4000-K41 758
EPH4000 EPH4000-K51 758
EPH4000 EPH4000-K60 758
EPH4000 EPH4000-KA0 758
EPH4000 EPH4000-L01 758
EPH4000 EPH4000-L11 758
EPH4000 EPH4000-L31 758
EPH4000 EPH4000-L41 758
EPH4000 EPH4000-L51 758
EPH4000 EPH4000-L60 758
EPH4000 EPH4000-LA0 758
EPL80 EPL80-A00 540
EPL160 EPL160-A00 880
EPL160 EPL160-A10 880
EPL300 EPL300-A00 880
EPL300 EPL300-A10 880
EPL500 EPL500-A00 880
EPL500 EPL500-A10 880
EPX1250 EPX1250-A000 310 Added at Ver2.80
EPX2050 EPX2050-A300 600 Added at Ver2.80
EPX2050 EPX2050-A500 600 Added at Ver2.80
EPX2700 EPX2700-A000 0 Added at Ver2.80

Model Name Robot Type
(Model File Name) Offset Value (mm) Remarks
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EPX2700 EPX2700-A100 0 Added at Ver2.80
EPX2750 EPX2750-A300 600 Added at Ver2.80
EPX2800 EPX2800-A000 795.5 Added at Ver2.80
EPX2800R EPX2800R-A000 817.5 Added at Ver2.80
EPX2900 EPX2900-A000 750 Added at Ver2.80
ES120N ES120N-A00 650 Added at Ver2.00
ES120N ES120N-A20 680 Added at Ver2.00
ES165N ES165N-A00 650
ES165N-100 ES165N-A10 650
ES165RN ES165RN-A00 450
ES200N ES200N-A00 650
ES200RN ES200RN-A00 450
ES200TN ES200TN-A00 650
ES200RN-120 ES200RN-A10 450
ES280N ES280N-A00 650
HP3 HP3-A00 300
HP3J HP3J-J00 290
HP3L HP3L-A00 300
HP3XF HP3XF-A00 300
HP3XF HP3XF-B00 300
HP5 HP5-A00 300
HP6 HP6-A00 450
HP6R HP6-R00 240
HP6R HP6-R10 240
HP6S HP6-A10 450
HP20 HP20-A00 505
HP20-6 HP20-A10 505
HP20 IP65 HP20-A20 505
HP20R HP20R-B2C 305 Added at Ver2.00
HP165 HP165-A00 650
IA20 IA20-A00 450
SDA10 SDA10-A00 1200
SDA10 SDA10-B00 550 Added at Ver2.10
SDA20 SDA20-A00 550 Added at Ver1.42
SIA10 SIA10-A00 360 Added at Ver1.20
SIA20 SIA20-A00 410 Added at Ver1.20
SP800N SP800N-A00 540
SSA2000 SSA3-A00 450
SSA2000
Ceiling Mounted Type

SSA3-A10 450

SSF2000 SSF6-A00 450
SSF2000R SSF6R-A20 240 Added at Ver2.00

Model Name Robot Type
(Model File Name) Offset Value (mm) Remarks
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UP20MN UP20MN-A00 540
UP50N UP50N-A00 540
UP50N UP50N-A51 540
UP50N UP50N-AA1 540 Added at Ver1.20
UP50N-80 UP50N-A10 540
UP50SN UP50N-A20 540
UP50SN UP50N-A71 540
UP50N-35 UP50N-A30 540
UP50RN-35 UP50RN-A10 450
UP120EN-165 UP120EN-A10 525
UP130RN UP130RN-B00 600 Added at Ver1.20
UP130RLN UP130RN-A2A 600
UP130RLN UP130RN-A2B 600
UP130RLN-85 UP130RN-A4A 600
UP350N UP350N-A00 900
UP350N-200 UP350N-A10 900
UP350N-500 UP350N-A20 900
UP350N-600 UP350N-A30 900
UP400RN UP400RN-A00 1000

Model Name Robot Type
(Model File Name) Offset Value (mm) Remarks
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 MOTOPOS
YRC1000

DX200

DX100

Model Name Robot Type Model File Name Remarks

D250B(A00) MPD250B-A00 MPD250B-A00 Added at Ver2017
D250F-A00 MPD250F-A00 MPD250F-A00 Added at Ver2017SP1
D500B(A00) MPD500B-A00 MPD500B-A00 Added at Ver2016SP3
D500B(B00) MPD500B-B00 MPD500B-B00 Added at Ver2016SP3
D500F(A00) MPD500F-A00 MPD500F-A00 Added at Ver2020SP1
D700F(A00) MPD700F-A00 MPD700F-A00 Added at Ver2020SP1
D700F(A04) MPD700F-A04 MPD700F-A04 Added at Ver2020SP1
S250B(A00) MPS250B-A00 MPS250B-A00 Added at Ver2017
S250B(B00) MPS250B-B00 MPS250B-B00 Added at Ver2016SP3
S500B(A00) MPS500B-A00 MPS500B-A00 Added at Ver2016SP3
S500B(A30) MPS500B-A30 MPS500B-A30 Added at Ver2017
S500E-A00 MPS500E-A00 MPS500E-A00 Added at Ver2016SP3
S500F-A00 MPS500F-A00 MPS500F-A00 Added at Ver2017
S1000F-A00 MPS1000F-A00 MPS1000F-A00 Added at Ver2021
T2000F-A00 MPT2000F-A00 MPT2000F-A00 Added at Ver2021
T5000B MPT5000B-A00 MPT5000B-A00 Added at Ver2016SP3
T5000F-A00 MPT5000F-A00 MPT5000F-A00 Added at Ver2021

Model Name Robot Type Model File Name Remarks

D250B(A00) MPD250B-A00 D250B-A00 Added at Ver2015
D250B(B00) MPD250B-B00 D250B-B00 Added at Ver2015
D500B(A00) MPD500B-A00 D500B-A00 Added at Ver5.20
D500B(B00) MPD500B-B00 D500B-B00 Added at Ver2015
D700B(A00) MPD700B-A00 D700B-A00 Added at Ver5.20
S250B(A00) MPS250B-A00 S250B-A00 Added at Ver5.20
S500B(A00) MPS500B-A00 S500B-A00 Added at Ver5.20
S500E-A00 MPS500E-A00 S500E-A00 Added at Ver2015
T5000B MPT5000B-A00 T5000B-A00 Added at Ver2015

Model Name Robot Type Model File Name Remarks

D200B-C00 MPD200B-C00 D200B-C00 Added at Ver2.45
D250B(A00) MPD250B-A00 D250B-A00
D250B(B00) MPD250B-B00 D250B-B00 Added at Ver2015
D500B(A00) MPD500B-A00 D500B-A00
D500B(A12) MPD500B-A12 D500B-A12
D500B(B00) MPD500B-B00 D500B-B00 Added at Ver2015
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NX100

D700B(A00) MPD700B-A00 D700B-A00 Added at Ver2.20
S250B(A00) MPS250B-A00 S250B-A00
S500B(A00) MPS500B-A00 S500B-A00
S500E-A00 MPS500E-A00 S500E-A00 Added at Ver2015
T5000B MPT5000B-A00 T5000B-A00

Model Name Robot Type Model File Name Remarks

D200B-C00 MPD200B-C00 D200B-C00 Added at Ver2.45
D250B(A00) MPD250B-A00 D250B-A00
D250B(B00) MPD250B-B00 D250B-B00 Added at Ver2015
D500B(A00) MPD500B-A00 D500B-A00
D500B(A12) MPD500B-A12 D500B-A12
D500B(B00) MPD500B-B00 D500B-B00 Added at Ver2015
D700B(A00) MPD700B-A00 D700B-A00 Added at Ver2.20
S250B(A00) MPS250B-A00 S250B-A00
S500B(A00) MPS500B-A00 S500B-A00
S500E-A00 MPS500E-A00 S500E-A00 Added at Ver2015
T5000B MPT5000B-A00 T5000B-A00

Model Name Robot Type Model File Name Remarks
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 MOTOFEEDER

 MOTOFEEDER Ⅱ

Model registration on the VRC controller Model Name Remarks

Arm Length: 1600mm, With Manipulator, 
High-Speed Rotation Specification

MF216A Added at Ver2.80

Arm Length: 1600mm, With Manipulator, 
High-Speed Rotation Specification(with spindle unit)

MF216A_SPINDLE Added at Ver2.80

Arm Length: 1800mm, With Manipulator, 
High-Speed Rotation Specification

MF218A Added at Ver2.80

Arm Length: 1800mm, With Manipulator, 
High-Speed Rotation Specification(with Spindle unit)

MF218A_SPINDLE Added at Ver2.80

Arm Length: 1400mm, Without Manipulator, 
High-Speed Rotation Specification

MF214B Added at Ver2.80

Arm Length: 1400mm, Without Manipulator, 
High-Speed Rotation Specification(with spindle unit)

MF214B_SPINDLE Added at Ver2.80

Arm Length: 1600mm, Without Manipulator, 
High-Speed Rotation Specification

MF216B Added at Ver2.80

Arm Length: 1600mm, Without Manipulator, 
High-Speed Rotation Specification(with spindle unit)

MF216B_SPINDLE Added at Ver2.80

Arm Length: 1800mm, Without Manipulator, 
High-Speed Rotation Specification

MF218B Added at Ver2.80

Arm Length: 1800mm, Without Manipulator, 
High-Speed Rotation Specification(with spindle unit)

MF218B_SPINDLE Added at Ver2.80

Arm Length: 1600mm, With Manipulator, 
Heavy Load Specification

MF416A Added at Ver2.80

Arm Length: 1800mm, With Manipulator, 
Heavy Load Specification

MF418A Added at Ver2.80

Arm Length: 1400mm, Without Manipulator, 
Heavy Load Specification

MF414B Added at Ver2.80

Arm Length: 1600mm, Without Manipulator, 
Heavy Load Specification

MF416B Added at Ver2.80

Arm Length: 1800mm, Without Manipulator, 
Heavy Load Specification

MF418B Added at Ver2.80

Model registration on the VRC controller Model Name Remarks

Arm Length: 1200mm, Without Manipulator MF_12BD-A00 Added at Ver2018
Arm Length: 1200mm, Without Manipulator 
(DOUBLE SPINDLE UNIT)

MF_12BD-
A00_SPINDLE

Added at 
Ver2020SP1

Arm Length: 1400mm, Without Manipulator MF_14BD-A00 Added at Ver2018
Arm Length: 1400mm, Without Manipulator 
(DOUBLE SPINDLE UNIT)

MF_14BD-
A00_SPINDLE

Added at 
Ver2020SP1

Arm Length: 1600mm, Without Manipulator MF_16BD-A00 Added at Ver2018
Arm Length: 1600mm, Without Manipulator 
(DOUBLE SPINDLE UNIT)

MF_16BD-
A00_SPINDLE

Added at 
Ver2020SP1

Arm Length: 1800mm, Without Manipulator MF_18BD-A00 Added at Ver2018
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 MOTOFEEDER TILT

Arm Length: 1800mm, Without Manipulator 
(DOUBLE SPINDLE UNIT)

MF_18BD-
A00_SPINDLE

Added at 
Ver2020SP1

Arm Length: 1200mm, With MPX1150 MF_12AD-A00 Added at Ver2018
Arm Length: 1200mm, With MPX1150 
(DOUBLE SPINDLE UNIT)

MF_12AD-
A00_SPINDLE

Added at 
Ver2020SP1

Arm Length: 1800mm, With MPX1950 MF_18CD-A00 Added at 
Ver2020SP1

Arm Length: 1800mm, With MPX1950 
(DOUBLE SPINDLE UNIT)

MF_18CD-
A00_SPINDLE

Added at 
Ver2020SP1

Arm Length: 1200mm, With MPX1150 Wall MF_12DD-A00 Added at Ver2018
Arm Length: 1200mm, With MPX1150 Wall 
(DOUBLE SPINDLE UNIT)

MF_12DD-
A00_SPINDLE

Added at 
Ver2020SP1

Arm Length: 1400mm, Without MPX1150 Wall MF_14DD-A00 Added at Ver2018
Arm Length: 1400mm, With MPX1150 Wall 
(DOUBLE SPINDLE UNIT)

MF_14DD-
A00_SPINDLE

Added at 
Ver2020SP1

Arm Length: 1400mm, With EPX1250II MF_14ED-A00 Added at 
Ver2020SP1

Arm Length: 1400mm, With EPX1250II 
(DOUBLE SPINDLE UNIT)

MF_14ED-
A00_SPINDLE

Added at 
Ver2020SP1

Arm Length: 1600mm, With EPX1250II MF_16ED-A00 Added at 
Ver2020SP1

Arm Length: 1600mm, With EPX1250II 
(DOUBLE SPINDLE UNIT)

MF_16ED-
A00_SPINDLE

Added at 
Ver2020SP1

Arm Length: 1800mm, With EPX1250II MF_18ED-A00 Added at 
Ver2020SP1

Arm Length: 1800mm, With EPX1250II 
(DOUBLE SPINDLE UNIT)

MF_18ED-
A00_SPINDLE

Added at 
Ver2020SP1

Model registration on the VRC controller Model Name Remarks

Without Manipulator MT226BD-A00 Added at Ver2021
With MPX2600 MT226GD-A00 Added at Ver2021

Model registration on the VRC controller Model Name Remarks
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15.10Frequently-Asked Questions

 When the driver has been installed with USB type key connected to 
a personal computer

1. With the USB type key attached to a personal computer, delete the item registered as 
"USB Token" in Device Manager.

2. Uninstall the driver (Sentinel System Driver 5.41.1(32-bit)) with "Add/Remove Pro-
grams".

3. Install the driver with key detached from personal computer.

 When a older version key driver has been installed over a newer key 
driver version.

In such case, the key driver may not operate properly.
Uninstall the Sentinel System Driver with Windows "Add / Remove Programs" function.  Then 
reinstall the Sentinel key driver.  For details, please refer to section " 1.4  Hardware Key " of 
the manual.

 Cell file dosen't display properly
Check that the full path of the cell file is less than 240 characters and that the cell file is saved 
in a folder that you have access right.

 Cell file containing HSF files don't display properly
When cell file containing HSF model files, if the HSF format version is higher than the one cur-
rently supported by MotoSim EG-VRC, the HSF file may not display properly.  In the case that 
a newer MotoSim EG-VRC version displays the cell properly, the newer MotoSim EG-VRC 
can save the cell file in a previous MotoSim EG-VRC format.  This will also save the HSF file 
into the corresponding format version (Refer to section " 4.3.2  Save As " for details.)  If the 
HSF file was generated by a 3rd party software, look in the that software HSF export options 
to export the file in an HSF format version corresponding to you current version of MotoSim 
EG-VRC.

 MotoSim EG Cell file compatibility
MotoSim EG-VRC can convert and load files created by MotoSim EG but cannot playback the 
job and the robot operations are limited.  The MotoSim EG robot should be replace by the 
VRC corresponding robot type.  Please refer to section " 13.5  Dual-Arm robot Setting ". 
Cell file created with MotoSim EG-VRC cannot be used by MotoSim EG or MotoSim EG.  

 MotoSim EG-VRC - CadPack Cell file compatibility
Cell file created with MotoSim EG-VRC can be used by MotoSim EG-VRC-CadPack.  Cell file 
created with MotoSim EG-VRC-CadPack can also be used by MotoSim EG-VRC even if CAD 
data (IGES,SAT) was imported into the cell.  When saving the cell, the MotoSim EG-VRC-
CadPack converts imported CAD data into HSF files.  Once that conversion is done, the regu-
lar MotoSim EG-VRC can open the file without problems. 
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 Backup VRC.BIN file
If computer power shortage or an application error occurs when MotoSim EG-VRC is access-
ing the VRC.BIN file, the file may become corrupted and prevent the controller and Virtual 
Pendant to load properly.  As a safeguard, when the cell is saved, the previous copy of the 
VRC.BIN is kept as a backup.

To restore the backup copy of the VRC.BIN file:
1. Open the controller folder under the cell directory and rename the VRC.BIN.bak file to 

VRC.BIN.  
2. Start MotoSim EG-VRC but don’t open the cell yet.  If MotoSim EG-VRC is already run-

ning, close all the cells.
3. Start the controller in maintencae mode with the restored CMOS.BIN file On the [Con-

troller] tab, in the [Boot] group, click the [Maintenance mode] button, and then selecting 
the newly renamed VRC.BIN. (For details, refer to section " 7.10  VRC Maintenance 
Mode ".)

4. Load the VRC.BIN on the Virtual Pendant, select {Compact Flash} - {LOAD CMOS}.  
(This may take a few moments and warning message, indicating not to turn off the con-
troller, appears at the bottom of the Virtual Pendant.  Wait until the message disap-
pears before proceeding to another operation that may cause the controller to reboot 
or close. )

5. Once the VRC.BIN load is done, close the controller by pressing the “End” button of 
the “VRC Maintenance Mode” dialog.

6. Open the cell.

 Recovery method when an alarm occurs during the creation of a 
new controller.

When a new controller is created with the "VRC Controller (using CMOS.BIN file)" of an actual 
controller, alarms may display on the Virtual Pendant. 
In such case, use the following procedure:

1. Save the cell and then close it.
2. On the [Controller] tab, in the [Boot] group, click the [Maintenance mode] button, the 

[Maintenance mode] dialog appears. 

3. The VRC Maintenance Mode dialog will display.  Use the browsing button to select the 
VRC.BIN file located in the controller folder under the cell folder.  Once the VRC.BIN 
file is selected, press the [Start] button.  The controller will start in maintenance mode 
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and display the Virtual Pendant (it may take a few moments).

The procedures below corresponds to various alarm.

Alarm 0320 Verify error (I/O Module)
(1) Select {System} - {Setup}.
(2) Select [I/O Module].

(3) Press the [Enter] key twice.  When the confirmation message displays, select [Yes]. 
(4) Press the [End] button of the [VRC Maintenance Mode] dialog to close the control-

ler.  
(5) When all the step above are completed.  Reopen the cell.

Alarm 0020 Communication Error(CPU)
(1) Select {System} - {Setup}.
(2) Select [Options].
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(3) Press the [Enter] key.  When the confirmation message displays, select [Yes]. 
(4) Press the [End] button of the [VRC Maintenance Mode] dialog to close the control-

ler.  
(5) When all the step above are completed.  Reopen the cell. 

Alarm 0060 Communication Error (IO Module) [16]
(1) Select {System} - {Setup}.
(2) Select [Options].

(3) Press the [Enter] key.  When the confirmation message displays, select [Yes]. 
(4) Select [IO Module].
(5) When the [IO Module] displays, press the [Enter] key twice.
(6) When the confirmation message displays, select [Yes].
(7) Press the [End] button of the [VRC Maintenance Mode] dialog to close the control-

ler.  
(8) When all the step above are completed.  Reopen the cell. 

Error 3100 Total checksum error

The CMOS cannot be loaded because the “VRC.BIN” version is from a controller version 
incompatible with the selected VRC version.
In such case, retrieve the individual data files from the actual controller and load them in the 
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VRC controller.
1. On the pendant of the actual controller, select [FD/CF] - [SAVE] and save:

• All the files from the JOB, FILE /GENERAL DATA, I/O DATA, SYSTEM DATA  sec-
tion.

• The "BATCH PARAMETER (ALL.PRM)" file under the PARAMETER section.
2. In MotoSim EG-VRC, select [Controller] - [New Controller] and add a new controller 

with "No CMOS.BIN file".
Please refer to section " 7.1  Adding a New Controller " for more details.

3. Copy the individual files retrieved from the actual controller in the "Storage Card" folder 
under the controller folder of the cell. 

4. On the Virtual Pendant, select [FD/CF] - [LOAD]

 Trouble shooting when virtual pendant doesn't accept operation 
after newly making controller (Nothing is displayed on the screen).

When a virtual pendant starts in the ordinary mode after completing CMOS loading operation 
in the maintenance mode when newly making it by setting "VRC Controller (using CMOS.BIN 
file)" when the controller newly makes it, a virtual pendant might not accept the operation at all 
(Even if the menu is selected, nothing is displayed on the screen).

When this phenomenon is generated, it restores it according to the following procedures.

1. After the cell is preserved, the cell is closed. 
2. On the [Controller] tab, in the [Boot] group, click the [Maintenance mode] button.

3. [VRC Maintenance Mode] appears.
Select "VRC.BIN" that exists in the controller folder below the folder where the cell 
exists, Push [Start] , and the maintenance mode is started.

When initializing this new controller, make sure to select the same settings as the actual 
controller (the control group and application must match to be able to load the individual 
files).

When loading the individual files, please proceed in the following order:
(1) PARAMETER file
(2) I/O DATA files
(3) Other files

Please refer to section " 15.3  Storage Card " for details.

NOTE

NOTE
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4. Select [SYSTEM]-[SETUP]. 
5. Select [OPTION BOARD].

6. Because the confirming message displays to push [enter], select [yes]. 
7. The “IO MODULE” screen displays it continuously. Select [SYSTEM]-[SETUP]-[IO 

MODULE] When it is not displayed.

8. Because the confirming message displays to push [enter] twice, select [yes].
9. The [End] is selected by the [VRC Maintenance Mode], and the maintenance mode is 

ended.
10. The restoration operation is completed above. Please open the cell again.

 Caution on setting up two or more 4-axis robots (ex. MPL300) to the 
one controller

On creating a new controller without a New VRC Controller (no file), If two or more 4-axis 
robots are set up to the one controller, use the following procedure certainly.
Basically, the following procedure is equal to that of " 7.1.1  Create a New VRC Controller (no 
file) ", but Setting on the [CONNECT] display of "Initialize the controller in the step 3" is used 
the following procedure.

The procedure is explained with setting up the two 4-axis robots to the one controller.

826/847



15.10  Frequently-Asked Questions

HW0485348

Procedure
1. Proceed to the step 1 to 3 of " 7.1.3  Initializing the Controller (YRC1000, YRC1000mi-

cro, DX200, DX100, NX100) ".
2. On setting [CONNECT] in the step 4 of " 7.1.3  Initializing the Controller (YRC1000, 

YRC1000micro, DX200, DX100, NX100) ", change [SV] from "#1" to "#2".

3. Proceed to the step 5 to 10 of " 7.1.3  Initializing the Controller (YRC1000, 
YRC1000micro, DX200, DX100, NX100) ".

 Way to make the display speed faster
When the large CAD data is used, the Collision Detection function is used, or the performance 
of using PC is low, the display process can not executed smoothly, so the simulation speed 
may be lower.
If the above symptoms occurred, do the following operation, and the display performance may 
be made better.

• Raise the number of Refresh Interval
The number of redrawing is reduced, so the load of redrawing is reduced.

→ For details, please refer to the section " 7.5.4  Refresh Interval ".
• Reduce the number of trace or Delete the trace

The number of drawing trace is reduced, so the load of drawing trace is reduced.
→ For details, please refer to the section " 7.9  Trace ".

• Enable "Back Plane Culling" of models
The back plane of the CAD data is hidden, so the CAD data is displayed faster.

→ For details, please refer to the section " 11.3  Editing a Part ".
• Raise the Culling Threshold of Framerate Optimization

Model data which displayed size is smaller than the selected pixel on the display are not 
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displayed, so the model is displayed faster.
→ For details, please refer to the section " 12.5  Other ".

• Hide the shadow
The shadow is hidden, so the load of drawing shadow is reduced.

→ For details, please refer to the section " 12.1.4  Shadow ".
• Disable "Smooth Transition"

The viewpoint changes without "Smooth Transition", it changes immediately.
→ For details, please refer to the section " 12.1.2  Smooth Transition ".

• Drawing performance is measurable.
On the [Home] tab, in the [Tools] group, click the [Measure Performance] button, the 
screen of MotoSimEG-VRC begins rotation and displays the number of drawing frames 
per second. If it measures before and after setting change and the following red frame 
numerical value becomes large, it is shown that drawing performance is going up.

 Solution in case characters is missing from the screen of MotoSi-
mEG-VRC in Windows7

When a character is missing from the screen of MotoSimEG-VRC in Windows7, please 
change character size by the following procedure.

1. Open the {Display} of Control Panel.
To open {Display}, Click the [Start] button, and [Control Panel].
(a) In the case of "View by" is "Category":

Click the [Appearance and Personalization] and [Display].
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(b) In the case of "View by" is "Large icons" or "Small icons":
Click the [Display].

2. In [Make it easier to read what's on your screen], Select the [Smaller - 100%] button, 
and click the [Apply] button.

 Docking Window
Some windows are dockable with any of the four directions of the main screen.
In MotoSim EG-VRC, the following windows are dockable.

• Position Panel
• OLP
• CadTree
• Variable Monitor
• Pulse Recorder
• Lap Time Panel
• Collision Detection
• Model Library
• Simple PP
• JobPad
• I/O Monitor
• Lap Time Panel
• BreakPoint
• Debug Monitor
• Safety logic circuit
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Docking Operation
When the window is dragged to another position, the guide diamond is displayed in order to 
re-dock the window.

When the dragged window reaches the location where want to dock it , move the pointer over 
the corresponding portion of the guide diamond. The designated area is shaded. To dock the 
window in the position indicated, release the mouse button.

 

Guide Diamond 

830/847



15.10  Frequently-Asked Questions

HW0485348

Floating Operation
Drag the window, and release the mouse button at places other than the guide diamond.
However, the window is "Auto Hide" enabled (  ), the window can not be froated. So, make 
the window "Auto Hide" dislabed (  ), and float the window..

To Enable Auto Hide

Click the pushpin icon on the title bar of 
the window, the window becomes "Auto 
Hide" enabled (  ). The window slides 
out of the way. When a window is auto-
hidden, its name appears on a tab at the 
edge of the main window.

To use the window, point to the tab so 
that the window slides back into view.

 

Drag 

 Click 

The window slides out 

The name appears 
on a tab 

 
Point to the tab 

The window appears 
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To Disable Auto Hide
Click the pushpin icon again on the title bar of the window, the window becomes "Auto Hide" 
disabled (  ).

Docking Operation with Two or More Windows
When two or more dockable windows show, it can dock not only with the main window but with 
another window. However, the window is "Auto Hide" enabled (  ), the window can not be 
froated. So, make the window "Auto Hide" dislabed (  ), and dock the window. 

Floating Operation with Two or More Windows
Drag the window, and release the mouse button at places other than the guide diamond.
Please refer to the "Floating Operation" for details.

Docking Operation as Tab with Two or More Windows
When two or more dockable windows show, Windows are dockable also as a tab.

Drag the window and move the pointer over the center of the guide diamond (   ) or drag to 

The window slides out of the way when use a 
different window.  

The window 
slides out 

 Drag to the another window 

Release the mouse button 

The window is docked 
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the title bar of another dockable window and release the mouse button.

Floating Operation as Tab with Two or More Windows
To float the window shown as the tab, drag it, and release the mouse button at places other 
than the guide diamond.
However, the window is "Auto Hide" enabled (  ), the window can not be froated. So, make 
the window "Auto Hide" dislabed (  ), and dock the window.

                     

Drag to the another window 

Release the mouse 
button 

The window is docked 

   

Drag 
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 Quick Access Toolbar
"Quick Access Toolbar" is convenient to execute a command quickly, without not changing a 

ribbon tab or displaying a menu from the MotoSim EG-VRC button (  ). 

If prepopulate the quick access toolbar with the frequently used commands, the button of the 
commands can always be displayed.

1. To customize the quick access toolbar, click the the following button. (  )

2. When add the "Open" command to the quick access toolbar, click the "Open" menu. 
When add the other commands, click the "More commands..." menu. The "Customize" 
dialog appears.

3.  Select the tab name by "Choose commands from" list box, and the commands is dis-

 
 

 

Quick Access Toobar 

 
 
 

 

Customize the quick  
access toolbar 
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played. Select the command, and click the [Add] button.

4. The added command is diplayed in the right side list. Click the [OK] button.
Then the command is added to the quick access toolbar.

To delete the command button from the quick access toolbar, right-click the target button, 
and click the "Remove from Quick Access Toolbar on the shortcut menu" menu.
When add or remove the two or more buttons, it can be operated efficiently in the "Custom-
ize" dialog.

NOTE
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 Comparison Table with the New Menu from the Old Menu and the 
Old Tool Bar

Old Menu and the Old Tool Bar New Menu

File

New
 -  - 

Open
 -  - 

Close

Save
 - 

Save As
 - 

Open Sample Cell
 -  - 

Template
 -  - 

Exit
 - 

Edit

Undo
[Home] - [Edit] - 

Redo
[Home] - [Edit] - 

Copy [Home] - [Tools] - 

Screen

Camera Scope

Zoom To Extents [Home] - [View] - 

Direction

View [Home] - [View] - 

Side [Home] - [View] - 

Top [Home] - [View] - 
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Front [Home] - [View] - 

View Manager [Home] - [View] - 

Select Model
[Home] - [Model] - 

Pick Mode

[Home] - [Pick] - Free

Vetex

Center

Edge

Pick  Object
[Home] - [Pick] - Models

Frames

Lines

Points

Floor

Line Size [Home] - [Screen] - 

Small

Medium

Large

Frame Display

[Home] - [Screen] - 

Rendering Mode [Home] - [Screen] - 

FlatShading

GourandShading

Wireframe

SmoothTransition

Light Manager [Home] - [Screen] - 

Shadow [Home] - [Screen] - 

Old Menu and the Old Tool Bar New Menu
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Memo [Home] - [Screen] - 

Dimension Line [Home] - [Screen] - 

Markup [Home] - [Screen] - 

Freehand

Circle

Rectangle

Notes

Cutting Planes

[Home] - [Screen] - X-Cutting Planes

Y-Cutting Planes

Z-Cutting Planes

Measure

Distance [Home] - [Mesurement] - 

Angle [Home] - [Mesurement] - 

Controller

New Controller
[Controller] - [Setup] - 

Copy Controller
[Controller] - [Setup] - 

Delete Controller
[Controller] - [Setup] - 

Select Controller/Robot

Controller Setting

Tool Data

[Controller] - [File Settings] - 

Old Menu and the Old Tool Bar New Menu
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User Frame Data

[Controller] - [File Settings] - 

Open a folder external 
storage [Controller] - [VPP] - 

Reboot Controller
[Controller] - [Boot] - 

Boot Maintenance-
Mode [Controller] - [Boot] - 

Refrash Interval [Home] - [Settings] - 

Servo Emulation [Simulation] - [Playback] - 

Welding Condition [Controller] - [File Settings] - 

Cube Area Update & 
Display

[Controller] - [File Settings] - 

Delete Cube Area 
Model

Safety Function [Controller] - [File Settings] - 

Safety Function 
File

Tool Interfer-
ence Model

Robot Approxi-
mate Model

Robot Setting

Property [Controller] - [Robot] - 

ReachView [Controller] - [Robot] - 

Calibration [Controller] - [File Settings] - 

Device

[Controller] - [External Device] - Add Conveyor

Ade Press

Add Gantry

SoftLimit Setting [Controller] - [External Device] - 

Old Menu and the Old Tool Bar New Menu
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Job Panel [Controller] - [External Device] - 

Conveyor Operation 
Panel

[Controller] - [External Device] - 

Conveyor Setting [Controller] - [External Device] - 

Conveyor Synchoroni-
zation

[Controller] - [External Device] - 

Playback

Cycle Time [Simulation] - [Playback] - 

Start
[Simulation] - [Playback] - 

Hold
[Simulation] - [Playback] - 

Step Next
[Simulation] - [Playback] - 

Step Back
[Simulation] - [Playback] - 

Reset Job
[Simulation] - [Playback] - 

Trace
[Simulation] - [Monitor] - 

Model

New Model

Edit Model

Hide/See

Model

Frame

Name

Wiring View

Model Attribute

Set Parent

Move Parent

Set File Path

Old Menu and the Old Tool Bar New Menu
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Rename

Set Position

Property

Edit

Cut

Copy

Patsh

Delete

Fine

Model Tree View

Refresh View

Expand Tree

Models List

Save Model Group

Load Model Group

Model Script Editor

[Simulation] - [Model Simulation] - 

Tool

CAD Tree
[Home] - [Model] - 

Positon Panel
[Home] - [Teaching] - 

OLP
[Home] - [Teaching] - 

Job Shift

I/O Monitor
[Simulation] - [Monitor] - 

I/O Events

[Simulation] - [I/O Settings] - 

I/O Connections

[Simulation] - [I/O Settings] - 

Old Menu and the Old Tool Bar New Menu
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Variable Monitor
[Simulation] - [Monitor] - 

Lap Time Panel

[Simulation] - [Monitor] - 

StafeMaster [Simulation] - [Playback] - 

Collision Detection

[Simulation] - [Collision] - 

Sensing Definition

[Simulation] - [Settings] - 

Pulse Record

[Simulation] - [Monitor] - 

Paing Setting

[Simulation] - [Settings] - 

Show Speed Graph
[Simulation] - [Monitor] - 

Execute Soft [Home] - [Tools] - 

Execute JobBraowser
[Home] - [Teaching] - 

Option
 - 

[Home] - [Settings] - 

CAM

[Home] - [Teaching] - Create Job Form CAM

Load Robot Settings

Option Tool

Motor Load Estimate

[Tool] - [Estimate] - 

Life Estimate
[Tool] - [Estimate] - 

View

Toolbar

Old Menu and the Old Tool Bar New Menu
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File Bar

Edit Bar

Playback Bar

CAD Bar

View Bar

Controller Bar

Memo Bar

Cutting Bar

Mesure Bar

Status Bar

Japanese

Windwos

Cascade

Tile Horizontally

Tile Vertically

Split

Help

Help
 - 

CAM Help
 - 

Version

Performance [Home] - [Tools] - 

Toolbar Only

[Controller] - [VPP] - 

[Home] - [Operation Handle] - 

[Home] - [Operation Handle] - 

[Home] - [Operation Handle] - 

Old Menu and the Old Tool Bar New Menu
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 Solution in case "The program can't start because MSVCP110.dll is 
missing from your computer." is displayed

"Microsoft Visual C++ 2012 Update 4 Redistributable Package" might not be installed.

• In case MotoSim EG-VRC is 64-bit application
In the Install DVD, 

(1) \setup_64bit\ISSetupPrerequisites\{BF2F04CD-3D1F-444e-8960-D08EBD285C3F}
        vcredist_x86.exe

(2) \setup_64bit\ISSetupPrerequisites\{3A3AF437-A9CD-472f-9BC9-8EEDD7505A02}
        vcredist_x64.exe

are executed, install "Microsoft Visual C++ 2012 Update 4 Redistributable Package".
Please check MotoSim EG-VRC can start.

• In case MotoSim EG-VRC is 32-bit application
In the Install DVD, 
        \setup_32bit\ISSetupPrerequisites\{BF2F04CD-3D1F-444e-8960-D08EBD285C3F}
                vcredist_x86.exe
is executed, install "Microsoft Visual C++ 2012 Update 4 Redistributable Package".
Please check MotoSim EG-VRC can start.

 Way to import a DWG file
DWG file may be able to be imported by changing the extension of CAD file to DXF.

 Solution in case characters is missing from the screen of MotoSim 
EG-VRC and virtual pendant in Windows10 Version 1703 or later 
with the high resolution monitor

When a character is missing from the screen of MotoSim EG-VRC and virtual pendant in Win-
dows10 Version 1703 or later with the high resolution monitor, please change the settings by 
the following procedure.

1. Open the installation folder of MotoSim EG-VRC in File Explorer.
(Ex1: C:\Program Files\MOTOMAN\MotoSimEG-VRC 2017SP2)
(Ex2: C:\Program Files (x86)\MOTOMAN\MotoSimEG-VRC 2017SP2)

2. Display the right-click menu with MotoSimEG-VRC.exe in the installation folder and 
select [Properties].

3. In the "Properties" dialog, on the "Compatibility" tab, under "Settings", check "Override 

[Home] - [Operation Handle] - 

[Home] - [Operation Handle] - 

[Home] - [Operation Handle] - 

Old Menu and the Old Tool Bar New Menu
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high DPI scaling behavior." and set "Scaling performed by:" to "System (Enhanced)".

4. Click the [OK] button.
5. Repeat STEP2 through STEP4 for each of the following files in the "Controller" folder in 

the MotoSim EG-VRC installation folder.
• Controller\DX100\VPP\DXPP_2.02-00\YppMain.exe
• Controller\DX200\VPP\DNPP_1.00-00\YppMain.exe
• Controller\FS100\VPP\FSPP_1.00-00\YppMain.exe
• Controller\FS100\VPP\FLPP_2.00-00\YppMain.exe
• Controller\NX100\VPP\NXPP_4.30-00\NxPp.exe
• Controller\YRC1000\VPP\YASPP_1.30-00\YppMain.exe
• Controller\YRC1000micro\VPP\YBSPP_1.30-00\YppMain.exe

 Exception Setting of Anti-virus Software
When anti-virus software (Symantec, McAfee, etc.) is installed on a PC running MotoSim EG-
VRC, when running MotoSimEG-VRC.exe, an error may occur and execution may not be pos-
sible.
If this happens, you will need to reinstall MotoSim EG-VRC for recovery.

To avoid this problem, please set "Exception Setting" for the installation folder of MotoSim EG-
VRC with anti-virus software installed in PC.
The default installation folder is "C:\Program Files\MOTOMAN\<<Installation Version 
Name>>".

When cannot specify the folder by exception setting, please set the exception setting to the 
following files.
File storage folder: installation folder
Setting target file: CollisionDetectorManager.dll
                             COMGraph.dll
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                             ModelMakerCLI.dll
                             Motolk.dll
                             MotoSimEG-VRC.exe
                             msegcom.dll
                             PathPlanEgn.dll
                             RobotModel.dll
                             RtsLib32.dll
                             RtsRRSx.dll
                             Rwdll32b.dll
                             SpaCDHOOPS_3DF.dll
                             SPACDKernel.dll
                             SweepModelGenerator.dll
                             VRC_IF.dll
                             VRC_IF_CS.dll

 Error Screen Displayed When Starting MotoSimEG-VRC
If the expiration date of the hardware key has passed, the following screen is displayed. If you 
would like to upgrade, please contact our sales department.
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